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How to use Team Forge 6.1

INavigation title:TeamForge 6.1 How-tos |
CollabNet TeamForge makesit easy and fun to manage all phases of the software lifecycle, from requirementsthrough release.
You get software configuration management (SCM), continuous build and test, issue tracking, project management, lab
management, and collaboration tools, all in asingle tightly-integrated, cloud-based platform that empowers distributed teams
to deliver great software.

Note: If you've used TeamForge before, you'll notice that the system administrator and developer portions of the
user guide aren't here. We've moved those parts out to their own sections for better usability. There's one for each
platform that TeamForge supports: look lower in the table of contents for headings that look like "Administrating
TeamForge 6.1 on <OS>."

[ 1

Get started with CollabNet TeamForge
Take these steps to get started quickly and efficiently on your TeamForge site.

Note: If you are coming to TeamForge from a CollabNet Enterprise Edition site, see Moving to a CollabNet
TeamForge project from a CollabNet Enterprise Edition project on page 190 for guidance on how to keep doing
what you were doing on your old site.

[ N

Quick start: Working on a TeamForge project
Jump right in! Join a project, check out the code, meet your collaborators.

Join a TeamForge site
To collaborate with others on a CollabNet TeamForge site, start by getting a user account.

Note: You need alicenseto use a TeamForge site. Your site administrator may have already assigned you alicense.
If not, you'll be asked to choose the type of license you need when you create your account.

* AnALM license enablesyou to usethefull set of toolson the site, including Source Code, Trackers, Documents,
Tasks and Reports.

* An SCM license enables you to use the site for basic source code management. You can browse repositories
and participate in Wiki conversations.

1. If your site authenticates through LDAP, follow these steps.
If your site does not authenticate through LDAP, skip to the next set of steps.
a) IntheLogInto CollabNet TeamForge section of the site home page, enter your corporate LDAP user name
and password.

Tip: Inmost cases, your user name and password are the user name and password with which you log in

[
to your corporate network.

b) Click Log In.
¢) Onthe Create Account page, re-enter your L DAP password.
d) Enter your full name and email address and click Create.

2. If your site does not authenticate through LDAR, follow these steps.

a) Click Create an Account in the New User s section of the CollabNet TeamForge home page.
b) Onthe Create New Account page, enter auser name for your account.
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3.
4,
5.

Note: Your user name must meet these criteria

&
* Minimum number of characters as specified inthesi t e- opt i ons. conf
file.
e No spaces.

* At least oneletter.
* Thefirst character is aletter.

¢) Enter and confirm a password.

d) Fill intherest of thefieldsand click Create.
Check your email at the address that you provided.
Follow the link in the email to the L og In page.

Enter your user name and password, and click Log In.

Your CollabNet TeamForge account is now activated.

Join a project
To create, store, and share work on a CollabNet TeamForge site, first join a project.

1
2.

=

Log into CollabNet TeamForge .

On your My Page, click Projectsin your personal navigation bar.

Now you're looking at the projects of which you are already a member, if any.

Click the All Projectstab to see all CollabNet TeamForge projects you can see, based on each project's access
settings.

Select the project you want to join and click Request M ember ship.

On the Request Project Member ship page, explain why you want to join the project, and click Submit.

Your request is submitted to the project administrator for approval. You will receive an email notification when your
regquest is either approved or denied.

Tip: You can also request project membership by clicking Join this Project on the home page of the project you
want to join.

Identify yourself
To help get started on collaborating with other project members, you can provide some information about yourself.

This information appears whenever someone clicks your name anywhere on the site. For example, when an artifact is
assigned to you, your name appears as a link that other users can click.

1.
2.
3.

Click My Workspace in the CollabNet TeamForge navigation bar.

Click My Settingsin your personal navigation bar.

On your User Details page, in the User Details section, click Edit and provide some information to help potential
coworkers get to know you.

a) Click Browse to upload a 100-by-100-pixel picture of yourself, or of something that suggests who you are.

b) Under Detail, provide asummary of your interests, skills, or other characteristics.

Select the language you prefer to use. You can choose to receive emails from your TeamForge site in English,
Chinese, Japanese, or Korean.

Note: If your browser is set to use one of the available languages, you should already be seeing TeamForgein
that language in your web browser.

If necessary, review and change your password, official name, and email address.

Note: Thisisthe email address where you receive aerts about changes to items you are involved with, such

[ i
as adiscussion forum you are monitoring or a code commit associated with an artifact you created.
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6. Click Save.

Get the code
Browse CollabNet TeamForge to find the code you want to work on, then check out the code.

You can view the contents of each filein arepository, plus additional information about each file such asrevision history,
comments, date and time of submission, and branch and tag information. You can also view differences (diffs) between

any two files.
g~ Note: You can see only those paths in the repository that the repository administrator has given you access to.
g~ Note: If you're getting code from a Subversion replica repository, the TeamForge account used while setting up

the replica determines what's available to be checked out. This account could have been provided total accessto
the master repository, or restricted access using path-based permissions.

1. Click Source Codein the project navigation bar.

2. Onthelist of project repositories, click the name of the repository in which you want to view code.
For each file, the revision number, time since check-in, author, and last log entry appear in the Repository Browser.

* Toview afile, or to view the diffs between two files, click the file name.
» To view a specific version of thefile, click Download.
* To view the differences between two files, do either of these:

e Click [select for diffs] next to each of the two files that you want to compare.
« Enter thefile revision numbers in the Diffs between boxes at the bottom of the page.

3. If you need to diff files, choose a display from the Type of Diff menu, then click Get Diffs.
The differences between the two files are displayed.

4. Useyour source control client to check out the code to your local machine.

Find a forum
Read through a project's discussion forums to find out about the project's plans, accomplishments, and challenges.

1. Click Discussionsin the project navigation bar.
The Forum Summary page displays alist of al project forums, and summary information about each forum's
activity.

2. Click aforum name.
The Topic Summary page displaysalist of al forum topics and summary information about each forum topic's
activity.

3. Click atopic name.
The Forum Topic page displays all messages that have been posted in response to the original forum topic.

You can configure your view in the following ways:

» To set the number of messagesthat display on each page, choose avalue from the View menu, then click Update.
» Todisplay threaded messages, choose one of the following options, then click Update.

* Nested - by Reply - Displays threaded messagesin a hierarchical, nested format of up to 20 layers. Thisis
the default display.
e Flat - Chronological - Displays all messagesin chronological order with no nesting.
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Catch up on project news
Watch project news updates to stay up to date on events that might affect your participation in the project.

News items appear on the project home page, on the Newstab of each user's My page, and on the CollabNet TeamForge
home page.

1. Goto the project home page.

« From within the project, click Project Home in the project navigation bar.

« From anywhere else in CollabNet TeamForge , choose the project from the Proj ects menu in the CollabNet
TeamForge navigation bar.

2. Look for newsitems at the bottom of the project home page.
Each news item lists its author and the date it was posted.

Find project resources
To find something quickly, use the Search option.

g Tip: If you know an item's unique identifier and want to go directly to it, use the Jump to ID box.

1. Loginto CollabNet TeamForge.

g~ Note: If you are not logged in, you can search only projects and items that have been designated public.

2. Inthe CollabNet TeamForge navigation bar, click Search.

3. Onthe Search Criteria page, enter the keywords to search for.

4. Specify whether you want to search tracker artifact attachments or comments.
Comments include tracker artifact comments and task comments.

5. For documents, specify whether you want to search all document versions or only active document versions.
Searching only active document versions allows you to eliminate search results for outdated documents.

6. Click Search.

Your search results are organized by CollabNet TeamForge application. The search score indicates the relevance of
each result to your search criteria.

g Note: Only items that your project membership and permissions alow you to see are displayed.

Quick start: Managing a TeamForge project
Jump right in! Set up your project site, add your project members, plan out your work.

Create a TeamForge project
Create anew project when you have identified work to be done that has its own distinct character, dependencies or schedule.

What constitutes a project depends on your organization. Some organizations favor a small number of big, centralized
projects. Others prefer alarger number of smaller, specialized projects. Your site administrator can help you decide if
your work should be part of alarger project or a project of itsown.

1. Onyour TeamForge site's main page, click the Projects dropdown list and select Create New Project.
2. Onthe Create Project page, give the project aname and a brief description.

« The name will appear in project lists and on the project's home page.

* A tersedescription is recommended. There will be unlimited room to discuss the project's aims and methods in
detail on the project pages themselves.
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3. ProvideaURL name for the project, if you want the URL for the project to be different from the internal project
name.

If you do not enter a URL name, the project URL will be the same as the project name.

4. If your site administrator has provided project templates, select the appropriate one for your new project.

Project templates give you ready-made artifact types, workflow support, user roles and other start-up content
appropriate to the kind of project you are creating.

5. Click Create.

The project is submitted to the CollabNet TeamForge site administrator for approval. You will receive an email notification
when the site administrator approves or rejects your project. When your project is approved, you can get to it from your
My Projects page or from the Projects menu in your navigation bar.

Add users to a project
Before a person can work on a project, you have to make them a member of the project.

You can make any registered user on your CollabNet TeamForge site a project member. You can assign rolesto the
user at the same time.

Note: Project members, roles and the associated permissions can be inherited via project hierarchy and reused in
subprojects. If your project isasubproject of any other project, you may haveinherited someroles, project members
Oor USer groups.

[ N

Click Project Admin in the project navigation bar.

On the Project Admin menu, click User Member ship.

Click Add.

Onthe Add User page, find the users you want by one of these methods:

A w DN

e Under Search for Users, filter thelist of site users eligible to join this project. You can filter by full or partial
name or user name.

L Note: Search text is not case-sensitive.

» Browsethelist of registered userson the site. Sort them by name, user name, email address or membership status.

The inherited project members continue to hold the inherited roles with corresponding permissions, as specified
in the source projects.

Note: If asite hasagreat many users, you must filter them first to narrow down the list. This helps avoid
slowing down the system.

5. Select the users you want to add.
6. Under Assign Roles, select the roles you want the users to have.

Tip: If you prefer, you can skip this step and assign roles later on the Project Admin > Permissions page.

[ i
Note that using the Assigned Project M ember s page, you can assign roles only to the direct project members.

7. Saveyour changes.

» Click Saveto return to the Project Member ship page.
e Click Save and Add More to keep adding users.

Create a project page
To provide information and functionality to people viewing your project, build one or more project pages.

1. Go to the page to which your new page will belong.
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6.
7.

Tip: Any project page can have sub-pages belonging to it. A page that belongs directly to the project home
pageis called a "top-level page."

[ 1

Click Configure: On.
Choose where your new page will fit in your project's structure.

» To create apage just under the project home page, click Add top-level page.

A top-level page'stitleisaways visible in the navigation tree at eft.
» To create a page under the page you are on right now, click Add sub-page.

Give your new project page atitle.
Keep thettitle brief and descriptive.

Choose who can see this page.

g~ Note: Your choice will apply to all subpages that you create under this page.

» To show this page to anyone with the necessary permissions, select Visible. For example, if you have defined a
group of users who have access to your project, your new project page isvisible only to those users. If your
project is open to the public, anyone in the world can see it. Use this option when the information on this page
isready for awide audience.

» To show this page only to users with the project administrator role, select Hidden. Use this option if you are
drafting content that you aren't ready to share yet, or want to share only with other project managers.

Click Save.
Click Configure: Off.

Now you are ready to build functionality into your project page with components such as text, news or tracker queries.

Create a tracker
Create atracker whenever you need to report and track bugs, feature requests, support requests, or any other type of issue
where ownership, status, and activity must be managed.

Individual tracker entries are referred to as tracker artifacts. A tracker is a set of tracker items with a common purpose,
such as bug reports, feature requests, or tasks.

A w DN pR

Click Project Admin in the project navigation bar.

Click Tracker Settings.

Click Create.

On the Create Tracker page, provide a name and description for the tracker.

Tip: Descriptions help userslearn how best to provide the information you want from them. To maximize your

[ i
chances of getting useful data, make your description as informative as you can.

Select anicon that suggests the type of work the tracker is handling.

Thisicon will appear with any artifact in this tracker, wherever it is viewed on the site. For example, if someone
brings an artifact from this tracker into a planning fol der, users of the planning folder can glance at the artifact'sicon
to see where it comes from.

Click Create.

The new tracker appears at the bottom of your list of trackers.

If necessary, drag the tracker to aplace in your tracker list that makes sense.
The order you set here controls the order of every tracker list in your project.

You'll probably need some custom fields to capture information that's specific to your project.
See Create your own tracker fields on page 26.
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9. To speed up the team's work, you may want to set up some rules for automatically reassigning artifacts when their
contents change.

See Create a tracker workflow on page 27.

Create a planning folder
Create and populate al the planning folders you need to capture the work you are planning.

A planning folder is away to organize work into feasible chunks and monitor its progress.

Tip: It often makes sense to set up planning folders after you have outlined and analyzed the features you plan to
deliver. See Define the scope of your project on page 106.

When you've thought about the general categoriesthework fallsinto, you are ready to create planning foldersthat reflect
those ideas.

A planning folder can represent:

e A setof tasks, such as Iteration 3, or "Initia infrastructure development.”
e A period of time, such as"April," or "Q2-2010."

* A phase of development, such as "Testing" or "Deployment.”

* A component of the product, such as"Chapter 12" or "Rear stabilizer."

1. Click Tracker inthe project navigation bar.
2. Under Planning Folders, click Root Folder, then New.
3. Intheview, right-click the Planning Folders node or an existing planning folder and select .

A planning folder in the has the same context menu option.

4. Giveyour planning folder a brief and descriptive name.
For example, in an agile project, you'll probably want two or moreiterations. Make aplanning folder called "Iteration
1," another called "Iteration 2," and so on. In a phased, waterfall-style project, you might name your first planning
folder "Design," the next "Build," and so on.

Tip: Don'tworry if you don't have anything of interest to put into your planning foldersyet. The parallel process
of filling out the feature tree will provide plenty of material for this.

5. Usethe Description to briefly signal the kind of work that will be contained in this planning folder.
Include enough information to help people get up to speed quickly whey they join your project. But save most of
the detail for the individual tracker artifacts, where project members will spend most of their time.

6. Select astart and end date for the work that this planning folder will contain.

You can change these dates at any time. It'simportant to specify dates even if they're not firm, however, because a
variety of useful visual aids and reports depend on them.

7. Click OK.

Set up hardware for your team to use
When you set up Lab Management, your team members can use TeamForgeto accesstheir own virtual machinesfor developing
and testing.
Get CollabNet TeamForge Lab Management .
On the Project Admin menu, click Linked Applications.
Onthe Linked Applications page, click Create.
On the Create Linked Application page, enter the name Lab Mgmt.
Enter the server location or URL of your Lab Management server.

ok w D


http://www.open.collab.net/products/CUBiT/

14 | OpenTopic | How to use TeamForge 6.1

6. If you are a CollabNet TeamForge administrator, select whether you want to use single sign-on for the linked
application.

» If you use single sign-on, CollabNet TeamForge manages authentication for Lab Management, and users don't
have to log into Lab Management after they have logged into CollabNet TeamForge.
< |f you do not use single sign-on, users must log into Lab Management using its native authentication system.

7. Click Browse and select thisicon for the linked application:

i

Thisicon will appear with the name Lab M gmt in the project navigation bar.
8. Click Save.

A Lab Mgmt button is added to your project navigation bar. Clicking it launches the application in the main CollabNet
TeamForge project window.

Contribute to a CollabNet TeamForge project

Navigation title:Contribute to a project |
CollabNet TeamForge is a set of integrated tools designed to make your collaborative experience more efficient, productive
and fun.

Plan and track anything
Use theissue tracking system to track and manage everything from requirements, user stories, and feature requests to defects,
build issues, and customer support cases.

Project administrators can model any desired lifecycle process by customizing tracker fieldsto correspond to the different
states required, defining aworkflow that governs the transitions between those states, and specifying which users can
make those transitions.

Estimate effort for agile development
Once the product features have been sketched out, if falls to the project team to figure out what it will take to deliver them.

Effort estimates are almost always more accurate when they address small, discrete chunks of work. But you need to
forecast effort for alarge, complex undertaking. TeamForge hel ps bridge this gap by dynamically calculating effort
estimates at multiple levels.

There are two ways to determine the effort involved in an artifact:

« Break the work down into discrete chunks, then use your experience and judgment to come up with a real-world
estimate for this artifact.

« Havetheeffort estimates for all the artifact's children (if any) automatically added and shown in this artifact.
You will be using a combination of these techniques as you work through the estimating process.

Analyzing the work is an iterative, interactive process. As you go through it, you'll find your effort estimates changing
shape in response to feedback from scoping the product and planning out the work.

1. With your team, review the artifacts the product owner has created.

How much effort will each one require? Do any of them require special skills or training? Record your observations
about each artifact in its Comment field.

g~ Noter Thisisarough cut. Don't try to come up with afinal effort estimate yet.

2. For each user story, identify the specific tasks that will be required. Create an artifact to contain each of these tasks.
Declare each of these task artifactsa"child" of theinitia artifact.
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Now you can attempt to estimate the work involved in each task artifact. Thiswill be the raw material for your
higher-level effort estimates and progress tracking.

3. Back inthe "parent" artifact, select Sum effort from children.
Now this artifact's effort field shows the total of the effort units assigned to each of its "children."

Note: If an artifact has children that belong to another project, the effort value for those child artifactsis not
counted.

4. Asyou proceed, you will find the overall picture taking on definition.

Relationships among artifacts will emerge, and many of them will seemto fall into one onelogical group or another.
L et these groupings determine the names and purposes of your planning folders.

Find tracker artifacts
The tracker contains a comprehensive search system that enables you to find a specific artifact or set of artifacts quickly.
View the right tracker columns
When you'relooking at the artifactslist in atracker or a planning fol der, you can can sel ect the columns you want to see, either
for this session or permanently.

You set your column preferences for each tracker or planning folder independently. If your project administrator has
set default columns for the entire project, your individual column choices override those settings.

1. Click Tracker inthe project navigation bar.
2. Select atracker or planning folder and click Columns > Configure.

< |If you've aready saved a column configuration, click it and skip the rest of these steps.
« To go back to the default column configuration, click System (default) and skip the rest of these steps.
« To set up anew configuration, click Configure.

3. Choose your columns.
a) Move the columns you want from Available Columnsto Selected Columns.
Artifact ID : Title, Priority and Status are required columns.

g~ Note: Selecting more columns can increase the time required to load the listing page.
b) Remove any columns you don't need from Selected Columns.
¢) Usethe Move Up and M ove Down buttons to change the display order of the columns.

4. Apply your choicesto your view of the tracker.

« Tousethisarrangement thistime only, click Apply. The next time you log in, you'll start with the default view
again.

» To save your column layout for repeated use, click Apply and Save, then give your arrangement a name. The
next time you log in, you'll see the column arrangement you just selected. (If you've sorted the records in your
view, that sort order is saved too.)

Tip: If you are editing a column configuration that already exists, you can rename it by saving it under a
new name.

[ 1

5. To make the same set of columns appear every time you come to this tracker or planning folder, select M ake this
my default view.

View the right tracker artifacts
When alarge number of tracker artifacts makesit difficult to find the one you want, filter and sort the list to narrow down the
possibilities.

1. Click Tracker inthe project navigation bar.
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2.
3.

4,

On the Tracker Summary page, click thetitle of the tracker in which you want to look at artifacts.
Click thefilter icon to see a subset of the itemsin the list. Click Apply after entering your filter value.

Note: You can usethe following special charactersto filter data: <, >, <=, >=, and %. The percent sign is used
for partial text filtering.

Use the up-down arrow at the top of any column to sort your list by that column.

* Your primary sort column isidentified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.
* Click the up-down arrow again to reverse the sort order.

View the right planning folder artifacts
When alarge number of artifacts in a planning folder makes it difficult to find the one you want, sort the list to narrow down
the possibilities.

1
2.

3.
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Click Tracker in the project navigation bar.
Select the planning folder you want.

I:., Tip: If there are dozens of planning foldersin thelist, try toggling to view only the Active planning folders.

Use the up-down arrow at the top of any column to sort your list by that column.

e Your primary sort column isidentified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.
e Click the up-down arrow again to reverse the sort order.

Tip: You can also drag and drop aplanning folder's contents into rel ative positions based on the sequence in which
you plan to address them.

Search atracker
If the filter returns too many results or not enough, try the search facility.
Search for tracker artifacts
Find tracker artifacts by supplying a keyword, an artifact ID, a date range or some other value.

You can also search comments, attachments, and user-defined fields.

1
2.

Click Tracker in the project navigation bar.
Set the scope of your search.

e Tosearchal thetrackersin your project, click Search Tracker
» To search a specific tracker, click the tracker you want to search, then click Search Tracker in that tracker's list

view.
On the Tracker Search Criteria page, enter the keywords to search for.
g~ Note: Wildcards are allowed.

Select the elements of the artifact to search.
For example, to search for akeywords in the title, description, and comments fields, select All Text Fields.

L Note: User-defined text fields are not included.

If you know the artifact's ID, enter that.

Click the calendar icon to select dates, if appropriate. You can also specify relative dates such as "Within the last 7
days'.

Use as many of the remaining tracker fields as seems useful.
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8. Click Search.

All tracker artifacts matching your search criteria are displayed.

Note: If your search included muliple trackers, the icon next to each artifact in your search results can help you
identify which tracker that artifact belongs to.

Find your own artifacts
To narrow your scope, try searching only for artifacts assigned to or submitted by you.

Click Tracker in the project navigation bar.

Onthelist of project trackers, click thetitle of atracker.

In the tracker artifact list view, click Search Tracker.

Onthe Tracker Search Criteria page, select the User running search option in the Assigned To or Submitted
By fields.

5. Click Search.

A wDN PR

All tracker artifacts matching your search criteria are displayed.
Save a search for tracker artifacts
To reuse a search that you devised for tracker artifacts, save the search criteria.

To be able to save your search, you must first select atracker, and create and run your search.

1. Inthe Tracker Search Results section, click Save Search.
2. Inthe Save Search As page, enter a descriptive name for the search, and click Save.

The search appears under My Saved Tracker Searches. The name of the search, the tracker for which it was run, the
criteriaused, and a system-assigned ID are displayed
Share a saved tracker search

To enable other users to use a search that you have devised, save it as a shared search.

To share your search with other users, you must be atracker administrator.

1. Inthe Tracker Search Results section, click Save Search.
2. Inthe Save Search As page, enter a descriptive name for the search.
3. Select the Shared Search option.

The search appears under Shared Tracker Searches. The name of the search, the tracker for which it was run, the
criteria used, the user who created the search, and a system-assigned ID are displayed.
Run a saved search

To find artifacts in the current tracker or a different one in the project, run a saved search in the appropriate context.

Click Tracker inthe project navigation bar.

On thelist of project trackers, click thetitle of atracker.

In the tracker artifact list view, click Search Tracker.

Select the Show My Searches Across Tracker s and Show Shared Searches Across Tracker s options.

Expand the My Saved Tracker Searches and Shared Tracker Searches sections.
The saved searches for all trackersin the project are displayed.
6. Torun asearch for the current tracker, click the Search or Search Here link below the search name in the required
search.
All artifactsin the current tracker, that match the search criteria, are displayed.
7. Torunasearch for adifferent tracker, click the Search Therelink below the tracker name in the required search.
All artifacts that match the search criteriain the selected tracker, are displayed.

a s~ DR
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Remove a saved search
To remove a saved search for tracker artifacts, delete it from the list of personal or shared searches.

[ 1

© 0k~ wbdPE

Note: Only tracker administrators can remove a shared search.

Click Tracker in the project navigation bar.

Onthelist of project trackers, click thetitle of the tracker in which you want to delete a saved search.

In the tracker artifact list view, click Search Tracker.

Expand My Saved Tracker Searchesor Shared Tracker Searches so that the available searches are displayed.
Select a search and click Delete.

Accept the confirmation message.

The search is removed from the table where you deleted it.

Create a tracker artifact
Create atracker artifact whenever you need to report and track a bug, feature request, support request, or other type of issue.

Individual tracker entries are referred to as tracker artifacts, or just artifacts.

1

In any tracker or planning folder view, click Submit New Artifact in and select the tracker in which you want to
create your artifact.

By default, your new artifact is created in the tracker or planning folder you are currently looking at.
Answer the questions posed by the required fields.

Note: Different trackers will have different combinations of fields to fill out, depending on what the tracker

L -
administrator has set up.

a) ProvideaTitle and Description that summarize the issue or work item in afew words.

Tip: Descriptions help users learn how best to provide the information you want from them. To maximize

&
your chances of getting useful data, make your description as informative as you can.

b) For Priority, select avalue that expresses the importance or urgency of the work you are describing.
¢) Assignthe artifact to a project member by choosing a name from the Assigned To list.

Note: If your project administrator has configured the tracker to automatically assign artifacts to project
members, you can skip this step.

[ N

d) Select the planning folder that the work belongs to from the Planning Folder list.

Record any other information that may be appropriate.
For example, if your project is using a Scrum-based methodol ogy, your project manager may have provided a Story
Pointsfield to track estimates of relative effort.

Add afile attachment, if appropriate.
Save your changes.

Create a tracker artifact by email
To create atracker artifact without being logged into CollabNet TeamForge , send an email to the tracker.

You do not have to be logged into CollabNet TeamForge to submit atracker artifact using email, but you must have the
tracker submit permission for the tracker to which you are submitting.

Send an email message to <tracker id>@< TeamForge server>.

' Tip: You can find the tracker ID on the List Artifacts page.
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TeamForge maps your email to the tracker record like this:

Email field Tracker field

To Tracker email address
Subject Artifact title

Body Artifact description
Attachments Attachments

Update a tracker artifact
Updating the information in tracker artifactsis one important way that project members can work together effectively.

When work has been done on atracker item, or more information is needed, the project member to whom the item is
assigned should update the item's status accordingly. Comments from other project members help the artifact's owner
decide how to handle the work.

For example, when the work defined in the tracker item is completed, change its status from Open to Fixed.

Your tracker administrator may have set up workflow rules that constain your ability to do certain kinds of updates. For
example, an administrator may have specified that only userswith the "QA Engineer” role can change an artifact's status
from Open to Closed.

A project manager might also change an artifact's priority, return it to the submitter for additional clarification, or assign
it to a project member for resolution or action.

Generally, the project member to whom the tracker artifact is assigned will update the status. Any project member with
the appropriate permissions can add comments.

Tip: Each comment in an artifact or task hasaunique ID withitsown URL. To link directly to aparticular comment,
copy that comment's URL and paste it into an email, a project page, or another comment. For example, to point to
thethird comment in artifact 12345, writear t f 12345#3 in your comment. (If the artifact or task you are linking
to ison adifferent site, give the complete URL, likethis: htt p: / / nysi t e. conl sf/ go/ t ask1234#3.)

1. Click Tracker inthe project navigation bar.
2. Onthelist of project trackers, click the tracker artifact you want to update.
3. OntheArtifact Details page, click Edit.
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4. OntheEdit Artifact Details page, make your changes and click Save.
5. Back on the Artifact Details page, change any other fields that need updating, and click Update.

All updatesto the artifact are recorded in the Comments section of the Status or Comments tab.

Edit a tracker artifact by email
To comment on atracker artifact when you are not logged into CollabNet TeamForge, send an email to the tracker, or reply
to an automatic update email about the artifact.

You can also add acomment or an attachment to atracker artifact that you are monitoring by responding to the monitoring
email notification.

You can also use email to add an attachment. But to edit any other fields, you must make the changesin CollabNet
TeamForge.

You do not have to be logged into CollabNet TeamForge to edit atracker artifact using email, but you must have the
tracker edit permission for the tracker containing the artifact you want to edit.

o Tip: Each comment inan artifact or task hasaunique 1D withitsown URL. To link directly to aparticular comment,
copy that comment's URL and paste it into an email, a project page, or another comment. For example, to point to
thethird comment in artifact 12345, writear t f 12345#3 in your comment. (If the artifact or task you are linking
toison adifferent site, give the complete URL, likethis: ht t p: // nysi t e. conml sf/ go/t ask1234#3.)

Send an email message to <artifact id>@<CollabNet TeamForge server>.
g Tip: You canfind the artifact ID on the Artifact Details page.
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TeamForge maps your email to the tracker record like this:

Email field Tracker field

To Tracker email address
Subject Artifact title

Body Artifact description

Attachments Attachments
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Change multiple artifacts
When you have alarge number of artifacts to update (for example, all the artifactsin atracker, or afiltered list of artifactsin
aplanning folder), you can edit all the artifacts at once.

Note: When you update two or more artifacts at atime, each user who is monitoring any of the changed artifacts
getsasingle email describing all the updates.

1. Click Tracker inthe project navigation bar.
2. Goto thetracker or planning folder that contains the tracker artifacts you want to edit.

L Tip: Inatracker, you can use thefilter to help you find the desired artifacts.

3. Sdlect the artifacts you want to edit, and click Mass Update.
4. For artifactsin atracker, choose which ones you want to update.

e Seected - Updates only the artifacts that you selected.

« Filtered Set - Updates al artifacts returned by your filter, or al artifacts in the tracker if you did not apply a
filter.

L Tip: Choose Filtered Set when the artifacts span multiple pages and you want to select them all.

5. Make your changes and click Update.

Important: Some fields in your tracker may have values that depend on values in other fields, or use validation
rulesto ensure correct content. If your mass update operation breaks any such dependencies, you must fix the errors
before running the mass update.

-

Move a tracker artifact
Aswork proceeds on atracker artifact, its focus may change. If this happens, it may be appropriate to move the artifact into
adifferent tracker, or to atracker in adifferent project.

To move atracker artifact between projects, you must have the tracker administration permission in both the source and
destination projects.

You can move one or more tracker artifacts in the same operation.

1. Click Tracker inthe project navigation bar.
2. Onthelist of project trackers, click thetitle of the tracker containing the tracker artifact that you want to move.

3. Select the tracker artifact (or artifacts) that you want to move, and Then click Cut.
CollabNet TeamForge removes the tracker artifacts and places them on the clipboard.

4. Go to thetracker into which you want to paste the tracker artifacts.

Note: To move the tracker artifacts into another project, first find the destination project using your Projects
menu.

[ 1

5. Click Paste.

« |If all artifact assignees have the appropriate permissions in the destination tracker, the tracker artifacts are now
moved.

« If not, the Paste Artifacts window tells you how many tracker artifacts cannot be reassigned automatically.

6. Choose one of the following methods to reassign any unassigned tracker artifacts.

« Reassign Artifactsto: - Assigns all unassigned tracker artifacts to the project member you select.
* Mysdf - Reassigns all unassigned tracker artifacts to you.

7. Click Next.
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The tracker artifacts are now moved to the destination tracker. The details of the move are recorded in the Change L og
tab of the Artifact Details page.

If the project membersto whom the tracker artifacts are assigned have the appropriate permissionsin the destination
project, the tracker artifacts are automatically reassigned to the same project members. If not, you are offered several
options for reassigning them.

If both trackers use the same user-defined fields and field values, values in these fields are retained.

If each tracker uses different user-defined fields or field values:

« Vauesareset to the default value, if one was specified by the tracker administrator. Default values are mandatory
for required fields.
» Valuesare set to None, if no default value was specified by the tracker administrator.

Associate tracker artifacts with other items
You can connect tracker artifacts with other CollabNet TeamForge items such as documents or topics. Creating associations
between items enables you to define relationships, track dependencies, and enforce workflow rules.

Associate a tracker artifact with a document, task, integrated application object, or forum
When atracker artifact isrelated to other CollabNet TeamForge items, such astasks, documents, integrated application objects,
or discussions, you can connect the tracker artifact to the other item by creating an association.

Creating associations between items hel ps you to define relationships, track dependencies, and enforce workflow rules.

1
2.

Click Tracker in the project navigation bar.
On thelist of project trackers, find the tracker artifact with which you want to create an association.
Use thefilter if needed.

Click the artifact title.

On the Artifact Details page, click the Associations tab.
The list of existing associations appears.

Click Add.
In the Add Association Wizard window, select the items with which you want to associate the artifact:

e Enter Item ID - If you know theitem's D, you can enter it directly.

Note: To associate an object in an integrated application from within CollabNet TeamForge, use the

[ i
[ <prefix_objectid>] format. Successful associations appear hyperlinked.

Tip: Each integrated application displaysits prefix on moving the mouse over the application namein the
tool bar.

e Add From Recently Viewed - Select one of the last ten items you looked at during this session.
¢ Add From Recently Edited - Select one of the last ten items you changed.

Click Next.
In the Add Association comments window, describe the reason for the association.
Save your work.

* Click Finish and Add Another to add additional associations.
» Click Finish to return to the Details page.

Note: To remind yourself of the details of the association later, look in the Change L og tab of the associated
Artifact Details page.
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Associate a tracker artifact with a file release
To track the source and resolution of a bugs or a feature request, associate its tracker artifact with the file release in which it
was discovered and fixed.

Tracker artifacts associated with file releases are al so displayed separately, providing asimple way to track all issues
that were discovered in or fixed in a specific file release.

g~ Tip: You can also add associations from the tracker artifact's Artifact Details page.

1. Onthe Project Administration page, enable both the Reported in Release and Fixed in Release fields.
* Reported in Release - When submitting anew artifact, the user can choose from adrop-down list of all releases
in the project to identify the release in which the issue was discovered.
« Fixed in Release - After theissueisfixed, the user can choose from adrop-down list of all releasesin the project
to identify the release in which the issue was fixed.

g~ 11p: If either of these fields says Unknown, the artifact you are working on may be associated with afile
~ release that you don't have permission to view. You can leave that asit is or change it to afile release that you
do have permission to view.

2. When submitting anew artifact, choose the rel ease in which the issue was discovered from the Reported in Release
drop-down list.

The drop-down list shows all releases in the project, except those that are in pending status.

3. After theissueisfixed, update the artifact by choosing the release in which the issue was resolved from the Fixed
in Release drop-down list.
The drop-down list shows all releases in the project, except those that are in pending status.

The associated tracker artifacts are displayed on the Release Details page, in the Reported Tracker Artifactsand
Fixed Tracker Artifacts sections.

Note: To remind yourself of the details of the association later, look in the Change L og tab of the associated
Artifact Details page.

Associate a tracker artifact with a code commit
When checking in files to your SCM repository, you can cregte links to one or more tracker artifacts or other CollabNet
TeamForge items.

Associationstrack the links between code and the bugs, feature requests, or other tracker artifactsthat the code addresses.
You can also associate code commits with other CollabNet TeamForge items, such as tasks or documents.

A project administrator can make associations mandatory for all code commits.
with other CollabNet TeamForge items, such as tasks or documents.
A project administrator can make associations mandatory for all code commits.

You can create tracker artifact associations from whatever interface you normally use to check code into your SCM
repository. You do not have to log into CollabNet TeamForge.

Use the same syntax for commitsto CV'S, Subversion, and Perforce repositories.

When making a code commit, add the associate command in the commit message like this:
[ <item i d>], such asthe TeamForgetracker artifact ID or task ID.

e TeamForgeitem IDs are always | etters followed by four or more numbers, suchast ask1029 orart f 10011.
» To associate acommit with multiple CollabNet TeamForge items, separate the item IDs with commas.

» All associations are displayed in the Associations section of the Commit Details page.

e TheComment section lists the comments made with each commit.

g~ Note: To associate an object in an integrated application, usethe[ <pr ef i x_obj ect i d>] format. Each
~ integrated application displays its prefix on moving the mouse over the application name.
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Tip: Toremind yourself of the details of the association later, look in the Change L og tab of the associated Artifact
Details page.

Make a tracker artifact depend on another artifact
To organize your work with tracker artifacts, you can make an artifact a"child" or a"parent" of another artifact.

3.
4,

A child artifact can have only one parent.
A parent artifact can have any number of children.
A parent artifact cannot be closed if a child is open.

Note: "Open" and "Closed," in this context, refers to atype of status, not the status itself. A tracker administrator
can specify agroup of statuses, such as "Deferred," "Fixed," or "Rejected,” as equivalent to "Closed,” while"In
progress' and "Under consideration™ might be specified as "Open" statuses. For example, when you look at the
artifact summaries at the top of any tracker list page, you are seeing a summary of the status type, not the status,
of the artifacts.

On an artifact page, click the Dependencies tab.
Choose or create the related artifact.

e |f the parent artifact already exists, click Choose Child or Choose Parent. In the pop-up, typein the artifact ID
or choose from the list of your recently edited artifacts.

« If therelated artifact does not exist yet, click Create Child in or Create Parent in and select the tracker that the
new related artifact will belongto. Fill inthe form the sameway asyou would for submitting an unrelated artifact.

Note: If Choose Parent or Create New Parent isnot visible, the artifact already has a parent artifact. An
artifact can only have one parent artifact.

[ N

Click Next.
Write a comment that describes the relationship, if appropriate, and click Finish.

The parent-child relationship between the artifacts is established.
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To cancel a parent dependency, click Remove.
To cancel achild dependency, select the child artifact and click Remove.

Note: Task dependencies and tracker artifact dependencies are different things.

» For tracker artifacts, an artifact with dependencies (a"parent" artifact) can't be considered closed unless all of
its dependent artifacts ("children™) are closed.
» For tasks, a dependency means one task can't start until another task is completed.

Schedule work on an artifact
To plan how and when an artifact is to be addressed, assign it to a planning folder.

3.

Note: A planning folder can contain artifacts from many different trackers. When you assign an artifact to a planning
folder, the artifact is still in the tracker where it was created.

Click Tracker in the project navigation bar.
Find the tracker that contains the artifact you want to assign, and select the artifact.
You can select any number of artifacts at once.

Click Plan for and select a planning folder.

The planning folder you assigned is now shown in the Planned For column on the Planning Folder Summary page.

You can always reassign an artifact to another planning folder as conditions change. Any effort data you have provided
is recalculated automatically.
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Note: When atracker isdisabled, artifacts from that tracker do not contribute to the effort totals calculated for any
planning folder they arein.

Tip: When you are working with asingle artifact, you might prefer another way to assign it to a planning folder:
open the artifact you want to assign and look for the Planning Folder field. Select a planning folder for the artifact
and save the artifact.

Set up trackers
A tracker isacollection of related artifacts that describe work to be done or issues to be resolved. Every project should have
one or more trackers.

When you start atracker, you decide which fields will be used, who will use them, and how they will use them.
Create a tracker
Create atracker whenever you need to report and track bugs, feature requests, support requests, or any other type of issue
where ownership, status, and activity must be managed.

Individual tracker entries are referred to as tracker artifacts. A tracker is a set of tracker items with a common purpose,
such as bug reports, feature requests, or tasks.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

Click Create.

Onthe Create Tracker page, provide a name and description for the tracker.
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Tip: Descriptions help userslearn how best to provide the information you want from them. To maximize your
chances of getting useful data, make your description as informative as you can.

5. Select anicon that suggests the type of work the tracker is handling.

Thisicon will appear with any artifact in this tracker, wherever it is viewed on the site. For example, if someone
brings an artifact from this tracker into a planning fol der, users of the planning folder can glance at the artifact'sicon
to see where it comes from.

6. Click Create.
The new tracker appears at the bottom of your list of trackers.

7. If necessary, drag the tracker to a place in your tracker list that makes sense.
The order you set here controls the order of every tracker list in your project.

8. You'll probably need some custom fields to capture information that's specific to your project.
See Create your own tracker fields on page 26.

9. To speed up the team's work, you may want to set up some rules for automatically reassigning artifacts when their
contents change.
See Create a tracker workflow on page 27.

Enable or disable fields
If atracker field is disabled, it does not appear on the Create Artifact page. Most fields can be disabled.
Disabled fields are accessible only to tracker administrators on the Tracker Layout tab.

You can enable or disable any field that is user-defined or configurable. However, you can't disable all configurable
fields. For example, the Effort and Story Pointsfields can't be disabled.

Note: If your god isto prevent users from entering datainto a field when submitting an artifact, but still display
the field on the Edit Artifact and Tracker Search pages, don't disable the field. Instead, clear the Display on
Submit option on the Edit Field page.

[ 1

1. Click Project Admin in the project navigation bar.
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2.
3.
4,

Click Tracker Settings.
From thelist of current trackers, click the tracker you want to configure.
On the Tracker Layout tab, select the fields you want to enable or disable.

« Click Disable to remove them from the Submit Artifact page.
e Click Enableto allow them to be configured and displayed.

g Note: Datain disabled fieldsis still searchable, but disabled fields do not appear asinputs on the Sear ch pages.

Require users to complete a tracker artifact field
If afield is set asrequired, users cannot submit artifacts without completing it. Most tracker fields can be required or optional.

Each tracker can have its own required and optional fields. Required fields are marked with ared asterisk * on the
Submit Artifact page.

[ 1
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7.

Note: When you make afield required, any field whose values depend on that field's valuesis also required. See
Help users select optionsin a tracker artifact on page 100 for more about dependent field values.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From thelist of current trackers, click the one you want to configure.

Onthe Tracker Layout tab, click the name of the field you want to set as required or optional.
By default, only the Title, Description, Artifact 1D, and Status fields are set as required.

On the Edit Field page, select or clear the Required option to make afield required or optional.
Required fields automatically show up on the Submit Artifact page.

g Note: System-defined fields and the Status field are always required.

For optional fields, select or clear the Display On Submit option.
This specifies whether the field will appear on the Submit Artifact page.
Click Save Field.

Create your own tracker fields
To track datathat is not captured by the default set of fields, create new fields that fit your project's purposes.

You can create:

[

Up to 30 date fields.
An unlimited number of user fields.

s Caution: Creating alarge number of multiple select and user fields may affect CollabNet TeamForge performance.

.

Configure tracker "Select" field values

To help

users provide meaningful information, supply them with useful field values to choose from in the input fields in the

tracker entry form.
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Tip: When you create a user-defined single-select or multiple-select field in atracker, you add predefined values
to the field. You can change these values at any time.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of existing trackers, click the name of the tracker that you want to configure.

On the Tracker Layout tab, click the name of the field whose values you want to edit.

On the Edit Field page, set up the field values you want you want users to see when they create atracker artifact.
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» Todefine anew value, click Add.

« Torename avaue, edit the existing text. If you rename avalue, the value is renamed in all existing artifacts.

» Toremove avalue, check the box and click Delete. If you delete avalue, the value is changed to Nonein al
existing artifacts.

» Sdect Default Valueto set which option will be chosen if the user makes no selection. When you move atracker
artifact from one tracker to another, the default field value is the value that comes along.

Note: When you edit the values of the Statusfield, you are also asked to describe what each value's status
means, as shown in the Values section of the Edit Field page. This status meaning isused in Advanced Sear ch
to define which values are returned when searching for open or closed artifacts.
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6. Click Move Up or Move Down to order the list the way you want it.
7. Click Save Field.

All values are now available in the selection menu for the field.
Assign a tracker artifact automatically
You can configure the tracker to automatically assign newly submitted artifacts to specific project members.

You can assign artifacts to individuals based on the values in the Category or Release field.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From thelist of existing trackers, click the tracker you want to configure.

On the Auto Assignment tab, select Auto Assign By Category or Auto Assign By Release.

For each category or release value, choose a project member from the Automatically Assign To drop-down menu.

This menu contains all project members with the tracker edit permission. Click the people icon to display alist of
project members to whom you can auto-assign artifacts. Choose None if you do not want artifacts with a specific
val ue automatically assigned.

6. Click Save.
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Whenever a new artifact is submitted with avalue in the relevant field, the assignee receives an email notification and
the artifact appears on his or her My page.
Change a tracker
A tracker's real-world uses often outgrow the name or description you gave it when you created it. When that happens, it'sa
good idea to update the tracker to reflect its changing role.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of existing trackers, click the tracker you want to edit, and click Edit.

On the Edit Tracker page, provide a new name or description for the tracker and click Save.
If necessary, drag the tracker to aplacein your tracker list that makes sense.

The order you set here controls the order of every tracker list in your project.

SIS

Create a tracker workflow
To channel project members' work on tracker items, set up rules for how atracker item can move forward.

Before creating a tracker workflow, see that these criteria are met:

* You have atracker to work with.
» Thetracker has a set of statuses defined, such as"In progress' and "Ready for QA."
* Rolesexist, and you can assign project members to them.

A workflow is a sequence of changes from one status to another. You can define status transitions for any combination
of tracker statusesin the tracker.
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Click Project Admin in the project navigation bar.
Click Tracker Settings.
From the list of existing trackers, select atracker.

Click the Wor kflow tab.
The Wor kflow page lists al of your status values and the tracker workflow that you have configured.

On the Wor kflow page, click the status value for which you want to create a workflow.

6. Onthe Edit Field Transition Status page, select a status value from the Create Transition to Status drop-down
menu.
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g~ Note: By default, the Any workflow isshown. Thismeansthat you are defining workflow rulesfor thetransition
- from the status that you selected to any other status.
7. Click Add.
A new workflow is added. The Any workflow is changed to Remaining Statuses.
8. Inthe Rolesto Makethis Transition section, specify which users can make this change.
For example, only userswith the QA Engineer role are allowed to change artifacts from Open to Cannot Reproduce.

9. Inthe Required Field(s) for Status Transition section, select the fields for which the user must provide values.
For example, the user must assign the tracker item to someone and enter a comment.

g~ Note:
» Fieldsthat are already required do not appear in thislist.
» Fields whose values depend on arequired parent field are automatically required. (See Help users select
optionsin a tracker artifact on page 100 for more on parent and child fields.)
10. Click Save.

The workflow is now saved. When a user submits or edits the status of atracker artifact, he or she sees only the options
that are allowed by the workflow.

Export tracker artifacts
To use the contents of artifacts from atracker or a planning folder in other applications, export themtoa. csv, . xn , or
tab-delimited file.

For example, sometimesit can be useful to look at the status of a project by sharing a spreadsheet using Microsoft Excel
or Google Spreadsheets.

g~ Tip: You can also export tracker artifacts from atracker report or a set of search results.

1. Click Tracker inthe project navigation bar.

2. Click atracker or planning folder.
In atracker, you can export a subset of the artifactsin the list view by setting up afilter. See View the right tracker
artifacts on page 15.

g~ Noter All the artifactsin your list are exported, not just checked items.
3. Click Export.

4. Inthe Export Data window, select an export format that you can import into the other application.
For example, to use the data in a spreadsheet program, select . csv.

5. Movethefieldsyou areinterested in from the Available Columnslist to the Selected Columnslist, then click Next.

Note: When you export tracker artifacts directly from atracker, you can choosefrom all thefieldsin thetracker.

[
When you export from a planning folder, only the standard fields provided by TeamForge can be exported.

For more detail on what you can do with different kinds of fields, see What fields can | usein a tracker? on
page 206
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6. Inthe Export Data confirmation window, click the link to save the file where you want it.

Work on tasks
Manage your project plan by defining units of work and assigning them to project members.

Create a task
Create atask when you identify a unit of work that you want to track to completion as part of your project.

Tip: You can aso create tasks by synchronizing task data with Microsoft Project.

[

1. Click Tasksin the project navigation bar.

2. Onthe Task Summary page, go to the task folder in which you want to create the task.
3. Click Create.

4. Onthe Create Task page, provide a name and description for the task.

5. Assign thetask apriority between 1 (highest) and 5 (lowest).

6. Assignthetask to anindividual.

Click the peopleicon to list the project members to whom you can assign the task.
7. Assignthetask a status.

* Not Started
« OK

*  Warning

o Alert

e Complete

8. Givethetask astart and end date.
Click the calendar icon to select dates.

9. Inthe Estimated Hoursfield, write the time you think is needed to compl ete the task.
10. Specify whether the time estimate is based on afive-day or seven-day calendar.

g~ Note: Choose a seven-day calendar to assign a start or end date that falls on on aweekend.

11. Save your work.

e Click Save and View Task to keep defining the task.
* Click Saveto save the task and quit.

Edit a task
Tasks often change assignee, start and end dates, and dependencies before they are finished. You can update all those aspects
of atask, along with its status.

Click Tasks in the project navigation bar.

On the Task Summary page, find the task folder containing the task you want to edit.
Click the task name.

On the Task Details page, click Edit.

On the Edit Task page, make your changes and click Update.

If you change the end date of atask that has dependent successor tasks, you may want to change the start and end
dates of the successor tasks. For example, if a successor task normally starts on a Friday, and is moved out two days
by a change in a predecessor task, its new start date is Sunday (if it uses a seven-day calendar) or Tuesday (if it uses
afive-day calendar).

ok w DR
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To changethe start and end dates of all successor tasks, click M ove Dependent Task Dates Forwar d/Backwar d
x Days. All dependent task dates are moved forward or backward by the same number of days that the original
task end date was moved.

To apply the date change to only the selected task, without changing the start and end dates of any successor
tasks, click Do Not Change Dependent Task Dates.

If your end date change impacts successor tasks that you do not have permission to view, these tasks are not
changed.

If your end date change impacts successor tasks that you have permission to view, but not to edit, these tasks are
marked for change approval by an administrator. The start and end dates for tasks that you have permission to
edit are changed.

Successors of tasks that are marked for change approval are not changed until approved by an administrator.
From this page, you cannot change the start and end dates of successor tasks selectively. You must change al or
none of them. To edit the start and end dates of selected successor tasks only, select Do Not Change Dependent
Task Dates, then edit each selected task manually.

Find tasks
Use the task manager to find a specific task or set of tasks quickly. You can filter tasks by predefined fields or search by
keyword, date or other values.

Search for tasks
Use the Search Tasks option to refine your search if task filtering returns too many results.

1
2.
3.

Click Tasksin the project navigation bar.
On the Task Summary page, click Task Search.
On the Task Search Criteria page, enter the keywords for the search.

o Tip: Wildcards are allowed.

Search by the type of content that makes sense to you.

» Search for keywordsin the Task Namefield.

» Search for keywordsin the Task Description field.

» Search the task progress fields: Accomplished, Planned, and | ssues.

» |If you are searching for a specific task, and you know itstask 1D, enter the task ID.
» To search by date, select date ranges for start date or end date.

e To search by project member, select one or more people.

g~ Note: Click the peopleicon to display alist of project members with permissions to edit or create tasks.

» To search by location, select the Task Folders to search.
e To search by Status and Priority, select those.
» Click Search.

See the right tasks
Filtering and sorting allows you to find atask or group of tasks using a number of pre-defined fields.

Thefilter option is available on every item list view in CollabNet TeamForge.

1
2.
3.

Click Tasksin the project navigation bar.
On the Task Summary page, click the title of the task folder that contains the tasks you are interested in.
Click thefilter icon to see a subset of the itemsin the list. Click Apply after entering your filter value.

Note: You can usethe following special charactersto filter data: <, >, <=, >=, and %. The percent sign is used
for partial text filtering.
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4. Usethe up-down arrow at the top of any column to sort your list by that column.

* Your primary sort column isidentified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.
* Click the up-down arrow again to reverse the sort order.

Check your assigned tasks
It'sagood practice to regularly look at all of your assigned tasksin the My Tasks section of your My Page.

Your My Page provides acentral location where you can view and manage all tasks assigned to you from all the projects
that you are a member of.

g~ Note: To see tasks assigned to you on a specific project, look at the Tasks section of that project.

1. Click My Workspace in the CollabNet TeamForge navigation bar.
2. If you have more than 20 tasks, click View All to list al of them.
3. Click thefilter icon to see a subset of the itemsin thelist. Click Apply after entering your filter value.

Note: You can use the following special charactersto filter data: <, >, <=, >=, and %. The percent sign is used
for partial text filtering.

4. Usethe up-down arrow at the top of any column to sort your list by that column.

e Your primary sort column isidentified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.

» Click the up-down arrow again to reverse the sort order.
5. Click the task name to see the task details.

Update task status
When you have completed some work on atask assigned to you, you must update its status.

If you don't mark atask as completed, you may get an automatic reminder from the task's owner, its administrator, or
other project members.

You can provide task status reports for all of your assigned tasks from a single page.

Note: If you want to enter a status update for only one task, you can do so from the Task Progress section of the
Task Details page.

1. Click Tasksin the project navigation bar.
2. Onthe Task Summary page, click the My Task Progress tab.
Your My Task Progress page displays alist of all tasks assigned to you.

3. Enter your task status updates in the Accomplished, Planned, and | ssuesfields.

« Accomplished - Record any accomplishments since your last update.
* Planned - Describe work you plan to do on the task.
e |Issues- Report any issues with the task.

4. If applicable, change the task status.

Note: Project administrators may require approval for changes to task status. If change approval is required,
you are notified when you submit your status report.
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5. Saveyour changes.

« Click Save Page to finish and save your changes.
» |If your tasks cover more than one page, click Save Page and View Next to proceed to the next page.
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Schedule a task before or after another task
When one task cannot be done unless another task is donefirst, set up a dependency to track the relationship between the two

tasks.

For example, if the deadline for atask changes, the tasks that depend on that task can automatically be rescheduled to
reflect the change.
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7.

Click Tasksin the project navigation bar.

On the Task Summary page, find the task folder containing the task to which you want to add dependencies.
Click the task name.

On the Task Details page, click the Dependenciestab.

On the Task Dependencies page, click Add in the Predecessor s or Successor ssection.

In the Add Predecessor window or the Add Successor window, choose a task.

e Enter Task ID - If you know the task ID, you can enter it directly.
e Add from History - The History isalist of tasks that you have submitted or edited.

Note: To create multiple dependencies, enter multiple task 1Ds separated by commas, or use the ctrl key and
select multiple tasks from the history list.

Click Next.

The Add Predecessor or the Add Successor window shows the dependencies you have added.

View task dependencies
Task dependencies allow you to establish relationships between tasks. Task dependencies show what must be done before a
given task and what will be done after the task is complete.
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Click Tasks in the project navigation bar.

On the Task Summary page, find the task folder containing the task that you want to view.
Click the task name.

On the Task Details page, click the Dependenciestab.

For each predecessor and successor task, you can see the person to whom the task is assigned, any issues with the task,
the start and end dates, and the effort expended on the task. For details about a predecessor or successor task, including
that task's predecessors and successors, click the task name.

Associate a task with other items
When atask isrelated to other CollabNet TeamForge items such as documents, tracker artifacts, file rel eases, integrated
application objects, or news items, you can connect the document to the other item by creating an association.

Creating associations between items hel ps you define rel ationships, track dependencies, and enforce workflow rules.
Some example uses for task associations include:

Associating tasks with a master document describing the project, such as a project plan.
Associating atask with the deliverables it requires, such as a requirements document, completed code, or afile
release.

Associating atask with arelated object in the integrated application.
Associating atask with items on which it is dependent, such as closed tracker artifacts.

Click Tasksin the project navigation bar.

On the Task Summary page, find the task folder containing the task to which you want to add an association, and
click the task name.

On the Task Details page, click the Associations tab.
Click Add.
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In the Add Association Wizard window, select the items with which you want to associate the artifact:

* Enter Item ID - If you know the item's ID, you can enter it directly.
Note: To associate an object in an integrated application from within CollabNet TeamForge, use the
[ <prefix_objectid>] format. Successful associations appear hyperlinked.

Tip: Each integrated application displaysits prefix on moving the mouse over the application namein the
tool bar.

e Add From Recently Viewed - Select one of the last ten items you looked at during this session.
« Add From Recently Edited - Select one of the last ten items you changed.

Click Next.
In the Add Association comments window, describe the reason for the association.
Save your work.

¢ Click Finish and Add Another to add additional associations.
» Click Finish to return to the Details page.

Manage tasks
Project members with the Task Admin permission can perform all task administrative functions such as copying and moving
tasks. They can also create and administer task folders.

Copy atask
Copying atask is useful if you want to use an existing task as atemplate for creating a new task with many of the same
attributes.

When making a copy of atask, reference to the source task is maintained in the task name and history and in the
Associations section of the Task Details page.

1
2.
3.

4.

Click Tasks in the project navigation bar.
On the Task Summary page, find the task folder containing the task that you want to copy.

Select the task that you want to copy, and click Copy.
CollabNet TeamForge creates a copy of the the task and places it on the clipboard.

Go to the folder where you want to place the copy and click Paste.
You can place a copy in the same task folder or adifferent task folder.

Thetask copy is now placed in the selected folder, with the name Copy of <Task Nane>.
Move a task
When atask's focus or status changes, it may be useful to move it to a more appropriate task folder.

You can move atask to another folder in the same project or in another project.

To move atask between projects, you must have task administration permission in both the source and destination
projects.

If the project members to whom the tasks are assigned have the appropriate permissions in the destination project, the
tasks are automatically reassigned to the same project members. If not, you must reassign them.

[ 1
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Important: If you move tasks across projects, the dependencies, resources, and change approval settings might
be changed.

Click Tasksin the project navigation bar.

On the Task Summary page, go to the task folder containing the task you want to move.
Select the tasks you want to move and click Cut.

Go to the folder to which you want to move the tasks, and click Paste.
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g~ Note: To move the tasks into another project, first find the destination project using your Projects menu.

« |f the destination folder isin the same project, the tasks are now moved.
» |If the destination folder isin adifferent project, the Paste Tasks window appears.

5. If the project members to whom the tasks are assigned don't have the appropriate permissionsin the destination
project, reassign the tasks to another project member or to yourself.

6. Click Next.

The tasks are now in the destination folder. The history of the move is recorded in the task history.

Organize tasks

Use task folders to organize tasks according to work group or project phase.
Create a task folder

Set up atask folder to contain tasks that are related to each other.

Task folders, like file directories, let you organize your tasksin alogical, hierarchical manner with labels that are
meaningful to you and your organization.

You can create foldersin the root folder or as subfolders in any other folder. Thereis no limit to the number of folders
you can create.

1. Click Tasksin the project navigation bar.
2. Onthe Task Summarypage, go to the location where you want to place the task folder.
You can create atask folder in the root folder or in any other task folder.

3. Click New.
4. Inthe New Task Folder window, write a name for the task folder.
5. Click Save.

Thetask folder is created.
Rename a task folder
When the focus or function of a group of tasks changes, you may wish to rename the folder they arein.

Click Tasks in the project navigation bar.

On the Task Summary page, find the task folder you want to rename.
Click the folder title and choose Rename from the Edit menu.

In the Rename Task Folder window, provide a new name for the folder.
5. Click Save.
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The folder is now renamed.
Reorder task folders
To make it easier for project members to find things, you can arrange task folders a phabetically or otherwise.

By default, task folders are ordered according to when they were created. New task folders are added to the end of the
task tree.

Note: After you reorder folders, you cannot restore them automatically to their original order. You must reorder
them manually.
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1. Click Tasksin the project navigation bar.
2. Onthe Task Summary page, find the folder containing the subfolders that you want to reorder.
You can reorder the task foldersin the root directory, or the subfoldersin any folder.

3. Choose Reorder Subfoldersfrom the Edit menu.
4. Inthe Reorder Subfolderswindow, order the subfolders.
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« Click Alphabetize to sort in alphabetical order.
» Click afolder and click Move Up or Move Down until the folder is where you want it.

5. Click Save.

Delete a task folder
If you no longer need atask folder, it's agood practice to deleteiit.

Important: Deleting atask folder deletes al of the tasks within it. Delete atask folder only if you are sure that
you no longer need any of the tasks within it. Move any tasks that you want to save before deleting the task folder.

1. Click Tasksin the project navigation bar.
2. Onthe Task Summary page, click the task folder that you want to delete.
3. Choose Delete option from the Edit menu.

The task folder isremoved.

Manage tasks in Microsoft Project
When you install the Task Management plugin and connect to your CollabNet TeamForge site from Microsoft Project, you
can export and import tasks between the tools.

Install the Task Manager Add-in for Microsoft Project
To synchronize task data between Microsoft Project and CollabNet TeamForge , you must install the CollabNet TeamForge
Task Manager Add-in for Microsoft Project.

Check with your CollabNet TeamForge administrator to get the CollabNet TeamForge Task Manager Add-in for
Microsoft Project.

The CollabNet TeamForge Task Manager Add-in for Microsoft Project requires the following:

* Microsoft Project 2002 on Windows XP or Windows 2
* Microsoft Project 2003 on Windows XP or Windows 2
* Microsoft .NET Framework Version 1.1.

You can download this at no charge from the following URL.:
http://msdn.microsoft.com/netframework/downl oads/updates/default.aspx

If you do not havethe Microsoft .NET Framework installed, you must download and install it during the add-in installation
process and restart the add-in installer.

Note: If you have installed a previous version of the CollabNet TeamForge Task Manager Add-in for Microsoft
Project or the CollabNet TeamForge Plugin for Microsoft Project, you must uninstall it before installing the new
version.
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1. Copy the CollabNet TeamForge Task Manager Add-in for Microsoft Project files from the location provided by
your CollabNet TeamForge administrator.

The add-infilesare delivered inasingle. nsi file. Save the .msi file anywhere on your hard drive.

Launchthe. msi fileto begin the installation process.

In the Setup Wizard, click Next until you reach the Select Installation Folder window.

Select the directory where you want to install the add-in.

Select whether you want the add-in to be available to just you, or to anyone using your computer.
Click Next until the installation process begins.

In the Installation Complete window, click Close to exit.

N o g~

The CollabNet TeamForge Task Manager Add-in for Microsoft Project is now installed.
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Log in to CollabNet TeamForge
To start working with CollabNet TeamForge tasksin Microsoft Project, thefirst step isto connect to your CollabNet TeamForge

site.

1. InMicrosoft Project, select File> CollabNet TeamForge > Synchronize with CollabNet TeamForge .
The Log I n window appears.

Log In
SOURCEF. RGE™

Log In to SourceForge

Flease log in o SourceForge with wour UserMame and Passwiord, o will ©
ko enter the hostname of the SourceForge installation you wish bo connect

Lsername: |u5E|.1
Password: |=|c=|c=mc=|c=|c**
SErver: |furge.cullah.nel:| Advanced Setti

[ 5ave This Information

2. Enter the username and password for your CollabNet TeamForge installation.
3. Enter the path to the CollabNet TeamForge server. For example: CollabNet TeamForge .collab.net

g Note: Do not include "http://" or "https.//" in the path.

4. To enter security and other network information, click Advanced Settingsand specify the details.
For example, here's how you specify that SSL be enabled for your site.



Security and Network Settings

SourceForge Advanced Security and Metwork Settin

[+ Enable secure 551 connection

[ Use HTTP pre-authentication

[ Cwerride IE proxy settings

-

Prosey UserMame:

Proocy Passwaord:

5. ClickLogIn intheLogIn window.

HTTP UserMame:
HTTF Password:

Prozy Server:
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After you've logged in, you can synchronize tasks between Microsoft Project and CollabNet TeamForge .

Create tasks from Microsoft Project

The CollabNet TeamForge Microsoft Project integration allows you to synchronize project plans between Microsoft Project

and CollabNet TeamForge .

By creating detailed project plansin Microsoft Project, you can take advantage of advanced project planning features
such as detailed cost and effort projections. After your project plan is completed, you can log into CollabNet TeamForge
from within Microsoft Project and synchronize the task data from your project plan with a CollabNet TeamForge task
folder. When the data is synchronized with CollabNet TeamForge , you can then execute your project tasks using the
advanced status reporting capabilities, task exception management, and project visibility toolsthat CollabNet TeamForge
provides. At any time, you can re-synchronize any changes madeto task datain either CollabNet TeamForge or Microsoft

Project.

THISTOPICAPPEARSTO BEUNFINISHED. IT BELONGSIN THE MSPROJECT SECTION ANYWAY. UPDATE

RELTABLE TO REFLECT THIS.
Import tasks in one direction

To perform a one-way import of tasks from CollabNet TeamForge to Microsoft Project, use a blank Microsoft Project file to

synchronize.

Note: You must have the task administration permission for the CollabNet TeamForge project with which you

want to synchronize your Microsoft Project plan.

1. Open ablank Microsoft Project file.

2. InMicrosoft Project, select File> CollabNet TeamForge > Synchronize with CollabNet TeamForge .
3. If you have not logged in to your CollabNet TeamForge site, the L og I n window appears. Supply your credentials

and server name and do so now.

4. If your project plan does not have the journal file required for synchronization, the Setup for Synchronization

window appears. Answer Yes for the journal file to be created.

5. Inthe Selection Dialog, select the task folder whose tasks you want to import, and click Next.
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=1+ Faorge.collab,net

i CollabMet User Informakion
1 Crasherator

1 Engineering

1 Marketing Resources

=l

=l

+

sF-zakurn
SourceForge Product Developrent

+

+

Cancel Mext == ‘Jﬂ

o Note: Thewindow displaysall CollabNet TeamForge projects of which you are amember, and all task folders
in each project.

6. If thereisany datathat could prevent successful synchronization, the Warnings Fields window is displayed.

A Warnings Fields

k5 Project dogs not allow null walues. The following tables show tasks fields which will be import:
on the SorceForge estimated hours of the task and the MS Project start date.

T ashk Mame | Field | SorceForge Value

<zonpt language="lavazcnpt' > alert["hi [tazk nam...  Start Date 1140001

<zoniph language="javazcnpt > alert"hi [tazk nam...  End Date 110001

test for remove azsigned Start Date 1./1/0001

test for remove aszigned End Date 110001

taskpd Start Date 1140001

tazkpd End Date 110001

test 2 Start Date 1./1.40001

best 2 End Date 1410001

test 3 Start Date 1./1.40001

test 3 End D ate 1./1.4000

a) Click Cancel, and correct the issues identified in this window.
b) When you're done, click OK in the Warnings Fields window .

7. Inthe Synchronization Summary window, click OK to proceed with the synchronization.
8. When Microsoft Project asks you whether you want to save your changes, select OK.

The tasks from your CollabNet TeamForge task folder are imported into your Microsoft Project plan.

Assign aresource when there is no match in CollabNet TeamForge
When you export tasks from Microsoft project to CollabNet TeamForge , if atask is assigned to aresource name that does
not have an exact match in CollabNet TeamForge , you will be provided various options for assigning the task to a resource
during synchronization.

g Note: When aresource name in Microsoft Project exactly matches a user name in CollabNet TeamForge user.

The Resour ce Assignment window appears during the synchronization process, after you have selected the File >
CollabNet TeamForge option in Microsoft Project.

1. Inthe Resource Assignment window for the task, choose whether to assign the task to yourself, or to any project
member with the appropriate permissions, or leave it unassigned.
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2. Select whether or not you want to apply the resource mapping to all tasks assigned to that resource.
3. Click OK.

B

Task Fiw izzuel 2345 iz azzigned to a resource whic
not found in the SourceForge membership list.

Reszource Azsignment Action
" Aszsign task to SourceForge project mermber
(+ Aszzign bo exporter [kavitha)
" Do not azsign tazk

SourceForge Project Membership List

ki apping Optionz

* Senlo achon o s task amlo

The synchronization process continues.
Synchronize task data with
You can synchronize task data between CollabNet TeamForge and Microsoft Project from within a Project file.

The CollabNet TeamForge Task Manager Add-in for Microsoft Project addsthe Synchronizewith CollabNet TeamForge
option to your Microsoft Project File menu.

Important: When you synchronize task data between Microsoft Project and CollabNet TeamForge, only certain
fields datais retained.

You must have the task administration permission for the CollabNet TeamForge project with which you want to
synchronize your Microsoft Project plan.

1. Make sure your Microsoft Internet Explorer proxy settings are configured correctly to access the Internet, whether
or not you are using Microsoft Internet Explorer as your Web browser.

If you receive a connection error when synchronizing task data, check with your system administrator for your
organization's proxy settings.
2. Open the Microsoft Project file that you want to synchronize with CollabNet TeamForge.

Note: You can also synchronize using a blank Microsoft Project file. Use this method if you want to do a

€
one-way import from CollabNet TeamForge to Microsoft Project.

3. From the File menu, choose CollabNet TeamForge > Synchronize with CollabNet TeamForge .
4. IntheLogin to CollabNet TeamForge window, provide the following information:

e Your CollabNet TeamForge user name and password.
e The server name of your organization's CollabNet TeamForge installation.
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9.

g~ Note: Do not enter thehttp:// orhttps:// beforethe server name.

Click Login.

In the CollabNet TeamForge Selection Dialog window, choose the CollabNet TeamForge project and task folder
with which you want to synchronize your Microsoft Project plan, and click Next.

a) If your Microsoft Project plan contains any conflicts that would prevent successful synchronization, alist of
possi ble problems appearsin the Incompatible Taskswindow. Click Cancel, then correct any issues. Repeat until
all synchronization issues are corrected.

b) If one or more tasks are assigned to resource names that do not have an exact match in CollabNet TeamForge
the Resource Assignment window appears. For all tasks that do not have exact resource matches, you must
reassign the tasks.:

Click OK.
The Synchronization Summary window lists the following:

e All the tasks that were added or deleted in CollabNet TeamForge that will be imported into Microsoft Project.
« All the tasks that were added or deleted in Microsoft Project that will be exported to CollabNet TeamForge.
Click OK.

« |f you do not have any conflicting task changes, your tasks are now synchronized. To establish the relationship
between your Microsoft Project plan and the CollabNet TeamForge task fol der, save the changesto your Microsoft
Project plan.

Note: If you choose not to save, your synchronization changes will not be saved in Microsoft Project and

&
you will not be able to perform subsequent synchronizations with that task folder. After you have saved
synchroni zation changes once, you can then choose not to save your changesto Microsoft Project. However,
your changes are always saved in CollabNet TeamForge.

g~ Note: Usethismethod if you want to do aone-way export from Microsoft Project to CollabNet TeamForge.

« |If you have conflicting task changes, the Task Conflict window appears.
You can use all values assigned in Microsoft Project or use al values assigned in CollabNet TeamForge.

Note: When editing start and end dates, you must choose both values from the same source. For example,

[ i
you cannot choose a start date from CollabNet TeamForge and an end date from Microsoft Project.

Click Next.

Your tasks are now synchronized, and you can save the changes to your Microsoft Project plan. For future
synchronizations, your Microsoft Project plan is now bound to the CollabNet TeamForge task folder with which you
synchronized. You will not be prompted to select atask folder after the first synchronization.
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Note: If you want to synchronize your Microsoft Project plan with adifferent task folder, you must unbind it from
CollabNet TeamForge. To unbind your Microsoft Project plan from CollabNet TeamForge, click Microsoft
Project Tools > CollabNet TeamForge Options> Unbind Project Plan from CollabNet TeamForge .

After you unbind your Microsoft Project plan, you cannot synchronize it with the original task folder, but you can
synchronize it with any other task folder.

Synchronize with a different task folder
If you have If you have already synchronized your Microsoft Project plan with atask folder, but later want to synchronize it
with adifferent one, you must unbind your project plan from CollabNet TeamForge.

When your tasks are synchronized and you save the changes to your Microsoft Project plan, the plan is bound to the
CollabNet TeamForgetask folder involved. You will not be prompted to select atask folder after thefirst synchronization.
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1. In Microsoft Project, select Tools > CollabNet TeamForge Opions > Unbind Project Plan from CollabNet
TeamForge .

2. Savethe project plan when prompted.

After you unbind your Microsoft Project plan, you will not be able to synchronize it with the original task folder, but
you can synchronize it with any other task folder.

Document your work
The document management system isa centralized repository for creating, storing, and managing information about a project.

Find and view a document
You can find and view a document by navigating to it, by searching for it, or by viewing it from a URL or unique identifier.
You can aso open a document from CollabNet TeamForge directly into Microsoft Office applications.

Go to a document
If you know where adocument is posted, or would liketo browseto see what documents are available, you can find adocument

by navigation.

You can get to documents from your project home page or by searching the project's documents page.

1. Choose away to find documents:

« Look for aDocumentswindow on your project home page. If your project manager has created a document
component, you will find all your project documents there.
« |If thereis no Documents component, click Documentsin the project navigation bar.

2. Expand the document tree by clicking the + icon next to afolder.
3. Click thefilter icon to see a subset of theitemsin thelist. Click Apply after entering your filter value.

Note: You can usethe following special charactersto filter data: <, >, <=, >=, and %. The percent sign is used
for partial text filtering.

4. Usethe up-down arrow at the top of any column to sort your list by that column.

« Your primary sort column isidentified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.
» Click the up-down arrow again to reverse the sort order.

5. Toview or save adocument, click the file typeicon to the left of the document name.
Documents with file types that can be viewed in abrowser, such asHTML and text, are displayed in a CollabNet
TeamForge window. For other file types, use the appropriate viewing software.

6. To view additional information about the document, click the document name.

Search for a document
Search for adocument by itstitle, its content, the project or folder in which it islocated, itsfile type, or its creation date.

If you don't know which project to search, or want to search for documents and other types of items simultaneously, use
global search.

1. Click Documentsin the project navigation bar.
2. Click Search Documents.
3. Onthe Document Search Criteria page, enter the desired search criteria.

g Tip: You can use wildcards.

« To search by name, enter the text of the document name in the Search Name field.

» To search by name or description, enter the text in the Search Keywor dsfield and select Search Name and
Description.
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» To search by document content, enter the text in the Sear ch Keywor ds field and Sear ch Within Document.
» Tosearch al document versions, select Search All Versions.

« To search by location: If you know the document is located in the current folder, check the current folder in the
Category field. Otherwise, the default Root Category searches all document folders in the project.

» To search by author, enter the user name in the Edited or Updated By field. Click the Peopleicon to display a
list of project members.

» To search by date range, enter the start and end dates for the search. Click the Calendar icon to select dates from
acalendar.

Click Search.

CollabNet TeamForge lists the documents matching your search criteria. From this page, you can open or view the
details of each document.

Create a document
You can create a document by uploading afile or by entering the text directly into CollabNet TeamForge.

You can aso create a document in CollabNet TeamForge automatically detects the file extension for many common
file types.

1

Click Documents in the project navigation bar.

2. Using the document tree, find the folder in which you want to create the document, and click Create.

You can create a document in the root document folder or any other document folder.

On the Create Document page, enter a name and description for the document.
Identify the status of the document.

e Draft - The document is not yet completed.
* Final - The document is finished.

If you want to prevent others from editing the document, select L ock Document.
Select the document creation method.

« To upload adocument, select Upload From File and browse to the desired file.
« To enter the content as text, select Create Online.

Write any comments you may have about this version of the document.
Save your changes:

» Click Save to save the document and return to the document list view.
e Click Save and View Document to save the document and display the document details.

Edit a document

When you are called on to help develop a document, you can edit the document online or by posting a new version.
Update a document

To update a document, you can upload a new document version or change the document's name, description, or lock status.

You can also update adocument in CollabNet TeamForge directly from one of the following Microsoft Office applications:

Word

Excel
Project
PowerPoint

Click Documentsin the project navigation bar.
Using the document tree, find the folder containing the document that you want to edit.
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3. Select the document you want to edit by clicking the document name.
4. Onthe Document Details page, click Edit/Update.
5. Onthe Edit Document page, make your changes.

* Update the name or description by entering new text in the appropriate field.

» Changethe status value if appropriate.

« To prevent others from editing the document, select L ock Document.

» Update a binary document by selecting Upload From File, then browsing for the updated file.
» Update atext document by selecting Create Online, then editing the document text.

6. Enter aversion comment to describe the changes made, if appropriate.
7. Click Save.

The document is now updated.
Change the active document version
You can specify which version of adocument is the active version at any time.

CollabNet TeamForge stores every document version that you or any other user posts. When you open adocument from
the document list view, you open the active document version. When you open a document's Document Details page,
the information you see is about the active document version.

The Versions section of the Document Details page lists all document versions and indicates which oneis currently
active. By default, the most recently posted document version is the active version.

1. Click Documentsin the project navigation bar.
2. Using the document tree, find the folder containing the document.
3. Sdlect the document by clicking its name.

Tip: Onthe Document Details page, in the Ver sions section, the active document is indicated with a check
in the Active column.
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4, Select the version that you want to make the active version, and click Mark AsActive.

The selected document version is now the active version.

Lock a document
While you are working on a document, you can lock it to prevent others from editing it and then posting new versionsto
CollabNet TeamForge .

When adocument islocked, any user with the document view permission can view or download the document, but only
document administrators and the document creator can post new versions to CollabNet TeamForge .

You can lock a document when you create it or at any time afterward.

g~ Note: Locking adocument does not prevent it from being edited in its native application.

On the Document Details page, confirm that the lock statusis currently Unlocked.
Click Edit/Update.
On the Edit Document page, select L ock Document.

Click Save.
The document is now locked. It is represented by the Padlock icon in the document list view.
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Unlock a document
To work with a document that someone else has locked, you must unlock the document.

Only a document administrator and the document creator can unlock a document.

1. Onthe Document Details page, confirm that the lock statusis currently L ocked.
2. Click Edit/Update.
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On the Edit Document page, clear L ock Document.
Click Save.

The document is now unlocked. All project members with the Document Edit permission can now update the document.

Get a document reviewed
There are afew things you have to do to get the most out of a document review.
Start a document review
To get adocument reviewed, select the appropriate reviewers, set adue date, and explain to the reviewers what you need from

them.

Before starting a document review, you must create the document in CollabNet TeamForge .

1.
2.
3.

8.

Click Documentsin the project navigation bar.
In the document tree, click thetitle of the document you want input on.
On the Document Details page, click the Review tab, then click Start a Review.

Note: If areview isalready in process, Start a Review does not appear, because you can only have one review
at atime.

On the Start a Review Cycle page, give the review a descriptive name.
Enter a due date for reviewers.
Click the Calendar icon to select dates.

Tip: Comments are due at 12:00 midnight on the date selected. Therefore, if you want all document reviews

&
to be completed by end of day Tuesday, select Wednesday as the review end date.

Select the required and optional reviewers.

Click the Peopleicon to pick from alist of project members whose access permissions enable them to see this
document.

Write a message to your reviewers describing the document and the type of input you need from them.
Your reviewers will get this message in an automatic email that shows you as the sender.

L Tip: If you add yourself to the reviewerslist, you will get a copy of this email for future reference.

Click Save.

The document is now submitted for review.
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All reviewers receive an email with the details of the review, your message, and alink to the Review Details page
where they can download the document and post their responses.

The document status is changed to Review and remains so until the review is closed.

Tip: To help keep track of the development of your document, associate a tracker artifact with your document
review.

Read review responses
After starting a document review, you receive email notifications whenever a reviewer posts review responses.

You can read the review responses from the email or from the Review Details page. The Review Details page isthe
starting point for managing all document review activities.

pw NP

Click Documents in the project navigation bar.
Using the document tree, find the folder containing the desired document.
Click thetitle of the document.

On the Document Details page, click the Review tab.
A summary of all open and closed reviews appears.
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Click thetitle of the desired review.
Review comments are listed in the bottom section of the page.

You can also reach the Review Details page by clicking thelink provided in any related email notification or by clicking
thetitle of the review in the My Document Reviews section of your My page.
Edit review details

At any time after areview is started, you can change the review name, the required and optional reviewers, and the due date.

When you edit review details, affected reviewers get an email notification with the details of the change.

1

Find the Review Details page.

Thereview details are listed in the top section of the page.
Click Edit.

On the Edit Review Cycle page, make your changes.

» Click the Calendar icon to select dates from a calendar.
» Click the Peopleicon to display alist of project members from whom you can select.

Click Save.

When you add reviewers, new reviewers receive an email with the details of the review.

When you remove reviewers, removed reviewers receive an email telling them that their reviews are no longer
necessary.

When you change the due date, outstanding reviewers receive an email with the new due date.

Send a reminder email
To help project members keep track of their review obligations, you can send areminder email to reviewers who have not yet
submitted their responses.
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5.

On the Review Details page, find the outstanding required and optional reviewers.
Click Send Reminder Email.

On the Send Reminder Email page, write amessage to include in the email.
Choose whether to send the document as an attachment to the email.

g Note: The URL to the document isincluded in the email regardless of whether the document is attached.

Click Send.

The email is sent to all reviewers who have not yet submitted responses.
Close a document review
After adocument review is completed, close the review.

Reviews are never closed automatically. You must close any outstanding reviews on adocument before you can start a
new one on the same document.

[ 1

1
2.
3.

Note: You can close areview even if the due date has not yet passed.

On the Review Details page, click Close Review.
On the Close Review page, change the document status to Final or Dr aft.
Click OK.

The review is now closed. Any reviewers with outstanding reviews receive email notifications that the review is closed.
No additional review responses can be submitted.

Review a document
To contribute to areview, you look at the document, consider responses from other reviewers, and post your own responses.

When you are identified as areviewer of a document, two things happen:
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You receive an email about the review. The details include the due date, whether you are a required or optional
reviewer, and any message text entered by the review submitter. The email also includes alink to submit your
response.

A new entry in the Documents Awaiting Review section of your My Page provides a summary of the review,
including the review due date, the project in which the document is posted, and the person who is requesting your
review.

Go to the Review Details page by clicking the link provided.

* Click thelink in the email notification you received with the review details.
» Click thetitle of the document in the Documents Awaiting Review section of your My page.

on the Review Details page, in the Submit a Response section in the center of the page, enter your response.
If appropriate, use the Browse button to attach a marked-up copy of the document, or another attachment.
Click Submit.

Your response is now submitted.

The review submitter receives an email notification containing your response.
Your response comments appear in the Responses section of the Review Details page.

Associate a document with other items
When adocument is related to other CollabNet TeamForge items such as tasks, tracker artifacts, file rel eases, or news items,
you can connect the document to the other item by creating an association.

Creating associations between items enabl es you to define relationships, track dependencies, and enforce workflow
rules. Some example uses for document associations include:

Associate a requirements document with supporting feature requests or bugs in the tracker.
Associate a document, or a document review, with the task that requires it as a deliverable.

Associate a master document, such as a product plan, with other supporting documents such as atest plan or beta
plan.

Associate a product announcement document with afile release.

Click Documents in the project navigation bar.

Using the document tree, find the folder containing the document to which you want to add an association. Select
the document by checking the box, then click Details.

On the Document Details page, click the Associations tab.

Click Add.

In the Add Association Wizard window, select the items with which you want to associate the artifact:

* Enter Item ID - If you know the item's ID, you can enter it directly.
Note: To associate an object in an integrated application from within CollabNet TeamForge, use the
[ <prefix_objectid>] format. Successful associations appear hyperlinked.

Tip: Each integrated application displaysits prefix on moving the mouse over the application namein the
tool bar.

e Add From Recently Viewed - Select one of the last ten items you looked at during this session.
« Add From Recently Edited - Select one of the last ten items you changed.

Click Next.

In the Add Association comments window, describe the reason for the association.

Save your work.

¢ Click Finish and Add Another to add additional associations.
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» Click Finish to return to the Details page.

Manage documents
Project members with the Document Admin permission can copy, move, and delete documents. They can aso create and
administer document folders.
Copy a document
If agiven document belongs logically to two or more document folders, keeping a copy in each folder can help users locate
it.
Copying adocument can also be useful if you want to use an existing document asatemplatefor creating anew document.
When making a copy of a document, reference to the source document is maintained in the document title and the
Associations tab.

g~ Note: Each copy must be maintained separately. Edits made to one copy are not propagated to other copies.

1. Click Documentsin the project navigation bar.
2. Using the document tree, find the folder containing the document that you want to copy.

3. Select the document you want to copy, then click Copy.
CollabNet TeamForge creates a copy of the document and placesit on the clipboard.

4. Find the folder where you want to place the copy, then click Paste.
You can place adocument copy in the same folder or a different folder.

The document copy is now placed in the selected folder, with the name "Copy of <Document Name>". The reference
to the source document is also maintained in the Associations section of the Document Details page.
Move a document
You can move it to another document folder within the project or to a document folder in another project at any time. This
allows you to reorganize documents as needed.

You can move one or more documents in the same operation. You cannot move adocument while it has an open review.

Note: To move a document between projects, you must have document administration permission in both the
source and destination projects.

Click Documents in the project navigation bar.

In the document tree, find the folder containing the document you want to move.
Check the box next to the document you want to move, and click Cut.

Find the folder to which you want to move the document, and click Paste.
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g~ Note: To move the document into another project, first find the destination project using your Projects menu.

The document is now moved to the selected folder.
Delete a document
If you no longer need a document, you can delete it.

Deleting a document deletes all of the document's versions, plus the document's details and review history.

Note: You must be adocument administrator to delete documents.

-

Click Documents in the project navigation bar.

Using the document tree, find the folder containing the document that you want to delete.
Select the document you want to delete.

Click Delete.
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The document is deleted.
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Organize documents
Project members with the Document Admin permission can create, edit, move, reorder, and delete document folders.
Create a document folder
Document folders, like file directories, allow you to organize your documentsin alogical, hierarchical manner using labels
that are meaningful to you and your organization.

You can create foldersin the root folder or as subfolders in any other folder. There is no limit to the number of folders
you can create.

Click Documentsin the project navigation bar.

Using the document tree, find the location where you want to place the folder.
Click New.

In the Create Folder window, enter a name for the folder.

5. Click Save.
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Thefolder is created.
Rename a document folder
When the function of a document folder has changed, it's a good idea to rename the folder.

Click Documents in the project navigation bar.

Using the document tree, find the folder that you want to rename, and click the title to select it.
Choose Renamefrom the Edit menu.

In the Rename Document Folder window, enter a new name for the folder.

5. Click Save.
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The folder is now renamed.
Move a document folder
You can move a document folder within a project.

You can move afolder in the following ways:

* From theroot folder to a subfolder.
* From asubfolder to the root folder.
* From asubfolder to another subfolder.

When you move a document folder, any documents and subfolders that it contains are also moved to the destination
folder.

Project members monitoring the destination folder will continue to receive monitoring notifications after afolder is
moved. Project members not monitoring the destination folder will not receive further monitoring notifications.

Click Documents in the project navigation bar.
Using the document tree, find the folder that you want to move. Click thetitle to select it.
Choose Cut from the Edit menu.

Using the document tree, find the folder into which you want to move the selected folder. Click thetitle of the folder
to select it.
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g~ Note: You can move afolder into the root folder or into any other folder.

5. Choose Paste option from the Edit menu.
The folder is moved to the destination folder.

Reorder document folders
To change the order in which document folders are displayed, you can a phabetize them or reorder them arbitrarily.

By default, document folders are ordered according to when they were created. New document folders are added to the
end of the document tree.
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Click Documents in the project navigation bar.

Using the document tree, find the folder containing the subfolders that you want to reorder. Click the title to select
it.

Choose Reorder Subfolder sfrom the Edit menu.

Organize the subfolders:

« To sort them alphabetically, click Alphabetize.
» Toreorder aspecific folder, select it by clicking the title, then click M ove Up or Move Down until the folder is
where you want it.

Click Save.

Delete a document folder
If you no longer need a document folder, it's agood ideato delete it.

Deleting a document folder deletes all of the documents within it.
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Important: Delete a document folder only if you are sure that you no longer need any of the documents within
it. Move any documents that you want to save.

Click Documentsin the project navigation bar.
Using the document tree, find the folder you want to delete.

On the document folder Edit menu, click Delete.
If the folder contains one or more documents that you do not have permission to delete, you cannot del ete the folder.

Work with documents from Microsoft Office
You can use the File menu of your Microsoft Office application to work with documents that are stored on your TeamForge

site.

Open a TeamForge document in Microsoft Office
You can get to your Microsoft Word, Excel, Project, and PowerPoint documentsin CollabNet TeamForge even if the CollabNet
TeamForge web interface is not open.

1
. From the File menu, choose Open from CollabNet TeamForge.

5.

Open your Microsoft Office application.

In the L ogin window, provide the following information:

« Your TeamForge user name and password.
e TheURL of your organization's TeamForge installation.

g~ Noter Donotenterthehttp:// orhttps:// beforethe server name.

Click Log In.
The Selection Dialog window shows all of the projects, document folders, and documents that you have permission
to view.

Select the document you want to open.

The document opens in your Microsoft Office application.
Save a document to TeamForge
You can store your Microsoft Office documents in CollabNet TeamForge even if the CollabNet TeamForge web interface is

not open.

CollabNet TeamForge works with Microsoft Word, Excel, Project, and PowerPoint.

1
2.
3.

Open your Microsoft application.
Open the document you want to save.
From the File menu, choose Save to CollabNet TeamForge .
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4. IntheLogin window, enter the following information:

* Your TeamForge user name and password.
* TheURL of your organization's TeamForge installation.

g~ Note: Do not enter thehtt p:// orhttps:// beforethe server name.

5. Click LogIn.
The Selection Dialog window displays all of the projects and document folders in which you have permission to
create documents.

6. Select the document folder in which you want to save the document.

g~ Note: Do not click on an existing document. This will prompt you to update that document.

7. Inthe Document Properties window, clear Use Filename, then enter aname in the CollabNet TeamForge
Document Namefield.

By default, the filename is used as the document name.

8. Write a description for the document.

9. Choose whether the document isin draft or final status.

10. To lock the document and prevent others from editing it, select L ock Document.
11. Write aversion comment, if appropriate.

12. Click OK.

The document is now saved in CollabNet TeamForge. You can see the document by going to the CollabNet TeamForge
document folder that you selected.

Note: After you save a document to CollabNet TeamForge, future saves will aso save in CollabNet TeamForge.

© . .
If you want to save a document to alocal drive, choose Save As from your File menu.

Communicate with project members
You can communicate with project members viadiscussion forums, mailing lists, wiki pages, and project news announcements.

Participate in discussions and mailing lists
CollabNet TeamForge discussions provide workspaces where project members can discuss project-rel ated topics online or by
email.

Create a forum topic
Create a new forum topic to begin discussion of a new subject.

A topic starts a message thread to which other users can reply. A forum can have any number of topics.

A forum topic is similar to an email, in that you can use it communicate with other people subscribed to the forum, as
if it werean email list. If theforum owner has enabled the forum to work asamailing list, then you can post to the forum
by email aswell.

Click Discussionsin the project navigation bar.

On the Forum Summary page, click thetitle of the forum in which you want to create a topic.
On the Topic Summary page, click Create.

On the Create a Topic page, describe the topic in the Subject field.

Write the message in the M essage field.
After the topic is created, other users can reply to this message.

6. If you want the message sent by email to people who are not members of the forum, add their email addressesto the
Other Recipientsfield. If there is more than one, put commas, semicolons or spaces between them.
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Note: In amoderated discussion forum, addressesin the &t her Reci pi ent s field get your message only
after the moderator approves the message.
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7. To add an attachment to the topic, click Browse and select the file.
8. Click Save.

Note: If this discussion forum is moderated, the topic is held until a moderator approves or rejectsit. (Except if it

i
isfrom atrusted user. These messages don't require moderation.)

Search for posts
Search for a post by using keywords, specifying the forum it belongs to, selecting the sender of the post or entering relative
date or date range.

You can search for posts either across all forums or within specific forums.

1. Click Discussionsin the project navigation bar.
2. Onthe Forum Summary page, click Search Posts.
3. Onthe Post Search Criteria page, enter the desired search criteria.

L Tip: You can use wildcards.

» Tosearch by subject, body or attachments, enter thetext in the Sear ch Text field and select Subject, Body and/or
Attachments options.
e To search by forum name, select the forum in the Forum field.

Note: When none of the forum options are selected, the system searches for matching posts across al
forums.
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» To search by post-sender, select the user name in the Posted By field.

g~ Note: You can select User running search option to display your posts.

« To search by time span, specify relative dates such as "Within the last 7 days’.
« To search by date range, enter the start and end dates for the search. Click the Calendar icon to select dates from
acalendar.

4. Click Search.

All posts matching your search criteria are displayed in the Sear ch Results page.
Reply to a forum message
You can post amessage in any topic in any forum you have accessto. You can also post amessage in reply to another message.

If the forum is moderated, you must have posting permission. Contact the forum moderator.

o Tip: If you are getting your forum messages delivered as email, you can reply to a post by email too.

1. Click Discussions in the project navigation bar.
2. Onthe Forum Summary page, find the topic in which you want to post a message.
3. Inthe section containing the message to which you want to respond, do one of the following:

« Click Quote to quote the original message in your response message.
« Click Reply to omit the original message from your response message.

4. Write the message.
5. To add an attachment to the message, click Browse and select thefile.
6. Click Save.

The forum message is posted. Other project members can reply to it using the same process.

Note: A messagetoamoderated discussion forumisheld until amoderator actsonit. (Except if it isfrom atrusted

&
user. These messages don't require moderation.)
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Subscribe to a discussion or mailing list
When you monitor adiscussion forum, you are notified of contributionsto the forum by email. Monitoring aforum isthe same

thing as subscribing to amailing list.

A bell icon in the M onitoring column indicates that you are subscribed to aforum.

It looks like this:

“\'LSI

If you prefer to do it by e-mail:

a) To subscribein message by message type subscription, send anemail to<nmi | i ng | i st name>- proj ect
nanme- subscri be@omai n.

b) To subscribein digest type, send an email to<mai | i ng |i st name >-project
nane- di gest - subscri be@lonai n

¢) You can also change the subscription type from message by message to digest and vice-versa.

If you prefer to do it through the web interface:

a) Click Monitor.
Set the notification frequency using "Monitoring Preference” as it suits you.

Subscribe others to a discussion or mailing list
You can add other other usersto a discussion.

If you are aforum administrator, you can also add users to the discussion as a group.
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Click Discussionsin the project navigation bar.

Select the forums that you want to add users to.

Inthe Monitor list, click Users Monitoring Selected.

Click Add and move the users you want into the Usersto Add column.

Tip: To add users as a group (assuming you are a forum administrator), do the same operation on the User
Groupstab.

Post to a forum by email
If the forum also works as amailing list, you can create aforum topic by sending an email message to the forum. You can

also reply to apost by replying to the email.

If the forum is moderated, you must have posting permission. Contact the forum moderator.

The forum's email address, if it has one, appears on the Topic Summary page.
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Tip: If aforumisnot set up to work asamailing list, you can still get posts by email when you monitor the forum.
See Monitor many items on page 85.

Click Discussionsin the project navigation bar.
On the Forum Summary page, click the forum in which you want to create atopic.

On the Topic Summary page, find the email addressin the Mailing List field. Send your email message to that
address.

CollabNet TeamForge maps your email to the forum topic like this:

Email Field Forum Topic field

To Forum email address

Subject Title of forum topic
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Email Field Forum Topic field
Body Text of forum topic
Attachments Attachments

Emails from the forum can beread in RTF (Rich Text Format) or HTML format. The format of the message is delivered
as an attachment to the post. Embedded attachments, such as text or images, are also delivered.

A message to amoderated discussion forum is held until amoderator actson it. (Except if it isfrom atrusted user. These
messages don't require moderation.)

In amoderated discussion forum, if you add other addressesinthecc: field of your email, those addresses get your
email only after the moderator approves the message.

Associate forum messages with other items
When aforum message concerns some other CollabNet TeamForge item, such as adocument, atracker artifact, afile release,
a code commit, or atask, link the message to the item under discussion by creating an association.

Creating associations between items enables you to define relationships, track dependencies, and enforce workflow
rules.

1. Click Discussionsin the project navigation bar.
2. On the Forum Summary page, find the forum message with which you want to create an association.
Any existing associations are displayed in the Associations section.

3. Click Associate.
4. Inthe Add Association Wizard window, select the items with which you want to associate the artifact:

e Enter Item ID - If you know theitem's D, you can enter it directly.

Note: To associate an object in an integrated application from within CollabNet TeamForge, use the

[ i
[ <prefix_objectid>] format. Successful associations appear hyperlinked.

Tip: Each integrated application displaysits prefix on moving the mouse over the application namein the

[
tool bar.

e Add From Recently Viewed - Select one of the last ten items you looked at during this session.
* Add From Recently Edited - Select one of the last ten items you changed.

5. Click Next.
6. Inthe Add Association comments window, describe the reason for the association.
7. Saveyour work.

¢ Click Finish and Add Another to add additional associations.
» Click Finish to return to the Details page.

Administer forums and mailing lists
Forum administrators create forums and do what is needed to keep them on track, such as editing or moderating forum posts.

You can choose to make a discussion forum either public or private.

You can be aforum or mailing list administrator without being a project administrator. Ask your project administrator
or site administrator to grant you forum administration permissions.

Forum administrators can enable or disable forum moderation and add or remove moderators and trusted users. Any
project member with forum post permissions can be a moderator.

Forum administrators can also make forums work like mailing lists.

Guest users can monitor aforum if the mailing list functionality is enabled and "Email Monitoring" isset to "All users."
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Tip: Who can post by email to adiscussion forum is controlled by the "Email Posting" options set for the forum.
It does not depend on the permissions set for users of the Web forum.

Create a discussion forum
Encourage project members to work together by creating discussion forums to which project members with the appropriate
permissions can post messages.

Discussion forums can also function as mailing lists.

Asaforum administrator, you can choose to make a discussion forum either public or private.
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Click Discussionsin the project navigation bar.
On the Forum Summary page, click Create.
On the Create Discussion Forum page, enter atitle and description for the forum.

To make it a private discussion forum, set the Type to Private.
Private discussion forums restrict anyone without specific access permissions from posting to the forum. For example,
you may want to restrict a preliminary planning discussion to your project's core team before sharing it more widely.

To set up amailing list, select Enable Mailing List.
a) Provide aname for the mailing list.

g~ Note: Themailing list name must be unique within a project.

b) Choose how replies to posts are handled by setting the Reply Behavior.

L Tip:

* Many users are accustomed to having their replies go automatically to the whole list. Others are used to
having replies go just to the original sender. You should check with your users to see what makes more
sense for a particular mailing list.

*  When Reply Behavior isset to "To thelist,” email replies are sent to the list as awhole, not to the
individual post. This may be a change from what some users are used to.

¢) Specify aprefix for the subject lines of messages from thislist.
This can help users sort their incoming messages, if they are subscribed to multiplelists.

d) Under Footer Text, provide any information you want to show up at the bottom of each email that subscribers
receive.

For example, you may want to offer useful web locations or email addresses.

To make this a moderated forum, select Enable M oder ation.
a) Usethe User Picker to add moderators.
A moderated discussion must have at |east one moderator.

g~ Note: If your project includes members of a parent project, you can select those members too.

b) UsetheUser Picker to add trusted users.
Posts by trusted users do not need moderator approval.

On the Create Discussion Forum page, click Save.

If you set your forum to work as amailing list, all project members monitoring the forum will receive notifications
whenever a new topic or message is posted.

Rename or edit a discussion forum
To help keep aforum or mailing list focused, try updating itstitle.

Asaforum administrator, you can enable/disable mailing list or moderation features or just update their settings for the
discussion forum.
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Click Discussionsin the project navigation bar.

On the Forum Summary page, select the forum you want to change, and click Edit.
On the Edit Forum page, make your changes.

Click Save.

g~ Note: All project members monitoring the forum receive notifications of the update.

Add or modify moderators
Asaforum administrator, you can add or remove forum moderators.
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Note:

» If aforumis moderated, it must have at |east one moderator.
* Whenyou designate aforum moderator, you al so become amoderator yourself.

Click Discussionsin the project navigation bar.

On the Forum Summary page, select the forum for which you want to add or modify the moderators.
On the Topic Summary page, click Edit.

On the Edit Discussion Forum page, add or modify the forum moderators.

g~ Note: The existing moderators are listed.

Click the User Picker icon to add or remove forum moderators.
You can select one or more moderators.

g~ Note: You can select the inherited project members also from the list.

a) To add moderators, select the required users, click Add and click OK.
b) To remove moderators, select the required users, click Remove and click OK.

On the Edit Discussion Forum page, click Save.

Moderate a discussion forum by email
If your discussion forum is also amailing list, you can approve or reject the post by email.

A message to amoderated discussion forum is held until amoderator actson it. (Except if it isfrom atrusted user. These
messages don't require moderation.)

Asamoderator, you get an email when a message is awaiting moderation. The email contains the URL where you can

approve or reject the message.
See the notification email for your options.
Options Description
To accept the message: Send an email to <postld>-accept@<domain>, or just click Reply.

To accept the message and add the sender  Send an email to <postld>-allow@<domain>, or click Reply-to-All.
tothe" Trusted Users' list:

To reject the message: Send an email to <postld>-reject@<domain>.

To add your commentsto the message: Include your commentsin the Start Comment and End Comment
blocksin your response email. Your comments will appear in the
approved post.
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Approve a forum post
If apost isappropriate, add it to the forum by approving it.

A message to amoderated discussion forum is held until a moderator acts on it.

Asamoderator, you get an email when a message is awaiting moderation. The email contains the URL where you can
approve or reject the message.

Note: If your discussion forum isalso amailing list, you can approve or reject the post by email. See the options
in the notification email.

Note: If the sender consistently contributes useful and appropriateinput, you can save moderation time by designating
that user a"trusted” user. Posts from trusted users don't have to be moderated.

1. Click My Workspace in the project navigation bar to return to your My Page.
2. On My Page, click the Items Awaiting My Approval tab.
The number of posts awaiting approval are displayed against the project names.

3. Toview forum details, click the hyperlinked Number of Posts for your project.
4. Click the number of posts awaiting approval link on the Forum Summary page.

Note: The Forum Summary pagedisplaysall the forum names and the corresponding number of postsawaiting
approval, if any.
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5. Select either of the three approval techniques in the Posts Awaiting Approval tab.
Asthe moderator of the post, you will be able to view the topic titlein the All Topicstab; and post title in the Posts
Awaiting Approval tab on the Topic Summary page.

Note: Inthe All Topicstab, the hourglass icons differentiate the topics that contain posts awaiting approval.
To view posts nested within atopic, you can use the hyperlinked topic title.
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Options Description
Toapprove postsand sendersindividually: Select the post and click Approve or Approve and Trust.

To approve multiple postsand sendersat  Select al the posts to be approved and click Approve or Approve
once: and Trust below the post details.

Toview the post details and approve: Click the post title and click Approve or Approve and Trust on
the Review Post Awaiting Approval page after reading the details.

Reject a forum message
If a proposed message is not appropriate or does not contribute to the goals of your discussion forum, you can reject it.

A message to amoderated discussion forum isheld until amoderator actson it. (Except if it isfrom atrusted user. These
messages don't require moderation.)

Asamoderator, you get an email when a message is awaiting moderation. The email contains the URL where you can
approve or reject the message.

Note: If your discussion forum isalso amailing list, you can approve or reject the post by email. See the options
in the notification email.

-

g~ Note: You can reject posts with or without comments or reasons for rejection.

1. Click My Workspace in the CollabNet TeamForge navigation bar.
2. On My Page, go to Items Awaiting My Approval.

3. Onthe Forum Summary page, click Number of posts awaiting approval.
Topics that contain posts awaiting approval have an hourglassicon.
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4. Onthe Posts Awaiting Approval tab, choose your method of rejection.

Options Description
Toregject the postsindividually: Select the each post, then click Reject at the end of the post.
To bulk-reject the posts:

1. Select dl the posts you want to reject, then click Reject below the
post details table.

To view the post detailsand reject: Click the hyperlinked post title, then click Reject on the Review Post
Awaiting Approval page.

To explain your rejection with a Click Rgject With Comment instead of Reject.

comment: g~ Note: Therejection comment is posted to the message sender.

Rejected messages are deleted from the posts awaiting approval list and the message senders are notified by email.
Delete a forum message
When amessage in aforumis off topic or potentially harmful, you may want to delete it.

Before deleting aforum message, consider leaving it in place so that future users can consult it if they need to. Consider
this even if the message does not seem very useful right now.

[ N

1

Important: You cannot delete the topic starter's original message without deleting the entire topic.

Click Discussionsin the project navigation bar.

2. Onthe Forum Summary page, find the forum message that you want to delete.

3.

Click Delete and confirm that you want to delete the forum message.

The forum message is deleted.
Delete a forum topic
If you no longer want aforum topic in your project, you can delete it.
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Important: Deleting aforum topic deletesall of the forum messagesin the topic. Delete aforum topic only if you
are sure that you no longer need any of the forum messagesin it.

Click Discussionsin the project navigation bar.

On the Forum Summary page, click the title of the forum containing the topic that you want to delete.
On the Forum Topic page, select the topic you want to delete.

Click Delete and confirm that you want to del ete the topic.

The forum topic is deleted.
Stop moderating a forum
If amoderated discussion forum does not require posts to be moderated anymore, moderation can be disabled.

To change a moderated discussion forum to unmoderated discussion forum in CollabNet TeamForge, select the forum
and turn off its moderation feature.
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Note: Userswith forum admin permissions only can enable/disable moderation.

Note: On disabling moderation on a moderated forum, the posts awaiting approval are automatically approved.

Click Discussionsin the project navigation bar.

On the Forum Summary page, select the moderated forum that does not reguire moderation anymore.
On the Topic Summary page, click Edit.

On the Edit Discussion Forum page, to disable moderation, de-select the Enable M oder ation checkbox.
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g Note: The following message is displayed: "Any post awaiting moderation will be approved automatically."

5. Click Save to turn off the moderation.
To keep moderation enabled, select Cancel.

Note: The moderated discussion forum changes to an unmoderated discussion forum and any posts sent to the

&
forum will be displayed without any restrictions.

Share project news
Regular project news announcements help members stay in touch with events that can affect their work on the project.

Post a news item
To help project members stay up to date, post regular news items on the project home page.

News items are posted and displayed on the project home page and on the CollabNet TeamForge home page.

1. Go to the home page of the project in which you want to post the news item.

« From within the project, click Project Home in the project navigation bar.
» Fromanywherein CollabNet TeamForge, choose the project from the Pr oj ects menuin the CollabNet TeamForge
navigation bar.

2. Inthe Project News section, click Create News Post.
On the Create News Post page, write atitle for the news item.
4. Write the news item in the message field.
The news item can be up to 4000 characters long, including spaces.

5. Click Create.

w

The news item shows up on the project home page and the CollabNet TeamForge home page immediately.

Delete a news item
It'sagood ideato promptly delete a news item that is out of date or otherwise incorrect.

Deleting a newsitem from a project also deletes it from the CollabNet TeamForge home page.

1. Find the project home page.
< From within the project, click Project Home in the project navigation bar.
e From anywhere in CollabNet TeamForge navigation bar.

2. Inthe Project News section, click Delete next to the news item that you want to delete, and confirm that you want
to delete the newsitem.

The newsitem is del eted.

Edit a news item
To keep the project news in sync with the developments, modify the news items as and when required.

1. Find the project home page where you want to update the latest news.

< From within the project, click Project Home in the project navigation bar.
« Fromanywherein CollabNet TeamForge, choose the project from the Pr oj ects menu in the CollabNet TeamForge
navigation bar.

2. Inthe Project News section, click Edit next to the newsitem that you want to modify.
3. Onthe Edit News Post page, modify the title and/or the content of the news item.
4. Click Save.

The news post appears on the project home page, along with your name and the time at which you modify the post.
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Contribute to the project wiki
The TeamForge Wiki allows you to create an unlimited number of Wiki pages in each TeamForge project. Wiki pages are a
tool for managing project information as unstructured, linkable content.

Start a Wiki
To start communicating with other project members viaWiki, create a new page in your project's Wiki.

Every CollabNet TeamForge project starts with a blank Wiki. You do not need to create aWiki before you can begin
adding content. After aWiki is started, any user with the appropriate permissions can add or edit content; however, you
cannot delete all of the content to start over with a new, blank Wiki.

1. Click Wiki in the project navigation bar.
2. OntheWiki home page, clickEdit.
3. On the Edit Wiki page, write your Wiki text.
Wiki content is a combination of plain text, markup for font elements such as bold or italics, headers, bulleted and
numbered lists, and links.
4. Customize your Wiki entry with any of these optional steps:
a) Usethe buttons at the top of the text area to add Wiki markup to your text.
You can also enter Wiki syntax directly into the text area. For an explanation of Wiki syntax, click Syntax
Reference.
b) Toinsert alink to another CollabNet TeamForge item, enter theitem id.
You do not need additional Wiki syntax to create the link.
¢) To change the size of the display window, choose a value from the Field Height menu.
d) To attach an external file to awiki page, click Add Attachment, then browse for the desired file.
€) To add aversion comment, writeit in the Version Comment field.

5. Click Preview Changes to see how your Wiki content will look.
You can make further edits from the Previewing Home page before saving your changes.

6. Click Update to save your changes.

Your Wiki is now started.

Add Wiki content
When the information you want to share with other project members does not fit neatly into atracker comment or a document
review, use aWiki page for amore free-form communication flow.

After aWiki is created, any user with the Wiki create, edit, or view permission can add or edit Wiki content. You can
also add associations or attachments, or create additional Wiki pages.

Note: You can delete sections of the existing content, but you cannot delete al of it and start over with a new,
blank Wiki.

1. Click Wiki in the project navigation bar.
Any existing Wiki content appears.
2. For more information about this Wiki, click View Details.
3. OntheWiki home page, click Edit.
4. Onthe Edit Wiki page, make your changes or additions to the Wiki content.
« |If you prefer to use buttons to do your text formatting, the way you would with aword processor, click [NAME

OF BUTTON].
« |If your tastes run more to typing in your wiki formatting, see Wiki syntax on page 285 for the choices available.

Tip: You can use avariety of preconfigured queries to generate up-to-date content for your Wiki page. For

&
example, to generate a graph of artifact statistics, add this string to your Wiki page (with the square brackets):

[sf:artifactStatistics]
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For more preconfigured Wiki content, see Wiki syntax on page 285.

5. Inthe Version Comment box, note the reason for your change.
It is optional, but advisable, to get in the habit of recording a version comment. If your project manager has made it
mandatory, then you must record a version comment before you can save your changes.

6. Click Preview Changesto see how your Wiki content will 1ook.
You can make further edits on the Previewing page before saving your changes.

7. Click Updateto save your changes.

Create a new Wiki page
A CollabNet TeamForge site can have any number of Wiki pages. All Wiki pages are linked, and their relationships are traced
on the Back Linkstab of each Wiki page.

1. Click Wiki in the project navigation bar.
2. Onthe Wiki home page, click Edit.
3. Inthelargetext field, insert the title of your new page between square brackets, like this:

Pl ease post comments about [test results] here.

Then click Update.
The text between the square brackets becomes alink on your Wiki page.

Note: You can also typethe new link in Camel Case (each word starts with an upper-case | etter, no spaces) and
skip the square brackets.

4. Click thelink to the new Wiki page.
The new pageis created. The title of the new page is the same text as the link, rendered in CamelCase.

5. Onthe Create Wiki page, write the content you need, then click Save.

Tip: You can use avariety of preconfigured queries to generate up-to-date content for your Wiki page. For

[
example, to generate a graph of artifact statistics, add this string to your Wiki page (with the square brackets):

[sf:artifactStatistics]

For more preconfigured Wiki content, see Wiki syntax on page 285.

The new Wiki page is created. The back link to the page from which it was created appears on the Back L inks tab of
the Details section.
Search a wiki

Use the wiki search page to find content in a project wiki.

1. Click Wiki in the project navigation bar.
2. Onthe Wiki home page, click Search Wiki Pages.
3. Try one of the predefined searches.
These can save you time by running some of the most widely used content searches with asingle click:

» List thewiki pagesthat have changed in the last 15 days.
» Listthe wiki pages that no other wiki page links to.
o Listal the pagesin this project's wiki.

4. If you need to narrow your search beyond the predefined searches, enter some search terms under Wiki Pages Sear ch
Criteria.

Wildcards are allowed.

» To search active wiki content, enter the search keywordsin the in the Search Text field.
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» Tosearch active and inactive wiki page versions, select Sear ch All Versions. (By default, searches are performed
on active wiki page versions only.)

» Tosearch wiki attachments, select Include Attachments.

» If you know approximately when the wiki content was created or last edited, enter the start and end dates for the
search and click Search. Click the calendar icon to select dates from a calendar.

« To search by author, enter the author's user name in the Created or Edited By field. Click the peopleicon to
display alist of project members.

5. Click Search.

A list of wiki pages matching your search criteria appears.
View a wiki page as HTML
One way to resolve messy or incorrect formatting on awiki page is by converting the page to clean HTML.

1. Click Wiki in the project navigation bar.
2. Find your wiki page by navigating or searching.
3. Click the View HTML button.

The wiki uses HTML Tidy to display the cleanest HTML it can manage. View the page source to see the results.
View a wiki page as a PDF
When you want to send awiki page to someone outside the project, it can be handy to convert it to a PDF document.

1. Click Wiki in the project navigation bar.
2. Find your wiki page by navigating or searching.
3. Click the View PDF button.

Depending on how your browser is set up, the resulting PDF document appears or the browser offersto download it for
you.

Manage source code

Browse a project's source code repositories for detailed information about code commits, changed files, and associations with
other CollabNet TeamForge items.

View code commits
To stay up to date with code development on a project, browse the code commits made to each repository integrated into your
CollabNet TeamForge site.

For each code commit, you can view the list of files that were checked in, the version history of each file, and any
associations with other CollabNet TeamForge items, such as tracker artifacts or tasks.

g Note: You can see only those paths in the repository that the repository administrator has given you access to.
1. Click Source Codein the project navigation bar.
2. From thelist of project repositories, select the repository you want to look at, then click View Commits.

The Commits section of the Repository Details page lists all the code commitsin the repository. By defaullt, it
shows the commits made over the preceding seven days. For each code commit, you can see:

¢ The code commit name.

e The name of the developer who made the code commit.
e Any commit message entered by the developer.

* The date on which the code was committed.

Tip: To get an automatic email notification whenever code is committed to this repository, click the Monitor
down arrow, then choose Monitor Selected. The emails will contain all the details you can see on this page,
unless the repository's owner has chosen to send emails with only the essential information.

[ N
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3. Tofilter thelist of code commits, click the filter icon, enter the filter criteria, and click Apply.

g~ Tip: Filter menus are displayed at the top of each column. You can filter by commit name, committed by, and
~ code commit date ranges.

4. To view the details of acommit, click itstitle.

The Files section of the Commit Details page lists all files that were checked in with the code commit, including
the version number of each file and the last operation that was performed, such as modified, deleted, moved, copied,
or added.

* Toview thefileinformation, click the file name.
+ Toview thelatest version of thefile, click the file version.

5. Tolook at other items related to this commit, click the Associations tab.

Associate code commits with other items
Create associations between code commits and other CollabNet TeamForge items, such as tracker artifacts or documents, to
help define relationships, track dependencies, and enforce workflow rules.

For example:

« Associate a code commit with the bugs, feature requests, or other tracker artifacts that the code addresses.
« Associate a code commit with the task requiring its completion.

» Associate a code commit with an object in an integrated application.

» Associate a code commit with a requirements document.

Associate code with other items while committing
When you commit files to your source code repository, use the commit comment to quickly link your commit with one or
more tracker artifacts or other CollabNet TeamForge items.

Associationstrack the links between code and the bugs, feature requests, or other tracker artifactsthat the code addresses.
You can also associate code commits with other CollabNet TeamForge items, such as tasks or documents.

A project administrator can make associations mandatory for all code commits.
with other CollabNet TeamForge items, such as tasks or documents.
A project administrator can make associations mandatory for al code commits.

You can create tracker artifact associations from whatever interface you normally use to check code into your SCM
repository. You do not have to log into CollabNet TeamForge.

Use the same syntax for commitsto CV S, Subversion, and Perforce repositories.

When making a code commit, add the associate command in the commit message like this:
[ <i tem i d>], such asthe TeamForgetracker artifact ID or task ID.

e TeamForgeitem IDs are always | etters followed by four or more numbers, such ast ask1029 orart f 10011.
» To associate acommit with multiple CollabNet TeamForge items, separate the item |Ds with commas.

» All associations are displayed in the Associations section of the Commit Details page.

e TheComment section lists the comments made with each commit.

g~ Note: To associate an object in an integrated application, usethe[ <pr ef i x_obj ecti d>] format. Each
~ integrated application displays its prefix on moving the mouse over the application name.

Tip: Toremind yourself of the details of the association later, look in the Change L og tab of the associated Artifact
Details page.
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Create associations with code that is already committed
At any time after a code commit is made, you can associate the code commit with other CollabNet TeamForge items, such as
tasks, integrated application objects or documents.

1. Click Source Codein the project navigation bar.

2. OnThelist of project repositories, select the repository containing the code commit with which you want to create
an association.

Click View Commits.

On the Repository Details page, click the name of the commit with which you want to create an association.
On the Commit Details page, click the Associations tab.

On thelist of existing associations, click Add.

In the Add Association Wizard window, select the items with which you want to associate the artifact:

N o g s~ ®

e Enter Item ID - If you know theitem's ID, you can enter it directly.

Note: To associate an object in an integrated application from within CollabNet TeamForge, use the

&
[ <prefix_objectid>] format. Successful associations appear hyperlinked.

Tip: Each integrated application displays its prefix on moving the mouse over the application namein the
tool bar.

* Add From Recently Viewed - Select one of the last ten items you looked at during this session.
* Add From Recently Edited - Select one of the last ten items you changed.

8. Click Next.
9. Inthe Add Association comments window, describe the reason for the association.
10. Save your work.

¢ Click Finish and Add Another to add additional associations.
e Click Finish to return to the Details page.

Create a source code repository
Each project can have one or more source code repositories.

Before you can create a source code repository, a site administrator must first add one or more SCM serversto the
CollabNet TeamForge environment.

1. Click Source Codein the project navigation bar.
2. Inthelist of project repositories, click Create Repository.
3. Onthe Create Repository page, enter the directory name for the repository.

Note: For CVSrepositories, the directory name is the name of the directory relative to the CV S server's

€
repository root directory. A UNIX group by the same name is also created to enforce permissions.

4. Enter aname and description for the repository.
If you plan to use an SCM server that requires approval for new repositories, use the Description field to provide
your reason for asking to create this repository.

5. Choose the server on which you want to create the repository.

Note: The menu contains all of the SCM servers that the CollabNet TeamForge administrators have added to
the CollabNet TeamForge environment.

6. If youwant to requirethat each code commit be associated with an artifact (or atask or some other work item), select
Association Required on Commit.
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7. For security reasons, you may want to restrict email notifications to the essential information. If so, select Hide
Detailsin Monitoring M essages.

8. Click Save.

Your request for anew repository is submitted. You will receive an email notification when your repository is created
or if your request for a new repository is denied.

» If the SCM server that you chose does not require approval for new repositories, the repository is created.
« |f the SCM server that you chose requires approval for new repositories, a CollabNet TeamForge administrator must
approve your repository beforeit is created.

Note: By default, repository requests on unmanaged CV S serversrequire approval, because the SCM administrator

[ 1§ X
must manually create the repository.

Replicate a repository
When a Subversion Edge replica has been successfully registered with a TeamForge SCM integration server, it is available to
project administratorsin projects using that server to house repositories. To replicate a Subversion repository, you need to add
it to areplica server.

Before you can replicate a Subversion repository, an administrator must first add one or more replica servers. This
involves converting a Subversion Edge server, and then approving the replica in TeamForge.

1. Click Source Codein the project navigation bar.
2. Inthelist of project repositories, select the one you want to replicate and click Edit.

The Edit Repository page lists the available replica servers. Here's an example:

Replica servers hosting repository: Desktop
Status Name Hostname/IP address Description Owner

(i) Mo results found.

Available Replica Servers
+ MName + Hostname/IP + Description = Owner -
Status address
] Tokyo cu126.doud.sp.collab.net  Replica in Tokyo office Subversion
Replication
Replicate repository

If you don't see any available replica server listed here, it may be because none were created for this Subversion
server, or there are pending replicas which haven't yet been approved by a TeamForge administrator.

3. IntheAvailable Replica Servers section, select areplica server and click Replicate Repository.
You will seeit in thelist of replica servers hosting the repository.

» To see details such as the hostname and the user managing the replica repository, and recent replication command
history, click the Statusicon for the repository.
« For the Subversion checkout command, see the project's Sour ce Code page.

Note: The TeamForge account used while setting up the replica determines what's avail able to be checked out
from areplicarepository. This account - the M anaged By user in the Repository Replica Details page - could
have been provided total access to the master repository, or restricted access using path-based permissions.

[ 1
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Check command history
Recent command history for areplica server or a specific repository allows you to check for errors and see whether there are
pending commands.

* Maybe arepository revision is not showing up. You can check for errorsto know it's not just because the repository
is still synching.

* You can aso check if there are commands waiting in the queue -- you'd be able to see whether the repository istruly
in synch.

« To check the command history for areplicarepository, follow these steps:

a) Click Source Code in the project navigation bar.

b) Inthelist of repositories, click theicon for the one you're interested in.
You'll see repository details and command history. Here's an example:

Repository Replica Details

Replica Server: Tokya SErver; Subversion
Hostname: cu126.doud.sp.collab.net Repository Name: Benchmark
Managed By: Subversion Replication Description: SVN benchmarks
Last Contact: " Wed Apr 06 12:23:32 PDT

2011

| Browse Repository Replic

Replication Command History Page 1 of 3 (45 Items) |7 Hide | Ty Apply | Wk Remove | | = Rows
Status =2 Command % Revision ¥ 2 Created Date %1 Last Contact
Any - From ga4/o5/2011 = (MM /dd fyyyy)
To  04/06/2011 (MM/dd fyyyy)
.J Sync repository 70 Wed Apr 06 12:21:50 POT 2011 Wed Apr 06 12:21:54 PL7
2011
J Sync repasitory o9 Wed Apr 06 12:21:46 POT 2011 Wed Apr 06 12:21:54 PLT
2011

()]
oo

) Sync repository Wed Apr 06 12:21:41 PDT 2011 Wed Apr 06 12:21:43 PO

L Tip: You can aso check command history by clicking on the Statusicon in the Edit repository page.

* You need to be a TeamForge administrator to check the command history across areplica server.

a) On the site administration navigation bar, click I ntegrations.

b) Onthe SCM Integrations page, click the name of the replica server you're interested in.
The Edit System page displays the command history.

Check out Subversion code anonymously
When you want to experiment with code, you can do an anonymous checkout from a Subversion repository.

The checkout command uses a unique system-created user called "guest" and works without authentication.

To make anonymous checkout possible, the project administrator must set public and repository view permission to
"All Users."

The checkout command differs based on whether a user islogged in or not.
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When you are not logged in, use this command to check out: svn checkout --usernane guest
<domai n>/ svn/repo URL nane

When you are logged in, use this command to check out: svn checkout --usernane <l| ogged
i n_user name><donai n>/ svn/repo URL nane

Access CVS with a stored SSH key
If you don't want to enter your password each time you access a CV S repository, you can create a set of SSH authorization
keys and use the public-key method for automatic authentication.

Secure shell (SSH) can use public-key cryptography to confirm your identity, authenticate you to the remote host, and
encrypt data transmission. On many TeamForge sites, accessto CV S repositories is authenticated using SSH.

[ 1
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6.

Note: Theseinstructionswill help you only if all the following are true:

* Youreusing CVS.

»  The CVSROOT (or "cvs -d")info givenyou by your admin (or the CTF "Repositories' list) does not include
. pserver:

e Your admin has set up SSH access for you.

Check with your site administrator if you are not sure about any of these conditions.

Generate an SSH key pair according to the instructions in the documentation for your SSH client.
(Each SSH client provides its own mechanism for key pair generation.)

Log into TeamForge .
Onyour My Workspace screen, click My Settingsin your personal navigation bar.
On your User Details page, click Authorization Keys.

On the Authorization Keys page, copy the public key from the. pub filein your SSH installation directory and
pasteit into the Authorized Keysfield.

Click Update.

Your SSH public key is now saved. When you log into a CV S repository on your TeamForge site, SSH automatically
checks your private key against this public key and authenticates you. You do not have to enter a password.

[ 1

Note: You can store multiple SSH public keys in TeamForge, but only one for each client machine.

Provision hardware
Use TeamForge Lab Management to access virtual or physical machines where you can build and test your code.

Tip: For moreinformation about the new featuresin TeamForge Lab Management 2.2, see thisintroductory video.
(You'll need afree open.collab.net membership to watch it.)

Get an account on this system
If you are new to this system and require access, contact a TeamForge (or CEE) administrator in your organization.

The administrator will add aroleto your CollabNet TeamForge (or CEE) account which will enable you to access
resources on this site.

What Lab Management systems are assigned to me?
The easiest way to see what Lab Management systems are assigned to you is to check the My Pages page.

Each system assigned to you is listed on the the My Pages page, organized by project.

For more detailson aparticular system, click the name of the system. On the host status page, you can get moreinformation
about the host's configuration and performance, release the system, and more.
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Find an available host to use
To work in the Lab Management environment, you need to either allocate a system to yourself or log into someone else's
system in your project.

1. Click My TeamForge L ab Management or the Projects tab and select your project.

Important: Itisusually considered impolite, and may even be aviolation of your company's policies, to check

[ i
out a system from one project that you are a member of in order to do work related to another project.

2. Click Project Hosts.
3. Inthelist of hosts assigned to the project, do what you need to do:

« |f the host is allocated, click the user's name to ask their permission to work on their host.

Tip: You may also ask the user if they still need the host, and would they mind releasing the system so that

[ i
you or someone else, could check out the host.

e |f thehost isin the Free state, allocate it to yourself.

Note: Itispoliteto ask the owner of amachineif you can useit to log in and run jobs on. TeamForge Lab
Management assumes that all TeamForge Lab Management usersin a project should be ableto log in to all
systemsin aproject, to facilitate developer and QA productivity. But, along with this freedom comes the
responsibility to be a"good citizen" and not step on other peopl€e's resources.

Allocate yourself a Lab Management machine
When you have been given membership and an appropriate role in a TeamForge Lab Management-enabled project, allocate
ahost for your own use.

Your personal host can be rebuilt with any profile whenever you want.

You can install any software you want on it (subject to the CollabNet Terms of Service and your own organization's
security policy, al depending on how and where your TeamForge Lab Management instance is deployed).

You can run any jobs you want on the server (subject to the same conditions as software installation).

Find an available host to allocate.

On your project's TeamForge Lab Management home page, click the host you've identified.
On the host status page, click Allocate to reserve the host for yourself.

Specify how long you wish to allocate the host.

A w DN PR

» Choose a specific time/date to deallocate the host using the calendar widget.
e Choose alength of time to allocate the host.
« Allocate the host indefinitely (until you or a project admin frees the host).

Note: Your project administrator may have set alimit on the amount of time a machine can be allocated. If
thisisthe case, then you will receive an error message if you try to allocate a host for alonger period.

You can aways change the all ocation time for your host later, if you decide that you need the host for a shorter or longer
amount of time (subject to the maximum limits set by your project administrator).

Compare profiles or profile versions
To choose a profile for your TeamForge Lab Management system, compare different profiles and profile version in the Profile
Library.

1. Onyour project'shome page, select Profile Library.
The table shows al profilesin your project.
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2. Choose a profile from each of the sets of profiles and click Compar e selected profiles.

Note: Profiles must first be added to your project as "allowed profiles’. It is not possible to compare profiles
before you have added them to your project.

&
3. Onthe Profile Compare screen, select the versions of each profile to compare.

The default version is the latest version of the profile, but any version of a profile can be compared against any
version of any other profile.

Note: Any two profiles can be compared, even if they are from two different operating systems. For example,
TeamForge Lab Management will let you compare a Solaris profile and a Windows XP profile (but do not
expect the results to be very meaningful).
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Create a profile from a host
Let's say you've built ageneric Lab Managenment host and customized it for your team. With Lab Managenment 2.4, you can
create a profile based on the host image and store it in the Project Build Library (PBL) for your project.

' Note:

* You can only create profiles from ESX guests.
» These OS profiles are supported: RHEL 5, CentOS 5, SLES/11, Windows XP and And Windows Server 2003.
Windows Server 2008 and Solaris profiles are not supported.

When creating a profile that contains user-specific software or services, here are a couple of things you should be aware
of:

» If thesoftwareor serviceisrun by auser who isalocally-created user (say, an 'oracl€e' user who was manually created
on the node), the profile should be easily portable to other projects.

« |f the software or service isrun by a user who is aLab Managenment user, the profile will only work in projects
where that user has access. In projects where that user has no access, it's not likely that the profile will work well -
it may not work at all.

1. Bring up your host's Admin tab.

2. Inthe Create Profile from This Node section, enter a name for the profile.
Only alphanumeric characters, hyphens, underscores, and periods are allowed.

Create Profile from This Node

I_reate a new profile based on this guest. This guest will be inaccessable while the new profile is being ¢

Profile Frofile names may only contain alphanumeric cha
Name: ynderscores, and periods (i.e., "a-z0-9_.-").

Profile
Description:

Storage Project freedom public PEL storage
Location:

| Create Profile from cu025.h.s
3. Provide adescription for the profile.

4. Select the PBL location for the project.
The profile will be stored here.
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5. Click Create Profile from <hostname>.

Your host will be switched to a clone, and inaccessible for few minutes. When it gets back to the allocated state, the
profile will be created. The profile will be available in your project and in any project that allows public profiles.

Rebuild a system

You can rebuild a host with a specific profile that you choose from within your project.

Usually you will want the latest (highest) revision of the profile you are working with. However, profiles are versioned,
like source code. This means that you can always build with an older version of an operating system or package if you
need to.

g~ Note: Profiles are assigned to projects by your project administrator.

1. Onthe Project Host properties screen, select the host to rebuild.
2. Click the Configuration tab.
3. Sdlect aprofile from the Profile drop-down list and click Rebuild.

You can check the status of the host's progress by refreshing your browser.

Log into a TeamForge Lab Management system

You can log into any machine that is assigned to a project you are amember of and that you have the requisite permissions

for.

For security reasons, all TeamForge Lab Management systems are on a private network, inaccessible from anywhere
outside of CollabNet. To access these systems, you must tunnel through the TeamForge Lab Management Manager.

If you need access to a system that belongs to a project you are not a member of, you have two options:

e Asktojoin the project, or to get permission within that project to access TeamForge Lab Management hosts.
« Ask the owner of the system, or a project/domain administrator, to create an account for you on the machine.

Note: Thismay violate your organization's security policy, so check with your site administrator before creating

any accounts. If the account is temporary, you will be responsible for removing it.

Log into a UNIX system

Tolog into UNIX systems, such as Linux and Solaris machines, you must use port forwarding over SSH.

Port forwarding over SSH is a secure way to tunnel traffic over the Internet.

1. Set up your SSH tunnel.

a) Fromalinux or Solaris system, or from aWindows system with Cygwin, the command to set up an SSH tunnel
to "cu086.$vars.mgr_domain" through the TeamForge Lab Management Manager host "$external_host" would
look like this:

ssh -1L22000: cu086. $vars. ngr _domai n: 22 $ext ernal _host -1 usernane

b) From aWindows system without Cygwin installed, set up the tunnel using PuTTY.

All connectionsto "locahost" port number 22000 are now tunneled to "cu086.$vars.mgr_domain" port number 22
(SSH) through the TeamForge Lab Management manager host "$externa_host"

2. Loginto "cu086.$vars.mgr_domain" by issuing this command:
ssh | ocal host -p 22000 -1 usernane

Log into aWindows system

To log into aWindows system in TeamForge Lab Management, you must use SSH with the Remote Desktop Protocol (RDP),
which renders a full Windows graphical environment on your desktop.

The TeamForge L ab Management environment includes Windows X P Professional and Windows 2003 Server machines.
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Tip: You can automate this whole process with atool called Wissh. CollabNet does not provide support for this
tool, but it is something which we recommend.

Set up your SSH tunnel to the TeamForge Lab Management machine.

a) If you have Cygwin installed, use acommand like this. For example, "cu087.$vars.mgr_domain”, through the
TeamForge Lab Management Manager host "$externa_host"

ssh -L3390: cu087: 3389 $ext er nal _host
b) If you do not have Cygwin, set up the tunnel using Putty.

Start Remote Desktop by clicking Start > Programs > Accessories > Communications > Remote Desktop
Connection.

Note: If youareusing Linux to accessaWindows system, you can usether deskt op program, which provides
the same functionality.
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In the Remote Desktop Connection dialog box, enter | ocal host : 3390 and click OK.

This initiates a remote desktop connection to the TeamForge Lab Management host.

At thelogin prompt, enter your TeamForge Lab Management username and password.

If you are an authorized user on the machine, you are granted access and the correct privileges.

If your remote Desktop Connectionto | ocal host does not work, try this workaround:

a) Copy thetwofilesmst sc. exe andnsct ax. dl | to another folder.
Thesefiles should bein the directory C. \ W NDOAS\ syst enB2, orin C: \ Progr am Fi | es\ Renot e
Deskt op if you installed the Remote Desktop Client from the Windows 2003 CD.

b) Right-click thenst sc. exe fileand select Properties.

¢) Onthe Compatibility tab, select Run this program in compatibility mode for Windows 98.

d) Start up the new copy of nst sc. exe from the new location.
You should now be able to connect to | ocal host at IP address 127.0.0.1.

Set up atunnel with PUTTY
Summary to come...
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Launch the PUTTY application.

For Host name, enter the TeamForge Lab Management Manager host "$external_host".
For Connection type, enter "SSH".

In the left pane, open Connection list.

Open SSH list and click Tunnels.

In the right pane, enter "3390" for Source port and "cu087.$vars.mgr_domain:3389" for Destination, and click
Add.

Select the forwarded port from the list and click Open.
At thelogin prompt, enter your TeamForge Lab Management username and password.

The RDP tunnel is now set up.

[ 1

Note: This procedure is equivalent to running this SSH command:
ssh -L3390: cu087. $vars. ngr_donai n: 3389 $ext er nal _host

Set up aVNC server on TeamForge Lab Management
To allow remote access to an X Windows display on Linux from aremote computer, set up aVNC console.

VNC is aconvenient and effective way to access an X Windows display from aremote computer. Some applications
reguire X, and since users don't have access to consoles on TeamForge L ab Management nodes, VNC might be the only
way those applications can be accessed.
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1. Set aVNC password using thevncpasswd command.

[grue@u012 grue] $ vncpasswd
Passwor d:
Verify:

Tip: Thisdoesn't need to be the same as your TeamForge Lab Management password, but keep in mind that
this password will give the bearer accessto an X session as your username, so keep it something reasonably
hard to guess.

2. Editthefile/ et ¢/ sysconfi g/ vncser ver s. Add an entry for your session number, defaulting to 1, followed
by your username.

Use this as an examplefile:

VNCSERVERS="1: gr ue"

3. Start theVNC service.
[grue@u012 grue]$ sudo /etc/init.d/vncserver start
Starting VNC server: 1:grue [ K ]

Note: To stop the VNC server on your machine, run the command like this: [ gr ue@u012 grue] $ sudo
/etc/init.d/vncserver stop

4. If you want VNC to start up each time this server isrebooted, use the chkconf i g command to turn it on.
[grue@u012 grue]$ sudo /sbin/chkconfig vncserver on

Note: To prevent the VNC server from starting up on your machine when it is rebooted, run the command this

€
way: [ grue@u012 grue] $ sudo /sbin/chkconfig vncserver off

Connect to aVNC server from your desktop
To access an X Windows display from a remote computer, install and connect aVNC client.

VNC saves your desktop session and allows you to connect to it later. For example, you can start an X session at work,
then log off your computer, go home, start up your computer again, and resume your same X session. Inthissenseit is
very similar tothescr een( 1) utility, which allows usersto create, disconnect and reconnect to text-based terminal
sessions.

1. Instal aVNC client on your computer.
Tip: Either of these recommended packagesis available for all major desktop operating systems.

. TightVNC
+ RedVNC
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2. Set up an SSH tunnel to port 5901 on the proper TeamForge Lab Management node.

For example, let's say you are the user gr ue and you have set up aVNC server on the machine
cu012. $vars. ngr _donmi n. The port forwarding command would look like this:

ssh -1L5901: cu012. $vars. ngr _donmi n: 5901 $ext er nal _host

g~ Note: Multiple - L options can be combined on the same command line.

3. Start your VNC client software, and give the following information:

¢ Hostname: | ocal host
¢ Port: 5901
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Your VNC desktop session appears.

When you are done with the session, you can close the VNC client application on your desktop.
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Important: Keepin mind that closing the VNC client does not close applications that are currently running. You
can connect to this session again at any time later and your compl ete session is saved.

For security purposes, we recommend that you do not keep any windows open which contain root shells or other
software running asthe r oot user. Thiswill mitigate the risk of someone being able to access your VNC session
without you knowing it.

Transfer files in and out of the system

You can use WebDAYV, SFTP or Windows RDP to transfer filesin and out of a TeamForge Lab Management system.
Transfer files with WebDAV

The most useful way to get filesin and out of the TeamForge Lab Management environment is via WebDAV.
Connect to WebDAV with Windows Explorer on Windows XP

With a software update, Windows can be used to connect to a DAV share on a TeamForge Lab Management system.

Microsoft recommends you install this Software Update for WWeb Folders before using Web Folders. You may need this
update for Web Folders to work properly.

1

Launch Windows Explorer.

2. Onthe Tools menu, click Folder Options and select the View tab. Clear Hide extensions for known file types.

Thiswill make file names that begin with adot (".") to appear properly (for example, your . bashr c file).
Launch Internet Explorer.

On the File menu, click Open.

Enter the URL for your home directory, which will always endin/ hone/ USERNAME.

For example:

https:// $external _host/ hone/ user

Select Open asWeb Folder.
Enter your username and password when prompted.

If the connection is successful, you will see a new entry added to My Network Places. You can re-connect to this
folder in the future by going to My Network Places and selecting this folder.

As of thiswriting Microsoft does not provide a client that can mount aWeb Folder as a drive letter using an encrypted,
authenticated connection, but a third-party tool called Webdrive can do this.
Connect to WebDAV with Mozilla Firefox on Windows XP

Firefox isn't aWebDAV client, but it will interface with the Windows native WebDAV client to open up WebDAV shares.
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Install the openwebfolder Firefox plugin and restart Firefox.

Log into TeamForge Lab Management and go to the Summary page of any host you have access to.

Under Access Options, right-click the link pointing to your home directory and select Open AsWebfolder.
Enter your user name and password.

Your WebDAV home directory is now mounted.

Connecting to WebDAV with Mac OS X
To connect to a TeamForge Lab Management system from aMac, open up your TeamForge Lab Management home directory
via DAV access.

This procedure has been tested with Mac OS X 10.4.8 (Tiger) and should work for all Mac OS X versions.

1

2.

In the Finder, click Go > Connect to Server.

g~ Note: You can also press cmd-K on the keyboard.

For Server Address, enter the URL corresponding to your home directory.


http://www.microsoft.com/downloads/details.aspx?familyid=17c36612-632e-4c04-9382-987622ed1d64&displaylang=en%20
http://openwebfolder.mozdev.org
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For example, ht t ps: / / $ext er nal _host/ hone/ user (where"user " isyour username).

Click Connect.

If prompted, click Continue.

In the Verify Certificate dialog, enter your TeamForge Lab Management username and password.

Select Remember thispassword in my keychain if you want to store your user name and password locally.
Click OK

You should now see your folder.
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Note: Filesand directories beginning with a"." are not shown in the graphical folder view, but are accessible via
the command linein OS X.

Connect to WebDAV with Nautilus on Linux
The Nautilus file browser -- the default file browser on distributions like Red Hat, Fedora and Ubuntu -- has built-in support
for DAV folders.

ok w DN

6.

From the main desktop, goto Places > Connect to Server .

For Servicetype, select Secure WebDAV (HTTPS).

For Server, enter the name of the TeamForge Lab Management server, e.g., $ext er nal _host
For Folder, enter / hore/ user , where"user " isyour username.

You can leave the User Name, Port, and Name to Use For Connection fields blank.

Click Connect.

This creates an icon on the desktop, which brings up your home directory when accessed.

Transfer files with SFTP
Secure File Transfer Protocol (SFTP) can be a useful way to transfer files between your desktop and TeamForge Lab
Management.

SFTPisan extension to the Secure Shell (SSH) protocol, which emulates File Transfer Protocol (FTP). File transfers
made with SFTP show up immediately in your TeamForge Lab Management environment. Any TeamForge Lab
Management client machines you are logged into immediately reflect changes made to your home directory from your
desktop.

1

On Linux, UNIX, or Windows with Cygwin, run the command-line SFTP program with a command like this:
sftp user nanme@ext er nal _host

g~ Note: There are also graphical clients available for Linux.

On Windows, we recommend using the Filezilla program to manage your SFTP transfers.
Filezillais available as a plugin for the Firefox web browser with an easy-to-use Explorer-like interface.

Connect to TeamForge Lab Management with Windows Remote Desktop
If you are connecting to a Windows host via Remote Desktop, you can share drives from your local system to the remotely
connected system.

1
2.
3.

On the Start menu, click All Programs > Remote Desktop Connection.
Click Options and click the L ocal Resourcestab.
Click Disk Drives > Connect

Find a build
You can search for file names (not file content) in the Project Build Library.

Search for filesin Project Build Library using these fields:
e Project
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e User
» File Name: Shell-like regular expressions are permitted. For example, for searching all RPMS you can type
*.rpm

»  Description: Substring-like pattern matching is permitted. For example, to search al filesadded by thepbl _f sck
script, type pbl _f sck.

g~ Note: Exclude directories from your search results with the Exclude option.

Connect to network services outside TeamForge Lab Management
TeamForge Lab Management systems are firewalled from the outside world, for our users' safety. However, you can use port
forwarding to connect to machines outside of TeamForge Lab Management.

For example, you may need to connect to aweb server holding the results of your nightly builds, or access an external
web server where libraries are installed.
Reach a TeamForge Lab Management server from the outside
Use port forwarding to allow users outside the TeamForge Lab Management environment to access specfic ports on specific
hosts inside the TeamForge Lab Management network.

Port forwarding must be set up by a TeamForge Lab Management Domain Administrator: neither you nor your project
administrator can do this. Thisis necessary because port forwarding can open up security holes.

4. Caution: Exposing an insecure network service outside of the TeamForge Lab Management environment could
" put your whole project and the entire TeamForge Lab Management environment at risk, if that serviceis
compromised.

Contact your Domain Administrator and give them the following information.

e Your name.

e Your project.

* Thehost you want to expose a port from.

* The port number you would like to expose.

* Theservice you would like to run on this port.

»  Security precautions you have taken to insure that this service is safe to expose outside of TeamForge Lab
Management.

Note: Your Domain Administrators may have more stringent information gathering or signoff processeswhich

i
you will be subject to.

Reach outside destinations from within TeamForge Lab Management
TeamForge Lab Management has no built-in features to allow outbound network access to be granted by an administrator.
However, if you need access to external destinations from inside TeamForge Lab Management, you have a couple of options.

Try one of these approaches:

» Contact your Domain Administrator and ask CollabNet to open up ahole in the firewall for this purpose.
» Get thefiles you need into your home directory from outside CollabNet, and access them that way.

Allocate a host from a cloud
To allocate a host from a cloud into a project, specify its type, size and profile information.

In Lab Management, you can alocate from virtual machines on physical hosts and EC2 hosts. You cannot allocate a
physical machine from acloud

1. Inyour TeamForge Lab Management project, click Hosts.
2. Click Allocate for the cloud from which you want to allocate your host.
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The clouds you can choose from depend on the ones available in the Lab Management domain, and which of these
the administrator has made available for your project.

In the Clouds page, select a host type and size.

Different host types have different attributes such as CPU, disk size and RAM. They aso have different costs and
available profiles.

Select the system profile you want on your host.

A profilein Lab Management is a collection of software packages that comprise a runnable operating system and
accompanying set of applications.

Note: Profiles have different costs. For example, a profile might include some licensed software that adds to
the cost.

Select the number of hosts you want to allocate.
The default is one.

To customize your host, click Advanced options.

a) Enter adescription for the host.
b) Select whether you want the host allocated up to a certain date, or for a specific number of days.

By default, the host is allocated indefinitely until you freeit.
Click Allocate Host.

Tip: You can seeinformation about the host in your My Pages.

Build and test your software

When your project manager makes CollabNet Build & Test available, you can set up the CollabNet plugin for Hudson in your
development environment.

Upload to a CollabNet File Release

Upload afile to a CollabNet release
To upload build results to afile release in CollabNet SourceForge Enterprise or CollabNet TeamForge, configure the file
release component as a post-build action in Hudson.

Before you set up the CollabNet plugin, make sure that the CollabNet SorceForge or TeamForge project contains valid
package and file release folders.
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Note: All Hudson builds that succeed will get uploaded to the CollabNet file release. If you want to upload only
promoted builds, install the Hudson Promoted Builds plugin as well.

In the Hudson interface for the job, click Configure.

In the Post-build Actions section, select CollabNet File Release.

Enter the URL of the CollabNet site. For example, https://forge.collab.net.

Enter the username and password of the CollabNet project member who will upload the files.

g~ Note: Thisuser must have at |least view permission for the package.

Enter the name of the CollabNet project, the package and the file rel ease where you want the build files added.

g~ Noter A package, and within that, arelease, must exist before you can add individual filesto that release.

Specify whether you want existing files with the same name to be overwritten.
Specify afile pattern so that files that match the pattern are uploaded.
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You may use Hudson environmental variablesin your file patterns. For example,
"pkg/subversion-r${ SYN_REVISION} .tar.gz", in ajob to build Subversion source code.

8. Click Save.

When the build compl etes, the files are uploaded into thefilerel ease. Here's an exampl e of the TeamForge View Release
page.

L £ A % 3 L= [l L

Project Home Tracker Documents Tasks Source Code Discussions Reports File Rele:

File Releases = myw package » beta = ¥iew Release

Release: rel1001

Mame: beta

Description:  Tesk

Files = Reported Tracker Artifacts  Fixed Tracker Artifacts  Associations

[[] File MName ¥ Size
IF D subrversion-r35290.kar, gz £.61 ME
ﬁ A A1 ME

Note: To upload only specific, successful builds, you need to enter the CollabNet file rel ease information as an
action for the build promotion process.

Publish promoted builds to a CollabNet release
To upload only specific, successful builds, configure the Hudson Promoted Builds plugin to publish those build filesto a
SourceForge or TeamForge release.

A "promoted build" in Hudson is a build that succeeds and also meets the criteria that you specify.

g~ Note: This feature requires the Hudson Promoted Builds plugin as well as the CollabNet file release component.

Let's say you set up ajob, "Subversion_Build", to build open source Subversion, and you want to promote builds by
manually approving them.

1. Inthe Hudson interface for the job, click Configure.
2. Select Promote builds when...

3. Enter aname for the promotion process and select Only when manually approved as the criterion for promoting
asuccessful build.

4. Inthe Actions section for the promotion process, enter the URL of the CollabNet site. For example,
https://forge.collab.net.

5. Enter the username and password of the CollabNet project member who will upload the files.

g~ Note: Thisuser must have at least view permission for the package.

6. Enter the name of the SourceForge or TeamForge project, the package and the file rel ease where you want the build
files added.

g~ Note: A package, and within that, arelease, must exist before you can add individual filesto that release.
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7. Specify whether you want existing files with the same name to be overwritten.
8. Specify afile pattern so that files that match the pattern are uploaded.
You may use Hudson environmental variablesin your file patterns. For example,
"pkg/subversion-r${ SYN_REVISION} .tar.gz".
9. Click Save.

When the build succeeds and is promoted, it is uploaded into the CollabNet file rel ease application.

Note: To upload al builds to a CollabNet file rel ease, whether promoted or not, you need to configure the File
Release System component as a post-build action.

Upload to CollabNet Documents

Upload afile to a CollabNet document application
Configure the Document Uploader component as a post-build action to upload Hudson build files as document artifactsin a
CollabNet SourceForge Enterprise or TeamForge project.

In the Hudson interface for the job, click Configure.

In the Post-build Actions section, select CollabNet Document Uploader .

Enter the URL of the CollabNet SourceForge or TeamForge site. For example, https://forge.collab.net.
Enter the username and password of the CollabNet project member who will upload the files.
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g~ Note: This user must have at least view permission for the document folder.

5. Specify the name of the project and the path on the CollabNet server where you want the files uploaded.

g~ Note: If the path you enter does not exist, it is created.

For example, when you enter the path "Build Results${ BUILD _ID}", a document folder is created at "Documents
> Root Folder > Build Results > 2009-01-29 13-43-51" for aBUILD_ID "009-01-29 13-43-51", and al thefiles
for that build are individual documents within the folder.

6. Enter adescription.
Your description can include environment variables as well. For example, "Build results for ${BUILD_ID} at
${SVYN_REVISION}".

7. Specify afile pattern so that files that match the pattern are uploaded. For example, "trunk/doc/***"

8. Click Save.

The build files are uploaded into the Documents application. You can see these filesin the TeamForge List Documents
page. By default, each document is unlocked and has the "Final" status.
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Generate and update CollabNet Tracker artifacts

Set up a build to generate CollabNet tracker artifacts
Configure the Tracker component as a post-build action to generate new CollabNet SourceForge Enterprise or CollabNet
TeamForge tracker artifacts or update existing artifacts based on Hudson build resuilts.

Before you set up the plugin, make sure the following are in place in the CollabNet project:

« A valid tracker where artifacts can be created or updated
* A user who isaproject member, and has view, submit and edit permissions for the tracker

1. Inthe Hudson interface for the job, click Configure.
2. Inthe Post-build Actions section, select CollabNet Tracker.
3. Enter the URL of the CollabNet site. For example, https://forge.collab.net.
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4. Enter the username and password of the SourceForge or TeamForge project member responsible for creating and
updating tracker artifactsin the project.

5. Enter the name of the project containing the tracker.

g Note: If the user specified is not a member of this project, the plugin will not be able to locate the project.

6. Enter the name of the tracker where artifacts will be created or updated.

Note: If the user specified does not have the requisite permissions in this tracker, the plugin will not be able
to identify the tracker.

7. Enter atitlefor the tracker artifact.
You may use environment variablesin the title. For example, ${ BUILD_ID). Entering a itle that could change
causes anew artifact to be opened every time the build fails. For atitle that does not change, all build results affect
asingle tracker artifact.

8. Specify theindividua to whom the artifact should be assigned.

Note: If the project administrator has configured the tracker to automatically assign artifacts to individuals
based on artifact criteria, skip this step. If not, and you do not select a user, the artifact is assigned to "None".
The artifact is also assigned to "None" in case the usernameis not valid.
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9. Enter apriority for the artifact.

10. Select whether you want the Hudson build log attached to the artifact.
Attaching the build log could be especially useful when abuild fails, since you would not need to check the Hudson
console output for details.

11. Specify whether you want the artifact to be updated irrespective of the outcome of the build.

« Sdlect yesif you always want to update the issue after each build, regardless of whether the build succeeds or
fails.
e Sdect noif you only want to track build failures.

12. Select whether you want an open artifact to be automatically closed when the build succeeds.

' Note:

» Usethisoption only to update existing artifacts. If the artifact is a new one, it will have the status "Open"
for anon-successful Hudson build, and "Closed" for a successful build.

» Make sure your selection does not potentially conflict with atracker workflow rule you may have set up.
For example, assume you had defined a status transition rule that an open artifact can be closed only when
the "Fixed in Release" field is specified. If you select the "Yes" option here to automatically close an open
artifact without manual intervention, there will be a conflict because of the "Fixed in Release” requirement.

13. If the artifact represents afailed build for afile release, enter the release name in Reported Release.

Tracker artifacts are created, updated or closed depending on your configuration and build results.

Upload to the Lab Management Project Build Library (PBL)
Get a Lab Management API key
To access Lab Management Web Services, you must first get aLab Management API key.

1. Logintoyour Lab Management site using a\Web browser.
2. Onyour Lab Management home page, click Create APl Key in the Lab Management Web Service APl Key
section.

g~ Note: If you already have an API key, click Show API Key to display it.
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3.

Copy the key to the clipboard.
You will need it when adding or specifying aLab Management Manager site.

Upload build results to a Lab Management Project Build Library
Configure this component as a post-build action to automatically upload files such as daily build results which do not need
permanent storage, to aLab Management Project Build Library.

Before you set up this component, make sure that there is a project on the Lab Management manager node where the
specified user has at least the "Lab Management - Root User" role.

The Project Build Library is the place within CollabNet Lab Management where build files are created and stored.
Unlike a project's Subversion repository, filesin the Project Build Library are not under revision control, and may be
permanently deleted. This makes the PBL an ideal place to upload large binaries which may not be needed forever, like
daily builds. Project members can browse to this location and view and download the build results they need

A wDN PR

10.

1.

12

13.

In the Hudson interface for the job, click Configure.

In the Post-build Actions section, select L ab Management Project Build Library (PBL) Uploader.
Enter the URL of the Lab Management manager node. For example, https://mgr.cubit.collab.net.
Enter the username of the user who will upload the files.

g~ Note: Thisuser must have the "Lab Management - Root User” role or better in the project you specify.

Enter the user's API key for the Lab Management web service.

L Tip: Copy and paste the key from the user's Lab Management home page.

Specify the name of the project where you want the build files uploaded.

Select whether you want to upload the files to the Public or Private location on the Project Build Library.

Public files are accessible to al users who have "Project Document - View" permission in any project. Private files
are accessible only to users who have "Project Document - View" permission in the project where the file resides.
Specify afile pattern so that files that match the pattern are upl oaded.

Enter the path where the files are to be uploaded

g~ Note: The path isrelative.

For example, if your path is"/my/path/${ BUILD_ID}", and you chose the private location in the Project Build
Library, the fileswill be uploaded at https://mgr.cubit.collab.net/pbl/project_name/priv/imy/path/${ BUILD _ID}.

Select whether you want to overwrite existing files.

Select Trueif you have files you want to replace after each build.

Enter a description.

For example, "Hereis ${ BUILD_ID} uploaded from ${HUDSON_URL}".
Enter an optional comment for thefiles.

The comment is stored in the Project Build Library Audit Log.

Click Save.

The build results from your Hudson server are available under Most Recent Uploads in the Project Build Library.

Release products
Publish the ouput of your project to selected audiences as packages and rel eases.

Download a release
Downloading arelease brings all the release’s filesto your local machineinasingle. zi p file.

1

Click File Releasesin the project navigation bar.
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2. Onthe Package Summary page, click thetitle of the package containing the rel ease you want to download.
3. Onthe Package Details page, click the title of the release.
4. Onthe Release Details page, click Download Release.

CollabNet TeamForge prepares the compressed filein . zi p format.
You are prompted to open or save thefile.
Create a package

A package isafolder into which one or more related releases are published.

For example, you might create a package to represent a product deliverable or major component. You can then create
releases within the package for product builds or other groups of files.

g~ Note: A package must exist before you create the releases and individual files that will go into the package.
Click File Releasesin the project navigation bar.

On the Package Summary page, click Create.

On the Create Package page, enter atitle and description for the package.

Click Save.
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The package is created.
When you have created a package, you can publish arelease into the package.

Create a release
A release isagroup of one or more files that are published as a unit.

Before creating arelease, you must have a package into which your release will go.

1. Click File Releasesin the project navigation bar.
2. Onthe Package Summary page, click thetitle of the package in which you want to create the release.
3. On the Package Details page, click Add.
4. Onthe Create Release page, write a name and description for the release.
5. Set the status of the release.
Pending Releases with pending status are not visible in the drop-down lists displayed when you set

Reported In Release and Fixed In Releasefieldsin an artifact. Use Pending status when you
have created a release but have not yet finished adding files.

Active Releases with active status are visible in the drop-down lists displayed when you set Reported
In Release and Fixed In Release fieldsin an artifact.

6. ldentify the maturity level of thisrelease.
Use one of these predefined values:
e Development build
e Alpha
 Beta
* Generd availability

7. Click Save.

Thereleaseis created. You can begin adding files.

Tip: To facilitate tracking, you may want to match this release to the planning folder that tracks the work that's
going into the release. If you do that, the relevant work items will automatically appear on the Planned Tracker
Artifacts tab. See Create a planning folder on page 102.

[ N
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Add files to arelease
After you have created arelease, you can add one or more files. All filesin arelease are published as a unit.

Project members can download the entirereleasein asingle.. zi p file, or download only selected files.

Click File Releasesin the project navigation bar.

On the Package Summary page, click thetitle of the package containing the release.
On the Package Details page, click the title of the release.

On the Release Details page, click Add.

On the Add File page, go to the desired file, then click Save.
Thefileisadded and you are returned to the Release Details page.

6. Repeat the last two steps until all files are added.
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After you have added your files, you might wish to change the status of the release from pending to active. Thiswill
allow userswith appropriate permissions to select the rel ease when entering or updating an artifact. You can also change
the maturity level if needed.

Update files in a release
You can replace an existing file in arelease with anew file.

Click File Releasesin the project navigation bar.

On the Package Summary page, click thetitle of the package containing the release.

On the Package Details page, click thetitle of the release containing the file that you want to update.
On the Release Details page, select the file you want to update, and click Update.

In the Update File window, go to the new file with which you want to replace the current file.

Click Save.
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Thefile is now updated.

Delete files from a release
If afileisno longer needed, it's agood ideato delete it from the release.

Click File Releasesin the project navigation bar.

On the Package Summary page, click the title of the package containing the desired release.

On the Package Details page, click the title of the release containing the file that you want to delete.
On the Release Details page, choose the file you want to delete, and click Delete.

SN -

Thefileis deleted.

Update release attributes
Asyour release matures, you should update its maturity level and status.

Click File Releasesin the project navigation bar.

On the Package Summary page, click thetitle of the package containing the release.

On the Package Details page, click the title of the release containing the file that you want to delete.
On the Release Details page, click Edit.

On the Edit Release page, identify the maturity level of thisrelease.

Use one of these predefined values:

o w e

« Development build
e Alpha

 Beta

e Generd availability
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6. Choose a new status for the release.
A release can be in Active or Pending status.

7. Click Save.

Change a package's name or description
When the purpose or the audience for a package shifts, you may want to rename the package or describe it differently.

Click File Releasesin the project navigation bar.
On the Package Summary page, select the package you want to edit, and click Edit.
On the Edit Package page, write the new name or description.

To make it easier for users to download the package, select Show Download Link in Project List.
This makes the download link show up in the project's entry in the Project Categories system, if the project has been
put in one or more categories. See Categorize a project on page 123.

5. Click Save.

> w DN

Associate a release with other items
If afilereleaseisrelated to other TeamForge items, such as documents, tasks, tracker artifacts, integrated application objects,
or news items, you can connect the file release to the other item by creating an association.

Creating associations between items hel ps you define rel ationships, track dependencies, and enforce workflow rules.
Some example uses of file release associations include:

» Associate arelease with arequirements document.
« Associate a beta release with atask related to managing the beta program.
» Associate arelease with tracker artifacts representing bugs fixed in the release.

Note: You can also associate tracker artifacts such as bugs and feature requests with the related file releases. You
do this as part of working with the tracker.

1. Click File Releasesin the project navigation bar.

2. On the Package Summary page, click thetitle of the package containing the release with which you want to create
an association.

3. Onthe Package Details page, click the title of the release.
4. Onthe Release Details page, click the Associations tab and click Add.
5. Inthe Add Association Wizard window, select the items with which you want to associate the artifact:

e Enter Item ID - If you know the item's ID, you can enter it directly.
Note: To associate an object in an integrated application from within CollabNet TeamForge, use the
[ <prefix_objectid>] format. Successful associations appear hyperlinked.

Tip: Each integrated application displaysits prefix on moving the mouse over the application namein the
tool bar.

* Add From Recently Viewed - Select one of the last ten items you looked at during this session.
* Add From Recently Edited - Select one of the last ten items you changed.

6. Click Next.
7. Inthe Add Association comments window, describe the reason for the association.
8. Saveyour work.

¢ Click Finish and Add Another to add additional associations.
e Click Finish to return to the Details page.
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Delete a package
If you no longer need a package, you can deleteit.

Deleting a package deletes all of the releases and files within it.

g5 |mportant: Delete a package only if you are sure that you no longer need any of the releases and files within it.
1. Click File Releasesin the project navigation bar.

2. On the Package Summary page, choose the package that you want to delete.

3. Click Delete.

The package and all of the releases and files within it are now deleted.

Delete arelease
If you no longer need arelease, you can deleteit.

Deleting arelease deletes al of the fileswithinit.

g~ Important: Delete arelease only if you are sure that you no longer need any of the fileswithin it.

1. Click File Releasesin the project navigation bar.

2. On the Package Summary page, click thetitle of the package containing the release that you want to delete.
3. Onthe Package Details page, select the release that you want to delete, and click Delete.

The release and all of the files within it are now deleted.

Watch for changes

When you monitor an item, such as atask or adocument, you are notified by email when that item is updated. You can also
monitor a discussion forum or project news by subscribing to its Really Simple Syndication (RSS) feed.

Sort emails from TeamForge automatically
When you areinvolvedin alot of activities on your TeamForge site, you can start receiving many emailsfrom project members
and administrators. To save time, you can configure your email application to sort these emails automatically.

For example, you are automatically emailed whenever someone comments on an artifact that you created. You may also
want to join the monitoring lists of itemsyou are interested in, and other team members can add you to the monitoring
list of itemsthey create. All of these things can add up to a good number of emails after you have been on a project for
awhile.

Your email program, such as Microsoft Outlook and Mozilla Thunderbird, looks for the X-headers in incoming email
messages and acts on them according to your instructions.

1. Inyour email client, create a message filter.

e InMozillaThunderbird, click Tools> Message Filters.
* In Microsoft Outlook, click Tools> Rulesand Alerts.

2. Specify the type of information you want to filter.
For example:

e UseX- Teanfor ge- Proj ect | d to identify the project that the incoming email isrelated to.

* UseX- Teantor ge- Fol der | d to identify messages related to a specific tracker or document folder.

« UseX- Teantor ge- Assi gnedTo to flag tasks or artifacts that are assigned to you.

¢ UseX- Teantor ge- Commi t Pat h towatch for commits path in a Subversion repository where you areworking.

* UseX- Teantor ge- Pl anni ngFol der towatch for artifacts to be added to or removed from a planning
folder you are working with.
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3. Tell your email program what to do with the messages with the X-header that you specified.
For example:

« Automatically move emailsinto aspecia "To Do" folder if they are about tracker items assigned to you.
» Color emailsred if they are about commits to the Subversion repository path you specified.
» Forward all build-related announcements to your mobile phone for reviewing later.

You can use as many X-headers as you need. If you have set them up judiciously, this can decrease the amount of time
you need to work through your incoming email.

Monitor an item
To get notified by email whenever an item changes, monitor the item.

CollabNet TeamForge , an item is something you produce with the site's tools. These are some examples of items:

e Documents

e Tasks

e Tracker artifacts

» Discussion forum topics
e Filesinarelease

1. Gotothefolder containing the item or items that you want to begin monitoring.
2. Select theitem or items that you want to begin monitoring.
3. Click the Monitor down arrow, then choose Monitor Selected.

You are now monitoring all selected items. Theicon is displayed in the item list view and the monitored items appear
in the monitored items list on your personal Monitoring page.

g~ Note: When you update two or more artifacts at atime, each user who is monitoring any of the changed artifacts
- getsasingle email describing all the updates.

To stop monitoring an item, select it, then roll your mouse over the Monitor down arrow and choose Stop M onitoring
Selected.

g~ Note: You can also stop monitoring any item from the monitored items list on your personal Monitoring page.

Monitor many items
To get notified about awhole class of items whenever oneis created or changed, monitor the folder that contains the items.

In CollabNet TeamForge, afolder is a container for multiple items. Any container can be considered afolder, evenif it
isnot explicitly called afolder.

e A document folder contains documents.

e A task folder contains tasks.

o A tracker isafolder that contains tracker artifacts.

« A forumisafolder that contains discussion topics.
* A repository isafolder that contains code commits.
* A packageisafolder that containsfiles.

1. Select the folder that you want to begin monitoring.
For example, in a project where you are amember, click Source Code in the navigation bar and select one of the
code repositories in the project.

2. Click the Monitor down arrow, then choose M onitor Current Folder.

You are now monitoring thefolder. Theicon isdisplayed in thetop row of thelist view, and the monitored folder appears
in the monitored items list on your personal M onitoring page.
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Note: You do not receive monitoring notifications for changes that you yourself make to an item in a monitored

[
folder.

To stop monitoring a folder, click the Monitor down arrow, then choose Stop M onitoring Folder.

g Note: Youcan also stop monitoring any item from the monitored items list on your personal M onitoring page.

Monitor an application
To monitor an entire application, such asal trackersor all documentsin aproject, select it on your personal M onitoring page.

Monitoring an application keeps you updated on all items and folders within the application. Unlike individual items,
lists of items, and folders, you don't monitor entire applications from within a project.

1. Click My Workspace in the CollabNet TeamForge navigation bar.
2. Click Monitoring in your personal navigation bar.

3. Fromthe Projectsand Preferences menu on your personal M onitoring page, choose the project in which you want
to monitor an application.

4. Onvyour All Monitored Objectslist for the selected project, click the M onitored Applications tab.
5. Onyour Monitored Applications page, select the applications that you want to begin monitoring.
6. Click Save.

You are now monitoring the selected applications.

Monitor discussion forums as RSS feed
To get an update in your RSS feed reader each time there is an exchange of ideas in a discussion forum, subscribe to the
forums's RSS feed.

In CollabNet TeamForge, you can subscribe to discussion forums via RSS feeds.

1. Click Discussionsin the project navigation bar.
2. Onthe Forum Summary page, click the title of the forum that you want to subscribe via RSS feed.

3. On the Topic Summary page, click the RSS feed icon -a

You can now monitor all topicsin the selected discussion forum using your RSS feed reader.

Note: You can access the project messages viathe RSS reader without logging in to TeamForge, so long as you
have the discussion view permissions.

Monitor project news as RSS feed
To get an update in your RSS feed reader each time something important is announced in your project, subscribe to the project
news as RSS feeds.

In CollabNet TeamForge, you can subscribe to project news for all the projects via RSS feeds but not to the news of
any specific project.

1. Click My Workspace in the CollabNet TeamForge navigation bar.

2 On the News tab, click the RSS feed icon.

g~ Note: You must be amember of aproject to view its news.

You can now monitor all project news announcements regarding your projects using your RSS feed reader.

Note: You can access the project news viathe RSS reader without logging into TeamForge, so long as you have
project membership in any project.
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What am | monitoring?
All of your monitored items appear in your personal M onitoring page.

From thislist, you can view or stop monitoring any item you are currently monitoring. You can also monitor entire
applications from this page.

1. Click My Workspace in the CollabNet TeamForge navigation bar.

2. Click Monitoring in your personal navigation bar.
Your personal M onitoring page lists all items you are currently monitoring.

3. Click thefilter icon to see a subset of theitemsin thelist. Click Apply after entering your filter value.

Note: You can use the following special charactersto filter data: <, >, <=, >=, and %. The percent sign is used
for partial text filtering.

4. Usethe up-down arrow at the top of any column to sort your list by that column.

* Your primary sort column isidentified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.
» Click the up-down arrow again to reverse the sort order.

To stop monitoring an item from your personal M onitoring page, select the item you want to stop monitoring, then
click Stop Monitoring.

Who is monitoring this item?
To see who is monitoring an item or folder, check the Users Monitoring This Item list.

1. Go to the page where the item appears.
2. Select theitem, then click Details.

L Note: You can also click theitem name.

3. Ontheitem’s Details page, click Users Monitoring.

The UsersMonitoring ThisItem window displays alist of all users who are monitoring the item.

Choose monitoring email frequency
How often do you want to receive monitoring email notificationsfor all the applications, foldersand items you are monitoring?

1. Click My Workspace in the CollabNet TeamForge navigation bar.
2. Click My Settingsin your personal navigation bar.
3. Onyour User Details page, in the User Preferences section, choose an email notification preference.

» Email Per Change: Get a separate email notification for each change to a monitored item.

< Daily Digest Email: Get one email notification each day containing a digest of all changes made to monitored
items in the preceding twenty-four hours.

e Don't Send Email: Get no email notifications for changes to monitored items. This can be handy when you are
on vacation.

4. Click Save.
After you have set your global email frequency, you can further customize the frequency of application monitoring
emails.

Note: When you update two or more artifacts at atime, each user who is monitoring any of the changed artifacts

i
getsasingle email describing all the updates.
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Choose how often to get emails from specific applications
How many email notifications do you want to get about the applications you are monitoring, and how often?

To further personalize your monitoring preferences, you can set the frequency of email notifications for each monitored
application on aproject level. If you don't set your application monitoring email frequency settings, your global setting
applies.

For example, suppose you are contributing code to the "Widgets" project, but your role in the "Gizmos" project is of a
more advisory nature. When you monitor an item in the "Widgets" project you'll want more detailed updates than you
will want from items you've monitored in the "Gizmos" project.

1. Settheglobal default email frequency from your My Settings page.
See Choose monitoring email frequency on page 87.

2. Click Monitoring in your personal navigation bar.
3. From the Projects menu, choose the project in which you want to configure monitoring email frequency.
4. Onthe Email Notification Preferences tab, specify how often you want to be notified and click Save.

Any email notification preferences you set here will override the default preferences that you set on your My Settings
page.

g~ Note: When you update two or more artifacts at atime, each user who is monitoring any of the changed artifacts
- getsasingle email describing all the updates.

Monitor an item for someone else
To aert another user to an item, add that user to thelist if people monitoring that item.

After auser is added to amonitored item, the user can configure their own monitoring preferences for the item, or stop
monitoring the item.

g~ Note: Users can stop monitoring an item only for themselves. You cannot "unmonitor” an item for someone else.

1. Gototheitem to which you want to add a user.
2. Select theitem, then click Details.

ol Note: You can also click the item name.

On theitem's Details page, click Users Monitoring.

In the Users Monitoring This Item window, click Add.

From thelist of available project members, select the user or users that you want to add to the monitored item.
Click Add.

Click OK.

N o oMW

The users are now added to the monitored item.

Lead a project team with CollabNet TeamForge

|Navigation title:Run a project
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Managing a project means providing tools and processes to give each project member's contributions their greatest possible
impact.

Create a TeamForge project
Create anew project when you have identified work to be done that has its own distinct character, dependencies or schedule.
What constitutes a project depends on your organization. Some organizations favor a small number of big, centralized

projects. Others prefer alarger number of smaller, specialized projects. Your site administrator can help you decide if
your work should be part of alarger project or a project of its own.

1. Onyour TeamForge site's main page, select Create New Project from the Proj ects dropdown list.
2. Onthe Create Project page, give the project aname and a brief description.

« Thename will appear in project lists and on the project's home page.

« A terse description is recommended. There will be unlimited room to discuss the project's aims and methods in
detail on the project pages themselves.

3. ProvideaURL name for the project, if you want the URL for the project to be different from the internal project
name.

If you do not enter a URL name, the project URL will be the same as the project name.

4. If your site administrator has provided project templates, select the appropriate one for your new project.

Project templates give you ready-made artifact types, workflow support, user roles and other start-up content
appropriate to the kind of project you are creating.

g~ 11p: The"Default Project Access" and "Project Access Editable” options are displayed based on the project
- settings. If you would like to change these settings, ask your site administrator.

5. Click Create.

The project issubmitted to the CollabNet TeamForge site administrator for approval. You will receive an email notification
when the site administrator approves or rejects your project. When your project is approved, you can get to it from your
My Projects page or from the Projects menu in your navigation bar.

Build your project web site

Project members and other users need to know how to interact with your project. You can give them the information and tools
they need by creating and maintaining a project web site tailored to them.

You can build your project home page from scratch or assemble it from building blocks provided by TeamForge.

Assemble your project web site
For quick, flexible site building, use the ready-made web page components that come with your TeamForge project site.

There are components for showing text, wiki pages, charts and graphs, and other purposes. These components make it
easy to put together a sophisticated project sitein little time.
Create a project page

To provide information and functionality to people viewing your project, build one or more project pages.

1. Go to the page to which your new page will belong.

o Tip: Any project page can have sub-pages belonging to it. A page that belongs directly to the project home
pageis called a "top-level page.”

2. Click Configure: On.
3. Choose where your new page will fit in your project's structure.

» To create apage just under the project home page, click Add top-level page.
A top-level page'stitleis awaysvisiblein the navigation tree at left.



90 | OpenTopic | How to use TeamForge 6.1

» To create a page under the page you are on right now, click Add sub-page.

o Tip: You can create afree-form page only as a sub-page.

4. Giveyour new project page atitle.
Keep the title brief and descriptive.

5. Choose who can see this page.

g Note: Your choice will apply to all subpages that you create under this page.

« To show this page to anyone with the necessary permissions, select Visible. For example, if you have defined a
group of users who have access to your project, your new project page isvisible only to those users. If your
project is open to the public, anyone in the world can seeit. Use this option when the information on this page
isready for awide audience.

« To show this page only to users with the project administrator role, select Hidden. Use this option if you are
drafting content that you aren't ready to share yet, or want to share only with other project managers.

6. Select the Freeform check box to create afree-form page.

Note: A free-form page'stitleisnot visible in the navigation tree at l€ft.

[
g Tip: You can not create free-form sub-pages when the top-level pageis ‘Hidden'.
7. Click Save.

8. Click Configure: Off .

Now you are ready to build functionality into your project page with components such as text, news or tracker queries.
Create a project page component
Put information and resources in your users hands with project page components.

For example, to let people know about important new devel opments, create a news component. To enable project
members to find tracker items quickly, create a query component.

1. Onthe project page, click Configure: On.
2. Click Add new component.
3. Give your new component atitle.

Keep the title brief and descriptive.

4. Select the type of component you need.

Documents L et project members exchange and review documents from the project page.

Project Metrics Show charts optimized for measuring progress on an agile project.

Project News Maintain ajournal or blog about your project, share information, make
announcements.

Project Statistics Put visual measures of your project activities on the page.

Text Use this all-purpose component to write free-form messages, reports or rants,
inplain text or HTML.

Tracker Search Results Make saved search results available from the project page.

Wiki Page Open up your project page to two-way communication.

5. Choose who can see this component.

« To show this component to anyone with the necessary permissions, select Visible.
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For example, if you have defined a group of users who have accessto trackersin your project, aquery component
will be visible only to those users. If your project's trackers are open to anyone, all users who view this project
page will see the query component. Use this option when you are sure the component is ready for general use.

« To keep this component under wraps until you are ready to show it, select Hidden.

Now only users with the project administrator role can see this component. Use this option if you are drafting
content that you aren't ready to share yet, or want to share only with other project managers.

6. Specify the location of this component on the project page.
7. Click Configure: Off.

Reorder project page components
To make things easy for your project members, lay out your page componentsin a useful order.

1. Onthe project page, click Configure: On.
2. Inthetitle bar of the project page component you want to move, click the up arrow or the down arrow.
3. Click Configure: Off.
Hide a project page component
While you are preparing a project page component, you may wish to keep it from being seen.

You can hide a page component from everyone except other project administrators.

On the project page, click Configure: On.

In thetitle bar of the project page component you want to hide, click the edit button.
Select the Hidden option for Visibility, and click Save.

Click Configure: Off.
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Now no one who does not have the Project Admin role can see the component, even if they have access to the project
and to this page. Users with the Project Admin role can see this component only when Configureis set to On.
Rename a project page component

As a page component's focus evolves, it's agood idea to rename it to match its changing function.

On the project page, click Configure: On.

In thetitle bar of the project page component you want to rename, click the edit button.
Update the Titleas appropriate to its current function, and click Save.

Click Configure: Off.

A w DN

Edit a project page component
You may want to make some changes to your project page component to make it more useful.

On the project page, click Configure: On.

In thetitle bar of the project page component you want to edit, click the edit button.
Update the Titleas appropriate to its current function, if required

Select the Hidden option for Visibility to hide the page while you work on it.

You can hide a page component from everyone except other project administrators.

A w DN PR

5. Change the following settings depending upon the project page component that you are editing:

« For a Sub-projects component, you can change the number of projects to be displayed.
« For aDocuments component, you can change the folder location.

6. Click Configure: Off.

The project page component is displayed with modified content and/or settings.
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Delete a project page component
When a component is no longer useful, remove it from the page to avoid distracting users.

1. Onthe project page, click Configure: On.
2. Inthetitle bar of the project page component you want to delete, click the X button.
3. Click Configure: Off.

Control access to a project page
Before you put information or functionality on your project page, make sure it is accessible to the people it isintended for.

Note: Thisisonly relevant if your pageisnot hidden. If your pageishidden, userswho are not project administrators
cannot see the page even if their role-based permissions would allow it.

1. Click Project Admin in the project navigation bar.
2. Onthe Project Settings page, click Permissions.
3. Click theroleto which you want to give access to your project page.

L Tip: If the appropriate role does not exist, you must create it first.

4. Onthe Edit Role page, click Project Pages.
5. Under Project Pages Per missions, select the pages that users with this role can see and edit.
» Toenable users with thisrole to create, read and modify all project pages, select the Project Pages Admin
permission.
» Toalow userswith thisrole to see pages but not edit them, select the appropriate page in the View section.

« Toalow userswith this role to modify the contents of atext component project pages, select the appropriate
pages in the Edit Text Content section.

g~ Note: The project home pageis always visible to any user who is authorized to see the project.

Reorder project pages
Facilitate your users’ experience in your project by putting your project pages in an order that matches their needs.

1. Click Configure: On.
2. Select aproject page and click Edit Structure.
3. Rearrange the structure of this page in any of these ways:

« Sdect apage, and use Cut and Paste to place it in adifferent location.

g Note: When you move a page, all of its sub-pages will also be moved.

« Drag and drop a page to a different position.
e Click Add New Page to add a sub-page to the current page.
» Select one or more pages and click Delete to remove them.

4. Click Save Changes.
5. Click Configure: Off.

Hide a project page

While you are preparing a project page, you may wish to keep it from being seen.
You can hide a page from everyone except other project administrators.
1. Click Configure: On.

2. Click Edit Page Properties.
3. For Visibility, select Hidden and click Save.
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Now no one who does not have the Project Admin role can see the page, even if they have access to the project and to
this page's parent page.
When you are finished building your page, don't forget to switch the pageto "Visible" so that the intended users can see
it.
Rename a project page

Asapage's focus evolves, it's agood idea to rename it to match its changing function.

1. Click Configure: On.

2. Click Edit Page Properties.

3. Changethe Title as appropriate to its current function, and click Save.
4. Click Configure: Off.

Hand-code your project web site
To fully custom control your project web site pages, build your own HTML and check it into the project's Publishing repository.

You can link to these pages as you would to any normal HTML page.
Create a custom project home page
If you decide to hand-code your project home page, the page works like any HTML page.

1. Click Project Admin in the project navigation bar.
2. From the Project Home Options, select Show custom web page.
(Show default project pages and components is selected by default.)

3. Addthei ndex. ht i filetothe publ i shi ng/ www Subversion repository.
The content of your i ndex. ht m shows up immediately.

g Note: When you switch to a hand-coded home page, you can still access any project pages you have created.

4. Click Save.
Your custom Project Home page is now active.

Note: If your project has any subprojects, the subprojects are also listed. To see them, make sure your

i
i ndex. ht m fileexistsand isin the right repository location.

See what's in your publishing repository
You can view thefilesin your TeamForge site'spubl i shi ng repository in viarelative URLSs.

1. Enterthe URL: https://forge. coll ab. net/sf/projects/sanpl eproject/index.htnm inthe
address bar to display contents of thei ndex. ht m file.

Inthiscase, your i ndex. ht m filemust beinthe publ i shi ng repository under the ww/ sanpl epr oj ect
path.
The contents of thei ndex. ht m fileare displayed in the Project Home page.

2. Enter the URL:
https://forge.coll ab. net/sf/projects/sanpl eproject/roles/rol edetails. htm inthe
address bar to display contents of ther ol edet ai | s. ht i file.
Inthiscase, your r ol edet ai | s. ht m filemust bein the publ i shi ng repository under the
www sanpl epr oj ect/ rol es path.

The contents of ther ol edet ai | s. ht ml file are displayed in the Project Home page.
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Set up trackers

A tracker isacollection of related artifacts that describe work to be done or issues to be resolved. Every project should have
one or more trackers.

When you start atracker, you decide which fields will be used, who will use them, and how they will use them.

Create a tracker
Create a tracker whenever you need to report and track bugs, feature requests, support requests, or any other type of issue
where ownership, status, and activity must be managed.

Individual tracker entries are referred to as tracker artifacts. A tracker is a set of tracker items with a common purpose,
such as bug reports, feature requests, or tasks.

A w DN PR

Click Project Admin in the project navigation bar.

Click Tracker Settings.

Click Create.

On the Create Tracker page, provide a name and description for the tracker.

Tip: Descriptions help userslearn how best to provide the information you want from them. To maximize your
chances of getting useful data, make your description as informative as you can.

Select an icon that suggests the type of work the tracker is handling.

Thisicon will appear with any artifact in this tracker, wherever it is viewed on the site. For example, if someone
brings an artifact from thistracker into a planning folder, users of the planning folder can glance at the artifact'sicon
to see where it comes from.

Click Create.

The new tracker appears at the bottom of your list of trackers.

If necessary, drag the tracker to aplacein your tracker list that makes sense.
The order you set here controls the order of every tracker list in your project.

You'll probably need some custom fields to capture information that's specific to your project.

See Create your own tracker fields on page 26.

To speed up the team's work, you may want to set up some rules for automatically reassigning artifacts when their
contents change.

See Create a tracker workflow on page 27.

Create your own tracker fields
To track datathat is not captured by the default set of fields, create new fields that fit your project's purposes.

You can create:

[

Up to 30 date fields.
An unlimited number of user fields.

s Caution: Creating alarge number of multiple select and user fields may affect CollabNet TeamForge performance.

.

Create a text field
To let userstypein data, create atext entry field.

A tracker can have up to 30 text fields.

1
2.

Click Project Admin in the project navigation bar.
Click Tracker Settings.

3. Click the tracker to which you want to add atext field.
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Onthe Tracker Layout tab, click Add Field.
On the Create Field page, provide aname for the field.
Configure the shape of the field with the Field Width and Field Height fields.

To help users enter the right text values, select Use Text Validation and supply aregular expression that describes
the appropriate values.

This can help reduce errors and keep your team's data as meaningful asit can be. For more detailed instructions, see
Validate text entriesin a tracker artifact on page 101

8. Click Save Field.
The new field is created.

N o g s

Create a "Select" field
To let users choose values from alist that you define, create a " Select” field.

You can create up to 30 single-select fields and an unlimited number of multiple-select fields in atracker.

g Note: Creating alarge number of multiple select and user fields may affect CollabNet TeamForge performance.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of existing trackers, click the tracker to which you want to add a" Select” field.

On the Tracker Layout tab, click Add Field.

On the Create Field page, provide aname for the field.

Use the I nput Type menu to specify whether users will be able to select one value or more than one.

If you're going to make this arequired field, pick one of the values to be the default value. Thisvalueis applied to
existing artifacts and artifacts that are moved from another tracker.

S O o

7. Decide whether users must choose a value.
» Required fields automatically appear on the Submit Artifact page.
g Note: If you make the field required, you must specify a default value.

* If youmake aUser field required, specify one or more default users.
» If you make a Date field required, the default is "today."

« For optional fields, select Display on Submit if you want the field to appear when a user first creates an artifact.
« To prevent the field from being used at all, select Disabled. (By default, new fields are enabled.)

8. Usethe Values section of the Create Field page to add more values for the user to choose from.
9. Keep adding values until you have the list of options you want, then click Save Field.

Create a people-picker field
To let users choose other users from alist, create a'people picker" field.

The Assigned to field is a people-picker field that is present in every tracker. An artifact can be assigned to only one
user at atime. You can give yourself more flexibility by adding any number of custom people-picker fields.

For example, your QA team may want to assign aperson to track progress on an artifact whileit is assigned to adevel oper.
You might create a people-picker field called "QA monitor" to specify who that person should be.

In people-picker fields you create, users can select multiple users.

g~ Note: Creating a huge number of user fields can dow down the site's performance.

=

Click Project Admin in the project navigation bar.
Click Tracker Settings.
From the list of existing trackers, click the tracker to which you want to add a people picker field.

w N



96 | OpenTopic | How to use TeamForge 6.1

N o g s

© ©

Onthe Tracker Layout tab, click Add Field.
On the Create Field page, provide aname for the field.
On the Input Type menu, select Select User(s).

In the Default Filter field, choose whether the list of people available in your new field will include members of
this project or everyone who is registered on the site.

Configure the shape of the field with the Field Width and Field Height fields.

Click Save Field.
The new field is created.

Organize tracker fields
Most tracker artifacts ask the user for alot of information. You can arrange the input fields in columns and rows to make it
easier for usersto find the fields they need.

1.
2.
3.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From thelist of current trackers, click the tracker whose fields you want to organize.
Click the Tracker Fieldstab if it isn't already showing.

If some fields seem to be logically connected to each other, create a section to bring them together.
a) Click Add Separator and select Section.
Give the section a short but descriptive label.
b) Inthelist of fields, drag your new "Section Separator” row to a position that makes sense.
¢) Drag the appropriate fields under the Section Separator that you just created.
Within a section, arrange fields logically into columns.
a) Click Add Separator and select Column.
Give the column a short but descriptive label.
b) Inthelist of fields, drag your new "Column Separator” to a position that makes sense.

¢) Drag the appropriate fields under the Column Separator that you just created.
d) Create as many columns as you need.

Drag a column separator above another column separator to move it to the left in the artifact entry form. Drag it
below to move it to the right.

Within a column, group fields into rows if appropriate.

a) Click Add Separator and select Row.
Give the row a short but descriptive label.

b) Inthelist of fields, drag your new "Row Separator" to a position that makes sense, then drag the appropriate
fields under the Row Separator.

g~ Note: Youcan have rows and columns without sections.

Enable or disable fields
If atracker field is disabled, it does not appear on the Create Artifact page. Most fields can be disabled.

Disabled fields are accessible only to tracker administrators on the Tracker Layout tab.

You can enable or disable any field that is user-defined or configurable. However, you can't disable all configurable
fields. For example, the Effort and Story Pointsfields can't be disabled.

Note: If your god isto prevent users from entering datainto a field when submitting an artifact, but till display
thefield on the Edit Artifact and Tracker Search pages, don't disable the field. Instead, clear the Display on
Submit option on the Edit Field page.
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Click Project Admin in the project navigation bar.

Click Tracker Settings.

From thelist of current trackers, click the tracker you want to configure.
Onthe Tracker Layout tab, select the fields you want to enable or disable.
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e Click Disable to remove them from the Submit Artifact page.
* Click Enableto allow them to be configured and displayed.

g~ Note: Datain disabled fieldsis still searchable, but disabled fields do not appear asinputs on the Sear ch pages.

Require users to complete a tracker artifact field
If afield is set asrequired, users cannot submit artifacts without completing it. Most tracker fields can be required or optional.

Each tracker can have its own required and optional fields. Required fields are marked with ared asterisk * on the
Submit Artifact page.

Note: When you make afield required, any field whose values depend on that field's valuesis also required. See
Help users select optionsin a tracker artifact on page 100 for more about dependent field values.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From thelist of current trackers, click the one you want to configure.

On the Tracker Layout tab, click the name of the field you want to set as required or optional.
By default, only the Title, Description, Artifact 1D, and Status fields are set as required.
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5. Onthe Edit Field page, select or clear the Required option to make afield required or optional.
Required fields automatically show up on the Submit Artifact page.

g Note: System-defined fields and the Statusfield are always required.

6. For optional fields, select or clear the Display On Submit option.
This specifies whether the field will appear on the Submit Artifact page.

7. Click Save Field.

Configure tracker "Select" field values
To help users provide meaningful information, supply them with useful field values to choose from in the input fields in the
tracker entry form.

Tip: When you create a user-defined single-select or multiple-select field in atracker, you add predefined values
to the field. You can change these values at any time.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of existing trackers, click the name of the tracker that you want to configure.

On the Tracker Layout tab, click the name of the field whose values you want to edit.

On the Edit Field page, set up the field values you want you want users to see when they create a tracker artifact.

a s~ w DR

« Todefineanew value, click Add.

« Torename avalue, edit the existing text. If you rename avalue, the value is renamed in all existing artifacts.

« Toremove avalue, check the box and click Delete. If you delete avalue, the value is changed to Nonein all
existing artifacts.
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» Select Default Valueto set which option will be chosen if the user makes no selection. When you move atracker
artifact from one tracker to another, the default field value is the value that comes along.

Note: When you edit the values of the Statusfield, you are also asked to describe what each value's status
means, as shown in the Values section of the Edit Field page. This status meaning isused in Advanced Sear ch
to define which values are returned when searching for open or closed artifacts.

6. Click Move Up or Move Down to order the list the way you want it.
7. Click Save Field.

All values are now available in the selection menu for the field.

Assign a tracker artifact automatically
You can configure the tracker to automatically assign newly submitted artifacts to specific project members.

You can assign artifacts to individuals based on the values in the Category or Release field.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of existing trackers, click the tracker you want to configure.

On the Auto Assignment tab, select Auto Assign By Category or Auto Assign By Release.

For each category or release value, choose a project member from the Automatically Assign To drop-down menu.

This menu contains all project members with the tracker edit permission. Click the people icon to display alist of
project members to whom you can auto-assign artifacts. Choose None if you do not want artifacts with a specific
val ue automatically assigned.

6. Click Save.
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Whenever anew artifact is submitted with avalue in the relevant field, the assignee receives an email notification and
the artifact appears on his or her My page.

Create a tracker workflow
To channel project members' work on tracker items, set up rules for how atracker item can move forward.

Before creating a tracker workflow, see that these criteria are met:

* You have atracker to work with.
» Thetracker has a set of statuses defined, such as"In progress’ and "Ready for QA."
* Rolesexist, and you can assign project members to them.

A workflow is a sequence of changes from one status to another. You can define status transitions for any combination
of tracker statusesin the tracker.

Click Project Admin in the project navigation bar.
Click Tracker Settings.
From the list of existing trackers, select atracker.

Click the Wor kflow tab.
The Wor kflow page lists all of your status values and the tracker workflow that you have configured.

On the Workflow page, click the status value for which you want to create a workflow.

6. Onthe Edit Field Transition Status page, select a status value from the Create Transition to Status drop-down
menu.

pw DN pE

o

Note: By default, the Any workflow isshown. Thismeansthat you are defining workflow rulesfor thetransition

[ i
from the status that you selected to any other status.

7. Click Add.
A new workflow is added. The Any workflow is changed to Remaining Statuses.
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8. Inthe Rolesto Makethis Transition section, specify which users can make this change.
For example, only userswith the QA Engineer role are allowed to change artifacts from Open to Cannot Reproduce.

9. Inthe Required Field(s) for Status Transition section, select the fields for which the user must provide values.
For example, the user must assign the tracker item to someone and enter a comment.

' Note:
» Fieldsthat are already required do not appear in thislist.
» Fields whose values depend on arequired parent field are automatically required. (See Help users select
optionsin a tracker artifact on page 100 for more on parent and child fields.)
10. Click Save.

The workflow is now saved. When a user submits or edits the status of atracker artifact, he or she sees only the options
that are allowed by the workflow.

Set default tracker columns
Choose what information is visible by default to users of your project when they open atracker or planning folder.

Users can also set their own personal default column configurations, which override the project defaults.

1. Click Tracker inthe project navigation bar.
2. Select atracker or planning folder and click Columns > Configure.

< |f you've aready saved a column configuration, click it and skip the rest of these steps.
« To go back to the default column configuration, click System (default) and skip the rest of these steps.
» To set up anew configuration, click Configure.

3. Choose your columns.
a) Move the columns you want from Available Columnsto Selected Columns.
Artifact ID : Title, Priority and Status are required columns.

g~ Note: Selecting more columns can increase the time required to load the listing page.
b) Remove any columns you don't need from Selected Columns.
¢) Usethe Move Up and M ove Down buttons to change the display order of the columns.

4. Apply your choicesto your view of the tracker.

» Tousethisarrangement thistime only, click Apply. The next time you log in, you'll start with the default view
again.

» To save your column layout for repeated use, click Apply and Save, then give your arrangement a name. The
next time you log in, you'll see the column arrangement you just selected. (If you've sorted the records in your
view, that sort order is saved too.)

Tip: If you are editing a column configuration that already exists, you can rename it by saving it under a
new name.

[ N

5. To make the same set of columns appear every time you come to this tracker or planning folder, select M ake this
my default view.

6. To make the same set of columns appear for every user the first time they see any tracker or planning folder in the
project, select M ake thisthe default view for all project members.

The project default configuration you set is now the default configuration for all project members, unless they have
created their own personal default column configuration.
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Change a tracker
A tracker's real-world uses often outgrow the name or description you gave it when you created it. When that happens, it's a
good idea to update the tracker to reflect its changing role.

a s wDdh e

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of existing trackers, click the tracker you want to edit, and click Edit.

On the Edit Tracker page, provide a new name or description for the tracker and click Save.
If necessary, drag the tracker to aplacein your tracker list that makes sense.

The order you set here controls the order of every tracker list in your project.

Help users select options in a tracker artifact

|Navigation title:Help users select options |

You can help users cope with complex information by guiding them to eligible values in single-select fields.

Any tracker that manages real-world information will quickly become very complex. Users can be confused by a
proliferation of "Select" fields. Confusion can lead to inconsistent data, which makes your job harder.

You can help relieve the complexity by showing users their eligible optionsin a given field based on values they have
aready selected in another field. You can create overlapping sequences of dependent fields, with as many levels as you
need.

This simplifies things for the user, but for the tracker administrator it can quickly get complicated. So let's ook at an
example.

1
2.

Click Project Admin in the project navigation bar.
Click Tracker Settings and create atracker.
For this example, let's call it the Lunch Planning tracker.

Create asingle-select field and call it Lunch type.

(For this example, we'll ignore the built-in fields, such as Status and Assigned to. We're just working with fields
that you create.)

Create some values for the Lunch typefield. Let's call them Buffet, Picnic, and Banquet.

Each type of lunch will make sense in some kinds of locations and not others. For example, you would not normally
plan a banquet lunch in a park. We are now going to make it easy for users to avoid making such a mistake.

Create asingle-select field called L ocation type, with Lunch type as the parent field, and give it some plausible
values.

a) Start by adding an option called Beach. In the Parent Values column, choose Picnic, because that's the kind of
lunch you would have at the beach.

(The Parent Values column lists all the valuesin the parent field you selected.)

b) AddaRestaurant. Inthe Parent Values column, hold down the Ctrl key and choose Banquet and Buffet, because
either of those could be held at a restaurant.

Create asingle-select field called L ocation, with Location type asthe parent field, and give it some valuesto choose
from.

a) Start with an option called Happy Food Restaurant. In the Parent Values column, select Restaurant, because
that's the type of location that Happy Food Restaurant is.

b) Add another option, Hanalei Cove. Under Parent Values, select Beach.

Save your work and go to the tracker whose settings you have been editing.
Try selecting from the interdependent values you have just created.
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Observe that the value you choose in the L unch Typefield controls which values are available to you in the L ocation
Typefield, and that selecting avalue in L ocation type in turn controls the values that appear in the L ocation field.

*  When auser selects Banquet for alunch type, they can select Restaurant but not Beach in the L ocation type field.
You will have less error correction to do, and users will avoid confusion.

«  When auser selects Picnic for their lunch type, the L ocation Type field offers only Park and Beach. Now you will
not have to go through and clean up after users who mistakenly choose to plan a picnic at Happy Food Restaurant,
and the doorman at Happy Food Restaurant will not have to turn away users who mistakenly show up with picnic
baskets.

Important: If you are used to defining your own Tracker fields, the ability to make field values depend on other
values may change how your trackers work in ways you didn't anticipate. Keep these pointsin mind:

e Linking fieldsin thisway doesn't modify existing data, but when users later modify fields that are linked, they
will have to adhere to the relationships you set here.

« |If afield hasa parent, and that parent field also has a parent, the top-most parent field must have at least one
value.

» When afield has a parent field that is required, the child field's default value is set to None. If that required
parent field is deselected, the child field no longer has to be required, but Required remains the default.

» If you require a specific field value before an artifact can be placed in a given status, that field's children are
subject to the same requirements. See Create a tracker workflow on page 27 for more about controlling what
status an artifact can bein.

« |f you delete afield that contains values that another field's values depend on, the dependent field becomes a
standard single-select field on its own.

* When you cut and paste an artifact from one tracker to another, only those field values that also exist in the new
tracker come along with the artifact. If those values aren't valid under the dependency rules of the new tracker,
they are still brought along.

Validate text entries in a tracker artifact
INavigation title:Validate text entries |
You can help users contribute useful information by testing their text entries against rules you configure.

Text fields can be error-prone because they invite free-form input. You can help users provide usable information by
automatically rejecting values that don't match the needs of the tracker.

This simplifies things for the user, but for the tracker administrator it can be complicated. So let'slook at an example.

Note: If your goa isto require usersto enter some value, whatever the valueis, don't use text field validation.
Select the Required option instead.

[ 1

1. Click Project Admin in the project navigation bar.
2. Click Tracker Settings and create atracker.
For this example, let's call it the Bugs tracker. It will be used to record entomological specimensin a collection.
3. Createatext field and call it Legs.
Thisisfor usersto record the number of legs each specimen displays.
4. Select Use Text Validation and supply avalidation rule that requires the user to enter a number.
For example, if agiven insect has six legs, you'll want the user to enter the numeral 6, and not a string such as "six"
or "several."

Try thisregular expression:
\d{1, 3}

This rule requires the user to enter a number with one, two or three digits. Now, a user who meansto record a
centipede with 100 legs but enters 1000 by mistake will not be able to save the artifact until the error is corrected.

5. Enter asample string to test your regular expression.
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Any part of the sample string that matches your regular expression appears under M atch Results. If nothing appears,
rework your regular expression until you get a match.

Create another text field and call it L ocation.

Thisiswhere users will record the geographical spot where they collected the bug.

Select Use Text Validation and supply avalidation rule that requires the user to enter a pair of geographical
coordinates.

For example, if a given insect was found outside CollabNet's California headquarters, you'll want the user to enter
astring like37. 674689, - 122. 384652, and not something like "Brisbane" or "Out on the lawn."

Try this regular expression:
[-1?[0-9]1*[.]1{0,1}[0-9]{0, 4}

This rule requires the user to enter two numbers, separated by acomma, in the general format of a pair of mapping
coordinates.

g~ Note: Thisparticular regular expression does not guarantee that the coordinates are valid, just that they look
like coordinates.

Save your work. In the tracker whose settings you have been editing, try entering anumber greater than 999 in L egs,
or astreet addressin L ocation

Thered X next to the field indicates that the text entry isincorrect. A green check indicates that the value meets the
requirements.

Notice that any field in which you are validating text entriesisidentified by Text Entry (with Field Validation) when
listed on the Tracker Layout tab.

Organize your project with planning folders
Create and populate all the planning folders you need to capture the work you are planning.

A planning folder is away to organize work into feasible chunks and monitor its progress. When you've thought about
the general categories the work fallsinto, you can to set up planning folders that reflect those idess.

A planning folder can represent:

A set of tasks, such as Iteration 3, or "Initial infrastructure devel opment.”
A period of time, such as"April," or "Q2-2010."

A phase of development, such as"Testing" or "Deployment.”

A component of the product, such as "Chapter 12" or "Rear stabilizer.”

Tip: It often makes sense to set up planning folders after you have outlined and analyzed the features you plan to
deliver. See Define the scope of your project on page 106.

Create a planning folder
When you've thought through your plan, expressit in one or more planning folders.

1
2.
3.

Click Tracker in the project navigation bar.

Under Planning Folders, click the folder in which you want to create a new planning folder, then click New.

Give your planning folder a brief and descriptive name.

For example:

* Inanagileproject, you'll probably want two or moreiterations. Make a planning folder called " Sprint 1," another
called "Sprint 2," and so on.

« Inaphased, waterfall-style project, you might name your first planning folder "Design,” the next "Build," and
SO on.
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Tip: Don't worry if you don't have anything of interest to put into your planning foldersyet. The parallel process
of filling out the feature tree will provide plenty of material for this.

[ 1

Use the Description to briefly signal the kind of work that will be contained in this planning folder.

Include enough information to help people get up to speed quickly whey they join your project. But save most of
the detail for the individual tracker artifacts, where project members will spend most of their time.

For Status, (available since TeamForge 5.4), select avalue that communicates where the planning folder isin its
lifecycle.

For anew planning folder, you'll probably want to select Not started.

g~ T1p: You can create more values to choose from in your Project Settings.

If you have set up afilerelease in the File Releases tool to deliver the work you are tracking here, you can identify
itinthe File Release field (available since TeamForge 5.4).

Any artifact you add to this planning folder will also appear in the Planned Tracker Artifacts tab when you look at
that file release.

For Capacity, (available since TeamForge 5.4), provide a number that expresses how much work your team thinks
it can do in the period represented by this planning folder.

Tip: When you create a new planning folder, it can be agood ideato set its capacity to zero until you get a
feel for the artifacts and resources you are working with.

Select astart and end date for the work that this planning folder will contain.

You can change these dates at any time. However, it'simportant to specify dates even if they're not firm, because
useful visual aids and reports depend on them.

Update a planning folder
A planning folder is adynamic representation of a changing situation. From time to time, you'll want to update its name,
description and other parameters to reflect changes in the underlying work.

1.
2.
3.

Click Tracker in the project navigation bar.
In the planning folder tree, click the planning folder you want to update.
Use the Edit menu to make your changes.

Edit Planning Folder

Flanning Folder Mame-* |Sonnt 4

Dezcription This sprink adds several key features.
Status In progress =]
Capacily 132
tart Date: OEUE010 T (MMl yyy)
End Date: EEA010 T (MMl yyy)
Cancel || Sawe |

a) Givethe planning folder a new name and, if needed, a new description, and click Save.
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b) For Status, select avalue that communicates where the planning folder isinitslife cycle.

g Tip: Foranew planning folder, you'll probably want to create a status like Not started. You can create more
values to choose from in your Project Settings.

¢) For Capacity, provide anumber that expresses how much work your team thinksit can do in the period represented

by this planning folder.
d) Revisethe start or end date of the planning folder to match any changesin your project's real schedule.

Manage statuses for a planning folder

To help team members understand how to work with a planning folder, create statuses for it that correspond to the planning

folder'slife cycle.

When you have created a planning folder status, you can apply it to any planning folder in your project.

For example, at a given moment you might have one planning folder in "Under development" status, while another is
in "Finished" status and another isin "Preliminary scoping” status.

e Tip: You may also want to move the planning folder to arelative position in the planning folder list that

communicates where it stands in the order of work.
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Click Project Admin in the project navigation bar.
Click Planning Folder Settings.

Under Statuses, click Add.
Configure your new planning folder status.

Froject Admin = Planning Folder Settings

Project Admin Menu

Project Settings
User Memb=rehip
Permissions
Projed: Teolbar
Tracker S=ttings

Manning Folder Settings

Tatk Manager Settings
Wikl SeTnings
Build & Test Integratian

Statuses

mﬁt"lﬂ'ﬁ? values with caution. Renaming a walue causes all planneng folders with the cument value to be

Values

None

[Wt started

In progress
Closed
SOOPINg
[Retrospective

Deferrad

Betive/Inactive

Active |
Acdive |
Inactive |

Aictive ;I

i

[Eetive ﬂ

a) Give the status an unambiguous name that others will find easy to understand.

b) Specify whether the status counts as active or inactive.
Project members may want to exclude inactive planning folders from their view, to avoid overload.

Py
L

Default Value Mowve Up

Mowve Daw
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¢) Select which valueisthe default value for new planning folders and planning folders that originated in earlier
TeamForge versions.
d) Arrange your planning folder statusesin the order that makes sense for you.

Reorder planning folders
When the sequence of work in your project changes, it's a good ideato reorder the planning folders so that they accurately
reflect the real order of work.

For example, it's not unusual for product owners, who must constantly weigh the changing business value of features,
to ask for one set of user stories to be put aside so that another set can be delivered first. When this happens, a project
manager may want to move the corresponding planning folders so that their relative positions visually confirm their

relationship.
g~ Tip: Youmay also want to set the planning folder's status to a value that communicates the change in the order
~ of work.

By default, planning folders are ordered according to when they were created. New planning folders are added to the
end of the folder tree.

Click Tracker in the project navigation bar.

In the folder tree, click the folder containing the subfolders that you want to reorder.
Choose Reorder Subfoldersfrom the Edit menu.

Organize the subfolders:
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» To sort them alphabetically, click Alphabetize.
« Toreorder aspecific folder, select it by clicking the title, then click M ove Up or Move Down until the folder is
where you want it.

Reorder the contents of a planning folder
You can move artifactsin a planning folder up and down to reflect the order in which they should be addressed.

A set of user stories often includes dependency relationshipsthat require that one user story be addressed before another.
For exampl e, suppose abackend database modification must bein place before auser interface component can be created
to access it. Both user stories may have the same degree of priority, but one has to be done before the other.

One way to manage thisis by ranking the user storiesin your planning view so that they reflect the sequence you want.
When you do this, team members have a better chance of selecting work efficiently and reducing the need for rework.

Note: Rank is not the same as priority. Two artifacts may have the same priority but different ranks, or sequence

Lo -
positions.

1. If you are not an administrator on this project, ask your project administrator or site administrator to assign you
sequencing permission.

2. Click Tracker in the project navigation bar.

In the folder tree, open the planning folder containing the artifacts that you want to reorder.

4. Click Rank.
You can now drag and drop the artifacts in your planning folder into whatever relative positions you want.

w

To go back to the sort order you had before (for example, sorted by priority), click Sort.

Move a planning folder
A planning folder's position may reflect scheduling changes in relation to the work contained in other planning folders.

For example, when plans change and the work represented in alater planning folder moves ahead of an earlier planning
folder, move the folders around in the hierarchy to reflect the new relationship.
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When you move a document folder, any documents and subfolders that it contains are also moved to the destination
folder. Before promoting a planning folder to a higher level in your hierarchy of folders, make sureits member artifacts
(and itsmembers parent artifacts, if any) are all assigned to the same planning folder, or to aplanning folder that belongs
to the same folder hierarchy.
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Click Tracker inthe project navigation bar.

In the planning folder tree, find the folder that you want to move. Click the title to select it.

Choose Cut from the Edit menu.

In the folder tree, find the folder into which you want to move the selected folder. Click thetitle of the folder to
select it.

Note: You can move afolder into the root folder or into any other folder, as long as no member artifact ends
up having a parent belonging to a higher-level folder in the same tree.

Choose Paste option from the Edit menu.
The folder is moved to the destination folder.

Manage a product with CollabNet TeamForge

|Navigation title:Manage a product |

A product owner can use TeamForge to help define the scope of a product and contribute to its planning and implementation.

Define the scope of your project
Defining scopeisan iterative, interactive process. Asyou go throughiit, you'll find elements of your scope expanding, shrinking
or changing shape in response to feedback from analyzing and planning out the work.

[ N

Note: It'sagood ideato get the feature definition process under way before setting up planning folders (see Create
a planning folder on page 102), because defining features gives you the raw material for your planning process.

Before you get started, you'll do some kind of user research, even if it'sonly afew phone calls, to get anidea of the
needs of the customers you hope to satisfy. Express these needs and desires as stories about what a user can do with
your product. Then create an artifact for each user story you identify.

A user story describesthe situation after your product has been launched: What can the user do now that they couldn't
do before?

Tip: For best results, your user story artifact should by limited to a clear description of the capability you want
in the product. Remember that a user story is not an implementation plan. Details about the implementation
will be recorded in the user story artifact, but when you write a user story, try to leave the implementation up
to the developer who will be responsible for it.

[ N

You may want to define one or more fictional users who resemble the real-life users of your product. This can help
simplify and focus your thinking.

Use the Priority field to express your opinion of how important the story isto the user. In general, the most eagerly
desired capabilities will be addressed first. (During implementation planning, your Priority setting will be used as
one input in summing up the effort involved in each priority level.)

Make it as clear as you can at the outset what degree of functionality is acceptable. For example, if your teamis
creating an airplane, how high must it be able to fly? How far must it go before refueling? How many passengers
must it carry? Stating your acceptance criteria concretely hel ps reduce the time needed for ongoing reviews and
changes.

Note: Thisisjust abasic outline of what's involved in defining the scope of a product. If you're new to agile
practices, you may enjoy Michael James video collection.


http://blogs.danube.com/scrum-video-series
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Monitor project output
Regularly test and measure the features your team produces, involving real users as much as possible.

Accurately representing the needs and responses of real-life usersis a key part of the product owner'srole.

1

Schedule acceptance meetings throughout the iteration, either at regular intervals or whenever a given user story is
completed.

Use the latest working build of the product, and exercise the functionality live.

Test that the functionality implemented matches what is specified in the user story.
Also review the user interface and user documentation associated with the user story, if any.

Enter any issuesin the artifact's Commentsfield.
Update the user story artifact to reflect the outcome.

« If auser story is accepted, change the artifact status to "Accepted” or the equivalent.
« |If auser story is not accepted, change the artifact status back to "In Development,” or the equivalent, for further
work. You can review it again in another acceptance meeting.

Note: Sometimes afeature turns out not to meet the user's needs even though it has been implemented as specified.
Thisisnormal. It is not uncommon for the user's needs to change after the user story has been captured, or for the
user research process to miss one or more important details. Just note the discrepancy in the user story and route
the artifact back into the appropriate part of the process.

Manage task workflow
As atask administrator, you can control how users move tasks along under various conditions.

Alert project members about overdue tasks
If atask is not completed by its proposed end date, you may want to send an automatic reminder to the task's owner, its
administrator, or other project members.

You can choose which of the people involved with the overdue task get the alert, and how late the task must be to trigger
an dert.
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Click Project Admin in the project navigation bar.

On the Project Admin menu, click Task Settings.

Click the Alertstab.

On the Alerts page, specify the number of days after atask's due date that an overdue task alert is sent.
Specify the recipients of overdue task alerts.

« Project Role Members- All project members who are assigned that role.

Note: If you select rolesor project membersthat do not have thetask view permission, these project members

[ i
will receive Permission Denied errors when attempting to access overdue tasks.

« Specific Project Members - Click the people icon to select from alist of project members.
e Task Creator - The person who originated the task.

g~ Note: The person to whom the task is assigned receives overdue task alerts automatically.

Click Save.

Overdue task alerts are now enabled for all tasks in the project.
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Require approval for changing tasks
During times when changes to tasks carry a high risk, task administrators can prevent users changes from taking effect until
the administrator approves them.

Requiring change approval keeps you informed about changes to task status, dates, dependencies, and other changes
that can affect the project plan.

You can select the fields for which you want require change approval. Whenever a user makes a change to afield for
which change approval isrequired, the change request is placed in the Change Requests section of the Task Summary
page, with alink in the Items Pending My Approval section of each task administrator's My Page.

g Note: Changes made by task administrators do not require approval.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Task Settings.

Click the Change Approval tab.

On the Change Approval page, select the fields for which you want to require change approval.
Click Save.
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Change approval isnow in force for all future changes made to the selected fields.

Handle a change request
When change approval isin force, changes made by project members to selected task fields must be approved or rejected by
atask administrator.

Change requests are placed in the Change Requests section of the Task Summary page. Change requests are also
displayed in the Items Pending My Approval section of each task administrator's My Page.

1. Click Tasksin the project navigation bar.
2. Onthe Task Summary page, click the Change Requests tab.
3. Respond to a change request in one of these ways:

< |f you do not need to view the request details, select the task and click Approve Selected or Reject Selected.

» Toview the request details or add a comment before responding to the change, click the task name and write
your comments, then click Approve Selected or Reject Selected in the Change Requests section of the Task
Details page.

Note: If you approve atask end date change that impacts dependent successor tasks, you must confirm your

i
changes for each of the successor tasks individually.

You can also approve or reject change requests from the Items Awaiting My Approval section of your My Page. In
the Tasks Awaiting Approval section, click the task name to view the request details, add a comment, and approve or
reject the request.

Indicate task status with colors
The status of each task isrepresented by a color. The status color of atask folder is an accumulation of the status colors of the
tasksin the folder.

When a certain percentage of tasks have turned a given status color, the color "rolls up" to the task folder. The status
colors of the task folders also "roll up" to the project according to the same criteria.

The percentage in each case is chosen by the project admin.

1. Click Project Admin in the project navigation bar.

2. Onthe Project Admin menu, click Task Settings.

3. Onthe Task Status Rollup page, set your color-coding criteria.
For example:
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» A task folder is represented by red when at least 10 percent of its tasks are red.
« A task folder is represented by green when at least 10 percent of its tasks are green.
« A task folder is represented by gray only when at least 80 percent of its tasks are complete.

When one or more criteriaare met simultaneously, the task folder is represented by the most critical of the applicable
status values. For example, using the criteria above, if 10 percent of the tasks in atask folder are yellow and 75
percent of the tasks in the same folder are gray, the task folder is represented by yellow.

Measure task workloads
For help in planning and all ocating resources, look at the project's task workloads.

You can measure the tasks assigned to each project member by status, due date, and estimated and actual effort.

1. Click Tasksin the project navigation bar.
2. Onthe Task Summary page, click the Workload tab.
3. Onthe Workload page, find the following information for each project member:

e The number of assigned tasks, organized by status value.
« Thetota number of incomplete tasks.
» Thetota estimated and actual effort for al tasks.

Set the default task calendar
For each task, you can specify whether work istracked son afive-day or a seven-day calendar.

For each CollabNet TeamForge project, you can specify adefault task calendar. This selection will be the default calendar
for new tasks. You can override this value for individual tasks.

Five-day calendars count only Monday through Friday. Seven-day calendars also count Saturday and Sunday.

g~ Note: Changing the default calendar does not update existing tasks.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Task Settings.

Click the Default Task Calendar tab.

On the Default Task Calendar page, choose afive-day or seven-day calendar as the default for the project.
Click Save.

SEFCENE -

Your default task calendar will be applied to all new tasks.

Report on project activity
Generate areport to get a shapshot of what is going on in a project.

Report on tracker artifacts
Tracker reports give you a summary of the history of tracker artifacts. A tracker report can cover the tracker artifactsin a
selected tracker or across all trackersin a project.

To generate areport, you must first define the report criteriain atemplate. You can then run the report at any time with
asingleclick.

Note: Report results contain only those items that you have permission to view. Other project members with
different permissions might get different results when running the same report.

1. Click Reportsin the project navigation bar.
The List Reports page displays alist of existing report templates.

2. Choose Tracker Report from the drop-down menu, and click New.
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OntheTracker Report Criteria: Step 1 of 2 page, definereport criteriathat are common across all selected trackers.
a) Write aname and description for your report.

b) Select the trackers from which you want tracker artifact data to be reported.

c) Optionally, select date ranges for create date, last edited date, or closed date.

d) Optionally, select one or more Assigned To or Created By project members.

€) Click theiconto display alist of project members with permissions to edit or create tracker artifacts.

f) Click Next.

Onthe Tracker Report Criteria: Step 2 of 2 page, define report criteriathat are specific to each selected tracker.
a) Select valuesfor any or all of the remaining tracker fields.
Click Generate Report.

e TheReport Summary tab shows your results in graphical format.
e TheReport Details tab shows your results in tabular format.

To edit the report criteria, click Edit, make the changes, and click Generate Report.
The report is automatically regenerated with the new criteria. The new criteria are also saved in the report template
for future use.

Repeat the last two steps until you have the report you want.

Report on tasks
Task reports display selected summary data about project tasks. You can generate reports on the tasks in a selected project or
across multiple projects.

To generate areport, you must first define the report criteriain atemplate. You can then run the report at any time with
asingleclick.

S e
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Note: Report results contain only those items that you have permission to view. Other project members with
different permissions might get different results when running the same report.

Click Reportsin the project navigation bar.

. Choose Task Report from the drop-down menu and click New.

o Tip: If the option does not appear, the Task tool may be disabled for this project. Check with your administrator.
On the Task Report Criteria page, write a name and description for your report.

Select the project or projects from which you want task data to be reported.

Optionally, select the status and priority values for the tasks to be included in your report.

Optionally, select one or more Assigned To or Created By project members.

Click theicon to display alist of project members with permissions to edit or create tasks.

Optionally, select a start date or end date.
Select the fields that you want displayed in your report, and click Generate Report.

« The Report Summary tab displays your resultsin graphical format.
* The Report Details tab displays your resultsin tabular format.

To edit the report criteria, click Edit, make the changes, and click Generate Report.
The report is automatically regenerated with the new criteria. The new criteriais also saved in the report template
for future use.

10. Repeat the last two steps until you have the report you want.
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Save a report template
To run reports, you must define the report criteriaand save it in areport template.

1
2.

5.

Click Reportsin the project navigation bar.

From the drop-down menu, choose a type of report template.

e Task Report - Reports on the numbers of tasks assigned to each user.

» Tracker Report - Reports on the numbers of artifacts submitted to selected project trackers.

Click New.
Onthe Task Report Criteria or Tracker Report Criteria page, select your desired report criteria.
Thefields on the Report Criteria page depend on the report type.

Click Generate Report.

The report results appear and the template is saved.

After you have saved your report template, you are ready to run reports.

Run areport
Run areport to get fresh data on the status of your project.

You must save areport template before running a report.

The report data is regenerated each time the report is run.

[ 1

Tip: You can modify the report criteria before generating the report data. For example, you might want to run the
same report each week, using all of the same report criteria except the start and end dates.

Note: Report results contain only those items that you have permission to view. Other project members with
different permissions might get different results when running the same report.

Click Reportsin the project navigation bar.

2. Click thetitle of the desired report template.

* TheReport Summary tab displays your resultsin graphical format.
* TheReport Detailstab displays your resultsin tabular format.

To edit the report criteria, click Edit, make the changes, and click Generate Report.
The report is automatically regenerated with the new criteria. The new criteria are also saved in the report template
for future use.

Repeat the last two steps until you have the report you want.

Export report results
To save your report results, you can export thedatatoa. csv, . xii , or tab-delimited file.

[ 1
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Note: If you created areport that includes trackers with different user-defined fields and click Export on the
Report Summary page, the Export Data window will only show the fields that appear in all trackers. To export
user-defined fields, click the Report Detailstab and click Export for a specific tracker.

Click Reportsin the project navigation bar.

Click the title of the report template.

On the Report page, click Export.

In the Export Data window, select an export format.

« CSV
* Tab-delimited
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« XML

5. Select thefields that you want to export and move them from the Available Columns list to the Selected Columns
list.

6. Click Export.

7. Inthe Export Data confirmation window, click the link provided if you want to save the file again.

Delete a report template
To avoid confusion, it isa good ideato delete report templates that you no longer need.

1. Click Reportsin the project navigation bar.
2. Select the report template that you want to delete, and click Delete.

The report template is del eted.

Control project access
To control who can access your project, consider the purpose of your project and the appropriate type of user.

Control access by user role
Project administrators use existing global project roles or create and assign roles to project members to define what those
project members can do in the project.

If you choose to use existing global project roles, you can quickly assign relevant rolesto your project members. Itisa
good practice to create anew role in your project only when a suitable global project roleis not available.

Note: If your project is asubproject of any other project, your project may have inherited some roles from the
parent project. To work with the properties and permissions associated with inherited roles, you must go to the
parent project where those roles are specified.
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Give roles to a project member
A project member can have any number of roles. As project administrator, you must assign each project member'sroles.

Permissions are cumulative. The project member has all of the access permissions allowed by all of the assigned roles,
plus any permissions that may have been assigned globally using application permissions.

Note: If your project isasubproject of any other project, you may have inherited some roles, project members or
user groups from the parent project. You can assign any role to any project member, regardless of whether it'sa
global project role, or the role belongs directly to the project, or isinherited from a parent project.

[ N

1. Click Project Admin in the project navigation bar.
2. Onthe Project Admin menu, click Permissions, then click the User-Role Matrix tab.
Observe the users listed on the left and all the available roles (global, direct and inherited) on the right.

Note: Users can be assigned global, direct and inherited roles. Inherited users have al the permissions that
they have in the parent project.

[ 1

» |If you assign another inherited role to an inherited user, that user gets both the roles.
« |If youassign aroleto auser in aproject, that user becomes a current member in that project.

3. Select rolesfor each project member.

Note: A user'slicense type also influences what the user can see and do on your site. A user'slicense type
supersedes any role assignments.

[ 1

* AnALM license enables the user who holds it to use the full range of TeamForge features: both the core
source-code management tools and the extended application lifecycle management functionality.

* An SCM license enables the user who holdsit to use the core TeamForge source-code management tools.
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Ask your site administrator how many licenses of each kind are available for your users.

4. Click Save.

Theroles are now assigned to each project member.
Give a role to multiple project members
A role can be assigned to many users at once.

The user-role matrix provides a convenient way to add project membersto arole, but it can become unwieldy if the
project has alarge number of users or roles. When that is the case, try assigning roles to multiple users at one time.

1. Click Project Admin in the project navigation bar.
2. Onthe Project Admin menu, click Permissions.
3. Click the name of the role that you want to assign to project members.
4. Onthe Role Permissions page, click the Assigned Project Memberstab.
The Assigned Project Member s page shows all users who currently have the role.

o Tip: You can assign the role only to the direct project members of the project.
g~ Note: A user'slicense type also influences what the user can see and do on your site. A user's license type
~ supersedes any role assignments.

« AnALM license enables the user who holds it to use the full range of TeamForge features. both the core
source-code management tools and the extended application lifecycle management functionality.
* An SCM license enables the user who holdsit to use the core TeamForge source-code management tools.

Ask your site administrator how many licenses of each kind are available for your users.

5. Click Add and use the Find a User window to move your desired users into the Selected Userslist.

L Tip: You can search by full or partial user name or full name to find the right project members.

6. Click OK.

The project members are now assigned the role.

Handle a role request from a project member
A project member in CollabNet TeamForge can ask to be granted arole. Asthe project administrator, it's up to you to approve
or reject such requests.

When a CollabNet TeamForge project member submits arequest for arolein aproject, the request is placed in the User
M ember ship section of the Project Administration page, pending approval by a project administrator. The request is
also displayed in the Items Pending My Approval section of each project administrator's My Page.

1. Click Project Admin in the project navigation bar.
2. Onthe Project Admin menu, click User M ember ship, then click the Pending Requests tab.
3. Under Role Requests, select the user whose role request you want to approve or reject.

e Click Approve to approve the request and assign the role to the user.
» Click Rgect to deny the request.

' Tip: To view the permissions granted viatherole, click the role name, if required.

g~ Note: Before approving or rejecting arole request, you can check the roles already assigned to the user by
- clicking the user name and selecting the Roles tab.

The user receives an email notification when the request is approved or rejected.
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Assign a global project role on request
Asaproject administrator you can edit a requestable global project role for your project. You can update the settingsto
immediately assign the role to a project member on request.

Note: Only site administrators or restricted site administrators with "Role-Edit" permission can edit global project
role details. Project administrators can only edit requestable global project role's grant settings for their projects.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Permissions.

From the list of global project roles, click the requestable global project role you want to edit.
On the Edit Role page, click Edit.

Select the Grant Automatically on Request option and click Save.
Selecting this option enables the project member requesting the role to be assigned the same immediately, without
waiting for an approval.

SEFCINE

Theroleis modified for your project.
Assign roles to a user group
Enable multiple users to do something all at once by giving their group arole.

A user group can have any number of roles. Each member of the user group has all the access permissions allowed by
all of the assigned roles, plus any permissions that may have been assigned by other methods, such as application
permissions or individually assigned roles.

Roles and the associated permissions can be inherited. If your project isasubproject of any other project, you may have
inherited some roles or user groups. You can assign any inherited role to any user group.

1. Click Project Admin in the project navigation bar.
2. Onthe Project Admin menu, click Permissions, then click the Group-Role M atrix tab.
Observe the user groups listed on the left and all the available roles (global, direct and inherited) on the right.

Note: User groups can be assigned global, direct and inherited roles. The inherited user groups have al the

€
permissions that they have in the parent project.

« |f you assign another inherited role to an inherited group, the members of that group get both the roles.
» If you assign aroleto auser group in aproject, that user group becomes a direct user group in that project.

3. Select theroles you want for each user group and click Save.

Note: When you give agroup accessto a CV S or Wandisco Subversion repository, members of the group can
view the repository but cannot do repository actions, such as commit and update. You must assign those
permissions to usersindividually.

Theroles are now assigned to each user group.
Assign user groups to a role
To manage permissions for alot of groups or roles at once, try assigning user groups to roles.

1. Click Project Admin in the project navigation bar.

2. Onthe Project Admin menu, click Permissions.

3. Todisplay existing global, direct or inherited roles, click the Global project roles, Roles Created For a Project
or Roles Inherited From Parent Project option of View.

Note: If your project isasubproject of another project, you may have inherited some roles or user groups. The
inherited role details like role name, description and the source project name are listed.

You can assign direct user groups to a global/direct/inherited role.
4. Click the name of the role that you want to assign to user groups.
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5. Onthe Role Permissions page, click the Assigned Groups tab.
The Assigned Groups page shows all user groups that are currently assigned the role.

o Tip: You can assign the role only to the direct user groups of the project.

6. Click Add.
7. Type some of the group’s name in the Name (sear ch) box and click Find.
8. IntheFind a user group window, select the user groups that you want to add, and click Finish.
Note: When you give agroup accessto a CV S or Wandisco Subversion repository, members of the group can

view the repository but cannot do repository actions, such as commit and update. You must assign those
permissions to usersindividually.

The user groups are now assigned therole.

Create a role
A role defines the applications that project members with that role can use, and the specific things project memberscan doin
each application.

Any project administrator can create and assign arole.

Tip: Itisagoodideato check the existing global project rolesvia Project Admin > Permissions> Roles > View:
global project roles before creating any new role in a project.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Permissions.

On the Rolestab, click View: Roles Created For a Project.

Click Create.

On the Create Role page, write a name and description for the role.

To let thisrole be automatically added to any private subprojects of this project, clear the Prevent Inheritance
option.

© 0k~ wbdPE

By default, roles are inherited by public and gated subprojects, but not private subprojects.

L Tip: If thisproject isasubproject of any other project, you may already have inherited someroles.

' Note:

7. Toallow project members to be able to request thisrole, select Requestable Role.
Project members can submit requests for requestable roles, which the project administrator can approve or reject.

g~ 11p: Select Grant Automatically on Request to skip the need to approve or reject a request.

8. Click Create.
Theroleis created. The Edit Role page appears.

9. For each application listed on the Role Per missions page, select the permissions and resources you want to make
available to users with thisrole.

Tip: You can specify the permissions for integrated applications here too.

[ i
g Note: Youcan specify access to individual top-level folders, but not to specific subfolders.
10. Click Save.

Theroleis created. You can assign it to project members at any time.
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o Tip: Based on the earlier settings, a project member may be able to submit arequest for the role.
Create a project administrator role
The project administrator is responsible for managing the project's users and roles.

The project creator is assigned the Founder Project Admin role, a special role granting all project and application
administration permissions for the project. You can transfer the Founder Project Admin role to another user.

If the project creator is a CollabNet TeamForge administrator, no Founder Project Admin is created.

Note: By default, project adminstrators do not have application administration permissions, such as Tracker Admin
or Task Admin. Application administration permissions can be included in a project administrator role, but must
be assigned separately.

1. Onthe Role Permissions page, select Project Admin Permissions.

g~ Note: If thisis an inherited role, you can not edit the permissions associated with it. You can edit the project

members and user groups to whom thisinherited roleis assigned.

» If you want the role to contain only the project administrator permissions to manage users and roles, Project
Admin Permissionsisall you need to select.

» If you want the role to contain additional application administration or other permissions, check the additional
permissions.

2. Click Save.

All project members assigned this role have project administrator permissions to manage the project's users and roles.
Change arole
If users need to do things that are not allowed by arole you have assigned to them, you may need to change the permissions
associated with that role.

When you edit arole, all project members with that role get the updated permissions automatically.

Note: If your project is asubproject of any other project, your project may have inherited some roles from the
parent project. To work with the properties and permissions associated with inherited roles, you must go to the
parent project where those roles are specified.
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1. Click Project Admin in the project navigation bar.
2. Onthe Project Admin menu, click Permissions.
3. From thelist of roles created for this project, click the role you want to edit.

Note: You can assign aroleto direct project members and user groups of the project regardless of whether the
role belongs directly to this project or isinherited from a parent project.

4. Onthe Role page, make the changes you need.

« To edit thetitle or other role details, click Edit. Make the required changes and click Update.

» Toedittherol€e's permissions, choose an application from the [eft side of the page and select or deselect permissions
and resources.

« To edit the project members to whom the role is assigned, click Assigned Project Members.

e To edit the user groups to whom the role is assigned, click Assigned Groups.

5. Click Save.

Therole is modified.
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View users and user groups assigned to arole
Before adding arole to a project member or user groups, see all the users and user groups who are assigned that role through
inheritance.

A user or user group can have any number of roles. Roles and the associated permissions can be inherited via project
hierarchy or project groups.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Permissions.

In the View dropdown, select Global project roles and from the results, a specific role.

In the Assigned Project Memberstab, click the View dropdown and make a selection.
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» Direct Member s displays the users who are directly assigned the role in the project.
« Inherited Members displays the users who inherit the role from parent projects as well as project groups.

5. Inthe Assigned Groupstab, click the View dropdown and make a selection.

« Direct User Groups displaysthe user groups that are directly assigned the role in the project.
* Inherited User Groups displays the user groups that inherit the role from parent projects as well as project
groups.

Theroles are now assigned to each user group.

Control access by user class
To avoid having to create and assign alot of similar roles for individual users, give access to applications to whole classes of
users whenever possible.

For each application (tasks, documents, file releases, trackers, and discussion forums), you can assign permissions
globally based on user type.

For example, if you know that you want al project members to be able to view and submit to all project trackers, set
the application's permissions to reflect this. You need to configure these settings only once.

1. Onthe Project Admin page, configure your project access settings and click Next.

2. Onthe Edit Default AccessApplication Permissions page, click the + symbol to expand the section for which you
want to assign permissions.

3. For each application and resource, choose a user type from the drop-down menus.

« All users of the selected type will have the specified permissions: view, submit/view, or post/view.
 For discussion forums and trackers, you can also specify submit or post permissions.

g Note: Youcan specify access to top-level folders, but not to specific subfolders.

g~ Note: If you want to control access to an application or resource that is not displayed on the Edit Default
Access Application Permissions page, you can do so using role-based access control.

4. Click Finish.

Control access by project type
Projects can be open only to project members, open to everyonein the world, or something in between.

By default, all new projects are created as private projects, accessible only to project members. You can change your
project to a public or gated community project at any time.

Important: Userswho do not have access to a project cannot see it on the Home page, in the All Projects list, or
in search or reporting results.

[ N

1. Click Project Admin in the project navigation bar.
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2. OntheProject Admin menu, click Permissions, then click the Default Access Permissionstab to see the project's
current access setting.

3. Click Edit.
4. Onthe Edit Default Access Per missions page, select the kind of access you want to allow to your project.
« Private - Project members only.

e Gated community - Project members and unrestricted users.
e Public-All users.

Let users see other users' roles
You can enable some project members to view the roles assigned to other project members.

For example, if your project includes both core team members and consultants, you may want to restrict full visibility
of user details to the core team members.

1. Click Project Admin in the project navigation bar.

2. Onthe Project Admin menu, click Permissions.

3. Onthe Rolestab, click the role you want to edit.
For example, if you have divided project membersinto a"Core Team" role and a"Consultant” role, click the "Core
Team" role.

4. Under Project Admin Permissions, select View User M ember ship.

Now only project members who have the role you edited can see the roles held by other project members.

g Note: They still can't see the actual permissions included in those roles, unless they have Project Admin status.

Lock or unlock a project
To ensure that no changes occur in a project while you are collating or migrating project data, lock the project. You must have
project administration permissions or be a site administrator to lock or unlock a project.

To lock or unlock a project in CollabNet TeamForge, go to Project Settings and lock/unlock the project.

Note: A locked project does not allow any member (including project administrators and site administrators) to
make any changes to the project. Besides that, alocked project can not be set as the parent project for any other
project and tasks like adding, editing or deleting integrated applications are also not allowed.
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Click Project Admin in the project navigation bar.

The project islocked or unlocked as desired. The lock icon 5 Locked appearson all the project pages while the project
islocked.

Note: If alocked project has an integrated application, for example, project tracker, all the project tracker pages
are also non-editable while the project islocked. The user who has access permissionsfor theintegrated application
can only view the pages.

Control access to source code
It's a good idea to make sure your source code can only be used by people who have business with it.

You can control which users can view or commit source code. You can make these distinctions at the repository level
or at the path level within arepository.

1. Click Project Admin in the project navigation bar.
2. Onthe Project Settings page, click Permissions.
3. Click the role whose access to source code you want to control.
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o Tip: If the appropriate role does not exist, you must create it first. See Create a role on page 115.
4. Onthe Edit Role page, click Source Code.

5. Under Repository Permissions, select arepository in the project and specify thisrole's access to the repository as
awhole.

» To block userswith this role from seeing this repository at all, select No Access.
« To allow userswith this role to see everything in the repository but not commit to it, select View Only.
» Toalow userswith thisrole to commit to any path in the repository, select View and Commit.

6. If you want to control access to a specific path within the repository for users with this role, select Path-based
Permissions.
a) Click Add.
b) Specify apath in the repository.

Tip: The path does not have to exist when you specify it. You can set a permission for a path that may be

[
created later.

c) Select NoAccess, View Only, or View and Commit for this path.

' Note:

* If noneof theavailable permissions (View Only, View and Commit, or Path-based Per missions) is selected
for any repository, and none of the options under Sour ce Code Per missionsis selected, users with thisrole
do not see the Sour ce Code toolbar button.

» |f two paths have different permissions, the permissions on the lower-level path take effect. For example,
consider arolethat has "No Access' set for the path / br anches/ ver si on3/ user s, but has"View
and Commit" accessto/ br anches/ ver si on3/ user s/ vi j ay. Userswith thisrole can:

e Check codeinand out of thevi j ay directory.

* Click down through all the directoriesin that path, including user s.

Users with this role cannot check filesin and out of the user s directory or monitor commitsto user s.
7. Click Save.

Note: You can also restrict the information that goes out with commit notification emails. See Who can access

[ i
source code? on page 232.

Allow anonymous Subversion checkouts
|Navigation title: Allow anonymous checkout
To grant anonymous checkout access while restricting write access to a Subversion repository, set the project's default access
permissions to public, provide Source Code View permission to all users, and limit other permissions to specific user classes.

1. Click Project Admin in the project navigation bar.
2. Onthe Project Admin menu, click Permissions, then the Default Access Per missions tab.
3. Under Application Permissions, choose All user s from the dropdown for Source Code View permission.

g~ Note: You can giveall users checkout access to al repositories or a specific repository.

4. For other application permissions, choose a user class based on your access requirement.

Users can now check out from a repository without entering a password.
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Show or hide an application
To help users focus on the relevant parts of your project, choose which applications they can jump to from the navigation bar
at the top of any project page.

1. Onany project page, click Project Admin.
2. Onthe Project Settings page, click Project Toolbar.
3. Sdlect the applications that you want to be visible to usersin your project, and click Save.

Only the application buttons you have set to Visible are in the navigation bar at the top of the project page.

« Removing buttons from the navigation bar does not remove the application from the site. Users with the appropriate
permissions can still get to the hidden applications by other means, such as clicking alink in an email. The hidden
application button will not appear.

*  When an application button is set to Visible, but a given user does not have permission to use that application, that
user still cannot see the application button. For example, if auser hasarolethat does not permit accessto any source
code repositories, that user does not see the Sour ce Code toolbar button, even if the button is enabled for the project.

« |f the Tasks tool is hidden for a project, the option to run reports on the Task tool is aso hidden.

« |f you create aproject template from aproject that has hidden applications, any project you create from that template
will have the same applications hidden.

Who can post to discussions by email?
To help reduce the risk of spam or other mischief, you may need to limit the users who can post to your project's discussion
forums by email.

To leverage the advantages of community collaboration, you should keep your forums as open as you can. However,
some projectsrequiretighter control over who can participate in discussions. TeamForge enables you to balance openness
against privacy along a spectrum of choices.

1. Click Project Admin in the project navigation bar.
2. Click Discussion Settings.
3. Set the value of Email Posting to one of these choices (listed from most restrictive to least restrictive).

Thisoption... has this effect:
Allow only forum admins Only users with the "discussion admin" permission can post by email.
Userswith roles & permissions Only registered userswith the "topic post" permission can post by email.

Thisisthe default. (For discussions marked as private, thisisthe least
restrictive setting possible.)

All logged in users All users who are registered on the site can post by email.

Allow known email addresses only Users can post by email only if they have explicitly been added to the
monitoring list. (This can include people who are not registered site users.)

All site usersand guests Anyone can post by email.

If you select avalue that's more liberal than the value your site administrator has set for the site as awhole, the site
administrator's setting rules. For example, suppose the site administrator has provided that only userswith the appropriate
role ("Userswith roles & permissions") can post by email. If your project requires extra security, you can choose to
accept email only from forum administrators. However, you cannot accept email posts from aless restrictive category
of users, such as"All logged in users."
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Manage project membership
You can add or remove project members on their request or on your own initiative.
Note: If your project is asubproject of any other project, your project may have inherited some roles from the

parent project. To work with the properties and permissions associated with inherited roles, you must go to the
parent project where those roles are specified.
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Add users to a project
Before a person can work on a project, you have to make them a member of the project.

You can make any registered user on your CollabNet TeamForge site a project member. You can assign rolesto the
user at the same time,

Note: Project members, roles and the associated permissions can be inherited and reused in subprojects. If your
project is a subproject of any other project, you may have inherited some roles, project members, or user groups.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click User Member ship.

Click Add.

On the Add User page, find the users you want by one of these methods:
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* Under Search for Users, filter thelist of site users eligible to join this project. You can filter by full or partial
name or user name.

e Note: Search text is not case-sensitive.

* Browsethelist of registered users on the site. Sort them by name, user name, email address or membership status.

Theinherited project members continue to hold the inherited roles with corresponding permissions, as specified
in the source projects.

Note: If asite hasagreat many users, you must filter them first to narrow down the list. This helps avoid
slowing down the system.

5. Select the users you want to add.
6. Under Assign Roles, select the roles you want the users to have.

You can select any global project role, role created just for this project, or inherited role that is available.

Note: If your project isachild project of another project, the members of the parent project become inherited

[
members of your project. The user roles specified in the parent project are available in your project provided
theroleinheritance is not prevented. If you assign arole in your project to a user, that user becomes a direct
member of your project.

' Tip: If you prefer, you can skip this step and assign roles later on the Project Admin > Permissions page.

Note that using the Assigned Project M ember s page, you can assign roles only to the direct project members.

7. Saveyour changes.

« Click Saveto return to the Project Member ship page.
e Click Save and Add More to keep adding users.
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Remove a user from a project
When you remove auser from aproject, all items such astasksand tracker artifactsthat were assigned to the user are re-assigned
to None.

Note: If your project is asubproject of any other project, your project may have inherited some users from the

parent project. To remove an inherited user, you must go to the parent project where that user is a direct member.

1. Click Project Admin in the project navigation bar.
2. Onthe Project Admin menu, click User Member ship.
3. From thelist of current project members, select the user you want to remove and click Remove.

The user is now removed from the project.

Handle a request for project membership
A registered CollabNet TeamForge user can ask to be amember of a project. As the project administrator, it's up to you to
approve or reject such requests.

When a CollabNet TeamForge user submits a request for project membership, the request is placed in the User
M ember ship section of the Project Administration page, pending approval by a project administrator. The request is
aso displayed in the Items Pending My Approval section of each project administrator's My Page.

1. Click Project Admin in the project navigation bar.
2. Onthe Project Admin menu, click User Member ship, then click the Pending Requests tab.
3. Under Users Requesting to Join Project, select the user you want to approve or reject.

» Click Approve to approve the request and add the user to the project.
» Click Reject to deny the request.

4. To view details about the user or add a comment before approving or rejecting the request, click the user name.
Thisisoptional.

The user receives an email notification when the request is approved or rejected.

Handle a request to leave a project
A CollabNet TeamForge user who wantsto leave a project must submit arequest. The project administrator can approve or
reject the request.

A request to leave is placed in the User M ember ship section of the Project Administration page, pending approval
by a project administrator. The request is also displayed in the Items Pending My Approval section of each project
administrator's My Page.

1. Click Project Admin in the project navigation bar.

2. Onthe Project Admin menu, click User M ember ship, then click the Pending Requests tab.

3. Under Users Requesting to L eave Proj ect, select the user whose request you want to approve or reject.

« Click Approve to approve the request and remove the user from the project.
» Click Rgect to deny the request.

4. Toview the user details or add a comment before approving or rejecting the request, click the user name.
Thisisoptional.

The user receives an email notification when the request is approved or rejected.
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Create a project template
To make it easier to start projects, provide project templates based on existing projects.

A project templateis used to populate new projects with the structure and configuration of the source project.It can aso
include the actual contents of the project it is based on, such as tasks, tracker items and documents.

When you create a project template, it is available only to projects on your own site. To make it available more widely,
you can export the project template and share it with others. Ask your CollabNet representative for more information
about doing this.

Note: The access settings for a project template are the same as the access settings for the project on which the
template is based. For example:

» |If you create atemplate from a project that has hidden applications, any project you create from that template
will have the same applications hidden.
« |If you create atemplate from aproject that is private, any project created from that template will also be private.

1. Set uptheproject that will serve asthe basis for the new project template.

L Tip: If you need a clean project template, you may want to create a new project specifically for this purpose.

2. Click Project Admin in the project navigation bar.
3. Onthe Project Settings page, click Create Project Template.
4. Write aname and description for the template.

Tip: Consider the uses that you or other project managers might have for this project template, and include
keywordsin your description that are related to those uses.

5. Choose the items that you want to make available in new projects that are created from this template.

» Every new project includes a Tracker s component into which you can add new trackers; a Documents folder
into which you can add more document folders and documents; and so on.

« If youwish, you canincludethe actua trackersfrom the current project's Tracker component; the actual documents
from the current project's Documents component, and so on.

6. Click OK.

The project template is created. The template is available to all users who have the required permissions to create new
projects.

The template name and description appear on the Template tab of the Projectslist, accessible from your personal
navigation bar.

Categorize a project
Organizing projects by categories can help users find what they need on a site quickly and easily.

Project categories express the rel ationships among projects. If your project isin acategory, it isvisibleto users browsing
projects from the main Project Categories page.

Your project can be in one or more project categories.

1. Click Project Admin in the project navigation bar.

2. Onthe Project Admin menu, click the Project Categorization tab.

The Project Categorization page lists al the categories the project belongs to.
3. Click Add.

The Select Category window shows all the available project categories.

4. If you find aproject category that your project should be in, select that category and click Add.



124 | OpenTopic | How to use TeamForge 6.1

Your project is now a member of the selected project category. You can repeat this process to add your project to any
number of project categories.

Make other applications available to project members
You can make it easy for project members to use awide variety of applications and sites from inside CollabNet TeamForge.

Link an external application
To make an application or site outside of CollabNet TeamForge available in your project, create alinked application.

You can create as many linked applications per project as you need.
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8.

Tip: Somesitesemploy page codethat disablesthisfeature. For example, some Google apps automatically generate
user login data and append it to their URLSs, which prevents them from opening in an iFrame.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Linked Applications.
The Linked Applications page displays alist of al currently linked applications in the project.

Onthe Linked Applications page, click Create.

On the Create Linked Application page, enter a name for the linked application.
This name will appear, with an icon you choose, in the project navigation bar.

Enter the server location or URL for the linked application.
If you are a CollabNet TeamForge administrator, select whether you want to use single sign-on for the linked
application.

» If you use single sign-on, CollabNet TeamForge users can automatically log into the linked application.
 If you do not use single sign-on, users must log into the linked application using its native authentication system.

Click Browseand select agi f, . j pg, or . png fileto serve asthe new icon for the linked application.
Make the image 25 pixels wide and 20 pixels high.

Thisicon appears with the application name in the project navigation bar.

Click Save.

A button for the linked application is added to your project navigation bar. Clicking it launches the application in the
main CollabNet TeamForge project window.

Change a linked application
When the use patterns of alinked application change, you may need to change the way the application integrates with CollabNet
TeamForge .

SEFCENS -

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Linked Applications.

On the Linked Applications page, select the application you want to edit.
Click Edit.

On the Edit Linked Application page, make the changes you need.

You can edit these elements:

» The name of the application.
e Theapplication's URL.
«  Whether the application uses single sign-on (if you are a CollabNet TeamForge administrator.

g~ Note: You cannot change the application icon.

Click Save.
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Reorder linked applications
If the order of the buttons for your linked applications makes a difference to users, you can reorder them.

By default, linked application buttons are displayed in the project navigation bar in the order in which they were added.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Linked Applications.

On the Linked Applications page, click Reorder.

Inthe Reorder Linked Applicationswindow, arrange your applicationsin the order that works best for your users.
a) Select an application by clicking thetitle.

b) Click Move Up or Move Down until the linked application isin the correct order.

5. Click Save.
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Integrate an external application into your project
To make an application or site outside of CollabNet TeamForge availableto your users seamlessly from inside your TeamForge
project, bring it in as an integrated application.

If the application you want to use is not yet available for your project, ask your site administrator to set it up.

You can use as many integrated applications as you wish, after your site administrator has made them available.

1. Click Project Admin in the project navigation bar.
2. Onthe Project Admin menu, click Project Toolbar.
The Integrated Applications tab displaysthe list of al currently integrated applications in the project.
3. Onthelntegrated Applications page, click Add.
4. Onthe Add Integrated Applications page, select the desired application and click Configure and Add .
a) If your site administrator has made it possible, specify a prefix for the resources created by the application you
are setting up.
A prefix enables TeamForge to provide handy links between objects managed by this application and other
TeamForge objects. For example, if you are bringing in a blogging application:

* You can connect a blog post with a TeamForge artifact using a special link called an "association.”
« For each blog post, you can give readers a simplified address, known asa"go URL."

for project-level associations and go URLSs.

g~ Note: The application's prefix is permanent after you saveit.

b) Set any other configuration parameters you need and save your changes.

« Click Saveto return to the Configure I ntegrated Application page.
« Click Save and Add More to keep adding integrated applications.

Anicon for the integrated application is added to your project navigation bar. Clicking it launches the application in the
main CollabNet TeamForge project window.

Remove an integrated application from your project
To stop making an application or site outside of CollabNet TeamForge available to your users from inside your CollabNet
TeamForge projects seamlessly, disintegrate an application.

Note: You may have integrated several external applications per project to maximize the integrated applications
feature's utility. However, because each integrated application adds an icon to the project navigation bar, alarge
number of integrated applications can cause horizontal scrolling. Consider removing the integrated applications
that are not in use.
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1. Click Project Admin in the project navigation bar.

2. Onthe Project Admin menu, click Project Toolbar.
The Integrated Applications tab displaysthe list of al currently integrated applications in the project.

3. Toremove an integrated application, on the I ntegrated Applications page, select the integrated application and
click Remove.
The selected integrated application is removed from the project.

The icon of the removed integrated application disappears from your project navigation bar.

g~ Note: Removing an integrated application, removes all associations to the integrated application too.

Add a parent project to your project
You can coordinate work among multiple projects; enable the user, user group and role inheritance by adding acommon parent
project to several projects.

g~ Note: A subproject can have only one parent. You can change or remove that parent at any time.

g~ Noter You must be a project administrator or site administrator to add/edit or remove the parent projects.
Click Project Admin in the project navigation bar.

On the Project Settings page, click Edit Parent.

Click Add Parent.

Onthe Choose New Parent page, choose a parent project that it makes sense for your project to belong to, and click
Confirm.
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g~ Note: You cannot add a parent project for the 'Look’ project asit isaspecial project in itself.

Separate a subproject from its parent project
When a subproject grows beyond its original scope, you may want to make it stand-alone project or move it to a different
project hierarchy.

By removing the association with a parent project, you can manage the subproject as a separate project.

Note: Only one parent project can be selected for a subproject. However, the parent project can be changed or

L !
removed, as required.

1. Click Project Admin in the project navigation bar.
2. OntheProject Settings page, click Edit Parent.
3. Change or remove the parent project as required.

You can be a project administrator or a site administrator to change or remove a parent project. As a project
administrator, you can remove or change a parent project only if you have administrator permissions for both the
projects that are being linked.

Note: A parent project can be removed or changed only when its members, user groups and roles are not in
use in any other project. In other words, you can not remove/change a parent project while its members, user
groups or roles are in usein any other project.
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e « Click Change Parent to choose another parent project.
« Onthe Choose a Parent Project page, select the desired parent project and click Confirm.

Note: If the project hierarchy exists, the project and its subprojects are moved only under the project from
which members, user groups or roles are inherited. If project hierarchy does not exist and no inheritanceis
in use, the project is made a'Root' project.
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« « Click Remove Parent to remove the association with parent project.
«  On the pop-up message box, click OK, if you wish to make the project a'Root' project.

The project hierarchy is changed or removed in accordance with role based access control and inheritance rules.

Require a wiki version comment
To help keep track of changesto aWiki page, require usersto record acomment about their changes when they save the page.

1. On any project page, click Project Admin.
2. OntheProject Settings page, click Wiki Settings.
3. Select RequiresVersion Comment on Edit.

Now users who edit a page in your project's Wiki must |eave a note describing their changes.

Provide build and test services

To enable project members to build and test their software, you can set up aremote Hudson continuous integration server they
can access from inside CollabNet TeamForge .

Install the CollabNet plugin
If you already have a Hudson server, get the CollabNet plugin from there. If not, download thewar file from the CollabNet
site.

Install Hudson and the Build & Test plugin
To install Hudson and its CollabNet plugin, download and run the Build & Test war file.

g~ Note: You must have Java J2SE 1.5 (or later) installed before you install Hudson.

1. Downloadthect f bui | dtest- 1. 1. x. war filefrom www.open.collab.net.
2. Runthewar filewith this command.

java -jar ctfbuildtest-1.1.x.war

You should now be able to access Hudson on your server, on port 8080. For example, if you ran thewar filelocally,
you would access Hudson at http://localhost:8080. The Hudson > Plugin Manager > I nstalled page should display
the CollabNet plugin.
Install the Build & Test plugin on your Hudson server

On your Hudson site, get the CollabNet plugin from the Plugin Manager.

g~ Note: You need administration privileges on your Hudson site.

1. Inyour main Hudson page, select M anage Hudson > M anage Plugins.
2. IntheAvailable page, select the Promoted Builds plugin.
The File Release component of the CollabNet plugin requires this.
3. Select CollabNet Plugin and click Install.
4. Restart Hudson.

On your Hudson project's Configure page, each plugin component is available as an option under Post-build Actions.

Connect to your Build & Test server
When you've set up Hudson with its CollabNet plugin, enable project membersto accessthat server inside CollabNet TeamForge.

1. Click Project Admin > Build & Test Integration in the project toolbar.
2. Inthe Override URL field, specify the URL of your Hudson server.
3. Choose what you want to happen when a project member clicks the Build & Test toolbar button.


http://www.open.collab.net/community/buildtest/
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* SameWindow: The user goesto a new page showing the control interface for the build and test environment.

¢ New Window: The user goesto anew page (or tab, if their browser is configured to open tabsinstead of windows)
showing the control interface for the build and test environment.

e |Frame: Theuser goesto a TeamForge site page showing the control interface for the build and test environment.

4. Select whether you want Single Sign On Enabled between your CollabNet TeamForge and Hudson sites.

Note: To allow a project member who logs into CollabNet TeamForge to automatically sign into Hudson, you

€
need to select the Single Sign On Enabled option here, as well as the Accept Single Sign-On token from
TeamForge option in the Build& Test plugin.

5. Click Save.

Upgrade the CollabNet plugin on your Hudson server
To upgrade your version of CollabNet Build & Test, get the latest plugin from the Plugin Manager.

g~ Note: To be able to upgrade, you must have administration privileges on your Hudson site.
The CollabNet Build & Test war fileinstalls both Hudson and the CollabNet plugin, but it is recommended only for a
new install. To upgrade an existing installation, follow these instructions.

1. Inyour main Hudson page, select M anage Hudson > M anage Plugins.
In the Plugin Manager, the latest version of the CollabNet plugin, 1.1.x, is available in the Updates page.

2. Inthe Updates page, select the Install checkbox for CollabNet Plugin and click I nstall.
3. Restart Hudson.

4. To verify that the plugin was upgraded, check the version of the CollabNet plugin in the Installed page of the Plugin
Manager.

Authenticate and authorize users in Hudson

Authenticate users in Hudson
Enable security on your Hudson site to authenticate users against a CollabNet TeamForge server and specify whether you
want single sign-on with TeamForge.

Note: Inthedefault configuration, Hudson does not perform any security check. When you turn on authentication,
usernames and paswwords are determined against a CollabNet site. To specify what users can do in Hudson, you
need to turn on authorization which is a separate action.

[ 1

In your Hudson installation, go to Manage Hudson > Configure System.

Select Enable Security.

In the Access Control section, select CollabNet Security Realm to authenticate usernames and passwords.

Enter the URL for your TeamForge site. For example, https://forge.collab.net.

To allow auser logged into TeamForge to sign into Hudson, select Accept Single Sign-On token from TeamFor ge.

g s wDdh e

g~ Note: The TeamForge site must have single sign-on with Hudson enabled.

6. Toalow auser logging into Hudson to automatically sign into TeamForge, select Authenticate to TeamForge
when signing on to Hudson.

7. Click Save.

Authorize users at the site level
At the site level, you can assigh administration or read-only permissions to TeamForge users and groups.

g~ Note: Authorization will not work if you do not also use CollabNet Authentication.



OpenTopic | How to use TeamForge 6.1 | 129

1. Make sure that the Authentication and Authorization plugin component is installed.
2. Inyour Hudson installation, go to Manage Hudson > Configure System and select Enable Security.
3. Select CollabNet Authorization to specify what TeamForge users or groups can do on the site.
a) To reduce the load on the application server, a user's TeamForge roles are cached while checking permissions.
If you want to turn off caching, set the Authorization Timeout value to O.

g~ Note: The permission cacheis only valid for the session and is discarded when you log off.

b) Enter acomma-separated list of users or groups to whom you want to grant administer privileges.

Note: Site administratorsin TeamForge will automatically get Hudson administrator rights, but you'll need
to manually add any other users or groups you'd like to have administrator access. It's agood idea to add
your own username here, so you don't lock yourself out.
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¢) Specify the TeamForge users or groups to whom you want to grant read-only privileges.

g~ Note: To grant users permissions within individual projects, see these instructions.

4. Click Save.

Authorize users at the project level
Assign TeamForge users default permissions for a Hudson project, or set up user roles for that project in TeamForge.

g~ Note: While configuring project-level access, you associate one TeamForge project to one Hudson project.

1. Inthe Hudson project, click Configure.
2. Inthe Authorization from CollabNet section, enter the name of the TeamForge project.
This project is used to determine what its members can do in the Hudson project.

3. Toautomatically set up Hudson-related roles in the TeamForge project, select Create Hudson roles on CollabNet
server in thisproject.
g~ Note: To be ableto do this, you must be the TeamFForge project administrator.
Here's an example of theroles.

User-Role Matrix  Group-Role Matrix  Default Access Permissions

Ems]
Role Mame = Description
Hudson BuildfiCancel Allows users to start a new build, or to cancel a
Hudson Configure Allows users o configure a build.
Hudson Delete Allow users to delete builds,
Hudson Promoke Alloww users ko promake builds,
Hudson Read Allows users read-access to Hudson jobs

Oncetheroles are available in TeamForge, the project administrator must assign them to project membersto specify
the things they can do in the Hudson project.

4. Togiveproject administratorsfull permissionsin the project, and all members read permission, select Grant default
per missionsto members of the project.

g~ Note: To be ableto do this, you must be the TeamForge project administrator.

5. Click Save.
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Assign project-level Hudson roles in TeamForge
As a TeamForge project administrator, assign roles to individual users and groups for the associated Hudson job.

Hudson-related roles are automatically created in a TeamForge project when the Create Hudson roles on CollabNet
server in a Project option is selected in Hudson.

1

In the TeamForge project, click Project Admin in the project navigation bar.

2. Onthe Project Admin menu, click Permissions.

3,
4,

« Toassign rolesto aproject member, click the User-Role Matrix tab.
e Toassign rolesto agroup, click the Group-Role Matrix tab.

Therole matrix lists all project members or groups on the left and all available roles on the top.
Select the appropriate roles.
Click Save.

Theroles are now assigned to the project member or group.

Configure global CollabNet settings
You can specify a set of global TeamForge values and use them in any CollabNet component for any job that you configure,
instead of filling in that information each time.

You must be a Hudson administrator to be able to configure global TeamForge settings.

1
2.

In your Hudson installation, go to Manage Hudson > Configure System .

In the Global CollabNet Configuration section, select Allow Global CollabNet Configuration to be able to use
these settings in any job you set up.

Enter the URL for your TeamForge site. For example, https://forge.collab.net.

Enter the username and password for the user who will perform Hudson-related actionsin TeamForge.

Click Save.

Note: When configuring a CollabNet plugin component within an individual job, you can choose to override
these global settings and specify different values for TeamForge URL, username and password.

Provision hardware for project members

You can use TeamForge Lab Management to provision physical or virtual hardware on which project members can remotely
build and test their code.

Tip: For moreinformation about the new featuresin TeamForge Lab Management 2.2, see thisintroductory video.
(You'll need afree open.collab.net membership to watch it.)

Set up hardware for your team to use
When you set up Lab Management, your team members can use TeamForge to accesstheir own virtual machinesfor developing
and testing.

o 0k~ wbdPE

Get CollabNet TeamForge Lab Management .

On the Project Admin menu, click Linked Applications.

Onthe Linked Applications page, click Create.

On the Create Linked Application page, enter the name Lab Mgmt.
Enter the server location or URL of your Lab Management server.

If you are a CollabNet TeamForge administrator, select whether you want to use single sign-on for the linked
application.


http://www.open.collab.net/nonav/community/sfee/training/wbt11/WhatsNewLM.htm
http://www.open.collab.net/products/CUBiT/

8.

OpenTopic | How to use TeamForge 6.1 | 131

« If you use single sign-on, CollabNet TeamForge manages authentication for Lab Management, and users don't
have to log into Lab Management after they have logged into CollabNet TeamForge.

« |If you do not use single sign-on, users must log into Lab Management using its native authentication system.

Click Browse and select thisicon for the linked application:

i

Thisicon will appear with the name Lab M gmt in the project navigation bar.
Click Save.

A Lab Mgmt button is added to your project navigation bar. Clicking it launches the application in the main CollabNet
TeamForge project window.

Reallocate a system
To enable a project member to use a system, you must reall ocate the system to that user.

You must be a Domain Administrator or Project Administrator to free a host that does not already belong to you.

1

Notify the user you're taking the system from through email or some other means, so that they don't |ose any important
work which they may not have saved on that system.

The user whose system was deallocated will get an email after the deallocation, but it isacourtesy to notify the user
beforehand.
On your project's Project Home page, click the host you want to reallocate.

Click FreeHost.
The host is now free and can be allocated by anyone in the project. TeamForge Lab Management emails the user
that their system has been deallocated by an administrator.

To discourage other users from allocating it, put a note in the host's Description stating something like "This host
reserved for Jane."

Notify the user who is going to allocate the new system that their system is now ready.

Edit a project
Asaproject administrator in TeamForge Lab Management, you can edit certain properties for your project.

1
2.

On the project home page for the project that you wish to edit, click Edit Project.
Edit the following parameters:

Project Summary A brief, one-line summary of the project.
Project Description A more detailed explanation of the project.

Project MOTD (Messageof the The Project MOTD is displayed to all usersin your projects. This message also
Day) may display to users when they log in to client nodesin your project.

Proj ect-specific host allocation In this section, project administrators can control how long usersin their project
timelimits can allocate hosts for. If you set this value to 0 (zero), thereis no limit on the
time a host can be allocated.

If you reduce this value, users hostsin your project may be deallocated. If
deallocations will occur as aresult of your lowering of the maximum allocation
time, you will be warned which systems will be affected, and given a chance to
change your mind.

Deletethis Project/Undelete  If your project is not deleted and has no hosts, you will be given the option to
this Project delete this project from TeamForge Lab Management. If your project is deleted,
you will be given the option to undelete it.

Note: only Domain Adminswill be ableto delete and undelete projects
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Dictate which profiles can be used in your project
To control which operating system profiles the users in your project can build hosts with, adjust the settingsin your profile
library.

1. OntheProfile Library page, click Add/Remove Profiles.

2. Inthelist of all potential profilesthat you can add to your project, select the profiles you wish to be allowed in your
project and click Save Changes.

Your changes take effect immediately.

g~ Note: Torevert any changes you have made, click Cancel or Reset.

Deliver a build

To get your software into users hands, upload your build to the Project Build Library.
Get the PBL upload client

You must download the pbl.py script to transfer filesinto the Project Build Library.

Th PBL upload client is free, open-source, and freely modifiable and distributable.
Download the PBL upload client from http://cubit.open.collab.net/pbl/.

g~ Note: TheAPI operationsare fully documented, for users who might want to develop their own PBL upload client.

Upload afile
To upload afile, runthe pbl . py upl oad command.

In this example, we upload afile named Rel ease. zi p from our local machine into the public area of the project
nmypr oj ect , inthedirectory / f oo/ bar/ baz/ .

g Note: If any part of the requested path does not already exist, pbl . py creates the intermediate directories.

Run thepbl . py upl oad command like this, substituting the correct values for your situation.

pbl . py upl oad - - api - user =user nane - - api - key=713cdf 90- 2549- 1350- 80c3- 2d0bcf 921697
--api-url http://$external host/cubit_api/1l --project=nyproject -t pub -r
/foolbar/baz -d "This is the description." /hone/Rel ease. zi p

g~ 11p: Wildcards are accepted in the filename argument. If the file argument is a directory, or awildcard which
~includes one or more directories, pbl . py recursively uploads all the subdirectories underneath the parent. All
thefilesin the recursive upload get the same description.

Once this operation has completed, you can download this file from
https:// $external host/ nyproject/ pub/foo/ bar/baz/ Rel ease. zi p.

For other optionsto pbl . py, runpbl . py hel p upl oad.

Change the description of afile
You can change the description associated with afile or directory without changing thefileitself or the md5 checksum of the
file.

In this example, you have already authenticated and saved your username and key credentialsin your home directory.

Runthepbl . py changedesc command like this:

pbl . py changedesc -1 http://$external _host/cubit_api/1l --project=nyproject -t
pub -r /fool/bar/baz/Release.zip -d "This is the new description"


http://cubit.open.collab.net/pbl/
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Move afile
With thepbl . py npve command, you can move files or directories within a project, or even between projects.

The syntax for this command is a bit different than the rest of the commands, because the other commands only operate
on one project or file or directory at atime, and that is not the case the the move operation.

To move afile, runthepbl . py nbve command with these options.
In the simplest case, we move afile, or adirectory and all its contents, from one name to another.

--Srcproj projname The name of the project the source fileislocated in.

--destproj projname The name of the project to move the file to. If Ieft blank, defaults to value of
--srcproj.

--srcpath path The path to the file or directory to move.

--destpath path The destination path for thefile or directory specified in - - sr cpat h. Two

important things to note about this option:

» If you specify apath which does not exist, that path will be automatically created
for you as part of the move.

» |f the- - dest pat h parameter ends with adlash ("/"), the destination will be
assumed to be a directory. If it does not end with a slash, the destination will
be assumed to be afile. An example of this behavior isbelow. Thisis
approximately how the UNIX "mv" command behaves.

--srctype {pub|priv} The visibility type of the sourcefile, either pub or pri v.
--desttype {pub|priv} The visibility type of the destination file, either pub or pri v.
--force If the destination file exists, the --force option must be used to replaceit.

Note: Because dest pat h doesnot end with aslash--/ f oo/ bar/ baz/ Rel ease_ol d. zi p -- thelast

[ i
component of the path isinterpreted as "afile named 'Release old.zip™.

pbl . py nove -1 http://$external _host/ TeanfForge Lab Managenent _api/1
--srcprj=nyproject --srctype=pub --srcpath=/foo/bar/baz/Rel ease. zi p
- -dest pat h=/ f oo/ bar/ baz/ Rel ease_ol d. zi p

To move afile from one project to another, and also change it from public to private, run the command like this.

Note: Becausedest pat h endswithaslash--"/ f oo/ bar/ baz/ ar chi ve/ " -- thelast component of the path
isinterpreted as "adirectory named ‘archive™.

pbl . py nove -1 http://$external _host/ TeanfForge Lab Managenent _api/ 1
--srcprj=nyproject --destproj=nyproject_archive --srctype=pub --desttype=priv
--srcpat h=/f oo/ bar/ baz/ Rel ease. zi p --dest pat h=/f oo/ bar/ baz/ archi ve/

Allow clouds in a project
To enable project members to alocate hosts from a public cloud in your Lab Management site, you must turn on a setting to
alow inclusion of public cloudsin your project.

1. In Administration > Projects, click Edit for your project.
2. Turnon the Allow Public Clouds setting.

If you want to be able to control the hosts your project members can select from, turn this setting OFF. In this case,
your project members can only select systems from a cloud your project explicitly owns. Your project's Allowed
Clouds page lists all the available clouds from which project members can allocate hosts.

Note: If you think that your project needs more systems than those available from a cloud, you need to ask the
cloud administrator for your site to increase this number.
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Provision a Continuous Integration server from a Lab Managenment cloud

|Navigation title: Provision a Continuous Integration server from a cloud

The Lab Managenment Cloud plugin enables Hudson and Jenkinsto automatically create slavesfrom Lab Management clouds.
Install the Lab Managenment Cloud plugin for Hudson and Jenkins

|Navigation title:Install the Lab Managenment Cloud plugin

Get the plugin from openCollabNet and upload it using the Plugin Manager.

1. Downloadthel abrmanagenent . hpi file from openCollabNet. (Please check back later for availability.)
2. Inthe Hudson or Jenkins Plugin Manager page, click the Advanced tab.
3. Inthe Upload Plugin section, browse to the location where you saved the . hpi file and click Upload.

In the Plugin Manager's Installed tab, you should see the Lab Management Cloud plugin enabled.

Configure the Lab Managenment Cloud plugin for Hudson and Jenkins

INavigation title:Configure the Lab Managenment Cloud plugin

When you add a new cloud, you set up templates specifying details such as the host type and profile for the nodes that will be

provisioned from this cloud.

1. Inthe Cloud section of the Hudson or Jenkins configuration page, click Add a new cloud and select CollabNet L ab

M anagement.

Lab Management options are displayed. Here's an example:

Cloud
CollabNet LabManagement
LabManagement URL httpe://mgr.cloud.sp.collab.net/
Username Imuserl]
Password S N I T LI R R R NN TN I I I IR ITITIIIIT Y]
API Key
Test Connection
Project labmgmt
Cloud WaporCloud
Templates Name e (7]
Host Type basic_i386 - @
Size 1cpu-1gb-60gb - 'ﬁ'
Profile ctf6.1-dev-r5.4-i386 - 'ﬁ'
Labels ctf 6.1 '@'
# of Executors | 'ﬁ'
Delete Template |

|

2. Enter the URL of the Lab Management Manager node. For example, https://mgr.cloud.sp.collab.net/.

3. Provide the username and password.
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This user must have access to the Lab Management project where new hosts will be allocated.
. Enter the user's APl key for the Lab Management web service.
o Tip: Copy and paste the key from the user's Lab Management home page.

. Click Test Connection to make sure that the options you provided are valid.

. Specify the Lab Management project where new hosts will be added.

. Select a Cloud from which new hosts will be allocated.

You can find the list of valid cloud names in the Lab Managenment Manager interface. For example:

Cloud tools
Browese All Clouds Name Summary
Allocate From Cloud DevCloud ¥ VMware-server cloud
PublicCloud ¥ Public cloud for all
How do I... projects
Allocate? VaporCloud w | Short term allocatic
A

. Click Add Templateto create a template that Hudson will start.
a) Specify aname that characterizes the template.
The name is used to identify the template and is displayed in various parts of the Hudson interface.
b) For Host Type, select the type of hardware you want for the node.
c) For Size, select the amount of resources -- memory, CPU, and disk -- assigned to this template.

You can find the exact amount of resources for each size in the Lab Managenment Manager's Clouds> Allocate
From Cloud page. For example:

Clouds

Aid

Select a host type and size from a cloud of your choosing. Different host types will have diff
FAM, networlk, reliability, etc.) and will also have different costs.

Allocate host into project:

labmgmt

1. Choose a host type and 2. Choose a system profile 3. Customize

size

Cloud: DevCloud H| (@) centos5_all H|

vtﬁcrnes;:sﬁvr;:dt?au;i?:_iaeri @ (@ centoss base ‘ . Hos
O o @ ST :
Lleze fopstanimiel [0 @ C175.2-3-sa35-r5.3-x86_64 @ Number o
[ Size: 1cpu-1gb-40gb Bl = s = den iz = imas Hi

Price niE

d) For Profile, select the Lab Managenment profile to be used for the template.
€) Providealist of labels separated by whitespaces.



136 | OpenTopic | How to use TeamForge 6.1

g~ Note: Thenamesand labelsyou provide for the templates are used to specify which jobswill usethis cloud.

f) Enter avaluefor # of Executors.

This controlsthe number of concurrent buildsthat Hudson or Jenkins can perform. So the value affectsthe overall
system load that might be incurred. A good value to start with is the number of processors on your system.

When using Hudson or Jenkins in the master/slave mode, setting this value to 0 would prevent the master from
doing any building on its own. Slaves may not have zero executors, but may be temporarily disabled using the
button on the dave's status page.

9. Click Save.

In the M anage Nodes page, you'll see an option to provision a node from Lab Managenment.

lenkins = nodes
4% Back to Dashboard s Name | Architecture Clock Differen:
e _ -
" 4 Manage Jenkins g. master  Linux (amded) In =
! Mew Node
| Provision via LabManagement ™
& Configure

Run a Hudson or Jenkins job on a host provisioned from Lab Managenment cloud
|Navigation title:Run a job on a Lab Managenment host
When you run ajob on a host provisioned from a Lab Managenment cloud, use atemplate you defined earlier.

1. Inthe Hudson or Jenkins configuration page for the job, provide a name and description.
2. Select the Restrict wherethis project can berun option to tie the job to the Lab Managenment cloud.
3. Enter alabel expression.

To always run this job on a specific node, just specify its name. However, when several nodes could be available
and you don't want to tie the job to a specific one, enter an expression based on the name and label values of alLab
Managenment cloud template you configured earlier.

Project name Elastic Provisioning test

Description Runs a build on a dynamically provisicned node from a Lab Management

Discard Cld Builds

This build is parameterized

Disable Build (Mo new builds will be executed until the project is re-enabled.)
Ewecute concurrent builds if necessary (beta)

¥| Restrict where this project can be run

Label Expression

4. Specify any other options you want and click Save.

When anodeis no longer used, it will be brought down and released.
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Support project teams with CollabNet TeamForge

INavigation title:Run a site |
Asasite administrator, you can help project managers and members of the site work together effectively throughout the
application life cycle.

A site administrator gets a special administration toolbar that looks like this:

e e M i — M ——
Site Administration

| I | &Y 3 |

= =) § W -aE

Projects Project Groups Users User Groups Roles Integrations Categories Syskem Tools License key  Integrated Apps

Move a site from CollabNet Enterprise Edition to CollabNet TeamForge 6.1
Asadomain administrator, you will find some aspects of TeamForge similar to CollabNet Enterprise Edition and others quite
different. Here are some steps you can take to ease the transition for yourself and your site's users.

[: Tip: Training is available to help you manage the transition. See the CollabNet training portal for details.

1. Get anew password for TeamForge 6.1 site

Your login nameis migrated from CollabNet Enterprise Edition to TeamForge 6.1, but your password is not.
To create your new password, click Forgot Your Password? on the TeamForge 6.1 home page.
Your TeamForge site emails you alink you can use to set a new password.

2. Beaware of password policy differences.

TeamForge 6.1 uses aslightly different password policy from your CollabNet Enterprise Edition site. To review the
site's password policy settings, click View Password Policy on the Reset Password page.

Note: Users password histories are not migrated. This meansthat if "Size of user's password history" was set
in CollabNet Enterprise Edition, the history will be cleared on migration.

3. Site-wide broadcasts are a good way to keep your site's users up to date during the transition.
See Communicate with all site users at once on page 148.

4. Each of the CollabNet Enterprise Edition tools hasits counterpart in CTF. Project information and resources work
alittle differently in each one.
For adetailed feature-to-feature comparison, see Migrating tools from Enter prise Edition to TeamForge 6.1 on page
312.

5. For the end user, permissions mostly work the same way on the new site as on the CEE site. However, it may be
useful to know about the different ways permissions are handled behind the scenes.
For a detailed comparison of permission handling between the two platforms, see How do user permissionsin
CollabNet Enterprise Edition map to permissions in TeamForge 6.1? on page 246

6. Project templates are not migrated from CollabNet Enterprise Edition to CTF.
CollabNet will provide support to manually recreate templates after the site is upgraded.

For information about how project templates work in CTF, see Create a project template on page 123.

7. TeamForge 6.1 URLs are different from CollabNet Enterprise Edition URLs. Backward compatibility is provided
for certain important URLSs.
For detailed information about how URLSs are handled, see How do URLs in CollabNet TeamForge 6.1 compare
with URLs in CollabNet Enterprise Edition? on page 211

8. Remote Publishing


http://www.open.collab.net/training/ctf/
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Remote publishing getsits own repository now. It islisted as a publishing repository in the SCM listing page. Please
check out the publishing repository and use it for all remote publishing activities.

9. Customize Project Home Page

Post migration, please check the Project Admin > Project Settings Home Page settingsto ensure that the desired
content is displayed as the Home page.

If the Show default project pagesand componentsoption is selected, the project home page displays project pages.
You will see the content of index.html (if you had onein CollabNet Enterprise Edition) in the project home page as
an html component. Moving forward, you will have to edit this html component through the PCE only and you can
not editi ndex. ht m directly in the repository to modify the project home page.

If the Show custom web page option is selected, the project home page displays content fromthewww/ i ndex. ht mi
of the 'Publishing' repository of the project. In this case, any changesto thewww/ i ndex. ht nl filewill bevisible
in the project home page.

You can refer this help page for details. Create a custom project home page on page 93
10. Change of CVSURL

CVSURLsused in CollabNet Enterprise Edition will work in TeamForge 6.1, but the repository path is different.
See the Sour ce Code tab of the TeamForge 6.1 project for the new checkout command for your CV S repository.
The CV S working copies must be recreated (checked-out afresh).

11. Subversion

Existing Subversion working copies can be used as available and do not require a fresh checkout, except for the
remote publishing content under the "www" folder.

12. Re-do project requests/posts

Unapproved project requests or discussion posts are not migrated to TeamForge 6.1. If you have project requestsin
CollabNet Enterprise Edition that were not approved until migration, it will have to be done afresh in TeamForge
6.1.

13. CollabNet Enterprise Edition's audit history

Audit history from CollabNet Enterprise Edition is not migrated into TeamForge 6.1, but the datais archived. Please
get in touch with your CollabNet representative for accessing the data.

Delegate site administration tasks with site-wide roles

INavigation title:Delegate site admin tasks |
To spread out the site administration burden, consider creating additional site administrators with permissions to do almost
everything afull site administrator can do.

To allow some CollabNet TeamForge users to use one or more TeamForge tools across projects, give them arole that
allows them to use project toolsin any project on the site.

Create additional site administrators
To assist in the administration of the CollabNet TeamForge site, a person must have a site administrator user account with a
corresponding role on that site. CollabNet TeamForge administrators can create suitable site-wide roles and del egate site
administration responsibilities.

g~ Note: You can choose site administration permissions via site-wide roles.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Roles.

Click Create.

On the Create Site-wide Role page, write aname and description for the role.
The role name is case-sensitive.

A w DN
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5. To prevent inheritance of the role into private projects, select the Prevent access option.

g~ Note: Selecting the option to prevent role inheritance does not affect access to public and gated projects. On
- selecting Prevent access, the user may not be allowed to do project-permissionsrel ated tasksin private projects.
6. Click Create.

The restricted site administrator roleis created. The Edit Site-wide Role Per missions page appears.

Note: You can select the permissions for site administration tools as well as for applications available across
all projects.

[ N

7. Select the apt site administration and/or project permissions listed on the Role Per missions page, to match the
responsibility assigned to a user with that role.

o Tip: You may not want to risk delegating the task of deleting projects, users, groups, roles or categories.

Theroleis created. You can assign it to site members at any time.

Modify the additional site administrators privileges
If restricted site administrators need to do things that are not allowed by arole you have assigned to them, you may need to
change the permissions associated with that role.

When you edit arole, all restricted site administrators with that role get the updated permissions automatically.

Tip: Youmay have prevented the access permission into private projects earlier. Now you can modify therestriction

[ 1§ o
or change other relevant permissions.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Roles.

From the list of roles, click the role you want to edit or select the checkbox and click Edit.
On the Edit Site-wide Role Per missions page, make the changes you need.

> w NP

« To edit thetitle or description of the role, click Edit.

» To edit the site administration and/or project permissions, choose an application from the left side of the page
and select or deselect permissions and resources.

* To edit the site members to whom the role is assigned, click Assigned Users.

5. Click Save.

Make selected users additional site administrators
You can empower site usersto assist in site administration by giving them a suitable role.
Depending upon the permissions you grant via site-wide roles, you can select site users who could be granted the
privilege.
1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Roles.
The existing site-wide roles are listed.

3. Click therole that you want to assign to the site users.

4. Onthe Edit Site-wide Role Permissions page, click the Assigned User s tab.
All users who currently have the role are displayed.

5. Click Add.

6. IntheFind a User window, select the site users you want to add, and move them from the Found Userslist to the
Selected Userslist. Click Add.
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7.

g~ Note: You can search by full or partial user name or full name to find the desired site members.

Click OK.

The additional site administrators are now ready to act! Their names are added to the Assigned Userslist.

Give project-independent access for project tools
To alow some CollabNet TeamForge usersto use one or more CollabNet TeamForge tools across several projects, create
site-wide roles with specific project permissions, minus site administrative permissions. Assign these site-wide roles to those
who may heed to access the project toolsin any project.

[ N

A w DN PR

Note: For example, you may want a user to be able to use Tracker across several projects. You don't need to create
and assign arole supporting the task individually across al projects. Just do it one time as a site-wide role and
assign it to the user.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Roles.

Click Create.

On the Create Site-wide Role page, write aname and description for the role.
The role name is case-sensitive.

To prevent inheritance of the role into private projects, select the Prevent access option.

Note: Selecting the option to prevent role inheritance does not affect access to public and gated projects. On

&
selecting Prevent access, the user may not be allowed to do project-permissionsrelated tasksin private projects.

Click Create.
The site-wide roleis created. The Edit Site-wide Role Per missions page appears.

g~ Note: You can select the permissions for applications and resources available across all projects.

Select the required project permissions listed on the Role Per missions page, to match the tasks you want the user
with that role to perform.

g Tip: Select "Tracker-Create” permission if you want the user to be able to create new trackers.

Theroleis created. You can assign it to site members at any time.

Provide ready-made roles

You might want to create rol es that projects across the site can use with minimum effort and maintenance. Using global project
rolesis an easy way of enforcing role-based similarities and removing role duplication across projects.

You can suggest to the project administrators to use common global project roles while assigning project tasksin
CollabNet TeamForge, instead of creating and managing several similar roles for their individual projects.

Create a global project role
To help project managers get their project members set up quickly, provide ready-made project roles that any project on your
Site can use.

Note: You need the "Role-Create" permission to create global project roles. All site administrators and some
restricted site administrators have this permission.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Roles.

Click the Global Project Roles tab.

All the existing Global Project Rolesare listed here. It isagood ideato check thislist before you create another role.
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Note: You can suggest that the project administrators check the Project Admin > Permissions > Roles >

i
View: Global Project Roles list before creating any new rolesin their projects.

4. Click Create.
5. Onthe Create Global Project Role page, write a name and description for the role.
The role name is case-sensitive.

g~ 11p: Remember that the role name can not be the same as a site-wide role name.

6. To allow inheritance of the role€'s permissions into private sub-projects, clear the Prevent I nheritance option.

7. To alow the project members to be able to request thisrole, select Project members can request thisrole.
Project members can submit requests for Available upon Request roles. For aproject, the project administrators can
set an Available upon Request role to be automatically granted to the project member requesting it.

8. Click Create.

The new global project roleis created. The Edit global project role per missions page appears.
9. Select the application permissions that are relevant to the role, from those listed on the Role Per missions tab.

I:., Tip: You may want to restrain providing project or application administration permissions, until required.

Theroleis created. The project administrators can assign it to their project members any time.

Modify a global project role
You may need to add or remove certain permissions from an existing global project role to assign new tasks or change the
access permissions given viatherole.

Note: Only site administrators or restricted site administrators with "Role-Edit" permission can edit global project
roles.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Roles.

3. Click the Glaobal Project Rolestab.
All the existing global project roles are listed here.

4. Select therole that you want to edit and click Edit or just click the hyperlinked role name.
The Edit global project role page appears.

5. Click Edit to make changes to the role details.

6. Modify the Role Name or Description, if required.
Therole name is case-sensitive and must not be the same as a site-wide role.

7. Change the inheritance setting to prevent or alow inheritance of the role's permissionsinto private sub-projects.

8. To make the role requestable or non-requestable, change the Project members can request thisrole setting.
Project members can submit requests for Available upon Request roles. For a project, the project administrators can
set aAvailable upon Request role to be automatically granted to the project member requesting it.

9. Click Update.

The global project roleis modified. The Edit global project role per missions page appears.

10. Select the application permissions that are relevant to the role, from those listed on the Role Per missions tab and

click Save.

Tip: You may want to restrain removing project or application administration permissions as the changeimpacts

L L
existing users too.

The role is modified.
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Delete a global project role
If you no longer need a global project role, you should delete it.

On deleting aglobal project role, all the user associations in the projects are removed.

[ 1

4,

5.

Note: Only site administrators or restricted site administrators with "Role-Delete" permission can delete global
project roles.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Roles.
Click the Global Project Roles tab.

All the existing global project roles are listed here.
Select the role that you want to delete and click Delete.
A confirmation message appears.

Click Ok to continue with deleting the selected role.

The selected global project role is deleted and all its associations are removed.

Manage projects as a group

To manage two or more independent projects, create aproject group in CollabNet TeamForge 6.1. Similar to projects, aproject
group provides the platform for sharing project members, roles and permissions across a group of projects. With some well
planned settings, you can manage several of your projects and also effectively control the project members accessing each

project.

To begin controlling multiple projects at one go, create a project group.

Create a project group
To begin managing your several projects together, create a project group in CollabNet TeamForge 6.1.

Note: When you create a project group, you are granted administration rights for the group and will be able to
perform actions such as adding or removing a project from the group. You will be listed as an administrator in the
group's Project Group Details. (Site administrators are exempt from this, since they can perform all actions on
the site without requiring specific roles).

Click Admin in the site navigation bar.
On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.

To create a new project group, click Create Project Group.
On the Create Project Group page, write a name and description for the project group.
The project group name must be unique, however, it can be the same as any of the projects.

The project group is created.

In your Project Group page, you can add projects, add project group members or specify roles for the project group.

[ 1

Tip: You can always come back to this page later to specify projects, users or roles that affect your project group.

Edit a project group
You can make changes to a project group to keep it updated with the various projects you may be managing with that in
CollabNet TeamForge C6.1. You must have the administrator permissions for project groups to make any modifications.

Tip: You could be either a site administrator or a project administrator, but you must have the project groups
administration permissions to manage projects as a group.
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Click Admin in the site navigation bar.
On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.

Click the project group that you want to modify. The Project Group Details page appears.

Click Edit and make the changes as required.

You can update the project group name, description aswell as the administrators.

To add one or more administrators for the project group, click the User Picker icon next to Administrators.

a) OntheFind a User page, select the required administrators, click Add and click OK.
The project group administrators are listed on the Project Group Details page.

The project group is modified.

From the Project Group Details page, you can add the projects, add project group members or specify the desired roles
for the project group.

Delete a project group
If the projects being managed under a project group have achieved their targets you may not need the project group anymore.
You can delete aproject group in CollabNet TeamForge C6.1. You must have the administrator permissionsfor project groups.

Tip: You could be either asite administrator or a project administrator, but you must have the project groups
administration permissions to manage projects as a group.

Click Admin in the site navigation bar.
On the site administration navigation bar, click Project Groups.
The existing project groups are listed here.

To delete a project group, select the project group from the list and click Delete.

You may get awarning message as the projects being managed under the group may have active role assignments.
Click OK on the message to proceed with deleting the project group.

The project group is deleted.

Tip: The relationship between projects and the project group is broken and you can no longer manage projects
using the deleted project group.

Add projects to a project group
You may be interested to start using the project group that brings your projects together. Add your projects to your project

group astheinitial step.

Tip: You could be either a site administrator or a project administrator, but you must have the project groups
administration permissions to manage projects as a group.

If you have just created your project group, you might already be on the Project Group Details page. Skip the first
three stepsin that case.

1
2.

Click Admin in the site navigation bar.
On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.

Click your project group. The Project Group Details page appears.
On the Project Group Details page, click Add to associate your projects with the project group.

A list of projects appears.
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o Tip: You can only add the projects for which you are the project administrator.

5. From the Choose a project table, select the projects and click Add.

The selected projects are added to the project group.

If you add an irrelevant project to the group, you can select it from the Project Group Details page and click Remove
to remove it from the project group.

Tip: You can aways come back to this page later to add more projects, specify users or roles that affect your

&
project group.

Manage user membership for a project group
Your project group needs to be set up with project group members to facilitate any administrative tasks that you may want to
do.

Tip: You could be either a site administrator or a project administrator, but you must have the project groups

[ i
administration permissions to manage projects as a group.

If you have just created your project group, you might already be on the Project Group Details page. Skip the first
three stepsin that case.

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.

Click your project group. The Project Group Details page appears.

From the left navigation pane, click the User M ember ship link to add users to the project group.
On the Project Group Membership tab, click Add.

On the Add User page, find the users you want by one of these methods:

S e

* Under Search for Users, filter thelist of site users eligible to join this project group. You can filter by full or
partial name or user name.

ol Note: Search text is not case-sensitive.

« Browsethelist of registered users on the site. Sort them by name, user name, email address or membership status.

Note: If asite hasagreat many users, you must filter them first to narrow down thelist. This helps avoid

&
slowing down the system.

7. Select the users you want to add.
8. Under Assign Roles, select the roles you want the usersto have.

You can select any available global project role or role created just for this project.

o Tip: If you prefer, you can skip this step and assign roles later on.

9. Saveyour changes.

» Click Saveto return to the Project Group Member ship page.
e Click Save and Add More to keep adding users.

The selected users are granted membership to the project group.

If you add a user who may not need to be amember of the project group, you can select the user from the Project Group
M ember ship page and click Remove to remove the user's membership.
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Manage users' access to project groups
Asaproject group administrator, you know that the key to any user's access to the project group and the projects belonging
to the group, isin the role you assign to the user. You can do amost all the role-related activities with project groups that you
could do with individual projects.

You can create site-wide roles and assign the users to those roles and then bring them into your project group. You can
create roles specifically for your project group and assign users to those or use global project roles, asrequired. The
permissions inherited via the assigned roles are subject to the "Prevent Inheritance" option setting done while creating
theroles.
Give a role to project group members

A role can be assigned to many project group users at once.

While the user-role matrix provides a convenient way to add project group membersto arole, it can become unwieldy
if the project has alarge number of users or roles. When that is the case, try assigning roles to multiple project group
users at onetime.

1. Click Admin in the site navigation bar.
2. Onthe site administration navigation bar, click Project Groups.

The existing project groups are listed here.

3. Click your project group. The Project Group Details page appears.
4. From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.

5. OntheRolestab, click the Global Project Rolesor Roles Created For a Project option of View, todisplay existing
global roles or roles created just for this project.

6. Click the name of the role that you want to assign to project group members.

7. Onthe Edit Role page, click the Assigned Userstab.
The Assigned User s page shows all users who currently have the role.

8. Click Add.
9. IntheFind a User window, select the project group members you want to add, and move them from the Found
Userslist to the Selected Userslist.

¢ Click Add to move selected users.
¢ Click Add All to move all users.

g~ Note: Youcan search by full or partial user name or full nameto find the desired project group members.

10. Click OK.

The project group members are now assigned the role.

Give roles to a project group member
A project group member can have any number of roles. As project group administrator, you must assign each project group
member's roles with care. The roles would impact not just an individual project, but would also grant same permissions across
the projectsin a project group.

Permissions are cumulative. The project group member has all of the access permissions allowed by all of the assigned
roles, plus any permissions that may have been assigned globally using application permissions.

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.

3. Click your project group. The Project Group Details page appears.
4. From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.
5. Click the User-Role Matrix tab.
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Observe the users listed on the left and all the available roles (global and direct) on the right. Users can be assigned
global roles and roles created just for this project.

6. Select rolesfor each project member.

7. Click Save.

Theroles are now assigned to each project group member.

Assign roles in multiple projects to a user group
Project managers can assign arole to multiple users at once by assigning the role to a user group that contains all those users.
Asasite administrator, you can do the same thing across multiple projects, by treating the projects as part of a project group.

1. Click Admin in the site navigation bar.

2. Onthe site administration navigation bar, click Project Groups, then click the project group you want to give arole
to.

3. OntheProject Group page, click Permissions.

4. OntheUser Group-Role Matrix tab, add the user group you want, then select the roles you want to assign to that
user group.

5. Click Finish or Finish and Add More.
g~ Note: When you give a group access to a CV'S or Wandisco Subversion repository, members of the group can

view the repository but cannot do repository actions, such as commit and update. You must assign those
permissions to users individualy.

Assign user groups to arole
To manage permissions for alot of groups or roles at once, try assigning user groups to roles.

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.

3. Click your project group. The Project Group Details page appears.
4. From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.

5. Onthe Rolestab, to display existing global or direct roles, click the global project roles or Direct Roles option of
View.
You can assign the project group users or user groups to a global project role or arole created just for this project.
6. Click the name of the role that you want to assign to the user group membersin the project group.

7. Onthe Edit Role page, click the Assigned User Groups tab.
The Assigned User Groupstable shows all user groups who currently have the role.

8. Click Add.
9. Type some of the group’s name in the Name (sear ch) box and click Find.
10. From the Add User Group to Roletable, select the user groups that you want to add, and click Finish.

Note: When you give agroup accessto a CV S or Wandisco Subversion repository, members of the group can
view the repository but cannot do repository actions, such as commit and update. You must assign those
permissions to users individualy.

The user groups are now assigned therole.

Create arole in a project group
A role defines the applicationsthat project group memberswith that role can use, and the specific things project group members
can do in each application.

Any project groups administrator can create and assign arole. It isagood ideato check the existing global project roles
before creating any new role for a project group.
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Note: Any existing site-wide or global project role can be associated with a project group. It is advisable to check
the permissions granted via arole before assigning it to users or user groupsin a project group asit would impact
more than a single project.

Click Admin in the site navigation bar.
On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.

Click your project group. The Project Group Details page appears.

From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.
On the Rolestab, click View: Roles Created For this Project Group.

You can view global project roles by selecting View: Global Project Roles before creating a new role for this
project.

Click Create.

On the Create Role page, write a name and description for the role.

To allow the inheritance of the role into private subprojects, de-select the Prevent I nheritance option.

Note: By default, the role inheritance into private subprojectsis prevented. For example, you may not want

i

administrator rolesto be inherited in subprojects, until required.
g Note: Selecting the option to prevent role inheritance does not affect public and gated projects.
Click Create.

Theroleis created. The Edit Role page appears.

For each application listed on the Role Per missions page, select the permissions and resources you want to make
available to users with thisrole.

g Note: Youcan specify access to individual top-level folders, but not to specific subfolders.

Click Save.

Theroleis created. You can assign it to project group members or user groups associated with the project group at any
time.
Edit arole in a project group

Asaproject group administrator, you may need to update the permissions granted by arole being used across the projects.

While modifying arole, it is better to be cautious about granting more access than required by the users or auser group.
In the case of project groups, as arole could be mapped across projects, consider being restrictive.

A w DN PR
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7.

Click Admin in the site navigation bar.

Click your project group. The Project Group Details page appears.

From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.
On the Rolestab, click View: Roles Created For a Project. The existing roles created for this project are listed.

You can view global project roles by selecting View: Global Project Roles, if required.

Select the role that you want to modify and click Edit.
On the Edit Role page, make the desired changes.

You can update the role name, description and inheritance settings on clicking Edit.
Therol€e's permissions, assigned users or assigned user groups can also be modified as required.

Click Save after making the changes.

Therolein the project group is updated.



148 | OpenTopic | How to use TeamForge 6.1

Delete arole in a project group
When you no longer need arole that you created for a project, it's agood ideato delete that role.

Any project groups administrator can create and assign arole. It is good to keep the project role tray as small and as
manageable as possible.

Note: Any existing site-wide or global project role can be associated with a project group. It is advisable to check
the permissions granted via arole before assigning it to users or user groupsin a project group as it would impact
more than a single project.

Click Admin in the site navigation bar.
On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.

Click your project group. The Project Group Details page appears.

From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.
On the Rolestab, click View: Roles Created For a Project.

You can view global project roles by selecting View: Global Project Roles. However, you can only delete roles
created for this project here.

Select therole and click Delete.

You may get awarning message if therole you are trying to delete isin use. Click OK to proceed with deleting the
non-required role.

The selected role is deleted.

Manage users
You can help projects succeed by creating and managing user accounts.

Communicate with all site users at once
To say something to everyone who uses your site, post a site-wide broadcast message.

For example, if you plan to upgrade your site, you may want to let users know afew days before your upgrade that the
sitewill be unavailable for a short time.

The broadcast message can be viewed even without logging into CollabNet

A w DN

Click Admin in the site navigation bar.

Click System Tools on the site administration tool bar.

Click Broadcast M essage.

In the Broadcast M essage field, type the message you want to broadcast and click Broadcast.

The message is displayed on all the pages of the site until it is deleted or replaced.

Create a new user account
To participate in a CollabNet TeamForge site, a person must have a user account on that site. CollabNet TeamForge
administrators can create these user accounts.

[ 1

Note: If your CollabNet TeamForge installation authenticates against an LDAP directory, CollabNet TeamForge
administrators cannot create new user accounts. On a site with LDAP authentication, each user must log into
CollabNet TeamForge using his or her LDAP user name and password.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Users.

Click the drop-down arrow next to Create and click Single User.

You can select Multiple User sto create several user accounts at one time.
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4. OntheCreate User page, enter a user name for the user.

Note: Your user name must meet these criteria

&
* Minimum number of characters as specified inthesi t e- opt i ons. conf
file.
e No spaces.

* At least oneletter.
e Thefirst character is aletter.

5. Enter and confirm a password for the user, if you prefer to set the user's password yourself.

Tip: Toinvite the user to create their own password, leave the Password blank. A What is a password ticket?
on page 261 will be emailed to the user by to let them create a password.

6. Enter the user's full name and email address.

]

L Tip: You can add more email addresses for the user after you finish creating their profile.

7. Enter the user's organization.

Organization can be a geographica designation, a corporate division, or whatever you want. It's advisable to keep it
consistent across your site.

8. Choose a user type.

¢ CollabNet TeamForgeadministrator - Administrators have unlimited accessto all datain CollabNet TeamForge

* Restricted user - Restricted users can only access projects of which they are members.

You can choose only one user type for each user.

g Note: If you do not select Restricted user, the user will be unrestricted. Unrestricted users can access all
projects that have not been made private by a project administrator.

9. To send awelcome message to the user, select Send Welcome M essage.
10. Click Create.

The user account is created.

Create multiple user accounts
To participate in a CollabNet TeamForge site, a person must have a user account on that site. CollabNet TeamForge
administrators can provide access to multiple users by creating their accounts together.

Note: If your CollabNet TeamForge installation authenticates against an LDAP directory, CollabNet TeamForge
administrators cannot create new user accounts. On a site with LDAP authentication, each user must log into
CollabNet TeamForge using his or her LDAP user name and password.

[ N

Click Admin in the site navigation bar.

On the site administration navigation bar, click Users.

Click the drop-down arrow next to Create and click Multiple Users.

On the Create M ultiple Users page, enter up to 25 lines like this, one user per line:

A w DN

user name user nane@our domai n. org nane organi zation Restricted

g~ Note: Usernames must meet these criteria:

* 1to 31 characters.
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e Only alphanumeric characters.
¢ No spaces.

« Atleast oneletter.

e Thefirst character is aletter.

Tip:

» Organization field is optional.

» To create an unrestricted user, omit "Restricted." Restricted users can only access projects of which they
are members, while unrestricted users can access all projects that have not been made private by a project
administrator.

» Use quotes around the full name or the organization information if it is more than a single word.

* A maximum of twenty-five user accounts can be created at one time.

5. Click Create.

The user accounts are created and password e-mails are sent to all the new users.

Create a user group

To manage multiple users at once, create a group that represents them.
1. Click Project Admin in the project navigation bar.
2. Onthe Site Administration page, click User Groups.

Note: In TeamForge 6.1, Groups (in earlier versions of the product) has been renamed to User Groupsto
better distinguish user groups from project groups.

3. Click Create and provide a name for the group and a description of its purpose.

Note: If your project isachild of another project, it may have inherited one or more user groups from its parent

[ i
project. To work with inherited users and user groups, you must go to the project that they belong to.

4, Click Create.

Add a user to a user group
Put together multiple users who share characteristicsin a user group.

1. Click Project Admin in the project navigation bar.
2. Onthe SiteAdministration page, click User Groups.

Note: In TeamForge 6.1, Groups (in earlier versions of the product) has been renamed to User Groupsto
better distinguish user groups from project groups.

3. Under User Groups, click the group to which you want to add the user.
4, Onthe Edit Group page, clickAdd.
5. Usethe picker to move usersinto the group, and click OK.

You can select the inherited project members also from the list.

6. Click Return.
Find a user
To find a user, filter the list all CollabNet TeamForge users on your site.

1. Click Admin in the site navigation bar.
2. Onthe Users page, click Show to reveal thefilter field at the top of each column.
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3. Filter the user list using one or more filter menus.

' Note:
* Searchtextis case-insengitive.
» Some search filters may not appear if your site's administrator has not enabled
them.
4. Click Apply.

All users meeting your filter criteria are displayed.

Find a user's groups
You can get a consolidated view of all user groups of which a user is amember.

1. Click Admin in the site navigation bar.
2. Onthe Users page, click the User Group Member ship tab.

The groups listed on this tab are the groups that this user is a member of.

Edit a user account
When a user has trouble accessing the site, you may need to reset the user's password or change the user's account status.

Note: If your CollabNet TeamForge site uses LDAP for single-sign-on, passwords must be reset in the LDAP

€
system, not on the Web administration pages. Ask your system administrator for help.

Important: To avoid disasters, TeamForge makes it impossible to delete or deactivate the TeamForge admin
account. You also can't remove the TeamForge admin flag or mark the admin user as a restricted user.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Users.

On the All Userslist, click the name of the user whose account you want to edit.
On the User Details page, click Edit.

On the Edit User Information page, make your changes and click Update.

You can specify upto amaximum of three alternate email addresses, if required.

o w DR

Act on multiple user accounts at once
A CollabNet TeamForge administrator can edit the status of multiple user accounts simultaneously.

For example, if you have multiple pending new accounts to approve, you can approve them in a batch instead of
individually editing each account.

Note: A pending user isauser who has requested an account but has not yet confirmed his or her email addresses.

[ i
g !mportant: Inthe case of CollabNet TeamForge admin accounts, you cannot make any of these edits:
» Delete the account.
» Change the account status to anything but active.
* Remove the CollabNet TeamForge admin flag.
* Mark it asarestricted user.
1. Click Admin in the site navigation bar.
2. Onthe site administration navigation bar, click Users.
3. Onthe Users page, select the users whose status you want to edit.
4. Click the desired status change.
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» Delete - Deleted users are removed from all projects. All assigned items are removed from the user. Deleted
users do not count against your CollabNet TeamForge license count.

« Deactivate - Deactivated users cannot log in to CollabNet TeamForge and do not receive notification messages,
but they remain members of projects and selection lists.

» Activate - Active users have full use of CollabNet TeamForge , subject to RBAC permissions.

Reset the admin account password
If your CollabNet TeamForge installation authenticates against an LDAP directory, follow these instructions to reset your
admin account password.

If your installation does not validate against LDAP, click Forgot Your Password on the CollabNet TeamForge home
page to reset the password for the admin account.

1
2.

3.
4,
5.

With aweb browser, go to the URL http://<host>sf/sfmain/do/f orgotAdminPassword.

On the Admin Account Password Retrieval page, Click Send Email.
CollabNet TeamForge sends an email to the address specified for the admin user.

Check your email and click the link provided to reset your password.
On the Reset Passwor d page, enter and confirm a new password.
Click Reset Password.

You can now log into CollabNet TeamForge with your new password.

Add ALM functionality to your site
If you started using TeamFForge as a source code management application, you can expand it to support the full range of
application lifecycle management functions.

Your license key allows for some number of users with ALM licenses and some number of users with SCM licenses.
(What's the difference?) To convert your site to ALM mode, one or more ALM user licenses must be included in your
license key and not assigned to any user.

1
2.
3.

If you don't already have a license to use TeamForge in ALM mode, talk to your CollabNet representative about
getting one.
To apply your ALM site license, see Supply your TeamForge license key.

Click Admin in the site navigation bar.
Click License Key in the Site Administration tool bar.
Click the Change Site M ode to dropdown list and select ALM.

Your site's users can now see and use the full range of applications on your site, including Tracker, Documents, Tasks,
and Reports.

[ 1

Note: When your siteisin ALM mode, any users you create get ALM licenses by default until all the available
ALM licenses are used.

Restrict your site to source code functionality
TeamForge suppports the full range of application lifecyle management functions, but you can also use it for only the core
source code management (SCM) functions.

[ 1

1
2.
3.

Note: Your site may have been switched to SCM mode due to alicense issue. (Why?) If thisisthe case, see Add
ALM functionality to your site on page 152 to fix it.

Click Admin in the site navigation bar.
Click License Key in the Site Administration tool bar.
Click Change Site Modeto SCM.
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Your site's users can now see and access only the Source Code, Discussions, and Wiki toolsin the toolbar.

g~ Noter Whenyour siteisin SCM mode, each user you create gets an SCM license by defauilt.

View all roles assigned to a user
A user can have multiple rolesin different projects either by being directly assigned those roles or by inheriting them. You
might find it useful to see all the roles assigned to a user in a TeamForge site before adding or removing arole.

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Users.
3. Inthe Rolestab, select arole typein the View dropdown - Directly Assigned Roles, Roles Inherited From Parent
Project or Site-wide Roles.
* Rolescreated for this project include the roles the user is directly assigned or assigned through a user group in
projects and project groups.
» Inherited rolesinclude the roles the user inherits from parent projects and project groups.

Support projects
CollabNet TeamForge administrators can do a variety of things to help projects on the site be successful.

Create a new project
CollabNet TeamForge administrators can create new projects without having to submit them for approval.

Note: When a CollabNet TeamForge administrator creates a new project, he or she is not made a member of the
project, and the Founder Project Admin role is not created. To designate a project administrator, you must add the
user to the project, then create and assign a project administrator role manually.

[ 1

Click Admin in the site navigation bar.
On the site administration navigation bar, click Projects.
Inthelist of CollabNet TeamForge projects, click Create.

On the Create Project page, provide aname for the project.
Thisisthe name that will appear in all project lists and on the project home page.

5. Enter aURL name for the project, if appropriate.
Thisisthe name that will appear in the project's URL.

6. Write adescription of the project.
7. Select aproject template.

A project template is used to pre-populate new projects with the structure and configuration of an existing project.
If you do not want to use a project template, choose None.

> w NP

Note: If you create a project from atemplate that contains an integrated application, you may have to provide

&
some information specific to the integrated application. For example, for Project Tracker you must set a new
artifact prefix that is different from the prefix in the template.

8. Click Create.

The project is created.

Approve a new project
Any registered CollabNet TeamForge user can request anew project. A new project is activated only after asite administrator
approvesit.

Before approving a new project, you have the option to review the project details.

1. Click Admin in the site navigation bar.
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2. Onthe site administration navigation bar, click Projects.
3. Click the Pending Projects tab.
4. Onthe Pending Projects page, select the projects you want to approve.

« Click Approve to approve the project and move it to the All Projects page with status Active.
« Click Reject to reject the project and remove it from thelist.

The project requester receives an email notification when the project is approved or regjected. If you entered a comment,
that also appears in the email notification.

Rename a project
Asthe focus of a project shifts, its name or description can become obsolete. A site administrator can update the name or
description to help keep the project current.

1. Click Admin in the site navigation bar.

Click Projects.

In the CollabNet TeamForge project list, click the project you want to edit.
On the project home page, click Project Admin.

On the Project Settings page, make the changes you need.

Click Save.

© 0k~ WD

Delete a project
If you no longer need a project or any of the datain it, you should delete it.

Deleting aproject deletesall of the datawithin it, with the exception of source code data, which is maintained separately
from the rest of the site's content.

4. Caution: Delete aproject only if you are sure that you no longer need any of the datawithin it. Move any items
' that you want to save.

' Note:

* You can delete a parent project only when its members, user groups and roles are not in usein any other project.

» When you delete a parent project, the direct subprojects are moved one level up; that is, under the immediate
parent of the deleted project.

» |f the deleted project has no parent, its subprojects become root-level projects.

1. Click Admin in the site navigation bar.
2. Onthe site administration navigation bar, click Projects.
3. From the CollabNet TeamForge project list, choose the project that you want to delete and click Delete.

The project is deleted.
Delete a project
If you no longer need a project or any of the datain it, you should delete it.

Deleting aproject deletesall of the datawithin it, with the exception of source code data, which is maintained separately
from the rest of the site's content.

A Caution: Delete aproject only if you are sure that you no longer need any of the data within it. Move any items
' that you want to save.

' Note:

* You can delete a parent project only when its members, user groups and roles are not in usein any other project.
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* When you delete a parent project, the direct subprojects are moved one level up; that is, under the immediate
parent of the deleted project.
» |If the deleted project has no parent, its subprojects become root-level projects.

1. Click Admin in the site navigation bar.
2. Onthe site administration navigation bar, click Projects.
3. From the CollabNet TeamForge project list, choose the project that you want to delete and click Delete.

The project is deleted.

Lock or unlock a project
To ensure that no changes occur in aproject while you are collating or migrating project data, lock the project. You must have
project administration permissions or be a site administrator to lock or unlock a project.

To lock or unlock a project in CollabNet TeamForge, go to Project Settings and lock/unlock the project.

Note: A locked project does not allow any member (including project administrators and site administrators) to
make any changes to the project. Besides that, alocked project can not be set as the parent project for any other
project and tasks like adding, editing or deleting integrated applications are also not allowed.

Click Project Admin in the project navigation bar.

The project islocked or unlocked as desired. Thelock icon 5 Locked appearson all the project pages while the project
islocked.

Note: If alocked project has an integrated application, for example, project tracker, all the project tracker pages
are also non-editable while the project islocked. The user who has access permissionsfor the integrated application
can only view the pages.
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Update a project template
To revise or correct an existing project template, overwrite it with atemplate of the same name.

You must be a site administrator to overwrite an existing project template.

1. Revisethe project that will serve as the basis for the new project template.

Tip: You can disable a project template while you make changes to the project. To disable a project tempate,

&
usethe My Workspace > Projects > Templates page.

Click Project Admin in the project navigation bar.

On the Project Settings page, click Create Project Template.

On the Create Template page, select Replace Existing Template and choose the template you want to overwrite.
Change the name and description of the template if necessary.

o~ wD

g~ 11p: It'sagood ideato use the description to note the changes from the previous version of the template.

6. Select the items you want to be available when new projects are created from this templ ate.

The replacement project template is created. Its name and description appear on the Template tab of the Projectslist,
accessible from your personal navigation bar.

Enable or disable project templates
Site administrators or users with site-wide roles with the project administration permissions only can enable/disable project
templates.

In CollabNet TeamForge, enable a project template to make it available for use while creating new projects.
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Click My Workspace in the TeamForge tool bar.

On the My Wor kspace page, click Projects and select the Templates tab.

To make the project template available for use, select the template and click Enable.
To stop making the project template available for use, click Disable.
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When projects are created afresh, only the enabled project templates are displayed.

Require documents to be associated with artifacts
To help reduce the problem of "orphan™ documents, require users who create a document anywhere on the site to associate
the document with an artifact.

"Orphan" documents are documents that are abandoned because they are not connected to any tracked activity.

Opentheconf/ si te-opti ons. conf fileinatext editor.
Change the value of the sf.requireAssociationOnDocumentCreate variable to true
Change the value of the sf.allowedAssociationTypeOnDocumentCreate variable to [ TrackerArtifact]

If you want to prevent users from associating documents with closed artifacts, change the value of the
sf.requireArtifact ToBeOpenOnDocumentAssociation variable to true

Saveconf/site-options. conf.
6. Recreate the runtime environment.

A w NP
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./linstall.sh -V -r -d /opt/collabnet/teanforge

Manage project categories
To help users navigate your site, help them sort projects into categories that make sense.
Add a project category
When you set up project categories for your site, project administrators can use this taxonomy to organize their projects.

You can create any number of top-level categories and any number of sub-category levels.

1. Click Admin in the site navigation bar.
2. Onthe site administration navigation bar, click Categories.
3. IntheProject Categoriestree, find the location where you want to create the new category.

< Highlighting Project Categories creates a new top-level category.
« Highlighting any category creates a sub-category beneath it.

4. Click New.
5. Inthe Create Category window, write a name and description for the category.
6. Click Save.

The category is created. It appears in the Project Categories navigation tree, and is available for use by all project
administrators when categorizing their projects.
Edit a project category
A project category's membership and function may change over time. If it does, you can update the category's name or
description.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Categories.
The Project Categories tree displays the hierarchy of existing categories.

3. IntheProject Categoriestree, find the category that you want to edit.
4. Make the changes you need and click Update.
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Move a project category
You can reorganize projects by moving a project category to another place in the project category hierarchy.

You can move a project category in the following ways:

From atop-level category to a sub-category
From a sub-category to atop-level category
From a sub-category to another sub-category

When you move a project category, any sub-categories that it contains are also moved to the destination category.

SEFCENE -

6.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Categories.

On the Project Categories page, find the project category you want to move.

On the Edit menu, click Cut.

Find the location to which you want to move the selected project category.

You can move a project category either to the root category or into any other project category.

Choose the Paste option from the Edit menu.

The project category is now moved to the selected destination.
Delete a project category
If you no longer need a project category, you should delete it.

When you delete a project category, all of its sub-categories are also deleted.

1
2.

3.
4,

Click Admin in the site navigation bar.

On the site administration navigation bar, click Categories.
The Project Categories tree displays the hierarchy of existing categories.

Using the document tree, find the project category that you want to del ete.
Choose Delete from the Edit menu.

The project category and all of its sub-categories are del eted.
Stop using project categories
If you do not need to sort projects into categories, remove the ability to do so on your site.

By default, project categorization is disabled for new CollabNet TeamForge installations.

[ 1

1
2.
3.

Note: Disabling project categorization does not del ete categories you have already set up.

Click Admin in the site navigation bar.
On the site administration navigation bar, click Categories.
On the Project Categories page, select Disabled and click Update.

Project categorization is disabled for your CollabNet TeamForge installation.

Add a parent project to your project
You can coordinate work among multiple projects; enable the user, user group and role inheritance by adding acommon parent
project to several projects.

[ N
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Note: A subproject can have only one parent. You can change or remove that parent at any time.

Note: You must be a project administrator or site administrator to add/edit or remove the parent projects.

Click Project Admin in the project navigation bar.
On the Project Settings page, click Edit Parent.
Click Add Parent.
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4. Onthe Choose New Parent page, choose a parent project that it makes sense for your project to belong to, and click
Confirm.

g~ Note: You cannot add a parent project for the 'Look’ project asit is a special project in itself.

Separate a subproject from its parent project
When a subproject grows beyond its original scope, you may want to make it stand-alone project or move it to a different
project hierarchy.

By removing the association with a parent project, you can manage the subproject as a separate project.

Note: Only one parent project can be selected for a subproject. However, the parent project can be changed or

L !
removed, as required.

1. Click Project Admin in the project navigation bar.
2. OntheProject Settings page, click Edit Parent.
3. Change or remove the parent project as required.

You can be a project administrator or a site administrator to change or remove a parent project. As a project
administrator, you can remove or change a parent project only if you have administrator permissions for both the
projects that are being linked.

Note: A parent project can be removed or changed only when its members, user groups and roles are not in
use in any other project. In other words, you can not remove/change a parent project while its members, user
groups or roles are in use in any other project.

[ 1

e « Click Change Parent to choose another parent project.
* Onthe Choose a Parent Project page, select the desired parent project and click Confirm.

Note: If the project hierarchy exists, the project and its subprojects are moved only under the project from
which members, user groups or roles are inherited. If project hierarchy does not exist and no inheritance is
in use, the project is made a'Root' project.

e « Click Remove Parent to remove the association with parent project.
«  On the pop-up message box, click OK, if you wish to make the project a'Root' project.

The project hierarchy is changed or removed in accordance with role based access control and inheritance rules.

Provide source control services

You can add a source control server to the CollabNet TeamForge environment at any time after CollabNet TeamForge
installation is complete.

Integrate a source code server
A site must have one or more servers to handle source code repositories and users. The source code server can be the same
machine as the application server or a separate machine.

When you set up amanaged software configuration management (SCM) server, you enable usersto create, manage and
share repositories through CollabNet

Note: The ability to add integration servers depends on the value of the
DISABLE _CREATE_INTEGRATION_SERVERSflaginthesi t e- opti ons. conf file. You can add new
integration servers when the flag is set to its default value of "false".

TeamForge.

You can integrate more than one source code server of agiven type. For example, you can have two or more Subversion
servers on your site. Consult a system administrator about the requirements for setting this up.
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Tip: If you use a source code solution other than Subversion, CV'S, or Perforce, you can integrate it using the
CollabNet TeamForge SOAP APIs. This enables you to exchange commit data with any SCM application. Consult
your CollabNet TeamForge system administrator.

Note: CVS serversthat integrate with CollabNet TeamForge must use the native UNIX/Linux authentication
method, and not external authentication mechanisms such as NIS, NIS+, Winbind, Active Directory, or LDAP.
TeamForge creates and manipulates local system accounts using the default user add, user nod, gr oupadd,
groupdel ,anduser del commands. It expectsto find any accounts or groupsit createdin/ et ¢/ passwd and
/ etc/ group.

Click Admin in the site navigation bar.

Click Integrations.

On the SCM Integrations page, click Create.

On the Create I ntegration page, write aname and description for the integration.
Choose the type of SCM server you want.

o w e

Note: When you give agroup access to a CV S or Wandisco Subversion repository, members of the group can
view the repository but cannot do repository actions, such as commit and update. You must assign those
permissions to usersindividually.
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Note: The SCM Adapter option only worksif you have created your own SCM integration using the CollabNet
TeamForge SOAP APIs.

6. Supply the host name for the Soap Service Host.
Thisisthe network address of the machine on which the integrated service, such as Subversion, is running.

Note: Thedefault| ocal host will work only if the integration server is on the same server as the CollabNet
TeamForge server.

[ 1

7. Leavethe default valuesin the SOAP Service Port field.
8. Specify whether userswill use SSL to connect to their repositories.

9. Changethe Repository Root value if you want to store the repository on your server in a different location.
The repository root is the top-level directory under which al source code repositories reside.

10. Select Requires Approval if an administrator must approve al repositories created on the server. By defaullt,
unmanaged serversrequire approval for al repositories, because repositories must be created and integrated manually.
11. For a Subversion or CV S server, supply the URL by which your users will access the service.

Thiswill beof theformht t p: / / <nyscnserver. con®/i nt egrati on/ vi ewc/ vi ewc. cgi

Important: If your system administrator has upgraded your site from SourceForge Enterprise Edition 4.4 or

&
earlier, remove the port number in the SCM Viewer URL.
Tip: If you areworking with a CV'S server that uses Pserver authentication, ask your system administrator for
the right URL.

12. Click Save.

CollabNet TeamForge attempts to validate the SCM viewer URL. If it cannot validate the URL, you can:

» Correct it if you have entered it incorrectly.
e Sdect Savewith errorsif the URL isdifferent for an end user than it is for the CollabNet TeamForge server;
for example, if you have afirewall in place.

» If you are adding a managed source code server, it is now added. All projects can now establish repositories on the
server.
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» If you are adding an unmanaged CV S server, al projects can now request repositories on the server. A CollabNet
TeamForge administrator must create and integrate them manually.

g Note: Only CV'S servers can run unmanaged.

Approve a source control repository request
When a user requests a source code repository on a source control server for which you have required approval, a CollabNet
TeamForge administrator must approve the request before the repository is created.

When adding a source control server integration, you have the option to require CollabNet TeamForge administrator
approval for all repositories created on the server.

When a user requests a source code repository on amanaged SCM server, the repository is created automatically after
it is approved by a CollabNet TeamForge administrator.

Note: Before approving a source code repository request for an unmanaged SCM server, a CollabNet TeamForge
administrator must create and integrate the repository manualy.
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Click Admin in the CollabNet TeamForge navigation bar.

On the site administration navigation bar, click I ntegrations.

On the SCM Integrations page, click the Pending SCM Integrations tab.

From the list of pending SCM repository requests, select the SCM repositories that you want to approve.
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e Click Approveto approve the repository.
» Click Reect to reject the project and remove it from the list.

The person who reguested the repository receives an email notification when the repository is approved or rejected. If
you entered a comment, that also appears in the email notification.

Approve an unmanaged CVS server access request
When a user asks for access to an unmanaged CV S server, an administrator must approve or reject the request.

When a project administrator assigns arole that provides SCM access to a project member, a CollabNet TeamForge
administrator must manually create the user account on the SCM server. Because user creation is not managed by
CollabNet TeamForge , CollabNet cannot verify that the user account has been created. A TeamForge administrator
must confirm that he or she has created the account.

Requests for SCM access removal are also submitted for manual confirmation by a TeamForge administrator.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Integrations.

On the SCM Integrations page, click the SCM Access Requests tab.
Create the requested user account on the unmanaged CV S server.
After the user account is created, select the request and click Approve.

o s w D

The user receives an email notification that the user account has been created.

Edit SCM integration details
You can move or reconfigure a source control server without having to reintegrate the server into CollabNet TeamForge .

Tip: If you edit or lose the permissions on your SCM server, use the Synchronize Per missions button on the SCM
I ntegr ations page to recreate the correct permissions on your SCM server from CollabNet TeamForge .

=

=

Click Admin in the CollabNet TeamForge navigation bar.
On the site administration navigation bar, click I ntegrations.
Onthe SCM Integrations page, click thetitle of the SCM integration you want to edit.

w N
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4. Onthe Edit Integration page, make the changes you need and click Save.

Move a source code repository
When the existing code base for an application may need to be managed by a different team or project, you can move the
source code repository from the first project into the other one.

g~ Note: You can move only Subversion repositories this way.

Open the project from which you want to move a source code repository.
Click Source Codein the project navigation bar.

Select the repository you want to move and click Cut.

Open the project into which you want to move the repository.

Click Source Codein the project navigation bar.

Click Paste.

o 0k~ wbdPE

Connect to a Subversion Edge console
When a Subversion Edge server has been converted to a SCM Integration server in TeamForge, you can log into its management
console from within TeamForge.

1. Click Admin in the site navigation bar.

2. Onthe site administration navigation bar, click I ntegrations.

3. Inthelist of serversonthe SCM Integrations page, click the Open Console link for the Subversion Edge server
you want to connect to.

g~ Note: Only Subversion Edge servers have thislink.

The login page for the server's management console appears. You can log in using your TeamForge administrator
credentials and view statistics such as network throughput and disk space usage for the server.

Discover a Subversion Edge server
Subversion Edge (version 1.1 and higher) serversregister their service on your local network using the DNS-Service Discovery
protocol. TeamForge administrators can see them.

Subversion Edge servers that were converted to TeamForge servers are displayed in the SCM I ntegr ations page.
1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click I ntegrations.
3. Onthe SCM Integrations page, click Discover Subversion Edge Servers.

A Javaapplet islaunched, and you will see alist of Subversion Edge serversin your LAN.
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COLLABNET. TeamForge.

Site Administration
| o 73 | .. g=
Projects Users Groups Integrations Categories

Discover Subversion Edge Servers

CollabMet Subversion servers register their service on your network using the DMNE
can only discover services running on the same TCP/IP subnet. Although with the ¢

http://127.0.1.1:8080/csvn
http://10.1.6.53:3343/csvn
http://10.1.6.222:3343/csvn
http://10.1.7.73:8080/csvn
http://10.1.6.41:3343/csvn

Current Domain: ) http://cul87.cubit.sp.collab.net: 808

Having problems viewing the applet? Try Java WebStart

=% Paunch™

You can click on a server to connect to it. To bring in the power and capabilities of TeamForge, you can convert the
Subversion Edge server to a managed SCM integration server in TeamForge.

Manage replicas
A replica server in TeamForge is a Subversion Edge server that replicates the content of an existing core SCM integration

Server.

Approve areplica server request
When there is arequest for areplica of acore SCM integration server, a TeamForge administrator must approve the request

before thereplicais created.

Replicarequests from a TeamForge admin user or site administrator are automatically approved. Replicas requested by
other users need approval by a TeamForge administrator.

1
2. Onthe site administration navigation bar, click I ntegrations.

3.

4. From thelist of pending SCM replicarequests, select the SCM replicas that you want to approve.

Click Admin in the CollabNet TeamForge navigation bar.

Onthe SCM Integrations page, click the Pending SCM Replicas tab.


http://help.collab.net/topic/csvn/action/convertcsvntotf.html
http://help.collab.net/topic/csvn/action/convertcsvntotf.html
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« Click Approveto approve thereplica.
« Click Reject to reject the replica and remove it from the list.

When areplicais approved, it islisted in the SCM I ntegr ations page beneath the master SVN server.

Edit replica settings
As a TeamForge site administrator, you can configure replica settings for the polling frequency of the master, and repository
initialization and synchronization events.

Replication events, such as creating new repositories and synching commits, are stored in a queue on the TeamForge
application server. The replica server polls the TeamForge application server for new events and then processes those
events on the replica server.

These events are divided into two separate pools:
« New repository initializations - this includes creating the repository and performing the initial synchronization of

the content.
* All other events

When existing repositories are selected for replication, this can take along time. It could take many hours or even days
to fully replicate an entire repository across aWAN. These big events are processed in their own thread pool, so that
other repositories which are already synchronized don't have to wait in line for them to finish.

For each pool, you can define how many simultaneous events will be processed. The higher the number, the greater the
potential load on both the TeamForge replica server and the Subversion master. However, this can aso decrease the
wait time for a given commit to appear on the replica server.

1. Click Admin in the CollabNet TeamForge navigation bar.
2. On the site administration navigation bar, click I ntegrations.
3. Onthe SCM Integrations page, click the name of the Subversion Edge replica you want to edit.

The Edit System page for the replica appears. Here's an example:
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Subversion Edge Replica

Mame; = Londor|
Descrintion=* T T Command polling interval:*
escription:
. ERlica SErver in Londan arice Maximum simultaneous new repository initializatio
Maximum simultaneous repository synchronizatior
Hostname: cu135,coud. sp.collab.net

Master Integration Server: Subwversion

Managed By: Subversion Replication (svnedge)
Approval Status: Approved
Last Contact: Wed Mar 23 15:13:28 PDT 2011

Recent Replication Command History

Status Replica Command Repository Revision Created Date
-J Sync repo reps1004: i18n 8 Wed Mar 23 12:29:25 POT
J Start replicating repo reps1005: Docs - Wed Mar 23 12:16:36 POT
', Startreplicating repo reps1004: i18n = Wed Mar 23 12:07:43 POT
) Update server properties - - Wed Mar 23 12:07:26 POT

Ranlirs carvar rem ect annrmeed _ _ -

4. Change the replicaname or description if required.

L Tip: Including the geographic location would help users select anearby replica.

5. Set Command polling interval to define how frequently the replica polls the master looking for new events. The
replicawill process all new events when it polls.

The default value for this setting is 60 seconds, but it can range from 5 to 12000000 seconds.

6. Set Maximum simultaneous new repository creationsto alow value.
New repository initializations can take along time and generate alot of load. So you wouldn't want to allow too
many of them to run at once. This value can range from 1 to 100, but we suggest you keep it at 3 or less.

7. Set Maximum simultaneous repository synchronizations taking into account how many repositories you will be
replicating and how many you think are likely to have commits occurring within the polling interval.

This value can range from 1 to 100. You may want to set this higher than the previousfield, but we suggest you keep
it at 10 or less. There's no reason to enter too high anumber because you are merely specifying how many synchs
can run at the exact same time -- and it never runs more than one per repository.

8. When you've made your changes, click Save.

Remove areplica
When you remove areplica from TeamForge, it is restored to a Subversion Edge server in standalone mode.

1. Click Admin in the CollabNet TeamForge navigation bar.
2. On the site administration navigation bar, click Integrations.
3. Inthe Edit System page for the replica, click Delete.

The replicais removed from TeamForge. The repositories that existed on the replica are deleted.
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Integrate an unmanaged CVS repository with CollabNet TeamForge
After creating the repository, you must modify two triggers, ver i f ynsg and | ogi nf o, to complete the integration with
CollabNet TeamForge .

The triggers must be modified manually, because much of the information in the triggers is specific to your CollabNet
TeamForge installation.

Each trigger must be modified to runa. j ava program. These topics provide an annotated example and instructions
on modifying and installing the trigger files.

g~ Note: You must create the CV S repository before you can modify and install the trigger files.

Note: CVS serversthat integrate with CollabNet TeamForge must use the native UNIX/Linux authentication
method, and not external authentication mechanisms such as NIS, NIS+, Winbind, Active Directory, or LDAP.
TeamForge creates and manipulates local system accounts using the default user add, user nod, gr oupadd,
gr oupdel ,anduser del commands. It expectsto find any accounts or groupsit createdin/ et ¢/ passwd and
/et c/ group.

Create a loginfo trigger file
Here's now to create the loginfo trigger file.

1. Check out the module CVSRQOOT from the CV S repository.

The CVSROOT moduleis automatically created in all new CV Srepositories, and containsthever i f ynmsg and
| ogi nf o files. When created, the files contain only comments.

2. Begin modifying thefile by inserting ALL followed by atab.
This enables CollabNet TeamForge to see al modulesin the repository.

3. Moadify the path to your Java home directory asin this example and add it to the file, followed by a single space.

Example M odification

/usr/local/javalj2sdkl. 4.1 01/ bin/java|Replace/usr/| ocal /javalj2sdkl.4.1 01/
-cp with the directory in which you have installed Java.

4. Modify the pathstothe. j ar files as shown here, then add them to the file separated by colons.

Examples M odifications
/yourdirectory/sourceforge _hone/lib/saaj.jar Replace
/yourdirectory/sourceforge hone/lib/axis-1.1rcl-va.jar /yourdirectory/
/yourdirectory/sourceforge_hone/lib/saturn.jar with the directory in
/yourdirectory/sourceforge_hone/lib/jaxrpc.jar which you have installed

/yourdirectory/sourceforge_hone/lib/externalintegration.jar |CollabNet TeamForge.
/yourdirectory/ sourceforge_hone/lib/commons-di scovery.jar
/yourdirectory/sourceforge_hone/lib/comons-1| oggi ng.jar
/yourdirectory/sourceforge_hone/lib/log4j-1.2.8.jar

5. Modify the parameters as follows:

Example M odification

-Dintegration.name=exsy1001 Replace exsy1001
with the ID of your
SCM server
integration with
CollabNet
TeamForge.
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Example

M odification

Note: Tofind
the ID, click
Admin >

I ntegrations >
Integration
Name. ThelD
appears at the
end of the URL.

[ 1

-Dcvs.cvsroot=$CV SROOT

No change

-Dappserver.url=http://local host:8080/ce-soap50/services/ScmL i stener

Replace localhost
with the name of
your machine
running CollabNet
TeamForge.

Note: If
needed, replace
8080 with your
SOAP server
port.

[ 1

-Dcevs.username=$USER

No change

-Dlogd4j.configuration=file:/yourdirectory/sourceforge_home/etc/externalintegration/log4j.xml

Replace
/yourdirectory/
with the directory in
which you have
installed CollabNet
TeamForge.

-Dexternalintegration.triggers.log.dir=/tmp

No change

6. Add the following Java class containing the body of the trigger.

com vasof tware. sf.external integration.triggers.cvstriggers. Loglnfo

% sWw}

7. Check your file against the completed example shown on Completed loginfo trigger file.
8. When you are finished, check the modified file back into your CV S repository.
If you have not aready done so, repeat the process for the verifymsg trigger file.

0w
messages.
Create a modified verifymsg trigger file

Here's how to modify the verifymsg trigger file.

1. Check out the module CV SROQT from the CV Srepository.

Note: If you make an error in the file, commits made to the repository will not fail, but you will receive error

The CVSROOT moduleisautomatically created in all new CV Srepositories, and contains the verifymsg and loginfo

files. When created, the files contain only comments.

2. Begin modifying thefile by inserting .* followed by atab.
This enables CollabNet TeamForge to see al modulesin the repository.




3. Modify the path to your Java home directory as indicated bel ow.

Add it to thefile, followed by a single space.
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Example M odification

/usr/local/javalj2sdk1.4.1_01/bin/java-cp
you have installed Java.

Replace /usr/local/javalj2sdk1.4.1 01/ with the directory in which

. Maodify the paths to the .jar files as shown in the following table.
Then add them to the file separated by colons.

Examples

M odifications

/yourdirectory/sourceforge_home/lib/sagj.jar
lyourdirectory/sourceforge_home/lib/axis-1.1rcl-vajar
/yourdirectory/sourceforge_home/lib/saturn.jar
lyourdirectory/sourceforge_home/lib/jaxrpc.jar
/yourdirectory/sourceforge_home/lib/externalintegration.jar
lyourdirectory/sourceforge_home/lib/commons-discovery.jar
/yourdirectory/sourceforge_home/lib/commons-logging.jar
/yourdirectory/sourceforge_home/lib/log4j-1.2.8.jar

Replace /yourdirectory/ with the
directory in which you haveinstalled
CollabNet TeamForge .

5. Modify the parameters as follows:

M odifications

Examples
-Dintegration.name=exsy1001 Replace exsy1001
withthe D of your
SCM server
integration with
CollabNet
TeamForge .
g Note: To find
theID, click
Admin >
Integrations
>|ntegration
Name. The
ID isat the
end of the
URL.
-Dcvs.cvsroot=$CV SROOT No change

-Dappserver.url=http://local host:8080/ce-soap50/services/ScmL i stener

Replace localhost
with the name of
your machine
running CollabNet
TeamForge . If
needed, replace
8080 with your
SOAP server port.

-Dcevs.username=$USER

No change
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Examples M odifications

-Dlogdj.configuration=file:/yourdirectory/sourceforge_home/etc/externalintegration/logdj.xml | Replace
lyourdirectory/
with the directory
in which you have
installed CollabNet
TeamForge.

-Dexternalintegration.triggers.log.dir=/tmp No change

6. Add the following Java class containing the body of the trigger:
com.vasoftware.sf.externalintegration.triggers.cvstriggers.VerifyM essage

7. Check your file against the completed example shown on Completed verifymsg trigger file.
8. Check the modified file back into your CV S repository.
9. If you have not already done so, repeat the process for the loginfo trigger file.

Note: If youmakean error inthefile and check it back into your CV Srepository, all commits made to the repository
will fail. To correct thefile, you cannot simply check it out and fix it. You must fix it on the repository. After fixing
the file on the repository, you must then check it out, fix it again, then check it back in.

Change your site's look and feel
You can redesign some aspects of your site to suit your organization's needs and preferences.

Theseinstructions support only some basic types of customization. Almost infinite varieties of customization are possible.
To get into specific customization optionsin more detail, search or post aquestion on the CollabNet TeamForge discussion
forum or talk to your CollabNet representative.

Important: Because of the many new featuresin TeamForge 6.1, the effects of some of your existing customizations
may have changed. As you begin using TeamForge 6.1, pay specia attention to any SOAP calls or VVelocity macros
contained in the files you have customized.

[ 1

Customize anything on your site
Follow these general instructions to customize a page, picture, text string, or other element on your site.

g~ |mportant: Custom branding changes can be overridden when your site is upgraded to a new version. You may
~ haveto reapply any look-and-feel modifications after an upgrade.

1. Download the sample branding files.
Choose one of these files:

« Basic branding package: Contains the files you need to do most of your branding tasks. Safest to use thisfileif
you are doing your own branding.

» Advanced branding package: Containsall thefilesthat can be customized. For use when someone from CollabNet
is helping you with your branding.

Note: It isimportant that you have the most recent available version of this archive as a starting point. Check
that the version number at the top of ther eadne. t xt filein your copy of the branding package is the same
asyour version of the application. If it is not the same, check ww. col | ab. net to seeif thereisamore
recent version.

[ N

2. Inthel ook project, check out the br andi ng repository.

3. Copy the default version of the appropriate file from the branding zip file to the equivalent directory in your local
copy of thebr andi ng repository.

4. Change the file to produce the results you want.


http://forums.open.collab.net/ds/viewForumSummary.do?dsForumId=736
http://forums.open.collab.net/ds/viewForumSummary.do?dsForumId=736
../../com.collabnet.doc.common/downloads/BrandingBundle-Basic-6.1.0.0.353.zip
../../com.collabnet.doc.common/downloads/BrandingBundle-Advanced-6.1.0.0.353.zip
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For example:

» To change alogo on your site's home page, overwrite the hone. gi f file with anew file of the same name.
« To change alogo on a project home page, overwrite the pr oj ect . gi f file with anew file of the same name.

5. Commit the changed filesinto your site’'sbr andi ng repository.

g |mportant: Your br andi ng repository does not have to contain all the files that are in the sample branding zip
file, but the structure of your repository must be an exact mirror of the structure of the sample file set.

I 0 WollabNelengineeringWCSFE 5. 00Branding Q5 randing QuickSiarl_zip r__lrl:l_lil
Flz £ Wew  Faeorbes  Took  Hel o
GFh‘k L > :j‘ S seach [ Folders =)= Project: look
ez ([0 Dol kel bl lergineariog) CSFE 5.0(Brancding CEBean dng_chickELart s v| B e ™ = = s | =
Propectome  Tracker  Doouments Tesks  Source Lode Deossos
Faliler Tasks = _'_,_;I _'_,_;I _'_,_;I _'_,_;I [branding]
. " e *
f
fa
Other Mlaces _,d-nl | File - lb:' Age ¥ Author ¥ lastleg ¥
gl README_., . sty
I Ereredig 05 ' - = 47 2cays| avilskobacdat
D My Donumvents : 3
~ hinageny 37 2cays svilskbasiat
J Shared Doouents -
‘\-J Wy hist ek Flacss O tampiates) 48 2daye avilskobuosfial
Details
Check-in the customized branding file

Customize the home page of your site
To change the content of your site's main page, replace the hone. vmfile or add either domai n_hone. ht M or
Domai nHone. ht M . ht m filetothe ht ml folder in the br andi ng repository.

g~ Note: For the general steps for changing the look and feel of a page, see Customize anything on your site on page
168.

The\ br andi ng\ t enpl at es\ sf nmai n\ home. vmtemplate controls the look, feel and structure of the standard
home page. The default version allows usersto log in and sign up for new user accounts, if CollabNet TeamForge is
configured to allow user self-creation.

If the Domai nHone. ht m . ht M or donai n_hone. ht m fileischecked into the br andi ng repository, the
contents of the file are displayed as the site home page.

P Tip: If both Donmai nHone. ht m . ht M anddomai n_hone. ht nl filesexist in the repository, the contents
of the Domai nHone. ht m . ht m are displayed.

Edit the hone. vmtemplate to produce the page you want.
You can change these objects on the site home page:

Object Description

siteNews The html block that shows site news. The html block itself is not customizable.

g Note: By uncommenting this object and commenting out "communityNews"
object, site news can be displayed across all projectsin the site.
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Object

Description

communityNews

The html block that shows community news.

Note: By uncommenting this object, and commenting out "siteNews" object,
community news (news from the look project) can be displayed across all
projectsin the site.

[ 1

mostA ctiveProjects The html block that shows the most active projects. The html block itself is not
customizable.
displayActivityGraph A flag that indicates that the activity graph should be displayed.

displayTeamForgelLinks

A flag that indicates that CollabNet TeamForge quick links should be displayed.

Customize the home page of projects
To change the default main pages of the projects on your site, edit the pr oj ect _hone. vmfile.

[ 1

Note: For the general steps for changing the look and feel of a page, see Customize anything on your site on page

168.

Edit the pr oj ect _hone. vmtemplate to produce the project page you want.
You can change these objects on the project home page:

Object Description

projectData The object that contains the information about the project. It implements the
interface com.collabnet.ce.customization.| ProjectData.

adminList Thelist of project administrators. Each object of the list implementstheinterface
com.collabnet.customization.lUserRow.

memberList Thelist of project members. Each object of the list implements the interface
com.collabnet.customation.lUserRow.

projectMember A flag that indicates that the user is a member of the project.

joinProjectButton

The button that contains the link to the Join Project page. It returns a
com.collabnet.ce.customization.widgets.Button.

useCustomHomePage A flag that indicates that the page shows the Wiki Home page instead of the
standard Home page.

customHomePage The html that displays as the Project Home page.

editCustomHomePageButton The button that is used to edit the custom Home page. It returns a

com.collabnet.ce.customization.widgets.Button.

projectAdmin

A flag that indicates whether or not the current user is a Project Admin.

useCustomProjectL ogo

A flag that indicates that the Wiki project logo image will be used instead of
the standard project logo.

customL ogoPathString

The url from where the custom project logo image can be loaded.
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Change your site's outgoing emails
When you site sends out automated emails, the text of the emails can be customized to fit your site's specific needs.

Note: Before customizing your site, download the branding files. See Customize anything on your site on page
168.

[ 1

You control screen labels and messages by overriding the resource bundle keys that specify the text strings that appear
in Vel ocity macros and JSPs.

1. Inyour local copy of the br andi ng repository, create adirectory caledt enpl at es/ nmai | .

2. Inthet enpl at es/ mai | directory, create afile containing the custom content for an email that the system sends
out. Give the file the same name as the equivalent sample email file in the branding files package.
For example, to override the email that is sent out to new members of the site, name thefile
tenpl at es/ mai | / user _wel come. vm Use Velocity syntax to identify the parts of the email, like this:

##subj ect

Wel come to our sitel

##subj ect

##body

Here is the content that | want to appear in emils conming fromny site..
##body

Note: To customize atemplate in a specific language, identify the locale as an extension to the file name. For

example, to create auser welcomefilein Japanese, namethefilet enpl at es/ nai | / user _wel corme_j a. vm

3. Commit your new and changed files into the repository.

Provide external applications
If your site's users need access to an application or web site that is not part of CollabNet TeamForge, you can make it available
by linking or integrating from within your CollabNet TeamForge site.

Provide a linked application
To bring an external tool into your environment quickly and easily, set it up as alinked application.
Create a site-wide linked application
When you create a site-wide linked application, it appearsin al projects on your CollabNet TeamForge site.

Site-wide linked applications are especially useful for incorporating corporate standard external applications, such asa
company intranet sites, into your CollabNet TeamForge installation.

Click Admin in the site navigation bar.
On the site administration navigation bar, click Integrations> Site-wide Linked Applications.
On the Site-wide Linked Applications page, click Create.

On the Create Site-wide Linked Application page, provide a name for the linked application.
This name appears on the link in the CollabNet TeamForge navigation bar.

Enter the server location or URL for the linked application.
6. Select whether you want to enable single sign-on for the linked application.

A w DN

o

« |f you use single sign-on, access to the linked application is managed through the CollabNet TeamForge
authentication system. Users are not required to log into the linked application after they have logged into
CollabNet TeamForge .

» If you do not use single sign-on, users will be required to log in to the linked application using its native
authentication system.
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7. Choose how you want the linked application to appear when a user clicksit.

* Inthe same window. The linked application takes over the entire browser window, replacing whatever the user
was looking at.

* Inanew window. The linked application launches in a separate browser window.

« Inaniframe. Thelinked application appears in a box in the same window, framed by the CollabNet TeamForge
site's header and navigation controls.

8. Click Save.

A link for the site-wide linked application is added to your CollabNet TeamForge navigation bar. Clicking the link
displays the application in the main CollabNet TeamForge window.
Edit a site-wide linked application
When the use patterns of alinked application change, you may need to change the way the application integrates with CollabNet
TeamForge.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Integrations> Site-wide Linked Applications.

On the Site-wide Linked Applications page, click the name of the linked application that you want to edit.
On the Edit Site-wide Linked Application page, make the changes you need.

You can edit these elements:

SN .

* Thename of the application.

e Theapplication's URL.

*  Whether the application uses single sign-on.

*  Whether the application is displayed in a new window, in the same window, or in an | Frame.

g~ Note: You cannot change the application icon.

5. Click Save.

Enable or disable integrated applications
Site administrators can enable or disable integrated applications.

In CollabNet TeamForge, enable an integrated application to make it available for use in the projects.

o Tip: You can aso disable an integrated application to restrict it from being added to projects.

Click Admin in the TeamForge tool bar.

On the Site Administration page, click I ntegrated Apps.

To make the integrated application available for use, select the integrated application and click Enable.

To stop making the integrated application available for use, click Disable.
The system asks for confirmation before disabling an integrated application. Click OK to disable the integrated
application.

A w DN pR

A disabled integrated application can be re-enabled when there is a need to use that integrated application in a project.

Provide integrated applications for use in TeamForge projects
|Navigation title:Provide an integrated app for projects to use
To make atool comprehensively available to your users, set it up as an integrated application.

Before you can make an integrated application available to project admins, your system administrator must integrate
the application with your site. This may involve modifying the application. How thisis done dependsin part on the
application. See the TeamForge sysadmin documentation for instructions.

g~ Note: For information about making integrated apps accessible via SOAP, see the TeamForge API documentation.


http://help.collab.net/topic/sysadmin.redhat.610/action/sysadmin-externalapp.html
http://help.collab.net/topic/teamforge.api.610/reference/api-integrationdataservice.html
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Integrate an external application into a TeamForge site
When you integrate an external application into your CollabNet TeamForge site, your site's project administrators can choose
to include the integrated application alongside the built-in tools in their projects.

When you have integrated the application, project administrators on your site can add it to their set of collaboration
tools. Objectsthey create will share the core TeamForge features, such as authorization, authentication, go-urls, association,
linkification, templating, Project Pages components, search, and source code management support.

1. Find the XML files that describes your integrated application.
For an example of aworking XML file, see pebble.app.xml.

Log into TeamForge as an admin user.

Click Integrated Appsin the Site Administration toolbar.

Click Create.

Use the Browse window to find the configuration file you created, then click Next.
On the Preview screen, review the parameters you set in the configuration file.

© 0k~ WD

g~ Note: You may have to revise one or more values to ensure they are valid.

7. Click Save.

The application is now available for al projects on your site. You can direct project administrators to these instructions
to add it to their own project toolbars.
Remove an integrated application from your project
To stop making an application or site outside of CollabNet TeamForge available to your users from inside your CollabNet
TeamForge projects seamlessly, disintegrate an application.

Note: You may have integrated several external applications per project to maximize the integrated applications
feature's utility. However, because each integrated application adds an icon to the project navigation bar, alarge
number of integrated applications can cause horizontal scrolling. Consider removing the integrated applications
that are not in use.

[ 1

1. Click Project Admin in the project navigation bar.

2. Onthe Project Admin menu, click Project Toolbar.
The Integrated Applications tab displaysthe list of al currently integrated applications in the project.

3. Toremove an integrated application, on the I ntegrated Applications page, select the integrated application and
click Remove.
The selected integrated application is removed from the project.

Theicon of the removed integrated application disappears from your project navigation bar.

g~ Note: Removing an integrated application, removes all associations to the integrated application too.

Set site-level permissions for an integrated application
In CollabNet TeamForge, as the site administrator you can set the site-level permissions for an integrated application.

The default access permissions are usually set using the configuring xml file for each integrated application. However,
you may want to provide permission access at site-level for some of the users.

1. Click Admin in the site navigation bar.
2. Onthe site administration navigation bar, click I ntegrated App.

3. Set the permissions for the integrated application and click Submit.
The permissions are set for the selected integrated application.


http://help.collab.net/topic/teamforge610/action/siteadmin-integratedapplications.html
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Note: Itispossible that an integrated application may be added to a project by arestricted user whose project
administration permissions come from aglobal project role. In such acase, you could beleft with no one authorized
to administrate the integrated application. TeamForge handles that situation in one of two ways:

* If oneor more userswith the "Founder project administrator" roleisamember of the project, then the restricted
user who did the integration gets that role too.

 If thereis no project member with the "founder project administrator” role, the restricted user who did the
integration gets a new administrator role called "<integrated_application_name> Administrator.”

Add a custom event handler to your TeamForge site

An event handler is a program that watches for events on a TeamForge site and communicates them to another system. You
can add your own event handlers to the set that are built into TeamForge.

For example, some of your site's members may be using TeamForge alongside a legacy issue tracking system. You may
want to write an event handler that listens to the "Artifact Create” event on your TeamForge site and sends the details
about any newly created artifact to the legacy system through awebservice.

1

N

N o g s~ ®

Create your custom event handler and packageitasa. j ar file.

Check with your system administrator that the ENABLE_UlI_FOR_CUSTOM_EVENT_HANDLERSvariable in the
site configuration file is set to true.

Click Admin in the site navigation bar.

Click System Tools on the site administration tool bar.

Click Custom Event Handlers.

Click Create and use the Browse control to locateyour . j ar file.
Click Add.

Note: If the system reports "Error Parsing Event Jar File," debug your event handler until the error message

&
no longer appears.

Your . j ar fileisuploaded to your TeamForge site and the event cache is cleared. All the events you specified in your
event handler are now captured and sent to the external web service.

Monitor your site
To facilitate troubleshooting, keep an eye on key data about your CollabNet TeamForge site.

Check your server's status
As afirst troubleshooting step, check the Server Status page to seeif your servers are running and connected to the main

CollabNet TeamForge server.

pw NP

Note: The Server Status page provides only the current status of each server. It is not adiagnostic tool, and you
must correct any connection or configuration issues on the server in question.

Click Admin in the site navigation bar.

On the site administration navigation bar, click System Tools.

On the System Tools menu, click Server Status.

On the Server Status page, find the status of the server you are interested in.

¢ SOAP server

e Email server

e Search server

* All integrated SCM servers

For each server, you see one of the following status messages:
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e OK - The server isrunning and connected to the main CollabNet TeamForge server.
* Could Not Connect - The server is not running or is not connected to the main CollabNet TeamForge server.

Check your site's configuration
Asafirst troubleshooting step, check the Site Configur ation pageto verify that your CollabNet TeamForgeis set up correctly.

> w DN

Click Admin in the site navigation bar.

On the site administration navigation bar, click System Tools.

On the System Tools menu, click Site Configuration.

On the Site Configuration page, find the variable whose value you are interested in.

Note: Theinformation on the Site Configuration page is read-only. To change configuration values for your site,
you must log into the server with ashell and edit thesi t e- opt i ons. conf file.

Read your site's logs
Inspecting the system logs for your CollabNet TeamForge site may product useful information for solving problems.

1
2.
3.

4,

Click Admin in the site navigation bar.
On the site administration navigation bar, click System Tools.

On the System Tools menu, click System L ogs.
All the logs the server has written are listed.

On the Site Configuration page, click the log file you are interested in.
For explanations of some of the most useful logs, see Log files.

Get build information
For solving some kinds of problems, it may be useful to know which software components areinstall ed, the exact build number,
and other technical information about your CollabNet TeamForge site.

A w DN PR

Click Admin in the site navigation bar.
On the site administration navigation bar, click System Tools.
On the System Tools menu, click Build I nformation.

On the Build Information page, inspect the detailed information about the software underlying your instance of
CollabNet TeamForge.

Options Description

Version The release of the product.

Build Number Number of times the software was compiled and packaged.

Operating System Thisisaways Linux.

Operating System Version Thevariety of Linux in use. See Supported software for CollabNet TeamForge
6.1 for eligible Linux distributions and versions.

Applied Patches Identifiers of any software updates that have been installed to deliver added
functionality or bug fixes. See #unique 524.

Instance Identifiers for any packages of customizations that have been applied. See
Customize a site.

RPM All the software packages that have been installed to support CollabNet

TeamForge.
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Track the number of users logging into your TeamForge site

INavigation title:Track user logins |

You can keep track of how often userslog into your site based on data that refreshes as frequently as you need it to.

This can be a handy way of assessing the value of work you put into your site. For example, to assess the impact of
changes you've made to your site'slook and feel (see Customize anything on your site on page 168), ook for trendsin
the user login numbers for the week following the changes.

1
2.
3.

ol
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Click Admin in the site navigation bar.

Click Reportsin the Site Administration toolbar.

Click aZoom option to see aweek, a month, a quarter, 6 months, or ayear of activity.
The Max option shows all the data that's ever been collected.

Use the From and To date fields to zero in on the exact period of activity you are interested in.

Roll your cursor over any data point on the graph to see the exact numbers that determine that point's position.
Click Grid View to see the data as atable.

You can toggle between chart and grid view as needed.

Tip: Watch for reports on more types of datain upcoming TeamForge rel eases.

Keep your site secure
As site administrator, you are responsible for making sure passwords are effective and hackers can't get in.

Set password requirements
For security reasons, you may want to enforce a password policy that requires certain password characteristics.

You can specify the following characteristics:

Minimum number of characters

At least one number

At least one non-a phanumeric character
Mixed upper and lower-case characters
Allowed invalid login attempts
Disallow old passwords

Use of dictionary words

Default password expiry

Disable/del ete user accounts

Inthe site-options. conf file setthefollowing variables.

[ 1

Note: Default values areindicated by brackets.

M NI MUM_PASSWORD LENGTH =[ 8]

PASSWORD REQUI RES NUMBER = true | [true]
PASSWORD REQUI RES NON_ALPHANUM = true | [true]
PASSWORD REQUI RES M XED CASE = true | [true]
REQUI RE_PASSWORD SECURITY = true | [true]

LOG N ATTEMPT_LOCK = 3

Tip: Thisoption controls locking out the user account after "n" invalid login attempts. Set thisto zero or a
negative number to lock the user account when the user provides an incorrect password for the first time.
Set thisto a positive number, say "2", to allow the user two wrong password attempts. The user account
would be locked at the "x+1" (here, third) attempt. When a user's account is locked, either an administrator
must unlock it or the user can use the "Forgot Your Password?" link to reset the password.

[ N
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+ PASSWORD HI STORY_AGE=5 | [5]

Tip: This option disallows the previous "n" passwords, while setting a password. However, if this option
iS set to zero, a negative number or it isleft empty, the user can use any previous password. The password
being set must satisfy the existing password policy each time.

« ALLOW PASSWORD DI CTI ONARY WORD=t r ue

Note: Youmust setthe"REQUIRE_PASSWORD_SECURITY" optionto"true" inthesi t e- opt i ons. conf
file for "LOGIN_ATTEMPT_LOCK", "PASSWORD_HISTORY_AGE" and
"ALLOW_PASSWORD_DICTIONARY_WORD" security setting to take effect.

2. Inthe /etc/ctf-pass. conf file set thefollowing values.

g~ Note: Default values are indicated by brackets.

» Enforce passwords to be changed every "n" days. hi st ory. age=90 | [ 90]

« Email users when passwords need to be changed. hi st ory. war n=5

» Disable user accounts. hi st ory. di sabl e =30 | [ 30]

» Delete accounts that have been disabled for "n" days. hi st ory. del et e=60 | [ 60]

Prevent cross-site scripting (XSS)
By using the upload document function, an attacker could potentially upload an HTML page to CollabNet TeamForge that
contains active code, such as JavaScript. This active code would then be executed by clients' browsers when they view the

page.

To prevent an attack of this sort, you can specify whether or not HTML code is displayed in CollabNet TeamForge.
Thisflag appliesto all documents, tracker, task, and forum attachments, and files in the file rel ease system.

Inthe
<SOURCEFORCE_SI TE_DI R>/ sour cef orge_hore/ et ¢/ sour cef orge_confi gurati on. properties
file, set the sf . saf eDownl oadMbde flag to one of the following values.

« none:All file typesthat can be displayed inline are displayed inline, including HTML and text.

g Note: Thisisthe CollabNet TeamForge default.
e htnl :HTML filesare not displayed inline. All other file types that can be displayed inline are displayed inline,
such astext. When a user tries to launch an HTML file, he or she is prompted to download and save the file

locally.
e al | : Nofiletypesaredisplayed inline. When a user tries to launch any file, he or she is prompted to download
and save thefile locally.

Support hardware provisioning
You can provide project managers with a TeamForge Lab Management site where project members can remotely build and
test their code.

Tip: For moreinformation about the new featuresin TeamForge Lab Management 2.2, see thisintroductory video.
(You'll need afree open.collab.net membership to watch it.)


http://www.open.collab.net/nonav/community/sfee/training/wbt11/WhatsNewLM.htm
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Set up a new TeamForge Lab Management project
To start using TeamForge Lab Management project, create or select a TeamForge (or CollabNet Enterprise Edition) project

tolink to.

a s wDdh e

7.

Note: You can use Lab Management with either CollabNet TeamForge or CollabNet Enterprise Edition. These
instructions assume you are using TeamForge. For information about working with CollabNetEnterprise Edition
projects, see the help for CEE project managers.

Log into TeamForge Lab Management as an administrator.
Click the Administration tab.

On the Administration menu, click M anage Projects.
Select the Add New Proj ects tab.

If Lab Management is connected to a TeamForge server, the Namefield displays adrop-down list of projectsinstead
of requiring atext entry. Select the project you want to add to Lab Management.

Inthe Summary field, write a brief summary of the project.

Note: The TeamForge Lab Management project summary may be different from the CEE or SFEE project
summary.

[ 1

Click Add New button.

Your project is added. You can now pass the project on to the Project Admin of the project to begin administrating and
configuring.

[ 1

Note: If your project is an SFEE project, you will see that TeamForge Lab Management has added some Roles to
your project.

Move hosts from one project to another
When a project has too many machines or needs more, you may wish to reallocate hosts between projects.

You must be adomain administrator to move hosts between projects.

1
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Notify the project administrator of the project you are taking hostsfrom, so their project memberswon't loseimportant
work which they may not have saved on that system.

Go to the Project Home page for the project which contains the host you are moving.

Select the Hosts tab to bring up the hosts list and click the host you want to re-all ocate.

Click the Admin tab for the host.

From the Project drop-down box in the Allocation Details section, select the project that you want to move to.

g~ Note: If you do not see adrop-down box here, it means:

* Thehost isavirtual guest. Virtual guests must remain in the same project as their parents.

» Thehost contains virtual gueststhat are not all allocated to the same user. From the web interface, you can
only change the project of avirtual host if the parent and all its guests are allocated to the same user.

* Thehost isacloud source.

Click Update to move the host (and its guests, if any).

If you are concerned about the security or contents of the machine that has been moved to the new project, rebuild
the machine as soon as possible.

Thisisthe only way to ensure that only the exact software and users that you specified will be on the machine.

Note: For amore flexible way of moving hosts between users and projects, you can use a TeamForge Lab
Management API client to perform the move.


http://help.collab.net/topic/cee/supporting_project_owners.html
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Forward a port
To make aservice accessible to users, sometimes you may need to forward aport on a L ab Management box to an external-facing
port.

g~ Note: Port forwarding isonly needed if Lab Management has been setup in an isolated deployment mode. If you
~ can access the nodes directly, without tunneling through the manager, then you do not need to worry about setting
up port forwards.

1. Intheleft-hand column of the Administration screen, click Port Forwarding.
2. Select ahost and specify the type of traffic you want to forward.

Host The TeamForge Lab Management host that you want to access the network service from. For
example, cu014. | rdomai n. your donai n. net

Host Port The port on the Host -- the hostname you sel ected above -- that you want to access the network
service on. For example, if you would like to forward aweb server, you would select Host Port
80.

External Port The port on the TeamForge L ab Management Manager host that you would like to forward the
traffic to. For example, if you would like to forward the above web server on Host
cu014. | ndomai n. your domai n. net and Host Port 80 to port 8080 on the TeamForge
Lab Management Manager host, you would enter 8080 in thisfield.

g~ Note: Only certain ports may be selected for the External Port. The list of portsis given
- at thetop of the screen.

Protocol The protocol or protocols to support when forwarding traffic. Choose one of these:

e TCP
« UDP
 Both TCPand UDP

g~ Note: If you're unsure, ask the requestor for clarification. Most network serviceswill only
require TCP.

Description A textual description of the servicethat isbeing forwarded. All usersin the project will seethis
description when they view the Summary page for the Host.

g Note: The Description is mandatory.

3. Click Add New to add your new forwarding.
The new forwarding is active immediately. To test your new forwarding, try accessing the external port on the
TeamForge Lab Management Manager from your desktop.

' Tip: If the network service requires special client software, especialy if the forwarding is using the UDP
protocol, you may not be ableto easily test it. In that case, contact the requestor and ask them to verify that the
forwarding works properly.

Stop port forwarding
When you don't want to forward a port, you can delete or suspend forwarding for that port.

1. Intheleft-hand column of the Administration screen, click Port Forwarding.
2. If you want to remove the port forwarding permanently, click Delete for the forwarding you wish you delete.
Forwarding for this port isimmediately disabled and deleted forever.
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g~ Note: You can always create a new forwarding with the same properties in the future.

3. If youthink you might need thisforwarding again soon, unchecking clear Enableand click Updatefor the forwarding
you wish to disable.
Enable the forwarding again by selecting Enable again and click Update again.

Set up host URL mapping
If you have real users accessing services on abox you have set up virtually with TeamForge Lab Management, consider giving
them a human-friendly URL to go to. You can do this by mapping an arbitrary URL to the host's real URL.

g~ Note: Only TeamForge Lab Management domain administrators can administer host URL mappings.

1. Onthe Administration tab, click Host URL Mapping in the navigation bar.
2. Provide the following information about the service you wish to map:

Host The TeamForge Lab Management host that you want to access the network service from. For
example, cu014. | rdomai n. your donai n. net

Host Port The port on the Host -- the hostname you selected above -- that you want to access the web
service on. For example, if you would liketo map aweb server running on port 8080, you would
select Host Port 8080.

Host URL The URL path on the Host that you want to map to. For example, if you want to map the URL
http://cu0l14. | ndomai n. your donai n. net : 8080/ bui | d/, you would enter
/ bui | d for theHost URL.

Mapped URL  Thelocation (URL path) on the TeamForge Lab Management manager to map the Host URL
to. The location will be under the directory / apps. For example, if you enter mybui | d for
Mapped URL in our example, you will then be able to reach
http://cu014. | ndonai n. your donai n. net: 8080/ bui | d/ as
http://mgr.| nmdomai n. your domai n. net/ apps/ mybui | d/ .

Valid characters for Mapped URL's are: Letters, numbers, spaces, underscores, and hyphens.

Use SSL Whether or not to force requests for the mapped URL to use SSL. Mapped URL's will always
be accessible via SSL, even if thisbox is not checked. But, if you check this box, it will be
impossible to access this URL without SSL. In general, unlessthereis a very good reason for
turning the Use SSL option off, we recommend keeping it on.

Dynamic Set to either Safer or More Aggressive. Using the Safer option, only HTML attributes which
Rewriting are known to contain URL's are dynamically rewritten. But in some cases, especially with

applications that use embedded Javascript code, this will not be sufficient and some parts of
your application will not work properly. In this case, try the M ore Aggressive option. This
option still attempts to be careful about what it rewrites, but looks into the HTML more deeply
and will rewrite awider variety of HTML tags and attributes.

Description A textual description of the web service that is being mapped. All usersin the project will see
this description when they view the Summary page for the Host.

g~ Note: The Description is mandatory.

3. Click Add New to add your new URL mapping.

The new URL mapping is active immediately. To test it, try accessing the resulting URL from your desktop.
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Stop URL mapping
When you don't need a URL mapped, it's a good idea to remove the mapping.

[ 1

Note: Only TeamForge Lab Management domain administrators can administer host URL mappings.

1. Onthe Administration tab, click Host URL Mapping in the navigation bar.

2.

Click Delete for the URL mapping you want to stop.

The URL mapping isimmediately disabled and deleted forever.

[ 1

Note: You can always create a new URL mapping with the same propertiesin the future.

Tip: To temporarily disable a URL mapping, clear Enable and click Update for the URL mapping you wish to
disable. To enable the URL mapping again, select Enable and click Update again.

Delete a project
To conserve resources on your TeamForge Lab Management site, it's agood idea to delete projects that are not in use.

Only TeamForge Lab Management Domain Admins can delete and undel ete projects. When a project has been del eted,
only TeamForge Lab Management Domain Admins can access it, and then only to undelete it.

Projects that contain hosts cannot be del eted.

1

3.

Check that there are no hosts allocated to this project.

You cannot delete the project if there are hosts currently allocated to it.

On the Projects tab, find the project you want to delete, and select Edit in the Actions column on the right for that
project.”

On the Edit Project page, click Delete, then Confirm Delete.

The project is deleted from the system.

Undelete a project
To bring a project back into your TeamForge Lab Management site, you can undelete the project.

Only TeamForge Lab Management Domain Admins can delete and undel ete projects. When a project has been del eted,
only TeamForge Lab Management Domain Admins can access it, and then only to undelete it.

1

2.
3.

On the Administration tab, click Manage Projectsin the navigation bar.
Inthelist of all the projectsin the system, deleted projects are in italics and are marked "Currently deleted.”.

Click the project you want to undel ete.
On the Edit Project page for the deleted project, click Undelete button, then Confirm Undelete.

The project isrestored to being afully active TeamForge Lab Management project.

Expand your domain with virtual guests

By using virtual guests, you can provide your users with many more machines than you actualy have.
Create a virtual guest

To add avirtual guest, go to the configuration page for the host where the guest will live.

[ N

Note: You can only create virtual guests on machines that are allocated to you, are not guests themselves, and are
not marked immutable.

On the Manage Hosts page, (or any other page where the host is visible), click the down arrow next to the host
where your virtual guest will live and select Manage Virtual Guests.

On the host's Manage Virtual Guests page, specify the details for your new virtual guest under Add New Virtual
Guest.
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Migrate a virtual guest
When avirtual guest consumes too many system resources, or you wish to rebuild or perform other more drastic maintenance
on the virtual guest's current virtual host's use, migrate the guest to a different host.

Before moving avirtual guest, make sure the following is true:

* You are a TeamForge L ab Management domain administrator.
e The current virtual host and guest, and the desired new virtual host, are al in the same project.

e Thetarget virtual host has enough RAM, disk, and CPU to accommodate the virtual guest you wish to migrateto it.
(TeamForge Lab Management displays a drop-down list of hosts that fulfill all these criteria.)

» Thevirtual guest being moved and the target virtual host are on the same subnet.

1. Gotothe Host|Admin page for the virtual guest that you wish to migrate.

2. Inthe Moveto Virtual Host drop-down box, select the host you wish to migrate this virtual guest to, and click
UpdateAllocation Details.

Note: If you do not see this drop-down box, but instead see the text "No hosts are eligible for re-parenting,”
there are no other virtual hostsin this project that could accommodate this virtual guest. You must delete or
reduce the hardware resources assigned to one or more existing guests.

3. Click Confirm Update.

Thevirtual guest immediately shuts down and begins migrating. The owner of the virtual guest (not necessarily the user
that requested the migration) receives an e-mail when the migration is complete.

Note: Thereisno exact time frame or estimate for how long a guest migration takes. A typical "base" system
without much data (e.g., under 10GB) usually migratesin 5-15 minutes. The time required is mostly dependent on
the size of the virtual machine, coupled with the load on the source and destination virtual hosts.

[ 1

Delete a virtual guest
You delete avirtual guest the same way you delete a physical host.

Important: Before you delete your guest, be avare of one very important difference: As soon asyou delete a
virtual guest, the virtual guest system and all its data are wiped out forever! Thisisin contrast to deleting a physical
host, in which case the machine gets removed from TeamForge Lab Management, but the contents of its hard drive
are not wiped out, and could still be rescued by an administrator with physical access to the system.

1. Onthe HostJAdmin screen, click Delete Host.
2. Click Confirm Delete.

The virtual guest is permanently deleted.

Manage profiles
Like hosts and projects, profiles must be added at the domain level before they can be used by individual projects. Likewise,
they can be administratively disabled from use at the domain level.

Add a profile to the Lab Managenment domain
Navigation title:Add a new profile |
In Lab Management, a"profile" is areproducible collection of software packages that comprise a runnable operating system
and accompanying set of applications. Every system inside the Lab Management environment has an operating system profile
installed on it.

There are three ways to add a new profile to Lab Management :

» Directly add it to the profile repository using a Subversion client, then import it into Lab Management through the
Add Profile page.

« Createthe Profile XML file directly, and upload the file through the Add Profile page.
* Make acopy of an existing profile on that profile's Admin page, and edit it to suit your needs.

Of the three, the third is the easiest, and used most often by our own profile creators.
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Log into TeamForge Lab Management as a user with TeamForge Lab Management Domain Admin privileges.
Click the Administration tab.

On the Administration menu, click M anage Profiles and then the Add New Profile link.

Enter the following information.

g Note: All fields are mandatory.

Profile name The name of the profile. Must already exist in the site's Subversion repository before it can be
added into TeamForge Lab Management. This name can never be changed, so be sure to get
the profile named properly when you initialy create it.

You can also upload a profile from your local system into Lab Management's Subversion
repository. The profile must be in valid Lab Management profile XML format.

Summary A brief summary of the profile. The Summary can be changed later on using the Profile Admin
page.

Project What project the profile belongsto. If you leaveit blank, the profile will belong to the domain,
and either be accessible to all projects (if the profileis public) or no projects (if the profileis
private). This property can be changed later on using the Profile Admin page.

Public Whether the profile is public (can be used by any project) or private (can only be used by the
project which ownsthe profile). This property can be changed later on using the Profile Admin

page.

Prebuilt Whether or not the profileisaVMware or other prebuilt imagefile. This profile property cannot
be altered once the profile is created. If your profile is an imagefile, thiswill beYes. If your
profile installs via a network install method like Kickstart(tm) or Jumpstart(tm), thiswill be
No.

Size (in GB) The minimum disk size required to build and run this profile. The minimum disk size should
be at least 10 GB.

Click Add New to add the new profile.

Modify the XML definition for a profile
Rather than using a Subversion client to check out and edit a profile, you can edit the profile XML definition in atext box in
the Lab Management user interface. This allows you the greatest flexibility in changing parts of the profile.

o w e

Log into TeamForge Lab Management as a user with TeamForge Lab Management Domain Admin privileges.
Click the Administration tab.

On the Administration menu, click M anage Profiles.

Right-click a profile and select Admin from its context menu.

In the Modify Profile: Profile XML Definition section, click View/Edit XML Definition of Profile.
This brings up the content of the profile XML definition in an editable text box.

To edit the content, we recommend that you copy it to atext editor, edit and save it. Then copy it back into the text
area.

To double-check your changes your changes before checking in the new version, click Show Diff.
When you're done, click Check In New Version.

If, by some chance, you made a mistake and the profile isinvalid, don't worry -- since profiles are versioned, you
can always mark that version as unbuildable.
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Stop using a profile
In Lab Management, profiles can be permanently deleted or disabled.

Delete a profile
If aprofile in Lab Management has never been used, it can be deleted. This can be helpful, for example, if you wish to clean
up some profiles that were created with incorrect names.

Log into TeamForge Lab Management with TeamForge Lab Management Domain Admin privileges.
Click the Administration tab.

On the Administration menu, click M anage Profiles.

Inthelist of all profiles currently in the system, click the profile you wish to disable.

Click the Admin tab.

Note: The Delete Profile section is displayed only for profiles that are you're allowed to delete.

S O A
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Click Delete Prdfile.

Disable a profile
When you disable a profile in Lab Management, it will prevent users from building or rebuilding a host with that profile. It is
possible to make disabled Lab Management profiles accessible again.

A disabled profile gets removed from all projectsthat currently alow the profile. If you disable aprofile and then enable
it later, project managers who previously allowed that profile will have to go back into their project's Profile Library
and add the profile again.

Important: Use caution before disabling aprofile. Contact the owners of the systems using that profile, and owners

[
of projects that include that profile, before disabling the profile.

Log into TeamForge Lab Management with TeamForge Lab Management Domain Admin privileges.
Click the Administration tab.

On the Administration menu, click Manage Profiles.

Inthelist of all profiles currently in the system, click the profile you wish to disable.

Click the Admin tab.

6. Click Disable Profile.

a s~ DR

The profile is disabled and removed from all projects that currently allow it.
Enable a profile
To build a machine with a profile that has been disabled, you must re-enable the profile.

Log into TeamForge Lab Management with TeamForge Lab Management Domain Admin privileges.
Click the Administration tab.

On the Administration menu, click M anage Pr ofiles.

Inthelist of al profiles currently in the system, click the profile you wish to re-enable.

Click the Admin tab.
On the Admin page, click Enable Profile to re-enable the profile.

© 0k~ wbdPE

Administer clouds
As an administrator, you can set up and manage the clouds in your Lab Management site.

Add a new cloud
When you pool physical resourcesinto acloud, they can be partitioned into different virtual machines and used in any project
on the domain that needs them.

1. Sdlect Administration > Clouds
2. Inthe Manage Clouds page, click New Cloud.
3. Enter aname and brief summary for the cloud.
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4. Enter any additional detailsin the Description.
5. Select an owning project for the cloud.
The owning project allows the physical source systemsin the cloud to be from that project. If you don't specify an
owning project, the sources for the cloud can only be systems that are unallocated and don't belong to any project .
6. Specify whether thisisa public or private cloud.

* A publiccloud appearsin any project on the sitethat allows clouds, and isavailable for other project administrators
toincludein their list.

e A private cloud appears only in the project that ownsit, so that only the usersin that project can allocate systems
fromiit.

7. Specify whether hosts allocated from this cloud should be deleted when they are deall ocated.
8. Specify the maximum time (in days) for which a host can be allocated from this cloud.
The default value is 0 and indicates that there is no limit.

9. Click New Cloud.

When your cloud gets created, you can proceed to add hosts to it.
Add a cloud host
When you've created a cloud, you can add hosts from physical sources or Amazon EC2 sources.

1. On the Clouds page, click acloud name and select Admin.
2. Toadd aphysical host to the cloud, select one from the dropdown and click Add host.
Physical hosts can be partitioned into virtual machines that can be allocated into different projects on the site.

3. To add an Amazon EC2 source, click Add EC2 Source.

g~ Note: You will need information from your Amazon Web Services account to complete this task.

a) Add adescription for the source.

b) Specify the maximum number of hosts that may exist at any given time from the set of EC2 credentials specified
on this page.

¢) Fill inthe EC2 credentias from the information in your Amazon Web Services account.
4. Click Save.

Define a host type
To add a host type for a cloud, specify its attributes such as CPU, disk size and memory, and price for usagein an XML
configuration file.

1. Onthecloud's Admin page, click Modify Cloud.

2. Edit the XML fille.
Here's an example:

<host type val ue="Sun">
<cont ai ns>
<size value="extra_small">
<price base="0.1" />
<provi des>
<nensi ze val ue="256" />
<di sksi ze val ue="10" />
<ncpu value="1" />
</ provi des>

</size>
<size value="small">
<price base="0.2" />

<provi des>
<nmensi ze value="512" />
<di sksi ze val ue="10" />


http://aws.amazon.com

186 | OpenTopic | How to use TeamForge 6.1

<ncpu value="1" />
</ provi des>

</size>
<si ze val ue="nedi un' >
<price base="0.3" />

<pr ovi des>
<nensi ze val ue="1024" />
<di sksi ze val ue="20" />
<ncpu val ue="1" />

</ provi des>

</ si ze>
<size value="|arge">
<price base="0.4" />

<provi des>
<mensi ze val ue="1024" />
<di sksi ze val ue="40" />
<ncpu val ue="1" />

</ provi des>

</ si ze>
<size value="extra |arge">
<price base="0.5" />

<provi des>
<nensi ze val ue="2048" />
<di sksi ze val ue="80" />
<ncpu value="1" />
</ provi des>
</ size>
</ cont ai ns>
<requi res category="cpuarch” op="in">
sun4u
sun4v
</requires>
<requi res category="type" op="eq">
physi cal
</requires>
</ host _type>

3. Click Update.

Delete a cloud
When acloud, and its hosts, are no longer in use, you can delete it.

Note: You can delete acloud only when al of its physical sources have been removed, and there are no hosts that
were created from the cloud.

1. Onthe Clouds page, click on a cloud name and select Admin.
2. Click Delete Cloud.
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Frequently asked questions about CollabNet TeamForge
6.1

|Navigation title: TeamForge 6.1 FAQ
Here is some background knowledge to help you make the most of CollabNet TeamForge.

g~ Note: For questions and answers about earlier versions of TeamForge, see:

e TeamForge5.4
e TeamForge5.3

e TeamForge5.2

TeamForge FAQ

Frequently asked questions about using CollabNet TeamForge

|Navigation title: Project member FAQ
Use this background knowledge to help you exchange information, track work and collaborate with your team.

Can | assign an artifact or task to a group of users?
Unfortunately thisis not possible with the current implementation of groupsin CollabNet Team Forge.

Asaworkaround, you can create a new user account and set its email address to that of amailing list that all group
members are subscribed to. Then the submitting user can assign the artifact to this user account, and the mailing list will
be notified.

What is an association?

CollabNet TeamForge allows usersto easily associate, or link together, any objectsin the system to simplify knowledge sharing
and provide traceability throughout the lifecycle.

For example, a discussion post regarding a customer problem could be linked to a document specifying the feature
requirement. An issue might be created to track the defect, the source code commits that fix the issue, and the release
that contains the fix. All of these records can be linked together with an association. When any item is associated with
another, the link appears on the item's Associations tab.

Associations enable devel opment organi zations to improve information sharing, capture institutional knowledge, and
simplify regulatory compliance.

How does CollabNet TeamForge support documents?

A key element in asuccessful product development project is ensuring that stakeholdersfrom all functional groupsareinvolved
in an iterative document review and approval process, particularly for critical documents, such as Product Requirements
Documents.

It isalso critical that any changes to key documents are recorded and the new information quickly communicated to
everyone concerned.

The CollabNet TeamForge Document Manager hel ps you manage your documents throughout their lifecycle and ensure
the appropriate level of involvement of other project members. In addition to storing documents for reference purposes,


http://help.collab.net/topic/teamforge540/faq/teamforge.html
http://help.collab.net/topic/teamforge530/faq/teamforge.html
http://help.collab.net/topic/teamforge520/faq/teamforge.html
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the Document Manager provides a document review workflow process to allow you to actively engage other usersin
the review and approval of a document.

Simple notification process

If you would like to keep other CollabNet TeamForge users informed when the status of a document, such aswhen a
document is posted or updated, or there is achange in the contents or status of an existing document, but do not require
aformal review and approval process, the following steps provide abest practicefor thislevel of document management:

» Post the document to the Document Manager in the desired location. If you would like to prevent other users from
editing, moving, or deleting the document, use the 'L ock Document" feature. (If you choose not to lock the document,
any user with the document edit permission can edit and update the document.)

* Notify other usersthat the document is available and request that they begin monitoring it. All users monitoring an
item receive email notification whenever the item is updated.

Document workflow review and approval

In cases where more formal document review is desired, the CollabNet TeamForge Document Manager provides an
easy-to-use workflow process for managing a document’s review and approval.

After submitting a document, you can start a document review. You are prompted to provide the following information:

e Thenamesof al required and optional reviewers. (All reviewers must have permission to access the document.)
e The date by which the review must be completed.
» Email message text.

You will be notified each time a reviewer submits review comments.

When selected to review a document, users receive an email notification with the relevant details and alink to the
document.

You can also choose to attach the document to the email notification. An item also appears in the Documents Awaiting
Review section of each reviewer’'s My Page, including the due date.

A Submit a Response section is provided within the Document Manager where reviewers can enter their review
comments. Reviewers should beinstructed to include " approve this document"” or similar text in the Submit a Response
section to indicate that they have approved the document.

All reviewers and the document submitter will be able to read the reviews of all other reviewers once they have been
submitted.

Which arbitrary HTML elements can | customize?

CollabNet TeamForge Snippets are customizable HTML text fragmentsthat can beinserted in predefined locationsin CollabNet
TeamForge pages.

Snippets can be added in the following locations:

» Below the pagetitle on all CollabNet TeamForge templates.
» Above the footer on all CollabNet TeamForge templates.

Snippets get checked into thet enpl at es/ ht m / directory in the branding repository.

* Thefile name for the header looks like this:
<appl i cati onnanme>- <acti onnanme>- Top. ht m
* Thefile name for the footer looks like this:

<appl i cati onnanme>- <acti onnanme>- Bott om ht m



OpenTopic | Frequently asked questions about CollabNet TeamForge 6.1 | 189

For example, to put your own custom snippet at the top of the Tracker ViewArtifact page, namethefile
tracker-viewArtifact-Top. htm .

o Note: The file names are case-sensitive.

> SourceForge : Create Project - Windows Internet Fxplorer

@Tf = [ hitp:Jsislatest.collab.netjsfjsfman/dojcreatepropct)

Fie Edit  Wew Favodtes Tools  Hep

w S0 pSourceFarge : Craske Project |

COLLABNET SOURCEFC RGE ENTERPRISE 5.0

Create Project

Please be sure to follow E i T = when choosing a name for your projects

zfmain-greateProject—Top.html

In addition, before creating 2 project, pleese s=arch to se= if there are any other projects covening

Create Project
Project Mams:™

URL Mame: If 3 AL name ks not specified, a name will be genera

Descrpbon: =

Project Template: PMone | W

zfmain-createfProject-Bottom.hitml
B R R N I Thank You for creating a project and participating in cur corporate community.

Powerad by
CUUABNE[ £ 2008 Collabet. CalabMet is a regstered frademark of ColabMet, Tnc.

IIDwn'I-:-ul:in: picture: bkbpffsFSabe st collab, net fsF-magesimasthead/inks _bgSios_selected

e Tip: You can find the application name and the action name in the URL of the page you are customizing. For
example, consider aURL suchashtt p: // sf 5l at est/ sf/ sf mai n/ do/ cr eat ePr oj ect . Here, the
application nameis 'sfmain” (the main CollabNet TeamForge application) and the action name is ‘createProject.”
If this page had a custom snippet near the header, the file containing the custom snippet would be
tenpl at es/ ht m / sf mai n- cr eat eProj ect - Top. ht .

simanfdajceateProjct

Can I request arole?
If you are a project member in CollabNet TeamForge, you can request arole in your project.

You can usethe Project Home > My Roles page to request for arole. Your request is submitted to the project
administrator for approval. You will receive an email notification when your request is either approved or denied.
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Note: Based on your project administrator's discretion, some role requests may be granted immediately, while the
other role requests may need approval.

[ 1

Can | specify an alternate email address?

Yes, of course you can specify one or more aternate email address. CollabNet TeamForge supports user profiles with one
primary email address and upto three secondary email addresses.

The email address specified while creation of auser account isconsidered the primary email address. The aternate email
addresses are optional and can be specified while updating the user profile.

L Tip: To add your secondary email addresses, usethe Admin > Users page to update your profile.

Why don't | have access to the "Reported in Release" information in my artifact?
If you cannot see the "Reported in Release" information in your artifact, ask your project owner to add the role required to
obtain access to this information.

Userswith tracker artifact submit/view/edit permissions will not be able to see "Reported in Release” information in an
artifact, asit is directly associated with the File Releases section.

You can request that the project owner add arole permission of View Only for All Packagesin File releases for you to
obtain access.

Moving to a CollabNet TeamForge project from a CollabNet Enterprise Edition project

|Navigation title: CEE to TeamForge for project members |
If you have used the tools in CollabNet Enterprise Edition, you'll find the equivalent tools in CollabNet TeamForge familiar.

Most of the tools and their functionalities are similar between CEE and CTF 6.1. However, within each tool, some
work-arounds might have been done to bring over your CEE project information.

This table shows how toolsin CEE map to CTF 6.1 tools:

CEE Tool CTF 6.1 Tool

Projects Projects

Category (Project) Category (Project Grouping)
Discussion Services Discussion

Docman Docs and Files

I ssue Tracker Tracker

PCE PCE

Wiki Wiki

Project Tracker Project Tracker (Integrated Application)
Framework Roles and Permissions

SCM SCM

Remote Publishing Remote Publishing

Project Dashboard Project Dashboard
Announcements News
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What is change management?

Change management is about monitoring and addressing work items, product defects, feature requirements, and support
regquests.

Do | have to use the administrator-given password always?
No, you don't have to use the adminstrator-given password beyond your first login into CollabNet TeamForge.
The site administrator may have provided you with a user name and password after creating your user account in

CollabNet TeamForge. When you login using those credential s, you might be asked to change your password for security
reasons. At thistime, you can set a password of your choice.

Tip: Youwill not be asked to change your password if you had created your own account, or if a password-request

&
had been raised for you or if an administrator had reset your password.

What software configuration management tools are available in CollabNet TeamForge ?
From within CollabNet TeamForge, users can browse the contents of a project's source code repositories and view detailed
information about code commits, changed files, and associations with other CollabNet TeamForge items.

CollabNet TeamForge is not intended to replace your SCM tool. Code must be checked in using Subversion, CVS, or
Perforce.

Why can't | cut and paste project pages?
Project.html components do not copy to other mediums in the format visable in TeamForge. You can link to the project page
in other documents or create a screen capture of the the page if appropriate.

For more information about TeamForge project pages, see the links bel ow.

How do | create an artifact via email?
To create atracker artifact using email Send an email message to <tracker id>@<TeamForge server>.

You can find the tracker id on the artifact list view page. Fields are mapped as follows:

e To: Tracker email address
» Subject: Artifact title

» Body: Artifact description
e Attachments: Attachments

Freguently asked questions about provisioning hardware with TeamForge Lab Management

Navigation title:TeamForge Lab Management FAQ |
Use this background knowledge to help you get the most out of TeamForge Lab Management.

Frequently asked questions about provisioning hardware with TeamForge Lab Management
INavigation title:TeamForge Lab Management FAQ |
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Use this background knowledge to help you get the most out of TeamForge Lab Management.

| don't need the priority and assigned-to fields, how do | get rid of them?
These fields are used internally by the system and can not be deleted or disabled.

Why do the open tracker counts differ from when I filter on "Open"?

The"Open" category on the summary screen is based on the meta status "Open". It includes multiple statuses; Open, Fixed,
and any other statuses that are defined as equivalent to Open by the tracker admin for your project.

For example, suppose the Tracker Summary block shows 21 Open artifacts. However, when filtering on the "Open"
status, only five artifacts are displayed.

If you filter by "All Open" you will see all 21 issues with statuses defined as Open. If you filter specifically by "Open"
you will see only the artifacts that specifically have the status "Open".

Why can't | edit a document when it opens in my browser?

If you click on adocument in TeamForge (for example, aWord doc), and it opens in your browser instead of launching a
separate M S Word window, chances are you will not be able to edit this document. The reason for thisis because your browser
has either called one of the MS document viewers, which do not have native edit capabilities, or the browser has " swallowed"
the running M'S Word process and the document has written to your %TEMP% directory as aread-only file. You can either
choose to download thefileto your desktop and then click on it to edit, or configure your browser to not swallow the application
(thisis described in various MS KB articles).

Can | force files to be downloaded, rather than opened in the browser?
You can configure the application to force your users to download files, instead of letting them open them within the browser.

Turning this mode on can prevent some of the more basic attacks on your other users. Simply add the following line to
/ opt/ col | abnet/t eanf or ge/ sour cef or ge_hone/ et ¢/ sour cef orge_confi gurati on. properti es:

sf . saf eDownl oadMode=al |

Oncethelineisin place, simply restart TeamForge for it to take effect. The default for TeamForge sets this to none,

which meansthat the user's browser will present them with the normal Open/Save options when clicking on files. When
you set thisto "all”, that pop-up will be altered so that the user's only choiceis Save. Should you wish, you can also set
thisvalueto "html" to force the user to save only html documents, while allowing all other content to behave as normal.

Why are some uploaded documents missing icons when displayed in TeamForge?

TeamForge has a small internal mapping of which icon is associated with which mimetype(s). This mapping is necessarily
small, as acomplete mapping would be exceedingly large, and almost always out of date. You can examine the mimetype that
TeamForge is receiving by examining the document's attributes using our SOAP API. You can also override this mimetype
info viathe API by uploading a new version of the document (which can be the exact same document contents).

Thereis sometimes ageneric icon for documents from certain applications. TeamForge accepts and stores the mimetype
that the user's browser sends on the HTTP upload of the original document. As an example, let's examine the M S Word
document. Some browsers will send strings like appl i cat i on/ vnd. nms- wor d; others will send

appl i cat i on/ mswor d and others will send something completely different.

Can | link to documents outside of TeamForge?

TeamForge has the concept of a"url doc" to support this very usage. When creating adocument in TeamForge, ssmply choose
this type from the Create screen and then enter the URL that references the document in the existing external system. This
will create a"placeholder” document in TeamForge that can be associated to, reviewed, etc asif it were anormal document,
while maintaining the document's actual contents in the external application.
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Can I lock a document in TeamForge?

Absolutely, yes. You can specify a document as locked at any point in time (document create, document edit, etc). You can
do thisviathe normal Ul or viathe SOAP API. Simply check the L ock document box whilein Edit Document.

Does TeamForge automatically resolve conflicts in documents made by multiple
concurrent editors?

If you store your documentsin CV'S, Subversion, or some other SCM tool, then that tool will handle conflict resolution per
its normal means. However, if you are using the Document Manager component of TeamForge, then there is no automated
means within the product to prevent another user from uploading a newer version of a given document that does not contain
the changes you just uploaded. To prevent this, we recommend you use the document locking feature of TeamForge to prevent
others from editing a document you are editing.

Why can't | reply when someone comments on my review?

By default, TeamForge doesn't add the review initiator to a review, which would be needed to facilitate this. To work around
this, simply add yourself as an optional reviewer when creating the review. Alternatively, some customers have chosen to
create aforum in TeamForge, and then include the forum's posting address in the review notes.

What document types are supported in TeamForge?

TeamForge supports al known and unknown document types. In fact, TeamForge makes absolutely no distinction on afile
type when uploading a document. This means that you can even upload binary files (like a Zip archive) into the document
manager. Note that while TeamForge will accept any incoming data stream as a document, it does use the mimetype sent by
the browser to determineif it has the proper icon to display for the document.

What is a document in CollabNet TeamForge?
For CollabNet TeamForge purposes, a document is any file that you track with a document artifact.

Any project involves some number of documents that have to be written, edited, reviewed and published. You can use
adocument artifact to facilitate and standardize the work you do with documents. CollabNet TeamForge automatically
maintainsthe version history of each document, including the person who posted each version, its status, and any version
comments.

If you are the author, use the Review feature to track the process of getting others to evaluate your document.

To make sure everyone who needs to know about a document knows about it, associate it with atask, a code commit,
or another kind of artifact.

Why doesn"t an open review automatically close when a new version of the document
Is uploaded?

TeamForge doesn"t automatically close a document review under any circumstances (new document version, review due date
passes, etc). Thiswas a conscious decision on our part in which it was decided that TeamForge cannot always be aware of the
business rules or personnel availability at a customer. For example, TeamForge cannot know that the one person whose
document review input is most needed is on vacation for the four days the document was under review. |If TeamForge were
to closethereview, then it would disappear from the user's My Page. Additionally, TeamForge cannot know that anew version
of adocument supersedes the prior versions (or that it doesn"t supersede it). You may be uploading a "draft" or
"work-in-progress" of the new version as document review feedback is received and if TeamForge were to close the review
at this point, you might have received feedback from lessthan 1 percent of the reviewers.
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| am unable to edit a specific artifact via email, but | can via the web Ul. Why is this?

There may be workflow rules applied to the tracker that require specific fields to be set. As you can only define the artifact
title and description viaemail, the artifact creation fails. If you wish to create artifacts in this tracker via email, the tracker
admin will need to disable these workflow rules.

How can | monitor a forum or mailing list?

There are two methods for monitoring aforum or mailing list in TeamForge: At the Discussion Forum level and at the My
Workspace level.

At the Discussion Forum level:

* Check the box beside the forum in question
* Select the Monitor button
* Select "Monitor Selected”

At the My Workspace level

e Sdect Monitoring.

» Select the project name.

» Sdlect the Monitored Applications tab.
» Sdlect Discussions.

* Click Save.

g~ Note:r You must monitor aforum to receive email from the mailing list associated with that forum.

Why is SourceForge Explorer forgetting my settings and not logging me in?

Certain conditions can cause SourceForge Explorer to stop functioning properly and to start behaving oddly. This can manifest
itself as the app not logging you into SourceForge, or forgetting your settings, or other general strange behavior.

To correct this behavior, you can delete your stored profile from within SourceForge Explorer.

If deleting the profile doesn't correct the behavior, try deleting the profile again, then uninstall and reinstall SourceForge
Explorer.

If that still doesn't fix it, delete the profile, uninstall SourceForge Explorer, and delete the registry key
HKEY_CURRENT _USERSof t war eVA ?Sof t war eSour ceFor ge ?Expl or er W ndows Mai nW ndow (and
al subkeys). Then reboot, then reinstall SourceForge Explorer.

Why don't | see all tracker fields when attempting to export the report?

When viewing the Report Details tab, you will see two Export buttons. The top button will only export fields that exist in
all trackers. To export al fields of the specific tracker, use the Export button located below the tracker that contains those
fields.

g~ Note: Withthe release of 4.4 SP1, the top button has been renamed "Cross Tracker Export” to reduce confusion.

Version
4.4

What is the file size limit on uploads or attachments in TeamForge?
TeamForge has a 2GB file size limit on uploads or attachments.

If you attempt to upload afile larger than 2GB using a Windows-based browser, you will not be able to upload thefile
and you may not receive an error message.
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How do | create a new forum topic?

A forum can have any number of topics. A topic start a message thread to which other users can reply. Create a new forum
topic to begin discussion of a new subject.

To create aforum topic:

Click Discussionsin the project navigation bar. The Forum Summary pageis displayed.

Click the title of the forum in which you want to create atopic. The Topic Summary page is displayed.
Click Create. The Create a Topic page is displayed.

Enter a description of the topic in the Subject field.

Enter the message text in the Message field. After the topic is created, other users can reply to this message.
(Optional) If you want to add an attachment to the topic, click Browse to select thefile.

Click Save. The forum topic is created.

No o A~wDdhRE

How do | find the email address for a forum?
The email address for the forum is displayed on the Topic Summary page. If amailing list is not enabled, you will not see
an email address on the Topic Summary page.

To find the email address for aforum:

1. Click Discussionsin the project navigation bar. The Forum Summary page is displayed.

2. Click thetitle of the forum in which you want to create a forum topic. The Topic Summary pageis displayed. The
email addressislisted in the Mailing List field.

How do | remove a user from a discussion?

Unfortunately there is not currently away for a TeamForge admin to remove a user from monitoring. You will need to have
the user login and remove themselves from monitoring viathe M onitoring button on the My Wor kspace page.

How do | post a reply to a forum topic?
To post areply to aforum message, follow the steps below.

1. Click Discussionsin the project navigation bar. The Forum Summary page is displayed.
2. Navigate to the forum topic in which you want to post a message.
3. Inthe section containing the message you want to respond to, do one of the following:

« Click Quote to quote the original message in your response message. The Post a Reply page is displayed with
the original message quoted. Click Reply to omit the original message from your response message. The Post a
Reply page is displayed without the original message.

4. Enter the message text.
5. (Optiond) If you want to add an attachment to the message, click Browse to select thefile.
6. Click Save.

The forum message is now posted. Other project members can reply to it using the same process.

| can see the message | posted to a discussion in the web Ul, but | didn't receive any of
the responses via email. Why is this?

In order to receive form posts viaemail, you must monitor the forum. You can do this by placing a check next to the forum
you wish to monitor and choosing "monitor selected" from the Monitor drop down at the bottom of the Forum list.

For more information on this see the section "Monitoring afolder" of the User Guide in the link bel ow.
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What is a discussion forum?
CollabNet TeamForge discussions provide workspaces where project members can work together online or by email.
Discussion forums and mailing lists are closely integrated. Forum administrators can choose to enable amailing list for

each project forum. A mailing list extends the discussion forum functionality to allow project membersto post messages
to the forum using email.

Discussion forums can be public or private, depending on the forum's objective and desired level of accessinto the
forum. Private discussion forums restrict anyone without specific access permissions from viewing or posting into the
forum.

In amoderated discussion, messages from anyone except "trusted" users are screened by a moderator before they are
posted. Messages posted by trusted users do not require the moderator's approval .

It'sagood idea to use a discussion forum instead of direct personal email whenever privacy or security concerns don't
prevent it, even when the communication only involves two project members.

« Members not directly involved often can make unexpected contributionsiif they are aware of the discussion.

« CollabNet TeamForge archives al newsitems, forum posts, and mailing list communications, so you can go back
and find valuable information later.

Why are some of the discussions threaded?

Posts that are sent the mailing list address of the discussion will create new topics, and hence will not be threaded. Posts that
are made in response to another post will be threaded beneath the original post.

What is CollabNet Build and Test?

CollabNet Build and Test is a plugin for the Hudson continuous integration tool. It provides integrations for CollabNet
TeamForgetracker, file rel ease and document applications, authentication and authorization, and TeamForge L ab Management.

The plugin components allow you to do the following:
» Authenticate user credentials against a CollabNet site

g~ Note: This component requires a TeamForge 5.2 server.

« Provide Hudson roles and permissions to CollabNet users
» Upload Hudson build filesto a CollabNet file release after a successful build

g~ Note: This component requires the Hudson Promoted Builds plugin.

» Upload successful builds that satisfy additional criteriato a CollabNet file rel ease using Hudson's Build Promotion
plugin

« Upload files to the documents application on a CollabNet server

» Create and update CollabNet Tracker artifacts based on build status

« Upload filesto aLab Management Project Build Library after a successful build

g~ Note: This component requires a TeamForge Lab Management server.

Since the plugins are independent, you can use all or any combination of them in your Hudson installation.
CollabNet Build and Test also provides a single-sign-on option for Lab Management and Hudson.

Important: If the CollabNet site configured in your Hudson installation is not accessible, for example, dueto a
network outage, you will not be able to log in to your Hudson site.

[ N
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How can | import tasks into TeamForge Task Manager?

Tasks can be imported into the Task Manager by using the CollabNet TeamForge Task Management Plugin for Microsoft
Project

Can | associate objects of different projects?
Yes, you can associate an object (for example from document to subversion commit) in one project to an object in another
project if you have access or are a Site Admin.

You must have permission to view the object that you're associating with before you can associate with that object,
unless you are a Site Admin.

| deleted the email that verifies my CVS password. How can | retrieve my password?
You can sync up your TeamForge login and CV S passwords by changing your password in TeamForge:

1. Loginand click on My Workspace.

Click on My Settings.

Click on Change Password.

Enter your old password and new password.
Click Submit.

arwDd

Note: The old and new passwords can be the same if you do not wish to actually changeit.

=

Does CollabNet TeamForge support merge tracking?
The Subversion repositoriesthat areinstalled with CollabNet TeamForge run on Subversion 1.5, which supports merge tracking.

Any Subversion 1.5 servers you have integrated with CollabNet TeamForge support merge tracking. If you need the
merge tracking feature and your Subversion server is running a version earlier than Subversion 1.5, you must upgrade
to Subversion 1.5 to get this functionality.

If you used svnner ge. py (http://www.orcaware.convsvn/wiki/Svnmerge.py) to do merge tracking before Subversion
1.5, and you want to convert your svnmrer ge. py datato the Subversion 1.5 merge tracking data format, CollabNet
provides amigration tool, linked below.

What happens when | post to a moderated discussion forum?

A messageto amoderated discussion forumisheld until amoderator actsonit. (Except if you are atrusted user. These messages
don't require moderation.)

« Themoderators of the discussion receive an email notification that you have posted amessage. The email notification
contains the URL path to moderate the post.

* A moderator can either approve or reject your message.

« |f the moderator accepts the message, the message status changesto "Accepted” and the messageis posted to all the
users monitoring the forum.

« |f the moderator accepts the message and trusts the sender, the message status changes to "Approved and Trusted"
and the message is posted to all the users monitoring the forum. All subsequent posts from you are automatically
approved.

» |If the moderator rejects the message, he/she can include his’/her comments or reasons in the moderation rejection
email, and the message is removed from the archive.

* Inthe All Topicstab, an hourglassicon indicates which topics contain posts that await approval .

Who can be a moderator?
A discussion forum moderator is selected by the forum administrator.

* You can be amoderator by being a project member with forum post permissions.


http://www.orcaware.com/svn/wiki/Svnmerge.py
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* A moderator can moderate a discussion forum using emails or the web Ul or one of the Collabnet desktops.

If themailing list isn't enabled for amoderated discussion forum, moderation can be done only through the web UI.
« A moderator can approve a message, approve a message and trust the sender, or reject the message.

Note: To enable or disable moderation or add or remove moderators, you must be either the forum administrator
or project administrator.

How can | reduce the number of emails from monitoring a folder?

Monitoring afolder might spam the mailboxes with emails that are generated for every small change. Email notification
preferences under the M onitoring sub-tab under My Workspace can be modified to Send Daily Digest Email, which provides
asummary of the email alerts.

1. Goto My Workspace under the TeamFor ge toolbar

2. Click on Monitoring

3. In Edit Monitoring Subscriptions, click on Email notification preference

4. For each project, the monitoring folders under various components (Tracker/File Rel eases/ Tasks/Discussions/Wiki)
can be customized to Daily Digest Email.

How can | stay informed about events on my CollabNet TeamForge site?
To keep up with changes, you can be notified by an automatic email when an item you are interested in is updated.

Monitoring items lets you stay up to date automatically on all changes without having to log into CollabNet TeamForge
and check the status of each item.

You can monitor individual items, folders, and entire applications in each project for which you are a member. You can
configure the frequency of email natifications to suit your personal preferences, and suspend monitoring messages
entirely if you are out of the office or for any reason do not want to receive messages.

Items that can be monitored include:

« Entire applications, such as all tasks or all documents.

¢ Folders, such astask folders or document folders.

e All itemsin atracker, forum, or package.

« Individual items, such as atask, a document, atracker artifact, or arelease.

You can tell by looking at each item whether you are currently monitoring it and how to begin or end monitoring it.

» For eachitem, list of items, or folder, you see aMonitor button or menu option.
» If you are currently monitoring an item, the M onitor option is replaced by a Stop Monitoring option, and the
monitoring icon is displayed.

Whenever you create an item or edit an item, you automatically begin monitoring that item.
You do not receive monitoring notifications for your own changes to a monitored item.
If you have the appropriate permissions, you can see who is monitoring an item.

You can add other usersto the monitored item. After auser isadded to amonitored item, the user can continue monitoring
the item, configure monitoring preferences for the item, or stop monitoring the item.

Why would | want to make a discussion forum moderated?
Automated processes can only do so much to protect forum quality. Moderated posting can be thought of as atemporary
transfer of control from automated processes to a human decision maker.

Software can instantly analyze an email to determine whether the sender is allowed to post messages directly to the list
or if the message should be sent for moderation. However, the software doesn't recognize the sender as a person who
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participates in the organization, nor does it have the sophistication needed to determine whether the message contents
are on-topic for the mailing list.

Advantages of moderated posting:

* Moderators help keep content on-topic by rejecting off-topic messages and providing helpful suggestions to users
whose posts are rejected.

* Moderators help maintain a positive environment for list users by rejecting messages containing harsh or abusive
language.

e Moderators can allow deserving nonmembers to post to lists that are ordinarily closed to nonmembers.

* Moderators prevent spam.

Example

Ashish makes the development forum in his project a moderated one as he wants to make sure that al the messages
posted to the discussion come to him for approval before they're included in the forum. When a message arrives, he
reads the message, and if it's appropriate for the discussion, he acceptsit; if not, he rejectsiit.

Over time, Ashish finds that the traffic in his discussion hasincreased and he is no longer able to moderate al the posts
by himself. So he adds a couple of other senior developersin his project as moderators, who can share the responsibility
of moderating the forum.

After awhile, Ashish realises that he doesn't have to reject any messages posted to the forum as everyone seems to
understand the purpose of the forum and uses appropriate language in emails. So he removes the restriction and make
the forum an unmoderated one. Now Ashish and the other moderators no longer receive emails for approval when a
user posts amessage to the discussion. Messages are directly included in the forum and delivered to the forum subscribers.

Is it possible to move an artifact from one tracker to another?

Yes. Simply use the cut button to remove the artifact, then paste it to another tracker. The destination tracker need not be in
the same project, but if the tracker definitions differ data could be lost.

Can I move a discussion to another project?
No. Discussions cannot be moved between projects.

For more information see: Discussions and mailing lists

How can | change the display order of the fields in my tracker?
Simply drag and drop the fields within your browser. Horizontal rules may also be added in this manner.

How do | find the version of my MS Project plugin?
To obtain the plugin version, select Sour ceFor ge>Synchronize, and when the login pops up, hoveri the mouse over the
SourceForge masthead. A tooltip will pop up with the component version numbers.

The version we're interested in is SFProject.DLL. It will show something like:

V2. 1.1699. 19433

Synchronizing my project plan, why do | get the error "Unable to check for pending
changes"?

Thiserror indicates that at some point after importing your project into TeamForge, you went into TeamForge and deleted the
top-level task folder that was imported.

Once imported, metadatais added to your project filein MS Project that indicates which item ids are inside TeamForge
that correlate to the items within your project plan. By deleting the top-level task folder, the synchronization method
can no longer determine which items in TeamForge correspond to the items within your project plan. Hence, it cannot
determine if there are pending changes. To correct thisissue, open M S Project, access the Tools menu, and then select


http://help.collab.net/index.jsp?topic=/csfe500/tasks/forums.html
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Unbind from the TeamForge options. Thiswill remove the meta data from your project plan, effectively returning it to
apre-import state. You should now be able to re-import into TeamForge without error.

How can | access the native install version of TeamForge? | can only find the VMWare
version.

You will need to contact your account manager; the TeamForge VMWare license does not include access to native install
media.

How do | create a parent/child artifact?
A tracker artifact can be a parent or a child to another artifact.

e A child artifact can have only one parent.
e A parent artifact can have any number of children.
« A parent artifact cannot be closed if achild is open.

To create a new parent/child artifact of an existing artifact:

1. Click on the Dependencies tab of the artifact.

2. Click onCreateNew Parent or Create New Child. Fill intheform asyou would for submitting an unrel ated artifact.
3. Click Next.

4. Enter acomment that describes the relationship, if appropriate.

5. Click Finish.

Note: If Choose Parent or Create New Parent is not visible, the artifact already has a parent artifact.

-

How do | put a notice to my users on the project home page?
To do this you will need to create a news item within the project. News items are posted and displayed on the project home
page. News items are a so displayed on the TeamForge home page.

To post anews item:

1. Navigate to the home page of the project in which you want to post the news item.

< From within the project, click Project Home in the project navigation bar.
« From anywhere in TeamForge, choose the project from the Proj ects menu in the navigation bar.

2. Inthe Project News section, click Add. The Create News Post page is displayed.
3. Enter atitle for the newsitem.
4. Enter thetext for the news item in the message field (up to 4000 characters including spaces), then click Add.

The news item is submitted. It is displayed on the project home page and the TeamForge home page immediately.

What is an agile project team?

Asamember of aproject team, you implement product features according to user stories created by the product owner and
planning input from the project leader.

Project team members must use their experience and judgment to estimate the effort involved in work that's been specified
by the product owner and the project leader. These estimates will often lead to changes in the product scope and the
project plan. In that sense, project team members are an important part of the agile planning process.

The project team members may be known as devel opers, programmers, engineers, individual contributors, or something
€else that's appopriate to the type of work being done.

In TeamForge, the project team member's main focus is the tracker. Project members can manage and track their work
by observing and maintaining tracker artifacts such as user stories, defects, or tasks.
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What is a release?
A release isagroup of one or more files that are published as a unit.

Each release can have a maturity level attribute to describe its state of completeness. Maturity levels are predefined and
include development build, alpha, beta, and general availability.

The CollabNet TeamForge file release system enables users to publish files and groups of files to selected audiences.
Using role-based access control, administrators can control which project members can access each package or release.

How do | remove a news item?
You can delete any news item that you no longer want displayed on the project home page. Deleting anewsitem from aproject
also deletes it from the TeamForge home page.

To delete anews item:

1. Navigate to the project home page.

e Fromwithinthe project, click Project Homein the project navigation bar. From anywhere in TeamForge, choose
the project from the Projects menu in the navigation bar.

2. Inthe Project News section, click Delete next to the news item that you want to delete. When prompted, confirm
that you want to delete the news item, and it will be deleted.

What kind of objects can | create reports on?

Reports can report on datafrom trackers and tasks. Task reports can report on datain asingle project or across multiple projects.
Tracker reports can report on datain a single tracker or across multiple trackersin a project.

How do user roles work?

Project administrators can define specific access permissions for individual project members. They do this by using global
project roles and/or creating roles and assigning the roles to project members.

Under role-based access control (RBAC), permissions are not assigned directly to an individual user. Instead, each user
has the permissions that are attached to any role that is assigned to that user.

A project member can be assigned multiple roles.

In CollabNet TeamForge, site or project administrators assign roles to the site users or project members. Besides this,
aproject member can submit arole request to the project administrator. The project administrator can approve or reject
such requests.

When you define users, user groups and roles with specific permissionsin one project, they can be inherited in one or
more subprojects. This helps you avoid duplicating the effort of defining users, user groups and roles across projects.

Note: Permissions are cumulative. If a project member is assigned arole that provides a specific permission, and

[ 1§ .
another role that does not, the user has that permission.

A role defines these things:

* The applications that project members with that role can and cannot access.
» Theresources on which project members with that role can use the applications.
» Theactionsthat project members can take in each application and on each resource.

g~ Note: If auser hasan SCM license, that user can see only the tools that support the core source control functions
- of the site, even if the user has arole that would otherwise grant access to other resources.

When auser's roles do not include access to an application or resource, that application or resource is not visible to that
user. For example, imagine that you are assigning roles to Jason, a software devel oper. Jason needs to check source code
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in and out in order to fix bugs, develop features and create software releases. However, Jason does not need access to
the wiki. If you set up Jason's roles according to those requirements, Jason's experienceis like this:

« Onany pagein the project site, Jason can see and click the Tracker, Source Code, and File Releases buttons along
the top of his screen.

« Jason does not see the Wiki button.

« |f someone sends Jason a link to a page in the Wiki application and Jason clicks the link, he gets an error message.
(The message does not specify whether the page exists or not.)

* When he accesses the project directly from Eclipse or Visua Studio, Jason can expand the project node and browse
the Tracker, Source Code, and File Releases nodes, but not the Wiki node.

g~ Noter A user'slicensetypealso influenceswhat the user can see and do on your site. A user'slicense type supersedes
~ any role assignments.

* AnALM license enables the user who holds it to use the full range of TeamForge features. both the core
source-code management tools and the extended application lifecycle management functionality.
» An SCM license enables the user who holds it to use the core TeamForge source-code management tools.

Ask your site administrator how many licenses of each kind are available for your users.

Applications

An application is a collection of related features designed to enable a user to collaborate on particular kinds of tasks.
For example, the Documents application hel ps users create documents, sharein document reviews, and publish documents,
among other things.

In the Web interface, each application is represented by a button in the navigation bar at the top of any project page. A
given user can see the buttons corresponding to applications they have access to by virtue of the roles assigned to them.

Applications are also known as "tools."

Resources

« Thetracker application might contain a bugs tracker and afeature request tracker. These are the tracker resources.
* A project can contain multiple SCM repositories. These are the SCM resources.

Permissions

View Allows usersto view and download items, but not to create or edit items, administer folders,
or edit application settings.

Create or Submit Allows users to create new items, but not to edit items, administer folders, or edit application
settings. Users with the create or submit permission also have the view permission.

Edit Allows usersto edit items, but not to administer folders or edit application settings. Userswith
the edit permission also have the view permissions.

Administer Allows usersto create and edit items, administer folders, and edit application settings. Users
with the administer permission also have the edit, create or submit, and view permissions.

Delete Allows users to delete items, but not to administer folders or edit application settings. Users
with the del ete permission also have view permissions.

How do | save areport so | can run it again later?
In order to save areport for later use, you will need to define the report criteria and save it in areport template.

To save areport template:

1. Click Reportsin the project navigation bar. The List Reports page displays alist of existing report templates.
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2. From the drop-down menu, choose atype of report template, then click New. The Task or Tracker Report Criteria
pageis displayed. Available report types are:

» Task Report - Reports on the numbers of tasks assigned to each user.
o Tracker Report- Reports on the numbers of artifacts submitted to selected project trackers.

3. Select your desired report criteria. Thefields on the Report Criteria page differ for each report type. Click Generate
Report.

The report results are displayed and the template is saved.

What's the best way to search the CollabNet User Information Center?

Searching this site with the Eclipse search tool is alittle different from searching the Web with a service such as Google. Here
are some guidelines for getting the most out of a search on this site.

» UseAND to require the term on each side of the AND operator be present in the topic.

Note: When you don't put anything between terms, the search tool assumesyou mean AND. Topicsthat contain
every term in the query are listed in the search. For example, if you enter database service, topics that contain
both the term database and the term service display. Topics that contain only the term service or only the term
database do not display.

[ 1

» Use OR before optional terms. For example, if you enter database OR service, topicsthat contain either the term
database or the term service display.

* UseNOT beforeaterm that you want to exclude from the search results. For example, database NOT service displays
topics that contain the term database, but do not contain the term service.

« Use ?to match any single character. For example, plu? displays topics that contain plug.

» Use* to match any set of characters, including an empty string. For example, plu* displaystopicsthat contain plug
or plugin.

» Use double quotation marks to enclose aterm that is to be treated as a phrase. For example, "edit menu" displays
topics with this entire term, not topics with only the term edit or the term menu.

« Caseisignored. For example, database service displays database service, Database Service, and DATABASE
SERVICE.

» Punctuation acts as aterm delimiter. For example, web.xml displays topics that contain web.xml, web, and xml. To
display only topics that contain web.xml, enclose the term in double quotes.

* Inasearch query, if you enter create, topicsthat contain create, creates, creating, and creation are displayed. To only
see the term create, enclose the term in double quotes.

« Thefollowing English words are ignored in search queries: a, and, are, as, at, be, but, by, in, into, is, it, no, not, of,
on, or, s, such, t, that, the, their, then, there, these, they, to, was, will, with.

Can | subscribe to a CollabNet TeamForge discussion forum's mailing list through an
email?

Sure, you can subscribe to a discussion forum's mailing list to keep up with changes, via an email. When you subscribe or
monitor a discussion forum, you are notified by an automatic email whenever thereis any update to the discussion.

Tosubscribetoamailing list: You can subscribe to the discussion forum's mailing list by sending an email to<mmai | i ng
i st nane>-project name-subscri be@domai n>.

You must have the "Discussion: view" permission to be made a subscriber. Check with your forum administrator, if you
do not have the permission.

Aswith other itemsthat you may be monitoring, the discussion forum to which you subscribe viaan email isalso added
tothe My Workspace > Monitoring > Monitored Objects list. Your user name is added to the "Users Monitoring"
list of the discussion forum. Both these entries are removed when you unsubscribe from the mailing list.

To subscribe in digest type, send an email to<mai [ i ng |i st nane>- proj ect
nane- di gest - subscri be@donai n>
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To unsubscribe from a mailing list: You can unsubscribe to the discussion forum's mailing list by sending an email
to<mai ling |ist name>-project nane-unsubscribe@domai n>.

What is a task dependency?

Task dependencies show what must be done before a given task and what will be done after the task is complete. Project
managers can create dependencies between any two or more tasks in a project.

Task dependencies allow you to establish relationships between tasks. This can help to frame atask in the context of a
larger project plan.

There are two types of task dependencies:
* Predecessors are tasks on which another task depends.

For example, before you can complete the task "Finalize project plan,” you might need another project member to
complete the predecessor task "Hire new staff."

* Successors are tasks that depend on your task.

In this example, "Finalize project plan” is a successor task to "Hire new staff."

g Note: Task dependencies and tracker artifact dependencies are different things.

« For tracker artifacts, an artifact with dependencies (a"parent" artifact) can't be considered closed unless all of
its dependent artifacts ("children™) are closed.

» For tasks, a dependency means one task can't start until another task is completed.

g~ |mportant: A task cannot be dependent on itself. You cannot make atask both a predecessor and a successor to
- another single task. If you attempt to do so, you will receive a circular dependency error.

Why can't | synchronize between Microsoft Project and CollabNet TeamForge?

Some conditions, such as having tasksthat are pending change approval in CollabNet TeamForge and Microsoft Project, cause
synchronization to fail.

Tasks pending change approval

If you have tasks that are pending change approval in CollabNet TeamForge , you will receive warnings during
synchronization. Address any pending change reguests, then try your synchronization again.

Tasks with no start or end date and dependencies

If you have atask that has either no start or no end date, and one or more dependencies, you will receive warnings that
you're unable to synchronize. Add the missing date or remove the dependencies, then try your synchronization again.

Milestone dependencies

Milestones with either predecessor or successor dependencies on other milestones or on regular tasks will cause
synchronization errors. To remove these errors, remove the milestone dependenciesin your Microsoft Project plan, then
try your synchronization again.

Non task-to-task dependencies

All dependencies must be task-to-task. Predecessor or successor dependencies between atask and atask folder, atask
and a critical or milestone task, or any combination thereof, will cause synchronization errors. To remove these errors,
remove al non task-to-task dependencies, then try your synchronization again.
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Non finish-to-start dependencies

All dependencies must be finish-to-start. Microsoft Project supports other types of dependencies, such as start-to-start;
however, these are not supported by CollabNet TeamForge and will cause synchronization errors. To remove these
errors, remove all non finish-to-start dependencies, then try your synchronization again.

Missing journal file

A Microsoft Project journal fileis created automatically with each Microsoft Project file that you synchronize with
CollabNet TeamForge Enterprise Edition 4.4 and later versions. If thisfileis missing, you will receive synchronization
errorsor dataloss. To removethese errors, locate the journal file and copy it into the same directory where your Microsoft
Project fileis saved.

Why are Microsoft Project and CollabNet TeamForge doing things | don't expect?

When you synchronize Microsoft Project and CollabNet TeamForge, in some conditions the tool works as designed but the
behavior might seem unexpected. For example, an empty task folder in CollabNet TeamForge creates ablank task in Microsoft
Project.

Why are there blank tasks in Microsoft Project?

If you have an empty task folder in CollabNet TeamForge, Microsoft Project creates a blank task when synchronizing.
Thisis because Microsoft Project does not have the concept of atask folder, only a parent task. The blank task remains
only until you add one or more tasks in the folder.

How are task dependencies handled?

Microsoft Project enforces stricter dependency handling than CollabNet TeamForge does. If you use CollabNet TeamForge
dates that conflict with Microsoft Project dependency handling, Microsoft Project adjusts your dates during
synchronization. For example, CollabNet TeamForge allows you to have atask end date |ater than the start date of a
successor task. Microsoft Project does not, and adjusts the start date of the successor task.

Are dependency constraints supported?

Synchronization does not support dependency constraints. For example, consider a scenario where the start date of a
successor task equals the end date of a predecessor task plus x number of days. If you change the end date of the
predecessor task in CollabNet TeamForge, and then synchronize, Microsoft Project does not adjust the start date of the
successor task until the end date of the predecessor task runs up against this start date.

g~ Note: Thisis contrary to the cascading dependency handling behavior in CollabNet TeamForge.

Are zero-duration milestones synchronized?

Zero-duration milestonesin your Microsoft Project plan are not synchronized with CollabNet TeamForge. They remain
in your Microsoft Project plan, but do not generate CollabNet TeamForge tasks. Only milestones with start dates, end
dates, and no dependencies, get synchronized with CollabNet TeamForge.

Does synchronization support removal of dependencies?

In your Microsoft Project plan, if you change the start date of atask that has predecessor dependencies, you are shown
a popup window asking whether you want to retain the dependency. You must exit the popup window and remove the
dependency manually in order for the change to be synchronized with CollabNet TeamForge. If you remove the
dependency using the popup window, it could result in synchronization errors.

Are multiple resource assignments supported?

Microsoft Project allows you to assign atask to multiple resources, and to specify the percentage of time each resource
will spend on the task. CollabNet TeamForge supports only single-resource assignment per task. If you have more than
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oneresource assigned to atask in Microsoft Project, with or without percentage all ocations, thisinformation gets removed
during synchronization. The task is assigned 100 percent to the first resource specified.

Are Gantt chart changes recognized?

Microsoft Project allows you to manipulate task start and end dates by dragging the task bars on the Gantt chart. Task
changes made in this way are not recognized by CollabNet TeamForge and are not synchronized.

Are task notes synchronized?

No, task notes entered in Microsoft Project are not synchronized.

How is task duration handled?

Microsoft Project allows you to have a task duration specified in hours. When synchronizing, any task with aduration
in hoursis rounded up to the nearest whole day.

What's the difference between an ALM user license and an SCM user license?
The type of license you have determines what you can do on your TeamForge site.

Your site administrator has assigned you a site license. Your licenseis of one of two types:

« AnALM license enables you to use the full set of tools on the site, including Source Code, Trackers, Documents,
Tasks and Reports.

* An SCM license enables you to use the site for basic source code management. You can browse repositories and
participate in Wiki conversations.

If you had an account on a TeamForge 5.3 site or earlier, you automatically have an ALM user license.

What fields can | use in a tracker?

You can use fields provided by TeamForge, and you can create your own custom fields. Most trackers use amix of
TeamForge-provided fields and user-defined fields.

TeamForge-provided fields
Some fields are provided by TeamForge for all trackers.

System-defined fields: Some TeamForge-provided fields are always present in every tracker. These are identified as
"system-defined" fieldsin the field list.

e TheArtifact 1D, Title, and Description fields are system-defined fields. They are aways present and always come
first when you view an artifact.

« Some system-defined fiel ds can be reordered. For example, the Priority and Assigned To fields are system-defined
fields, so they are always present, but you can move them around in your tracker's display.

Configurable Fields: Somefields are available for any tracker, but can be modified in different ways. These are called
"configurable” fields.

« Any configurable field can be arequired field. When afield isrequired, a user can't submit an artifact without
providing avalue for that field.

» Some configurable fields can be disabled. When afield is disabled, TeamForge does not store data for it or include
itin calculations. For example, the Reported in Releasefield is meant for tracking bugs, so you may want to disable
it for atracker that's for user stories. But the Status field isimportant for any tracker, so it can't be disabled.

» For some configurable fields, you can specify whether users see the field when they submit an artifact.
« Some configurable fields need values for users to choose from. You have to provide those choices.
* You can set the width and height of configurable text fields.
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User-defined fields

When none of the TeamForge-provided fiel ds captures exactly the information you need to track, you should create a
field tailored to your own needs. Such fields are identified in the field list as "user-defined” fields. See Create your own
tracker fields on page 26 for details.

What is a tracker?

A tracker isacollection of records that follow the devel opment of a unit of work from conception through to completion. You
can create atracker to manage amost any kind of work that your project calls for.

In each CollabNet TeamForge project, you can create any number of trackers. Each tracker tracks a different type of
data.

For each tracker, you can define values for status, category, and other default fields. You can create your own fields to
capture additional datathat is specific to your project or organization. You can also create tracker workflows to specify
the criteria necessary for users to change tracker status values.

Individual tracker entries are referred to astracker artifacts. The role-based access control system enables you to control
which project members are allowed to view, create, and edit tracker artifacts.

Summary information about the number and status of project tracker artifactsis provided on each project's Tracker
Summary page. The Project Dashboard also provides an at-a-glance overview of the status of each project member's
projects, including information on the number and status of the tasks and tracker artifacts in each project, and project
overrun and underrun statistics.

What is tracker workflow?
To help users handle their tracker items effectively, you can set up some workflow rules. Workflow rules require a user to do
something to atracker before they can reassign it or update its status.

Administrators can define these kinds of workflow rules:

Statustransitionsthat a user can makebased For example, if an artifact is Open, you can specify that it can be
on an artifact's current status. changed to Pending or Cannot Reproduce, but not to Closed.

Statustransitionsthat a user can makebased For example, if an artifact is Pending, you can specify that only users
on hisor her role. with the role QA Engineer can changeit to Closed.

Field valuesthat a user must providewhen  For example, if an artifact is Closed, you can specify that auser must
making a specific status change. enter acomment in the Commentsfield before changing the artifact's
status to Open. You can also require an attachment.

You can create a workflow for each combination of tracker status valuesin atracker.

What is an activity table component?
An activity tableisaspecia kind of text component that gives project members quick accessto afocused set of artifacts,
action items and work products.

An activity table includes organized links to up-to-the-minute information about work that is going on in the project.
You can add, remove or change these links with the HTML editor that comes with every text component.

You can add static links to particular artifacts, or you can link to a search query. When you link to a query, you enable
project usersto get al the results of the query with asingle click.

The activity table template isjust a suggestion for how you might want to organize your information. You can change
any of its properties to support the way your project members work.
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What is a project page component?
A project pageisacollection of simple portlet-like components that enable you to add custom HTML content, reports, project
tracker queries, and much more to the project home page so your team quickly access what isimportant.

For more information, see the following topics:

« Reorder a project page component
* Delete a project page component
» Rename a project page component

What is TeamForge?
|Navigation title:What is TeamForge?



http://help.collab.net/index.jsp?topic=/csfe500/tasks/reorderprojectpagecomponents.html
http://help.collab.net/index.jsp?topic=/csfe510/tasks/deleteprojectpagecomponent.html
http://help.collab.net/index.jsp?topic=/csfe500/tasks/renameprojectpagecomponent.html
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CollabNet TeamForge integrates software configuration management (SCM), continuous build and test, issue tracking, project
management, |ab management, and collaboration tools into a single Web-based application lifecyle management platform that

empowers distributed teams to deliver great software.
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Join a TeamForge site
CollabNet Desktop - Microsoft Windows Edition
. CollabNet Desktop - Eclipse and Visual Studio Editions
. Lead a project team with CollabNet TeamForge on page 88
. WWork on tasks on page 29
. Manage source code on page 61
. Plan and track anything on page 14
. Build and test your software on page 75
. Provision hardware on page 66
. Release products on page 80
. Report on project activity on page 109
. Participate in discussions and mailing lists on page 50
. Contribute to the project wiki on page 59
. Document your work on page 41

RSN REEREB®Y®

What is a wiki component?
A wiki component lets you link to an existing wiki page from a project page.

Which role is assigned to me?

There are several ways in which you could have been assigned certain roles in CollabNet TeamForge. Your access to the
projects depends largely on the permissions granted to you via your roles.

You could have been granted access to any CollabNet TeamForge project in any of the following ways:

» Through site-wide roles (assigned directly to the user)

» Through global project roles (assigned directly or inherited via another project, either individualy or as agroup
member)

« Through project roles (assigned directly or inherited via another project, either individually or as a group member)
» Through permission inheritance (via project hierarchy)

There are two ways you can check which roles are assigned to you in any of your projects:

g~ Note: If you are asite administrator, you can view any user's access rights to the system.

To view the roles assigned directly to you:
Usethe My Workspace > Projects page and click the My Projects tab.

g~ Note: Youcan click the role to view the folder-level permissions assigned to you in a project.

To view all the roles assigned to you:
Usethe My Workspace > My Settings page and click the Roles tab.

You can select Roles Created For a Project, Roles Inherited From a Parent Project or Site-wide rolesto view the
corresponding roles assigned to you.

g~ Note: A global project role that has been assigned to you in a project where you are a direct member will be listed
- asadirectly assigned role.

g~ Note: Youcan click the role to view the folder-level permissions assigned to you.


http://help.collab.net/topic/cndesktop-win/action/vsdesktop_CTF.html
http://help.collab.net/topic/cndesktop-eclipse/action/vsdesktop_CTF.html
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Who can work with documents?
Any project member with the Document Edit permission can edit a document.

Why would | attach things to a wiki?

The most common example of when you would attach something to awiki would be when you need an image in the wiki page
and you're concerned that if theimageis hosted remotely (acorporate web server, for exampe), it might be moved or removed.
Additionally, you might wish to attach afileto awiki page if the attachment is only truly important in the context of the wiki
page and therefore isn't important enough to be uploaded to the Document Manager of TeamForge.

How do | delete an attachement from a wiki page?
Use the steps below to delete an attachment.

* Browseto the wiki page that contains the attachment and click Edit.
« Update the wiki page, even though you've not made any changesto it.
* Click Show Details.

» Click the Attachments tab.

e Select the attachment you want removed and click Remove.

| set my project to "use wiki homepage" so why isn't my wiki showing up?

TeamForge currently usestwo distinctly different wikis. Thereisthe wiki you've already edited, which isavailable by clicking
on the Wiki button at the top of any project page, and there is the "project home" wiki, which is what you enabled in the
Project Admin screen. If you visit the project home page after setting this option, and you have the proper RBAC permissions,
there should be an Edit button in the bottom-right corner of the home page under the graphs. Use this button to edit the project
home page wiki.

How do | edit the wiki home page?

Once you've enabled the wiki as the project home page option in Project Admin, you must return to the project home page by
clicking the Project Home button. There will be an Edit button on the bottom right of the page under the graphs. You may
need to scroll your browser window to the right to see this button.

Frequently asked questions about managing projects with CollabNet
TeamForge

|Navigation title: Project administrator FAQ
Use this background information to help support the work of project members.

General questions about using TeamForge
Common questions about using TeamForge.

CollabNet TeamForge - Project Administration FAQ

How do URLs in CollabNet TeamForge 6.1 compare with URLs in CollabNet Enterprise Edition?
The URLsin CollabNet TeamForge 6.1 and CollabNet Enterprise Edition are not exactly the same, but they can be made to
work together.

Any bookmarks you have saved in CollabNet Enterprise Edition projects can now be accessed from within CollabNet
TeamForge 6.1.

CollabNet Enterprise Edition URLs that specify item identifiers, such as artifact ID, document ID or discussion post
ID, are specified are routed to the exact item page in CollabNet TeamForge 6.1. However, CollabNet Enterprise Edition
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URL sthat do not have exact item identifiers may be routed to the tool's main page or project home page. As an example,
link to CollabNet Enterprise Edition's specific post ID is redirected to the exact post ID page whereas, the link to a
discussion forum may be re-directed to the Discussions>Forum Summary page.

Note: If any of your bookmarked CollabNet Enterprise Edition URLs are not routed to the CollabNet TeamForge
6.1 URLSs, contact your system administrator.

Only the URL s listed here will work the same way in TeamForge 6.1 asin CollabNet Enterprise Edition. You may need
to change some other URL s manually and communicate the changes to your site members. For example, there may be
aform submission to enter Project Tracker artifacts which may look like:

I servlets/tracking/action/CreateArtifact?type=defect.Theequivaent URL in TeamForge 6.1
would be: / t racker/tracki ng/linki d/ prpl 1042/ action/ Creat eArtifact ?t ype=defect .You
should get the corresponding URL s from the CollabNet TeamForge site and update your HTML or project pages
accordingly.

Note: If you are making thetransition viaastaging site, do thisin production, after the upgrade is compl ete, because

[ i
changes you make on the stage site are not preserved.

Issue Tracker

CollabNet Enterprise Edition URLS, where issue tracker IDs or PCNs are specified, are re-directed to the exact artifact
or tracker appropriately. Any other Issue Tracker tool-specific URLs are re-directed to the CollabNet TeamForge 6.1
Tracker application's home page.

« After migration, enter a CollabNet Enterprise Edition URL of an Issue Tracker issue in the browser address bar like:
https://project.domain/ issues/show bug. cgi ?i d=xxx. Thisgetsre-directed to aURL like:
https://host/sf/go/artfxxx.

Discussions

CollabNet Enterprise Edition URLSs, where forum IDs, topic IDs or post I Ds are specified, are re-directed to the exact
forum, topic or post appropriately. Any other discussionstool-specific URLsarere-directed to the CollabNet TeamForge
6.1 Discussions application's home page.

* Bookmarked forum URLSs of the form
htt ps://project.domain/ds/vi ewfor unSummar y. do?dsFor um d=xxxx are correctly redirected
to the corresponding forum in the CollabNet TeamForge's Discussions tool like
https://host/sf/di scussion/do/listTopics/projects. project/discussion.forund.
» Bookmarked message url's of the form
https://project.donain/ ds/vi emessage. do?dsFor unm d=xxxx?dsMessagel d=xxxx are
correctly redirected to the corresponding topic or post page depending on whether the message represents a post or

atopic, like:
htt ps: // host/ sf/ di scussi on/ do/ | i st Post s/ proj ects. proj ect/di scussi on. forumd.topicid...
* Any other url'sof theformht t ps: // pr oj ect . domai n/ ds/ . ... areredirected to the Forum summary page

ashttps://host/sf/gol/projects. project/discussion..

Documents
CollabNet Enterprise Edition URLs, where document | Ds are specified, are re-directed to the appropriate exact document.
Any other document tool-specific URLs are re-directed to the CollabNet TeamForge 6.1 Documents application's home

page.

e CollabNet Enterprise Edition URL.:
https://project.domain/servlets/Project Docunment Reser vati onAdd?docunent | D=xxx
isre-directedtoht t ps: // host/ sf/ go/ docxxx.
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CVS

« For repository browsing purposes, CVS URLs are appropriately redirected to CollabNet TeamForge 6.1 Viewvc
URLs. https://project. domai n/ source/ browse/ proj ect/dd. t xt ?r 1=x&r 2=y isre-directed to
https://host/integration/viewc/vi ewc. cgi/dd. txt ?r oot =pr oj ect &yst enFexsyxxxx& 1=x& 2=y

« For purposes of checking out or committing with a client, see the Sour ce Code tab of the CollabNet TeamForge 6.1
project for the new repository path. CV S working copies must be recreated (checked-out afresh).

SVN
Subversion URLs for specific revisions of afile, log messages or difference between two revisions are appropriately
redirected to CollabNet TeamForge 6.1's Viewvc URLS.

e CollabNet Enterprise Edition URL:

https://project. donai n/ source/ browse/ proj ect/trunk/test.txt?vi ew=rmar kup&pat hr ev=x

isre-directed to

https://host/integrati o/ viewc/ viewc. cgi / trunk/ test . txt 2r oot =or g ect &syst enexsyxox&vi evenar kup&pat hr ev=x
« CollabNet Enterprise Edition URL:

https://project.domai n/ source/ browse/ project/trunk/test.txt?viewsl og&pat hr ev=x

isre-directed to

https://host/integrati o vi ewc/ vi ewrc. cgi /trunk/test. txt 2 oot =or of ect &syst enrexsyxox&i ewd og&pat hr ev=x
« CollabNet Enterprise Edition URL:

https://project.domain/ source/ browse/ proj ect/trunk/test.txt?r1=x& 2=y&pat hr ev=x

isre-directed to

https://host/integrati oV viewc/ viewc. cgi /trunk/test. txt 2r oot =pr of ect &syst enrexsyxox& 1=x& 2=y&pat hr ev=x

PD/Task
Any URL of CollabNet Enterprise Edition's Dashboard/Task pages are redireceted to the CollabNet TeamForge 6.1
Tasks application's home page.

e CollabNet EnterpriseEditionURL:ht t ps: // proj ect . donai n/ servl et s/ acti vity/*. doisredirected
tohttps://host/sf/taskngr/do/vi ewSunmary/ proj ects. proj ect/taskngr.

Wiki
All CollabNet Enterprise Edition Wiki URLs are redirected to the CollabNet TeamForge 6.1 Wiki application's home
page.

* CollabNet Enterprise Edition URL:ht t ps: // proj ect . domai n/wi ki /... isredirectedto
https://host/sf/w ki/do/vi ewPage/ <proj ect nane>/ wi ki / HonePage/ sf/wi ki /. ..

Project Metrics
CollabNet Enterprise Edition URL s of Report tool areredirected to the CollabNet TeamForge 6.1 Reporting application's

e CollabNet Enterprise Edition URL: ht t ps: // pr oj ect . domai n/ servl et s/ Report *. .. isredirectedto
https://host/sf/reporting/do/listReports/<projectnane>/reporting.

Announcements
All CollabNet Enterprise Edition News URLSs are redirected to CollabNet TeamForge 6.1's Announcements.

» CollabNet Enterprise Edition URL: htt ps: // pr oj ect . domai n/ servl et s/ Proj ect NewsAdd. . . is
re-directedtoht t ps: // host/ sf/ sf mai n/ do/ nyPage?sel ect edTab=news.

Help
CollabNet Enterprise Edition Help page URLs are redirected to appropriate help pages on "help.collab.net".

* CollabNet EnterpriseEdition URL: ht t ps: / / pr oj ect . domai n/ nonav/ ser vl et s/ Hel pTCCisre-directed
tohttp://hel p.coll ab. net/index.j sp.
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How is a project template structured?
When you create a template that includes project content, each tool bringsin its own kind of structure, depending on the type
of content it manages.

Folders

Some tools, such as Documents, Tasks, and File Releases, can be thought of as folders that contain individual items,
subfolders, or both.

For example, the Documents tool has a Root Folder, inside which you can create atree of subfolders to organize your
documents according to your project's needs. Every document lives inside one of these folders.

Note: Thisworks the same way regardless of the name of the root folder. For example, in the Tasks tool the root
folder is called the Tasks Summary, and in the Discussions tool the root folder is called the Forum Summary.

In aproject that hasbeen in use for any significant time, users have probably created some number of documents, which
they have shared by adding them to afolder in the Documentstool. When you create a project template from that project,
you can choose to include those documents in the project template or not.

« |f you chooseto include the documentsin the template, those documentswill appear in any new project that is created
using that template.

 |f you do not include the documentsin the template, new projects based on that template will include the Documents
tool, including the Root Folder and its sub-folders, but none of the documents that existed in the original project.

Not folders

The Reports and Wiki tools are not organized in folders. When you include the content from these tools in atemplate,
new projects created from that template include aflat collection of all the Wiki pages or reportsin the original project,
with al their text and data.

Why do you need the authentication and authorization plugin for Hudson?
TheAuthentication and Authorization plugin allows you to set up your Hudson installation to authenticate against a CollabNet
server and specify access control for CollabNet users.

Note: Authentication and authorization are independent actions. You could set up your Hudson installation to
authenticate against a SourceForge or TeamForge site, but not use that CollabNet site for authorizing users.
Authorizationisavailable only with CollabNet TeamForge 5.2, but authentication is possible with earlier CollabNet
SourceForge Enterprise versions as well.

[ N

Authentication

Authentication determines usenames and passwords. You establish user credentials when you enable your Hudson site
to use the CollabNet security realm.

Authorization
Authorization determines what users can do on the Hudson site.

Your Hudson server can be shared between many CollabNet projects, and you can grant TeamForge users permissions
a thesitelevel. You specify site-level permissionswhen you configure the site to use a CollabNet server for authorization.

A job on your Hudson server may be involved with more than one TeamForge project. For example, ajob that builds
software can pull in source code from multiple project repositories. For the purpose of authorization, however, each job
is associated with one CollabNet project, and you can give users project-level roles.

When your Hudson siteis set up to use CollabNet authorization, TeamForge project administrators can assign these
rolesto project members:

¢ Hudson Build/Cancel
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* Hudson Configure
e Hudson Delete

e Hudson Promote
e Hudson Read

Users get the highest permissions they are entitled to. For example, if auser is part of a group that has administration
permissions for the Hudson site, that supersedes any Hudson-related role the user might be assigned within a specific
CollabNet project.

What is the difference between a stagger and normal header in query result heading settings?
The normal and the stagger header preference setting allows you to set a standard header for your query view or a staggered
header.

For more information about queriesin Issue Tracker see: Query database of issues

How can Silver/Basic support customer file product enhancement requests?
Silver/Basic customers who want file enhancement requests, go to the "Discuss Roadmap" forum to file your requests online.

Use the "Discuss Roadmap" forum to file your requests online:
http://hel p.collab.net/topic/csfe510/tasks/support-requestfeature.html

Concepts and terms in TeamForge
Descriptions of concepts and terms in TeamForge.

What is a project?
A project is aworkspace where people can use the CollabNet TeamForge applications to collaborate and to create, store, and
share data. All the work you do with CollabNet TeamForge is organized into projects.

Any registered CollabNet TeamForge user can create a project, subject to approval by a CollabNet site administrator.
After anew project is approved, the project creator can configure project applications, add project members, and create
and assign rolesto govern each user's individual access permissions and the access permissions of groups of users. A
registered CollabNet can also request membership in any CollabNet project. Requests to join projects are submitted to
the project's administrators for approval.

How CollabNet TeamForge projects are organized is up to you and your organization. You might choose to create one
large, centralized CollabNet TeamForge project in which to manage all of your organization's devel opment work. Or
you might choose instead to create a number of smaller projects for each team or sub-project.

Any registered user on the site can create a project, subject to approval by a CollabNet TeamForge site administrator.
You can use a project template to pre-populate new projects with the structure and configuration of an existing project.

When you create a project, it is submitted to the CollabNet TeamForge administrator for approval. You will receive an
email notification when the site administrator approves or rejects your project. When your project is approved, you are
assigned the Founder Project Admin role and made a project administrator. You can access the project from your My
Pr oj ects page or from the Projects menu in your CollabNet TeamForge navigation bar.

What is a project page?
A CollabNet project page is a place where users can see and add information about the project, such as messages from the
project manager, open issues or documents you want people to read.

You can build your own project pages to design, manage and track your project’s lifecycle. When you create a project
page, users automatically seeit in their navigation panes.

To post information or provide functionality on your project page, you add a page component of the appropriate type
for the information or functionality you are working with.

For example, to et people know about how the project is coming along, add a Project Statistics component to the page.
To let project members upload documents for other users to read, you add a documents component.

If the page is a part of a parent page, it appears as anode in the tree in the | eft navigation area.


http://www.open.collab.net/nonav/scdocs/ddIssues_Query.html
http://help.collab.net/topic/csfe510/tasks/support-requestfeature.html
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You can add a page directly to the top of the project, or as a subpage.

Tip: When you have your project pages defined and your process honed, you can export your project pagesin the
form of a project template, so other projectsin your organization can reuse the resources you created. See Create
a project template on page 123.

[ 1

How does TeamForge support dynamic planning?
TeamForge helps you maximize your team's effectiveness by keeping you in close touch with the multiple moving targets
facing your project.

In adevelopment project, each piece of the picture constantly changes in response to changes in the other parts. Asyou
continue to iterate through the process, a feedback loop like this takes shape. (Click a node for more detail.)

The new Dynamic Planning features in TeamForge 6.1 give you a more open and extensible platform that integrates
and centralizes the software development tools necessary in modern application lifecycles.

Note: The Dynamic Planning features helps you effectively utilize Agile-like processes, but you can use any
process model you like.

Tracker summary screen

TeamForge 6.1 incorporates a new Tracker Summary screen display to accommodate planning folders, treeviews, and
multiple tracker viewing. The Tracker Summary section is available at the top of the screen with summaries of open
and closed artifacts as well as a summary of open artifacts by priority. The Planning Folders section islocated at the
bottom of the Tracker Summary screen. This section includes summaries of open and closed artifacts, a summary of
open artifacts by priority, and a summary of Effort for each planning folder.

Tree view

TeamForge 6.1 incorporates an expandable and collapsible tree view of the planning folder hierarchical structure to
display parent/child relationships of artifacts.

Thetreeview allowsfor the viewing of artifactsin ahierarchical structure and displays parent/child relationships across
multiple trackers.

What is a planning folder?
A planning folder isavirtual container that helps you organize and plan the work that goesinto delivering a product.

You can create a hierarchy of planning folders to organize artifacts by product, release, iteration, etc. You can store
artifacts from multiple trackersin aplanning folder. This allows you to plan various stages of your project (i.e. releases,
iterations, etc.).

Selecting an individual planning folder provides aview of all artifacts from all trackers within the selected planning
folder.

The Planned For field identifies which product, release, or iteration the artifact is planned for, based on the planning
folder that it is assigned to.

For example, in an agile development environment, a project manager breaks down the prospective product into its
component parts and looks at what it would take to deliver each one. When all the parts planned for a given iteration
are finished, the product is considered complete for that iteration.

Some parts of aproduct can be developed more or lessin isolation, but most depend on other parts. Tracking these
relationships is one of the trickiest aspects of product devel opment.

For example, you can only provide a graphical user interface for a shopping cart application if you also come up with
a database for the customer's payment data to be stored and accessed. That in turn requires a data storage and backup
solution of some kind. And so on.

Use a planning folder to track the dependencies among the parts of your project as each moves toward completion. As
you work through the question of what depends on what, you'll move artifacts representing user storiesinto the appropriate
iteration in the appropriate release. As you proceed, you'll find a pattern like this emerging:
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e Product 1
e Reeasel

e |teration 1
e |teration 2

* Release?2
¢ Product 2

g~ Note: "Move" is meant figuratively. When you "move" an artifact into a planning folder, it is still a member of

- thetracker whereit lives, and you can till do all the things with it that you can do with an ordinary tracker artifact.
Your planning folder |ets you see at a glance the pieces of the work that support other pieces, and the pieces that depend
on other pieces. Think of thisasa"planning tree." If you are responsible for a devel opment project, you can use this
tree view to understand and predict the time and effort required to deliver a given set of features.

Why can't | move these artifacts into this planning folder?
To avoid confusion, you must observe afew basic rules when you assign artifacts to planning folders.

When an artifact in a planning folder has a child artifact, the child artifact can only be assigned to the same planning
folder as the parent artifact, or a sub-folder of that folder. For example:

» Before you assign an artifact to a planning folder, make sure the artifact and al its children are assigned to asingle
planning folder and its sub-folders.

« Don't assign an artifact to aplanning folder that is above the artifact's parent artifact in the planning folder hierarchy.

« Before promoting aplanning folder to ahigher level in the hierarchy, make sureits member artifacts (and its members
parent artifacts) are all assigned to the same planning folder or a sub-folder of it.

An artifact can only be assigned to a planning folder in its own project.
Asabest practice, consider instead creating a matching artifact in this project and associate the two artifacts.

Before you assign an artifact to a planning folder, be sure you have permission to edit every artifact affected by the
move.

What is velocity?
Your team's velocity is the amount of work the team has shown it can complete in a sprint. You can use this information to
help estimate how much work can be completed in future sprints.

You can see your team's current average velocity by clicking the burndown chart to expand it in its own window.

Velocity only makes sense as arelative measure. There is no specific velocity that is good or bad or standard, because
no two teams take on work of exactly the same scale or complexity. However, if your team's velocity isincreasing from
sprint to sprint, you can surmise that you are on the right track.

Velocity is calculated by dividing the amount of work time contained in the sprint by the effort completed. Effort is
often measured in "story points."

For example, say your team used Sprint 2 to complete the tail assembly, which had been estimated at 13 story points,
and the communication system, which was worth 8 story points. In total, 21 story points were completed during that
sprint. If each team member put in 8 hours a day, and you are working ten-day sprints, it took 560 person-hours to
complete the work. When you divide the hoursin the sprint by the story points completed in the sprint, you find that
your team is able to complete astory point in just under 27 hours.

Now that you know your team's vel ocity and the number of story points at stake, you are in a position to guess at how
much work your team can complete in the next sprint. As each successive sprint exposes more information about your
team's strengths and weak points, your estimates can become increasingly reliable.
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What is a story point?
A story point isameasure of effort that expresses the relative difficulty of implementing a user story. You can use story points
to help estimate how much work can be done in a sprint.

Story points are useful for relative measurement. A story point has no specific valuein hours, or lines of code, or anything
else. When you are estimating work, use story points only to compare one piece of work with another.

When you record avalue in the Story Pointsfield of an artifact, that value is added to the total story pointsin the
planning folder that the artifact belongs to. You can then use that figure to support forecasting.

How does TeamForge automatically sum up effort estimates?
Asyou refine your agile project plan, you break down user storiesinto smaller stories, and eventually into tasks. TeamForge
can watch the changing effort estimates all the way down the hierarchy, and give you a running total for each parent artifact
and al its children.

Example

Imagine that you originally created a user story to describe the need for a " Shopping Cart" feature in your e-commerce
application. You gave this story arough effort estimate of 20 units, and entered that figure in the Effort field.

Upon further discussion, your project team recommends breaking the story down into three tasks:

» Database (5 units)
e Back End (15 units)
e Ul (8 units)

You create artifactsfor those three tasks, identifying them as children of the user story artifact, and enter their respective
effort estimatesin the Effort field in each task artifact.

Back in the "Shopping Cart" story artifact, you select Autosum effort to indicate that effort number for this artifact
should be rolled up from its children.

Now, rather than showing the manually entered number (20 units), your user story artifact showsthe figure derived from
adding the effort estimates for al three child artifacts (28 units).

Double-counting?

Effort numbers are never "double-counted" when auto-summing is on. For example, if the sum for planning folder A
would include effort for child C and parent P, and P has autosumming turned on, C's effort number is only counted once.

However, when auto-summing is off, the effort numbers from parent P and child C can both contribute to totals. So if
aplanning folder A includes parent P (autosum=off, effort=3) and child C (effort=5), then the pair contributes atotal
of 8toA'stotal.

An artifact's effort number is calculated from the effort numbers of its immediate children artifacts only. Thisistrue
whether or not those children's numbers are themselves automatically derived.

Note: When atracker isdisabled, artifacts from that tracker do not contribute to the effort totals calculated for any
planning folder they arein.

Permissions

If you are along-time user of TeamForge tracker features, be aware that autosumming can lead to some situations you
haven't seen before. For example, picture these scenarios.

» Artifact A isassigned to Sanil. He therefore has permission to edit that artifact, but he does not have permission to
edit the artifact's parent, artifact B. Artifact B isassigned to Sergey, who has edit permission for both artifacts. Sergey
turns on autosumming for artifact B. When Sanil updates his effort estimate for artifact A, the content of the Effort
field in artifact B is updated as a result, even though only Sergey is explicitly authorized to change valuesin artifact
B.

» Connie creates artifacts X and Y, and declares both of them children of artifact Z. Then she assigns artifact Z to
Thiru. Thiru now has edit permission for artifact Z. But he cannot edit artifact X or artifact Y, because he does not
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have access to the separate tracker where they live. When Thiru turns on autosumming for artifact Z, that artifact's
Effort field includes the sum of artifacts X and 'Y, even though Thiru is not explicitly authorized to see any data
from those artifacts. (In fact, he may not even know that artifacts X and'Y exist.)

How do you measure "effort?"
Effort isauniform span of time for measuring work on your product. Defining the unit of effort isan essential part of planning
your work.

TeamForge 6.1 shows you the effort that has been estimated, and actually expended, for each artifact on the tracker
summary screen. Parent artifacts can automatically add up these effort figures from their child artifacts' effort figures.
The calculator icon indicates that the artifact’s effort is a sum of its child artifacts’ effort.

g~ Note: When atracker is disabled, artifacts from that tracker do not contribute to the effort totals calculated for any
- planning folder they arein.

The unit of effort should be something that makes sensein your environment. TeamForge does not require any particular
unit. Your unit of effort might be hours per person, days, weeks, or something else. (If you are using a scrum-based
project methodology, you may have opted to measure effort in relative terms, using story points, in which case you can
leave the Effort fields blank.)

For example, some teams use the "ideal hour" as their standard unit of effort. To define an ideal hour, consider all the
activitiesin astandard work day that must be done but don't directly contribute to development: installing and configuring
tools, eating lunch, responding to email and instant messages, providing customer support, etc. For every hour of direct
development work, how much time goes into these activities, on the average? If the answer is about a half hour, then
your ideal hour is 1.5 clock hours.

Now consider atask that you judge to represent about four hours of direct development work. The value you'll enter in
the Effort field is 6, because for each hour of direct devel opment you'll need an extrahalf hour to makethat development
work possible.

In an environment with alot of overhead -- for example, agroup that relies on avery complex tool set -- your ideal hour
might equal two clock hours, or perhaps much more. Thisisnot in itself a problem: the point is not to suppress needed
activities, but to plan realistically, in order to reduce the need for routine scheduling adjustments and to forecast more
reliably.

(However, when units of effort seem radically out of linewith reality, thismay be acluethat something in the environment
could be better optimized.)

For aquick view of the effort values you are working with, check the Planning Folder Summary page.

» The estimated, remaining and actual values are listed for the planning folder as awhole.

e TheEst column showsthe original estimated effort value for each artifact in the folder.

« The Rem clolumn shows the value remaining for each artifact after the latest update to the artifact.

» The Act column shows the actual effort expended for each artifact, calculated after the work is done.

Tip: Tomakeyour tracking easier, consider having TeamForge automatically generate arunning total of estimated
effort for awhole hierarchy of user stories or tasks.

What are all these charts about?
The chartsin CollabNet TeamForge provide a variety of graphica windows on your project's progress. You can print these
charts, import them into presentations, or send out links to them.

Charts are acomplement to the datain your planning folder, not asubstitute for it. Each chart is good for aquick update
on aparticular kind of information about your project. For the fullest picture, consider al the charts in context, and
always check your impressions by inspecting the detailed information contained in your tracker artifacts and planning
folders.

g~ Note: Your browser must have a Flash player installed to view the charts.


http://get.adobe.com/flashplayer/
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What can | learn from a burndown chart?
Burndown isthe estimated amount of work that remainsto be donein an iteration, compared with thework originally estimated.

At any time, you can click on aplanning folder and see how the sum of the estimated and remaining effort for all
contained and descendant features is changing within a given timeframe. This helps you see how the estimates for your
features are changing from day to day, and how the team is progressing towards "done" (remaining effort at zero).

You can use the trend line shown in your burndown chart to do some useful things:

» Project the time when all the work for this iteration will be completed.
» Predict the amount of work your team can expect to complete during any given iteration. (Thisis known as your
team's velocity.)

The information you derive from your burndown chart will help revise the product scope, make accurate planning
decisions, and refine implementation details.

Here's an example of a burndown chart.

\//— B Priority 1 Remaini
28

24 B Priority 2 Remaini
" 20 I Priority 3 Remaini
[=]
E 16 Priority 4 Remaini
12 o .
Priority 5 Remain
&
4 Priority None Rem
i I B Total Estimated E
(=] [=4] (=] (=] (=] (=] [=x] (=] (=] (=] [=4] (=] (=] (=] [=4]
[=] [=] [=] [=1] [=] [=] [=] [=] [=] [=] [=] [=] [=] [=] [=]
i R @ 8 8 8 8 8 8 8 8 & &8 8 & MW Velocity Trend
- G R . - - - = = =]
A [l ('] ('] ™ ™ [l ('] [l ™ ™ (o] (] ) [
S O & &0 &5 &0 &5 8 &5 & & & & = =
1 vl vl il il vl vl vl | vl vl vl | vl vl 1 g i
Date . Avg velocity

In general, aburndown chart trends downward until it reaches zero. In practice, some events can reverse the downward
trend of your burndown chart. For example, development work frequently uncovers agreater scope for a user story than
was initially estimated. As aresult, you'll revise your estimate of remaining work on that story, and your burndown
figure may be pushed upwards.

The burndown chart uses whatever effort units you are using in the planning folder.

Note: The story told in your burndown chart is only as reliable as the underlying data. The owners of individual
task artifacts can help keep the burndown chart accurate by regularly updating their remaining effort figures.

What can | learn from a capacity chart?
The capacity chart shows the project team's judgment of how much work can be done with the resources available and the
time period represented in the planning folder.

* When you compare average capacity with individual users' assignments, you can see which team members are
relatively over- or under-assigned. You can a so see how much of the estimated and remaining effort is unassigned.

» Comparing average capacity with the relative priorities of artifactsis one way to gauge your team's ability to deliver
the work that the product owner has defined.

« When you view average capacity against the count of open and closed artifacts, you have another way to assess your
team's likelihood of meeting its sprint commitment.

The data behind the capacity chart is updated in real time, so that your team can respond quickly to changesin effort
estimates or relative priorities.
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Capacity is expressed as a numeric value, using the same scale as you are using for estimated, remaining, actual effort
accounts.

You can see the capacity of a planning folder in the planning folder summary view.

Tip: A planning folder's capacity must be equal to or greater than the total estimated effort (or total remaining
effort) for the artifacts in the planning folder. To avoid confusion, you may want to wait for estimates to emerge
before setting the planning folder's capacity.

[ 1

What can | learn from an Open by Priority chart?
Dynamic planning is most effective when you know the relative priorities of work items you are tracking. The Open by
Priority chart helps you check that your team is working on the optimal mix of artifacts.

Use the Open by Priority chart for a quick overview of the type of work your project isworking with. A glance at this
chart can suggest some broad generalizations, which you'll then want to test by examining your planning folder contents
more closely.

*  When the darker bars on the |eft side of the chart are high, you are probably working on the high-impact issues that
come up earlier inawork cycle. Don't be surprised if thetrend linein your Burndown chart isnot yet sloping steeply
downward to the right.

« When thelighter bars on the right side of the chart are high, you are likely to be working on cleanup issues and
refinements. You may be approaching the end of the work cycle you defined in this planning folder. At this stage,
the Closed dlice of the Open vs. Closed chart islikely to be equal to or larger than the Open proportion.

Note: The Open by Priority chart won't tell you how much work isinvolved in the artifacts that it measures. For
that, check the Burndown chart.

What can | learn from an Open vs. Closed chart?
Sometimes you just want araw count of the number of work items you are looking at.

Usethe Open vs. Closed chart for aquick overview of your team's progress in purely numerical terms. A glance at this
chart can suggest some broad generalizations, which you'll then want to test by examining your other charts and your
planning folder contents more closely.

TheOpen vs. Closed chart isgood for some basic summary information. You may want to sharethis chart with executive
sponsors who need to know how things are going in quantitive terms, but don't need alot of detail about the types of
work being addressed.

What is a feature tree?
A feature treeisaway to look at planned product features hierarchically, so you can quickly understand the rel ationships
among product features you have specified.

A feature tree is what you see when you click the Tree button on atracker overview screen. (You can return to the
traditional single-level tracker view by clicking list.)

The feature tree shows you the nested descendants of an artifact at whatever level of detail you need, all the way down
to the tasks supporting your lowest-level user stories. When you define a user story that depends on several tasksfor its
completion, and you declare each of those tasks a"child" of the user story, they appear as subordinate nodes under the
"parent” user story artifact in the feature tree.

User stories are the most common components of a feature tree, but any kind of artifact can appear. For example, when
the completion of a user story depends on fixing a bug, the artifact representing the bug appearsin your feature tree as
a"child" node under the artifact representing the user story.

For each artifact in the feature tree, look for this key information:

Priority A relative measure of how important the feature is, compared with the other features you
want in the product.

Artifact ID The permanent alphanumeric identifier for the artifact. Usethe Jump to | D box to quickly
find artifacts by their artifact ID.

Title A short phrase identifying the work that the artifact describes.
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Status The artifact's position in the workflow of its project. Standard status values are "Open,"
"Under development,” "In QA," and the like.

Estimated Effort A measure of the work required to deliver the work described in the artifact. The units
used are up to you -- just make sure they are used consistently across the project, so that
you get accurate totals when you need them.

Remaining Effort A measure of the work that's still to be done on the artifact, in the same units used in
Estimated Effort. Project members must update this value whenever they advance the
work in the artifact.

Planning Folder The planning folder that the artifact is assigned to, if any.

What is an iteration?
Aniteration (also called a sprint) is the period of time it takes to produce something that works well enough to show to the
user.

At the end of an iteration, users get to try out the functionality. They can and accept it or send it back for more work.

» Acceptance meansthe user agreesthat the acceptance criteriastated in the user story have been met, and the capabilities
as implemented support the needs that the user identified.

* Rejection means the product, as implemented, does not support the user's requirements. Sometimes this means the
development team has not understood the user story the way the product owner meant it. Sometimes it means the
user'sinitial ideasturned out not to be so helpful in practice. In either case, thisleadsto more analysis and devel opment
work.

Keeping iterations as short as possible hel ps reduce the time spent on corrections when features don't meet the users
expectations. It isless costly to redo two weeks of development than six or eight weeks.
Shorter, more modest iterations also tend to generate more reliable burndown data for estimating further work.
What is a product owner?

The product owner works with the users, or customers, to define how a product can address their needs and wishes.

Astheintermediary between the user and the development team, the product owner defines the product scope and
reguirements.

The product owner is sometimes called a product manager or a marketing manager. If your organization has a project
office, that group may include people who function as product owners.

The product owner's primary focusis on the content of the product. The details of implementation planning and scheduling
will affect and be affected by the product owner's work, but they are not the product owner's direct concern.

In TeamForge, the product owner's main focus is the feature tree. Thisis the part of the interface where discussions of
product features are organized and tracked.
Thisisjust avague summary of the product owner'srole. For more detail, see[list of resources|.

What is a project administrator?
The project leader takes user stories created by the product owner and works with the project team to manage the process of
analyzing, scheduling and executing them.

The project leader coordinates the development team.
The project leader is sometimes called a scrum master, ateam lead, or some other variation.

The project leader's primary focusis on the development of the product. This work provides feedback that's useful for
defining and revising the scope of the product and for estimating the effort involved, but those are not what the project
leader is directly concerned with.

In TeamForge, the project leader's main focusis the planning tree. Thisisthe part of the interface where you define and
schedule the work items and personnel needed to deliver the required features.
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What is an agile project team?
Asamember of aproject team, you implement product features according to user stories created by the product owner and
planning input from the project leader.

Project team members must use their experience and judgment to estimate the effort involved in work that's been specified
by the product owner and the project leader. These estimates will often lead to changes in the product scope and the
project plan. In that sense, project team members are an important part of the agile planning process.

The project team members may be known as devel opers, programmers, engineers, individual contributors, or something
else that's appopriate to the type of work being done.

In TeamForge, the project team member's main focus is the tracker. Project members can manage and track their work
by observing and maintaining tracker artifacts such as user stories, defects, or tasks.

Who can access project planning information?
A project manager should consider carefully who is able to change the project plan.

You can specify the people who can change the product plan based on their rolesin the project. Only users with therole
you select can view, create, modify, and delete artifacts in the planning folder hierarchy, and popul ate those artifacts
with content.

Every project must strike its own unique balance between openness and control. These broad guidelines may help you
decide how to set up the appropriate roles for your project.

e Err onthe side of visihility. Most of the time you will want all project membersto at least see the contents of all
planning folders. This helps developers avoid duplicating their efforts, and it can enable team members to volunteer
their help to each other when appropriate.

However, occasionally you may want to hide all or part of the planning folder hierarchy from selected people. For
example, when you bring on a contract developer for a short period, you may want to restrict that person's view to
the specific artifacts they are working on directly.

e Limit the number of people who can modify or populate planning folders. In many cases, only the project manager
really needsto do this.

However, it may make sense to allow some people with adirect stake in the project to modify some folders. For
example, if you are working with a product owner, it might be useful for that person to be assigning artifactsto future
planning folders while your team is working on the current one.

What does the status of a planning folder mean?
The status of a planning folder communicates where it currently stands in the devel opment process. You can set the status of
aplanning folder to values you define yourself.

The status of a planning folder can help project members make sense of what can be a complex development process.
For example, consider these scenarios:

Drop everything!

Just when you've prepared a planning folder and are ready to kick off a sprint, the product owner gets word of a more
pressing set of features and asks you to postpone this work and get right to the newly revealed priority. You're worried
that your project's momentum might lead project members to keep picking up tasksin this planning folder instead of
switching to the new work.

Create astatus called "On hold," and specify it asan "Inactive" status. When you give the planning folder your new "On
hold" status, project members whose view shows only active folders won't see thisone in their planning folder list.

It's a wrap

Your sprint has just concluded. You don't want any further development work to happen in this planning folder, but you
do want team members and others to be able to peruse it for insight into what we